— |STIBOSYSTEMS

- MASTER DATA MANAGEMENT

USER GUIDE
Getting Started

Release 11.2 (2023.2)-MP2 — August 2023



| ISTIBOSYSTEMS

MASTER DATA MAMNAGEMEMT

Adding aBookmark ... 48
RemovingaBookmark ... 51
Table of Contents g

EditingaBookmark ............................. 52
Table of Contents ........................... 2 Copying a Bookmark to the Clipboard .... 54
Getting Started ... 7 Menu ltems . 55
Introduction ... .. 8 File Menu 56
STEP Terminology ............................... 9 Edit Menu . 64
Basic STEP Concepts ........................... 23 View Menu 69
Object TypesOverview ... 23 NavigateMenu ... 77
Object Super Types .......................... 23 Format Menu ... 81
Object Types Versus Object Instances ....... 24 Maintain Menu . 86
Object Super Types .............................. 31 Window Menu ... 95
Assets ... 31 HelpMenu ... ... ... ... 97
Classifications ... 32 Object Editor ... 99
Entities ... 33 SearchTab ... ... ... . ... 100
Products ... 34 STEP WorkflowTab ... 102
Publications ... .. 34 Tasks 102
Accessing STEP System Information ... 36 Profile 105
'About STEP'Page ............................. 36 System SetupTab ............................. 106
Detailed Version Information _............... 37 Toolbar 107
System Snapshot and Diagnostics Stibo SystemsLogo ... 107

PackageLinks ................................ 38
ContextList ... ... 107

STEP Workbench Ul ... ... ... ... 39
Workspace Toggle Button .................... 107

BGProcessesTab .............................. 41
Navigation Buttons ._.._.._..................... 108

BG Processes Displayed ....................._. 42
AddressField ... ... 108

Background Process Tab ....................... 42
Viewing Mode Buttons ... ... 108

QueuelnfoTab .................................. 44
Normalmode ... ... ........... 108

Bookmarks Tab .............. ... ... 46

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 2



| ISTIBOSYSTEMS

MASTER DATA MAMNAGEMEMT

Translatonmode ............................ 108
Workspacemode ............................ 108
Contextmode ............................... 109
Revisionmode .............................. 109
GotoField ... ... 109
TreeTab ... ... 110
Object Maintenance in the Tree Tab ... 112
AllObjects ... 113
Approval of Objects ............................ 114
Approval Overview _............................ 114
InUse and Not In Use Objects ............... 115
Approving an Object .._........................ 117
DataOwnership ... ... 117
Approvingan Object ........................... 118
Partially Approvingan Object ..............._. 119
Suppress Re-translation ................. 122
Check Approve ...........ocoooiioiiiiiiiiii.. 122
Approve Recursively ........................... 123
Approval Feedback ... ... 125
Approve Object Feedback ............... 125
Partial Approve Feedback _.............. 125
Approve Recursively feedback ......._. 126
Approved Symbols and Messages ........ 131
Approved Status Symbols .................... 131
Approved Status Messages .................. 132
Creating Objects in the Tree Tab ........... 134
Deleting Objects in the Tree Tab ........... 137

Editing Objects inthe Tree Tab ............. 140
Multi-Editors ... 142
Right-Click Editing Options ................... 145
Additional Information ......................... 146

Inline References in Attribute Values ... 147

Inserting an Inline Reference using
Workbench ... .. 147

Inline References and Multi-Valued
Attributes .. ... .. 150

Copying Attribute Values as Inline
References ... .. . .. ... 151

Assets ... ... .. 154
Classificationof Assets ........................ 154
Asset File Type Designation .................. 155
Asset Objects and Digital Media Files ....._. 156
Image Variantsand Handling ................ 157
More Information .............................. 157

Maintaining Assets ............................. 158
Creating Assets ... 158
AssetEditor ... 159

Images & Documents _...................... 159
References ... ... .. ... 161
ReferencedBy ... ... ... 162
Status ... . 163
StateLog ... 163
Tasks ... 163
Asset Dimension Dependencies ............. 163
Custom Asset Metadata ................ .. . 165

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 3



| ISTIBOSYSTEMS

MASTER DATA MAMNAGEMEMT

Linking Assets to Products .................. 169
Classifications ... 175
Classification Editor ............................ 175
SubProducts ... 175
References ....... ... 178
ReferencedBy ... ... ... ... 180
Images & Documents ... 181
Tables ... ... ... 181
Status ... 181
State Log ... 182
Tasks ..o 182
Collections _............ ... 183
Creating Collections ........................... 186
Creating a Collection from Search .......... 186
Creating a Collection from File Import ... 188
Creating Collection Groups ................. 191
Creating a Collection Group .................. 191
Maintaining Collections ....................... 193
Delete ... 193
Edit Search Criteria ............................ 195
ExportDataBelow ... ... ................... 196
RefreshData ... .. ... 197
RunBulkUpdate ............................... 198
Republish ... ... 199
SearchBelow ......... ... 200
Collection Properties and Statistics ...... 202
CollectionTab .................................. 202

Description Flipper .......................... 202
Statistics Flipper ... 203
DataProfileTab ... 204
LogTab ..o 206
Entities ... .. 207
Entity Hierarchy ... 207
Entity Editor ... . 208
Entity References, Referenced By, and
StatusTabs ... 209
ReferencesTab ................................ 209
ReferencedByTab ............................ 211
StatusTab ... 212
Products ....... ... ... ... 214
ProductHierarchy .............................. 214
Product Editor .................................. 215
Additional Editors ... 217
Inheritance in the Product Hierarchy ... .. 218
Linking Attributes to Products ._.._........._. 219
Working with Inherited Values ............... 222
Images & Documents Tab .................... 224
Interactingwith Assets ......................... 224
Editasset ... 224
Editreferencetype ... ... 225
Filter the displayed assets .................. 225
Navigatetoasset ... ........... 226
Product Overrides ............................. 227
Creating a Product Override ............... 228

Linking Products into a Product Override 229

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 4



| ISTIBOSYSTEMS

MASTER DATA MAMNAGEMEMT

Removing Products from the Product

Override ... ... 229
Creating a Subordinate Product
Override ... ... 229
Referenced By Tab ... ... ... 230
References Tab ................................. 232
StatusTab ... ... 234
SubProductsTab ........................... .. 236
Recycle Bin for the Tree Tab ................ 238
Resolving Deleted Objects .................... 239
Schedule Empty Recycle Bin ............... 241
Configuring a Schedule Empty Recycle Bin
Operation ... 241
Navigating and Searching .................... 246
Navigation ... ... ... 247
ExpandingaFolder .._................... ... 247
CollapsingaFolder .......................... 247
CollapseTree .......cooooiimiii . 247
Goto ... ... 250
Bookmarks ... ... 253
Standard Navigation Bookmarks ............ 253
SearchBookmarks ............................ 253

Editinga Bookmark ... 255
RemovingaBookmark ........................ 255
Search ... ... 256
SearchElements .............................. 256
SearchOptions ... 258
Search Functionality ........................... 260

Standard Search Criteria ..................... 260
Search Field Typeahead ...................... 260
Limiting Results to MatchesonIDs .......... 261
Limiting Results to Matches on Name ...... 261
Attribute Value Searches .._.................. 262
Attribute Value Search Operators ........... 263
Wildcardsin Searches ..................... .. 264
Searches in 'Full Text Indexable' Attribute
Values ... L 264
Numeric Value Searches for Attributes
withUnits ... . 265
ISODateSearches ............................ 265
Combining Search Criteria ..._............... 266
Using 'Exclude’ Search Criteria .............. 267
Using the 'OR'Operator ....................... 268
Search Result Profiling ....................... 270
Search: Advanced Options _.._..._......._.. 272
Search Operations on Entire Result ... .. 278
Exportinga SearchResult ................. 278

Saving a Search Result as a Collection ..278

Bulk Updating a Search Result _........._. 279
Search: Data Containers ................. ... 280
Search: Document Content ........_..... .. 288
Search: JavaScript Search ................... 289
Search: Missing Mandatory Values ....... 291

UseCases ..., 291
Search: Object Type .......................... 294
System Setup Object Types _................. 296

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 5



Special TYpes ... 297
Search: Product Override Search ....... .. 298
Search: Referenced Assets .................. 302

Checkboxes for Referenced Assets
Search ... . 303

ReferencedBy ... .. ... ... 311

References and Referenced By
Metadata Attribute Value Searches ...... 313

Search: Revised Objects Changed Since 314

Search: SampleResult ... ... 319
Search: SearchBelow ......................... 321
Search: Search fromList ..................... 324

Search: Search in Publication Hierarchy 333
Search: STEP Workflow ._.................. . 339
Search: Unapproved ... 342
Search: Unpushed or Failed Assets ...... 345
STEP Workbench Keyboard Shortcuts ..348

BasicShortcuts ... ... 348

Navigate to Main Side Bar Tabs in
Workbench ... . 349

Navigate to Horizontal Tabs within Main
SidebarTabs ... ... 349

InsertOptions ... ... 351
Linking Options ... 353
Style Options ... 353
Flatplanner Shortcuts .......................... 354

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023

[ ]

STIBOSYSTEMS

MASTER DATA MAMNAGEMEMT



|STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

Getting Started

This section is intended to provide users with an introduction to the STEP system and concepts. Additionally, it
provides detailed information needed to perform basic data maintenance tasks in STEP, including detailed
descriptions of the workbench interface and search functionality. While geared towards end users, the guide
provides information that is necessary for all users to understand as a foundation for more advanced topics.

This guide is centered around STEP Workbench, but the concepts and functionality presented are often
applicable to both the workbench and Web Ul interfaces. Because of this, it is helpful for users of either interface
to be familiar with the material in this guide. For documentation specific to the Web Ul, refer to the Web User
Interfaces guide.

The Getting Started guide contains the following sections.

Introduction: This section includes a terminology table and an overview of some basic STEP concepts.
This material should be understood prior to proceeding through the guide as it lays the foundation for the
subsequent topics.

STEP Workbench Ul: This section introduces the user to the workbench interface, as well as providing
detailed reference information for the various functions, including toolbar actions and menu options.

Object Maintenance in the Tree Tab: This section provides an overview of creating, editing, and
deleting objects in the workbench, as well as providing detailed information for working with particular
types of objects.

Navigating and Searching: This section introduces the user to basic search and navigation functionality
in STEP Workbench, as well as providing detailed descriptions of the search criteria available on the
Search tab.

STEP Workbench Keyboard Shortcuts: This topic provides a list of keyboard shortcuts that can be
used in the workbench.
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Introduction

This section introduces the reader to basic STEP terminology and concepts. This information provides a
foundation that is key to understanding the subsequent materials.

« STEP Terminology: A table defining basic STEP terms, including links to topics with additional
information.

« Basic STEP Concepts:Introduces some core concepts in STEP to facilitate understanding of the Getting
Started and System Setup guides.

« Object Super Types: Provides an introduction to the STEP object super types, including links to detailed
information for each type.
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This topic provides definitions for basic STEP terminology that is helpful to be aware of when reading the online
help. Links to additional material on related topics are also provided, when appropriate. This should not be
considered a complete list of all STEP terms as it is intended to cover only the more commonly used terms that
users are likely to encounter throughout the online help.

A
Definition Further
Reading
Action Type of business rule that can be executed to manipulate data or perform an Refer to the
action. Actions can be executed by various processes and events within the Business
system. For example, at approval of an object, within a workflow (onentrytoa | Actions topicin
state, exit from a state, on the transition between tasks, or when a deadline has | the Business
been met), as part of an import process, or from a bulk update process. Rules
documentation.
API refer to Public API Refer to the
STEP API
Documentation
link on the Start
Page.
Approval | The process of pushing data from the Maintenance workspace to the Refer to the
Approved workspace in STEP. Approval can be associated with business logic | Approval of
that may prevent approval or may perform automated data updates during Objects topicin
approval. Approvals are often the triggers for sending data to downstream the Getting
systems. Started
documentation.
Asset Any type of digital media, such as an image, Word document, PDF, Excel file, Refer to the
PowerPoint, JPG, GIF, etc. Assets topicin
the Getting
Started
documentation.
Asset A process that exports assets from STEP to a file system. Conversion Refer to the
Push templates can be applied to transform images, for example from highrestolow | Asset Push
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Further

Reading

res, resizing, applying color scales, etc., though assets can also be sent as-is to
make them available on the file system.

topicin the
Digital Assets
guide.

Assignee | The user or group to which a task is assigned for work to be performed withina | Refer to the
workflow. User states can be assigned directly to a named user or to a user Assigneesin
group. When a state is assigned to a user group the task is "offered" to all Workflows
members of that group. To perform the task associated with the state, a topicin the
member of the group has to claim the task. Once a task is claimed it is no Workflows
longer visible in the group task list; only the person who claimed the task is able | documentation.
to view it. A user may subsequently release a task back to the group.

Attribute | A characteristic or detailed piece of information related to a particular object. Refer to the
Attributes can be one of two types, description or specification. Description Attributes topic
attributes are available on most object types in STEP, while specification in the System
attributes are only available on objects in the Primary Product Hierarchy. Setup

documentation.

Attribute | Groups attributes, reference types, and/or link types. Attribute groups can Refer to the

Group have sub-groups. Attributes

Groups topicin
the System
Setup
documentation.

Attribute | The value stored in a particular attribute on a particular object. Refer to the

Value Attributes topic

in the System

Setup

documentation.
B

Definition

Further Reading

Bookmark | A placeholder created by the user that serves as a shortcutto a

previously viewed location.

Refer to the
Bookmarks topicin the

Getting Started
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Term Definition Further Reading

documentation.

Business | Automated piece of programming logic that may implement customer- | Refer to the Business

Rule defined rules, such as validations, automatic updates, notifications, Rules topicin the
data-driven workflow routing, etc. Also refer to Condition and Action. Business Rules
documentation.
C
Term Definition Further Reading
Calculated An attribute where the value is calculated according to a specific Refer to the
Attribute formula defined for this attribute. The formula may include static text, Calculated
other attribute values, information from references on the object, and Attributes topicin
a number of other options. the System Setup
documentation.
Category View in STEP that helps product managers and data analysts to get Refer to the Data
Profile an overview of an entire section of the Product Hierarchy through Profiles topicin the
various metrics that are displayed in dashboard format. Data Profiling
documentation.
Character Tag | An entry that begins with “<” and ends with “/>” such as <check/>. Refer to the Tags
These tags represent characters that may not be found in the special topicin the System
character map in Unicode, or may be used instead of the Unicode Setup
character. documentation.
Claim The action that a user performs to take a task in a workflow out of a Refer to the
group queue and assign to himself / herself. Claiming and
Releasing Tasks in
Workflows topic in
the Workflows
documentation.
Classification | A particular type of hierarchy that organizes groups of objects or Refer to the
assets. Objects are linked to classifications via references, and may Classifications
have references to multiple classifications. Also referred to as "yellow | topic in the Getting
folders." Started
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Term Definition Further Reading
documentation.
Collection An object that holds a static set of objects, or a dynamic search criteria | Refer to the
that can be refreshed as needed to find the latest matching objects. Collections topicin
Using collections, the resulting data can be displayed, bulk actions can | the Getting Started
be performed, or the objects can be exported. documentation.
Completeness | A measurement within STEP, expressed as a percentage, to indicate | Refer to the Metric
Score the proportion of key data that has been completed for a particular Visualization topic
object. This key data is configurable, as is the weighting of in the System
importance. Setup
documentation.
Condition A condition is a type of business rule that evaluates to either true or Refer to the
false, and does not change data. In relation with approval, a condition | Business
can act as validation for whether an approval action can be carried Conditions topicin
out. In relation to workflows, conditions can be used to prevent a the Business
transition from being taken if certain conditions are not met. Rules
documentation.
Context A specific filter placed on the system data. Each contextis a Refer to the
combination of different dimensions such as language, country, and Contexts topicin
so forth, for example, English US, French CA, or German DE. Data the System Setup
may vary based on context. documentation.
D
Term Definition Further Reading
Data An object type for modeling complex entity or product data structures Refer to the Data
Container with a single record. Data containers make use of composite attributes Containers topicin
which are composed of other data structures, and they are intended to the System Setup
ensure that all create, read, update, and delete operations can be documentation.
performed as a whole.
Data Model | Basic system configuration defining the allowable structures and make Refer to the
up of data within STEP. Consists of system setup data, including: sections within the
dimensions, contexts, object types, reference types, keys, component System Setup
© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 12




1STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

Definition

Term Definition Further Reading
models, attribute groups, attributes, lists of values, units, and tags. documentation.
Dimension- | An attribute that can have different values for different dimension points, | Refer to the
Dependent | where the actual value is determined by the context in which the Dimension
Attribute attribute is presented. Dependent
Attributes topicin
the System Setup
documentation.
E
Definition Further
Reading
Entity A group of master data that has a specific business meaning. Entities Refer to the
typically store product-neutral data in STEP according to client-specific Entities topicin
groupings of information, such as customers, employees, suppliers, and the Getting
addresses. Entities are also often used to store reference data that is utilized | Started
within the system. Entities can be grouped into a hierarchy using reference documentation.
types that are only valid from an entity object to an entity object. A source
object can be displayed as a child of the target object or the target as a child
of the source.
Externally | A characteristic of an attribute or reference that can be setto'Yes’ or’'No’. A Refer to the
Maintained | 'Yes’ selection indicates that the data point is maintained externally, and a Externally
Attribute change in it does not trigger a change in approval status and/or a new Maintained
revision on the STEP object on which the data was changed. A ’No’ selection | Attributes topic
indicates that the data point is maintained internally and a change in it has the | in the System
potential to trigger a change in the approval status and/or a new revision on Setup
the STEP object on which the data was changed. documentation.
F

Further Reading

Function

A type of business rule that allows for input parameters to

produce an output. These operations are side-effect free, and it
do not change STEP data.

Refer to the Business
Functions topic in the Business
Rules documentation.
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G
Term Definition Further Reading
Golden | Collection of data from a variety of sources, based on Refer to the Survivorship in Match and
Record | matching, linking, and survivorship rules. The Golden Merge topic the Survivorship in Match
Record is considered the trusted data record, compiled | and Link topic in the Matching, Linking,
from the various source objects. and Merging documentation.
GUI Graphical user interface. For STEP, this can be the Refer to the GUI Setup topicin the
workbench or Web Ul. A GUI System Setup documentation or the
Design Mode Basics topic in the Web
User Interfaces documentation.
H

Term Definition Further Reading

Hierarchy | A data structure composed of parents | Refer to the Object Type Hierarchy topic in the Object
and children. Types and Structures of the System Setup
documentation.

Hotfolder | File system of folders where data can | Refer to the IIEP Receiver Methods in the Data
be dropped for automatic loadinginto | Exchange documentation, Configuring an

STEP, based on the particular Asynchronous File Exchange Service in the Data
configurations and/or code applied to Integration documentation, or Asset Importer in the
the hotfolder. Digital Assets documentation.

Definition Further

Reading

ID The unique identifier for all objects within STEP. It cannot be translated or
edited once created, and cannot contain special characters.

Image A series of parameters defining the way in which an image is transformed Refer to the

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 14
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Definition Further
Reading
Conversion | from the standard high resolution asset that exists in STEP to the required Image
downstream format. Several conversion options are available by default, Conversion
and additional conversions can be added via configuration and/or Configuration
extensions. Note that conversions change assets as they are pushed from topicin the
STEP, leaving the originating file unchanged in STEP. Digital Assets
documentation.
Inbound Communication channel defining how data is received by STEP. Each Referto the
Integration | endpoint defines how data is received from an external system, specifying Inbound
Endpoint location, transport protocol, data to be exchanged and other configuration Integration
(EP) parameters. Endpoints topic
in the Data
Exchange
documentation.
Integration | Communication channel between STEP and external systems. Refer to Refer to the
Endpoint Inbound Integration Endpoint and Outbound Integration Endpoint. Data Exchange
(IEP) documentation.
Inheritance | The ability to make data available in the product or classification hierarchy to | Refer to the
lower nodes by linking it to a higher node in the hierarchical structure. Inherited
Attributes topic
in the System
Setup
documentation.

J
K
L
Definition Further Reading
Library Set of functions that can be reused in multiple business rules or other Refer to the Business
libraries. Libraries cannot be called independently and must be Libraries topic in the
referenced from other actions, conditions, or functions. Business Rules
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Term Definition Further Reading
documentation.

Link A parent/child relationship between objects within the STEP system. Refer to the
Reference and Link
Types topic in the
System Setup
documentation.

List of A validation base type for an attribute that only allows a value to be Refer to the List of

Values considered valid if it belongs to a respective list of pre-configured values | Values (LOVSs) topic

(LOV) assigned to the attribute. Also used to refer to the value list itself. LOVs in the System Setup

are also referred to as 'Domains' at times. documentation.

Localized | An attribute value that is set directly on an object and is not inherited Refer to the Inherited

Value from any level above in the hierarchy. Attributes topic in the
System Setup
documentation.

M

Term Definition Further Reading

Mandatory | Indicates that the product and all its sub-products must Refer to the Mandatory Attributes

Attribute have a value for the specified attribute in order for the topic in the System Setup

object to be approved. documentation.

Multi- An attribute that can contain more than one value for a Refer to the Editing Multi-Valued

Valued specific object. Attributes topic in the System Setup

Attribute documentation.
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N
o
Definition Further
Reading
Object An element within the system, for example, a product, image, classification, Refer to the
attribute, workflow, business rule, etc. Basic STEP
Concepts topic
in the Getting
Started
documentation.
Object A specific label for levels within a taxonomy, given to different elements within | Refer to the
Type the system. Nearly every object in STEP is labeled with an object type to help | Basic STEP
identify whatitis (i.e., a product or entity rather than an image, a TIF rather Concepts topic
than a PDF, etc.). This includes entities, products, product categories, in the Getting
alternate hierarchies, images and other assets, attributes, and LOVs. Started
Through the use of object types, system administrators can control how rigid | documentation.
or loosely defined the database will be in terms of object creation and where
objects are allowed to ‘live’ and/or be used. This labeling also becomes very
important when working with exported data so that each type of object in
STEP can be identified for special handling in web applications or other uses
outside of STEP.
Orphan A specification attribute that has a value, which has been deleted from / not Refer to the
Attribute linked to a product node or classification and is denoted by italics. Linking Orphan
Attributes topic
in the System
Setup
documentation.
Outbound | Communication channel defining how data is sent by STEP. Each endpoint Refer to the
Integration | defines how data is sent to an external system, specifying location, transport | Outbound
Endpoint protocol, data to be exchanged and other configuration parameters. Integration
(OIEP) Endpoints topic
in the Data
Exchange
documentation.
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Term Definition Further Reading
Postprocessor | A plugin component within the IEP framework that allows Refer to the IIEP

STEP to act on the result of the import / export such as Configuration Flipper and
starting workflows, sending notifications, etc. the OIEP Output Templates
Flipper topics in the Data
Exchange documentation.
Preprocessor | A plugin component within the integration endpoint Refer to the IIEP
framework that allows STEP to modify the message priorto | Configuration Flipper and
import / export. It can be used for various functionality such | the OIEP Output Templates
as pre-validation, format conversion, filtering, etc. Flipper topics in the Data
Exchange documentation.
Primary Hierarchy that allows for different types of objects to be Refer to the Object Type
Product stored once in the database; each object within this Hierarchy topicin the
Classification | hierarchy has a unique ID / identifier and may have only one | System Setup
(PPC) location within the hierarchy. Also referred to as the 'blue documentation.

hierarchy'.

(green) hierarchy.

Product One of the object super types, referring to any object within | Refer to the Products topic in
the Primary Product Classification (blue hierarchy). the Getting Started
documentation.
Product InDesign templates that determine what type of data will Refer to the Product
Template appear on a printed page, including the positioning and Templates topic in the
styling. Publisher (Adobe InDesign
Integration) documentation.
Product Data type used to model multiple variants of a similar object. | Refer to the Product
Variant For example, T-shirts in various sizes and colors could all be | Variants topic in the System
variants of a single product. Setup documentation.
Print Proof A tab in workbench or Web Ul that displays a product Refer to the Print Proof View
View template view ('proof') of a selected node (typically a section of the Publisher
Product but can also be an Entity or Classification) without (Adobe InDesign
the user needing to access InDesign. Integration) documentation.
Publication One of the super types, referring to objects in the publication | Refer to the Publication

Hierarchy section of the
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Term Definition Further Reading

Publisher (Adobe InDesign
Integration) documentation.

Public API The set of server-side functions that have been exposed to Refer to the STEP API

be used in the business logic. This includes many functions | Documentation link on the
to create, get, and set data, such as values and references. Start Page.

It also includes various methods for logging as well as
sending emails.

Purge Removal of an object from the database. Following purge, Refer to the Revisions topic
an object cannot be revived. in the System Setup
documentation.
Q
Definition Further
Reading

Queue | The mechanism within the IIEP framework that allows messages to be Refer to the

processed in an asynchronous way. The queuing concept allows separating Background

processes from different integration endpoints as well as controlling the degree of | Processes and
parallel imports (a queue size of one guarantees sequential import, while a queue | Queues topicin

size larger than one allows parallel processing of multiple messages for the System
increased throughput where sequential execution is not required). Setup
documentation.

Definition Further Reading

Reference | An association between objects within | Refer to the Reference and Link Types topic in the
the STEP system. System Setup documentation.
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Term Definition Further Reading

Special A character that cannot be found on a standard keyboard but Refer to the Tags topicin

Character can usually be found in the Windows character map. the System Setup
Example: Trademark Symbol - ™ documentation.

State A step within a workflow to which a specific user, user group, Refer to the Creating a
or system can be assigned to complete the task(s) associated | Workflow topicin the
with the state. Workflows

documentation.

STEP Stibo Enterprise Platform master data software application
that provides business managers a single source database to
store, manage, and re-purpose product information for
publication or syndication.

STEP’n’design | STEP’s plugins for InDesign that allow data from the STEP Refer to the Publisher
database to be pulled onto pages. (Adobe InDesign

Integration)
documentation.

STEPXML The native XML language for STEP, which can be used for Refer to the STEPXML
importing / exporting STEP data, as well as transferring Format topic in the Data
configurations between STEP systems. Exchange documentation.

Super type A major category of data within STEP including: Asset, Refer to the Object super
Classification, Entity, Product, and Publication. Refer to the types topic in the Getting
specific definition for each super type for additional Started documentation.
information.

Superseded The 'Superseded' status displays with affected components Refer to the Web Ul
and serves as guidance to admin users selecting which Component Basics topic
components to implement when configuring their Web Ul. in the Web User

Interfaces documentation.

Super User A user that is given administrative privileges within the STEP Refer to the Actions Sets
system. topicin the System Setup

documentation.
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T
Term Definition Further Reading
Task The work and/or action that must be completed within | Refer to the Working with Tasks in
a specific workflow state (whether by a user or via Workflows topic in the Workflows
automation). documentation.

Transition | The change of tasks from one state to another withina | Refer to Creating a Workflow in the
workflow. Workflows documentation.

U
Definition Further
Reading
Unique Key | A unique key is a system entity that represents a specific objectin the STEP | Refer to the
system. The entity is composed of one or more data points, whether utilized | Unique Keys
as-is or in a combined and/or transformed format using a specified formula. | topicinthe
There can be exactly one record for each object for each defined key. No System Setup
two objects with the same unique key for an active key can exist. documentation.
User Rules that allow or restrict users from performing certain functions within Refer to the
Permissions | the system. Privilege Rules
topicin the
System Setup
documentation.

\'
Definition Further Reading
Validation | A characteristic of attributes that identifies the format of the Refer to the Validation
Base accepted data for the attribute value, such as whether the valueis | Rules topicin the System
Type a date, integer, fraction, text, LOV, etc. Setup documentation.
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W
Definition Further
Reading
Web Ul A web-based interface to access the STEP database in order to read, edit, Refer to the
or download data and assets. Multiple Web Uls can be configured for each Web User
STEP installation. Interfaces
documentation.
Workbench | An interface for managing datain STEP, as well as carrying out Refer to the
administrative functions. STEP
Workbench Ul
topicin the
Getting Started
documentation.
Workflow Business process(es) modeled as a series of states and tasks that can be Refer to the
executed by users and/or automatic processes within the STEP system. Workflows

Workflows prompt the next step of a process to be started, by either creating | documentation.
a task for a user, or sending an alert. Workflows may contain a number of
process steps or tasks, as well as business logic.

Workspace | A set of independent ‘copies’ of the database objects that provides a Refer to the
revision-specific view of objects. Workspaces are organized into separate Workspaces
areas including Main and Approved. The Main workspace is where data topicin the
maintenance takes place. The approved workspace is a non-editable System Setup
snapshot of data that has been determined to have been acceptable for documentation.

publishing to downstream systems.

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 22



|STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

Basic STEP Concepts

This topic introduces the reader to some fundamental STEP concepts that provide a foundation for the rest of the
material in the Getting Started documentation, as well as the System Setup documentation. The focus of this
topicis on data structures and data management, and is not intended to be an introduction to the full capabilities
of a STEP system.

Object Types Overview

Technically, nearly everything in STEP is an object, and object types must be defined for which instances of
objects can exist. Object types provide a specific label for levels within a taxonomy, given to different elements
within the system. Nearly every object in STEP is labeled with an object type to help identify whatitis (i.e., a
product or entity rather than an image, a TIF rather than a PDF, etc.). This includes entities, products, product
categories, alternate hierarchies, images and other assets, attributes, and LOVs. Through the use of object
types, system administrators can control how rigid or loosely defined the database will be in terms of object
creation and where objects are allowed to "live" and/or be used. This labeling also becomes very important when
working with exported data so that each type of object in STEP can be identified for special handling in web
applications or other uses outside of STEP. Object types in STEP can largely be divided into two categories:

» Tree Object Types: Object types that make up the standard STEP hierarchies accessible on the Tree tab in
workbench. Many of these object types can be further grouped into five categories of object types, referred
to as the super types. Tree object types are defined in System Setup, but instances of the object types are
accessed within the Tree.

« System Setup Object Types: Also referred to as Basic Object Types. This category encompasses all of the
remaining object types that make up a STEP system. Among many other things, this includes attributes,
users, integration endpoints, workflows, and business rules. System Setup object types are defined in
System Setup, and instances of the object types are also accessed within System Setup.

More information on object types in general, including how to create and maintain object types, can be found in
the Object Types and Structures section of the System Setup documentation.

Object Super Types

Each super type has specific characteristics that make it suitable for modeling particular types of data. For
example, inheritance of data is available within the Product super type so objects that share data based on
common characteristics are typically modeled using this super type. Alternatively, digital media files are housed
using the Asset super type, which allows for automatic reading and storing of asset properties such as size and
format. Any number of individual object types within each super type can be created. For example, a system may
use both an 'lcon’ object type and an 'lllustration’ object type (along with any number of others) within the Asset
super type.

The object super types are:
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Assets
Classifications
Entities
Products

o~ b=

Publications

More information on the characteristics of the various super types can be found in the Object Super Types topic
within this guide.

Object Types Versus Object Instances

Two core capabilities for managing data in STEP are the Tree tab and the System Setup tab. In order to
successfully use STEP, itis critical to understand the differences between the functions available in these two
areas, specifically in relation to types of objects versus instances of objects.

Technically, everything in STEP is an object, including workflows, attributes, business rules, export and import
configurations, products, classifications, images, etc. However, the term "objects" is more generally used to
mean assets, classifications, entities, products, and publications. In other words, the super types are also all
things that you can find on the Tree tab in STEP. This section focuses on the differences between object types
and object instances for Tree objects, specifically those that fall into the super types.

For example:
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F-{ 7] Assets

r_=| Configurations

=[] Web Sites

=[] Acme Retail Web Site
L—__||'_=| Apparel

-] 18207012
-] 18214012
| 18215-012
-\l 18217012
Lol 18217054

~[[5] Women's Apparel

{7 Automotive

({7 Building and Electrical Products

[+ Entity Root

-0 Publications

[=-{IT] Primary Product Hierarchy

E}r_:l Products

-5 Apparel

r_=| Footwear

r_=| Safety

r_=| Hardware

-7 Displays
r_=| Furniture
|__=| Automotive
r_=| Building Products
E|r_=| Electrical & Electronics
|j Electronic Accessories
E}Fj Wire & Cable
. =7 Cable
=} il Cable Items
- - 050-42151
E}|__=| Cable Sales Items
-4l 7832-200

[ STEP Worlkflow ” Bookmarks " System Setup ” BG Processes ” Search ]

The objects and structures available in the Tree will vary based on your particular data model, but the concepts
described can be applied across any data model. Regardless of the specific names or structures, each node on
the Tree tab is an individual object that has a defined "place to live" within a hierarchy. A user can right-click on
many of these objects and have a 'New..." option, such as 'New Product' or 'New Classification’, allowing them to
create a new node in the hierarchy. For example, when right-clicking on the 'Apparel' object and selecting 'New
Product', a dialog appears with an option to create a 'Level 2' object.
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5] Products > |Attribute N

__ r_=| Apparel 5 s

-1 Footwear [1 Create Product *
-5 Safety
r_=| Hardware
r_=| Displays
r_=| Furniture
B[ Automotive | 1D 411231
r_=| Building Prody
£ Electrical &l

[+-[[F) Electroni Create Cancel
15 Wire & 7

E|r_=| Primary Product Hierarchy ‘ ‘ MName

"Dbject Type

Marne

Typing a Name and clicking Create would create a new object as a child to the Apparel node. But what defines
that a 'Level 2' object can be created on this node? And that it is a Product (blue) object rather than an Entity
(gray) or Classification (yellow)?

The allowable structure of objects and hierarchies that are accessed in the Tree are defined in System Setup. To
continue with the above example, we can observe that the defined object types and structures include a Primary
Product Classification that has a number of levels. A Level 1 can only have a Level 2 child, which in turn can only
have a Level 3 child. However, a Level 3 object type can have a number of child object types, including an Item
Folder, Level 4, and a Sales ltem Folder. A Sales Item Folder is a child of a Level 3 object type, as mentioned, but
can also be a child to a Level 4. Similarly, a Sales Item can be child to multiple things, including a Sales ltem
Folder and a Sales Item Family.
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System Setup

=2 Object Types & Structures

rj Alternate Classifications
-- Assets
-3 Basic Object Types
35 Commerdal Types
lﬂ‘ Entity uzer-type root
(& Event Queus Object Types
E}|__=| Primary Product Classification
i Discontinued Products
iﬁ‘ External Products
i Packaging Hierarchy
r_=| Primary Product Classification
E Product Overrides
E|r_=| Products
E}Fj Level 1
Elr_=| Level 2
E}|'_=| Level 3
[ijl i Ttem Folder
EI a Item
S . Open Item
=N il [tem Family
= E Item
..... . Open Item
= r_=| Level 4
E} - Item Folder
- ﬁ Ttem
Pk Wl Open Item
El -Jill Ttem Family
= E Item
..... . Dpen Item
E} |__=| Sales Item Folder
E] ll Sales Item
o | Open Sales Item
El {7 SalesItemFamily
= I_ Sales Item
----- | Open Sales Item
=7 Sales Item Folder
E} l_ Sales Item
- | Open Sales Item
I'él 7] SalesItemFamily
=8 IL Sales Item
----- I_ Open Sales Ttem
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The object types defined in System Setup provide the "skeleton" for the allowable instances of objects that can
be created in the Tree. It is important to understand that it is only the structure and types of objects that are
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defined in System Setup, but any number of instances of the defined types can be created in Tree. This is best
illustrated by viewing System Setup and Tree side by side, as shown below. Object instances are displayed in
Tree, with red text indicating the corresponding object type designations from System Setup.

System Setup

=¥ Object Types & Structures
B[] Alternate Classifications
[ Assets
E]--I%’ Basic Object Types
-85 Commerdial Types
[}-I%’ Entity user-type root
-z Event Queue Object Types
[=H{[T) Primary Product Classification
i Discontinued Products
%‘ External Products
i Packaging Hierarchy
1j Primary Product Classification
E Product Overrides
E|1_'_=| Products
E}Fj Level 1
E||"_=| Level 2
E|r_=| Level 3

-l Ttem Folder

ER Py
. Open Item
E- Item Family
- Ttem
. Open Item
-7 Level 4
E}i Item Folder
- tem
i . Open Item
E|- Item Family
=i Ttem
‘ Open Item
E}E Sales Item Folder
E_lli Sales Item
¢ L) Open Sales Ttem
E|r_=| SalesItemFamily
|l Sales Item
L Open Sales Ttem
[=1-77 Sales Item Folder

=I5} Primary Product Hierarchy| Primary Product Classification

=[5 Products Products

El-[T] Apparel Level 1
E}|“_=| Upper Body Wear Lewvel 2
E-5] T-shirts Level 3
E-Jill T-shirts Items Ttem Folder
. gl 88723-12 Item Family
. -l Cotton T-Shirts Ttem Family
(=} T-Shirts Sales Items Sales Item Folder

----- .. 198523 Sales Item

----- |l 183409 Sales Item
=[5 Head Wear Level 2

E-5) Hats and Caps Level 3
E}- Hats and Caps Items Ttem Folder
- (120170) Item
-\ (120666)
- (179653)
- (179364)
-\ (179866)
E 109308
ﬁ Blue Hat
E Blue Hat
E Gray Hat
E Industrial Hard Hat
-\ Sk Hat
= ski Helmet

-|ji] (181525) Open Item
[#-[[7] Hats and Caps Sales Items  Sales Item Folder
[—:Ir‘_=| Footwear Lewvel 1
-3 Shoes Level 2
| E-5Pumpz Level 3

E}- Pumps Items Level 4
: £l Heels - High: 3" or higher Ttem Family

- 207144 Item
| 207148

| 20714C
H —

Notice in the above screenshots that a Level 2 object exists in System Setup only once, but there are multiple

instances of itin Tree.

The same principles described for the Primary Product Hierarchy apply to all other hierarchies in STEP. For
example, an entity hierarchy could have a Customer object type with allowable children of Address and Contact
object types. The object types and structures are defined in System Setup, and instances of these objects can

then be created in Tree.
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System Setup Tree
EI@’ Object Types & Structures [i]--‘ Entity Root
B[] Alternate Classifications =+-£8fs [Customer Hierarchy |
w103 Assets =2 Customer A
(2 Basic Object Types % Axel Kiers Veej 11
-85 Commerdal Types {8 Jesper Jensen
E} Iﬁ’ Entity user-type root -8 Customer B
: El ‘ Entity Root ><[‘|'_3f 3550 George Busbee Plwy
QB All Customers . BZ| John Smith
B 3 Customer | . g Customer C
b ~£% Address
--{BE] Contact

Note that object super types can only exist within their designated hierarchy types. To clarify, a product hierarchy
(blue hierarchy) can only contain object types of the product super type, while an entity hierarchy (gray hierarchy)
can only contain objects of the entity super type. It is possible to have the visual appearance of mixed hierarchies,
but this is accomplished via references rather than actual data structures. For example, products may appear in
the Tree to be within a classification hierarchy, but this is due to references on the object, as shown below.

18207-012 rev.0.2 - References

E'ij Merchandising Hierarchy A (|| commercial || Tables || Category Profile State Log || Tasks
E]lj Apparel Product ” Sub Products ] References [ Referenced By " Images & C
S e Omommedproductvnnne
EHj T-shirts o
5[ Tshirts ImageReferences
L 18217054 @ lemReferences, Classificaton
. g ¢
L] 18214012 Reference Type v| > [Target > >
: E ﬁiﬁﬁﬁ > |Merchandising Link 4 [k [—] Merchandising Hierarchy/Apparel(Sportswear [T-shirts *
[T Automotive > |website Link + [y 7] Web Sites/Acme Retail Web Site/Apparel/Mens Casual/T-shirts and Sweatshirts | 7
3 0 teverages osdestenfewenes okt
e (3] Footwear € Ungrouped Classification Links
= Chdewods
|:—:|r‘_=| Web Sites o
[ Acme Retail Web Site publcatiors
=[] Apparel @ linked Attributes from Product Hierarchy
[ Hers an Sl fon Cashatonreacy

[ Caps
E|r'_=| T-shirts and Sweatshirts

Notice that the corresponding System Setup structure for the above does not include the product object types.

El r_=| Merd’1andlsmg Hlvararr::l'wI Root
LB rj Department

=8 r_=| SubDepartment

+~[Z] MerchandisingClass
El r_=| Web Hierarchy Root
== [T Website Root
- T] Web Level 1
=8 |'_=| Web Level 2
----- [C1WebLevel 3
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The true residence of the product objects is within the Primary Product Classification, with a visual display of the
product references into various classification hierarchies being just that: a visual display of references. However,
assets are an exception to this concept. Assets are not part of the Classification structure in System Setup, but
do in fact exist within this structure in Tree. Each asset must be linked in to one or more classifications, and this is
the only location in which they "live" in STEP. Each asset automatically has a reference applied to each
classification in which it is linked. More information on references can be found in the Reference and Link
Types topic in the System Setup guide. More information on the various object super types and their
characteristics can be found in the Object Super Types topic within this guide.

Using the above information, the questions posed earlier in this topic can now be answered:

Why can we only create a Level 2 object under the Apparel node? Because in this particular data model
configuration the Apparel node is a Level 1 object type, and only Level 2 object types are allowed to be created
under a Level 1 object type.

Why can we not create an Entity or Classification under the Apparel node? Because only object types within the
same super type can exist within the same hierarchy. And even if this was not the case, the structure defined in
System Setup in this particular hierarchy only allows a Level 2 object type (of the product super type) under a
Level 1 object type.

Note: All text data is saved in the system in Unicode UTF-8. All standard data exports from the system are
also in UTF-8. Some system extensions may use a different character set on export, but the standard is UTF-
8.

UTF-8 can define more than one million characters. To do so, it uses up to 4 bytes of storage. Regardless of
whether it uses one, two, three, or four bytes, it is still one character and as such any character counts that
are imposed on text attribute’s length is specified and counted in characters and not bytes.

As a standard, the Microsoft Arial Unicode font is used for display. Its character set supports most languages
of the Americas, and Western and Eastern Europe (including Cyrillic and Greek). In some cases, as in the
case with some Asian languages, additional fonts must be loaded onto the PC or MACs. But for most cases,
the character set provided by Arial Unicode MS is sufficient.

For more information on Unicode UTF-8 the reader is advised to refer to the various web sites that describe
its functionality, such as the Wikipedia site: https://en.wikipedia.org/wiki/UTF-8.
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Object Super Types

This topic provides an introduction to the STEP object super types. It will be helpful to have read and understood
the Basic STEP Concepts topic in this guide prior to reading this material.

Object types that make up the standard STEP hierarchies accessible on the Tree tab in workbench are referred
to as Tree Object Types. Many of these object types can be further grouped into five categories of object types,
referred to as the super types. This topic introduces the five primary object super types in STEP. Understanding
the differences between the various object super types is important when making decisions about how to model
datain STEP.

Each super type has specific characteristics that make it suitable for modeling particular types of data. For
example, inheritance of data is available within the Product super type so objects that share data based on
common characteristics are typically modeled using this super type. Alternatively, digital media files are housed
using the Asset super type, which allows for automatic reading and storing of asset properties such as size and
format. Any number of individual object types within each super type can be created. For example, a system may
use both an 'lcon’ object type and an 'lllustration’ object type (along with any number of others) within the Asset
super type.

The object super types are:

Assets
Classifications
Entities
Products

o s~ wbd =

Publications

Each is described below, along with links to more detailed information for working with the various super types.

Assets

The Asset super type is used to hold any type of digital media, including images, videos, documents, and text
files. Assets are organized within classifications, and can be linked to other objects in STEP using references.
Specifically, assets can be linked to objects of the Classification, Entity, or Product object super types. Upon
import, STEP populates some basic information about each asset, which can be viewed under the System
Properties flipper on each asset, but cannot be edited. Default asset icons vary by file type, and can be updated
by admin users.
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Name > |Value
]E ProductFolderlcon
& > ID 111684
#-[7] Hlustrations * Name MNEWW!
#-[7] Installation Manuals > [Dbject Type Product Image
B[] Logos > Revision 1.1Last edited by USER4 on Fri Aug 19 14:42:18 EDT 2016
[]--rj MSDS Sheets ’ T
(-] Owners Manual > \pproved 3€ Never Been Approved
B[] Product Images > Translation Not Translated
- Produc.t Videos > Path Classification 1 root/Assets Tcons/NEW!
#-{ 7] Configurations
(-] ETIM Hierarchy L2
-] Index Words Mame > |Value >
[H-{_] Merchandising Hierarchy » Gamma 12a 0.45
-] Suppliers s Class abe Indexed color
B[] Web Sites > [Colors |
[+ [l Entity Root » Colorspace abe RGB
[]---a Publications > Compression abe Zip
[]..i Primary Product Hierarchy > Depth 112 [1 (bits/sample)
-5 Collections > O abe pg
=8 Ecablogs_ » Filename abe NEW!.png
[J"ﬁ Recyde Bin > Format abe PNG (Portable Network Graphics image)
» Height 123 231.47 (mm)
» MIME Type abe imagefpng
* Pixel Height i 556 (pixels)
> Pinel Width [+ 657 (pixels)
> Samples |i]23 I:S(samples;‘pi)rel)

For more information on working with assets, refer to the Assets topic within this guide.

Classifications

The Classification super type is used to build hierarchies and objects that bundle other objects into organized
groupings. These are represented by default with yellow folders in STEP, though these icons may be updated by
an admin user. For example, images, manuals, and icons could be uploaded to STEP as assets and stored in
appropriate subfolders under the 'Assets’ classification folder. Product objects could also be linked into
classifications to provide alternative categorizations of objects that vary from the product hierarchy structure.
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Assets rev.0.4 - Classification

[_-_|i—_=| Referenced By || Images & Documents || Tables || Status || State Log || Tasks
Elj Tlustrations Classification [ Sub Products References
i || Pens % Description
= '@ ProductFolderlcon Mame 3| » |value N
'@ Producticon
il i] STEPReferencesTab > o (SRR
B[] Installation Manuals » MName Assets
B[] Lelcons » Object Type Asset Root
[+ Logaos
[}_g MOSQDS Sheets » Revision 0.4 Last edited by USER on Fri Dec 04 17:40:33 EST 2015
B[] Owners Manual » Approved « Approved on Fri Dec 04 17:40:33 EST 2015
B[] Product Images » [Translation Mot Translated
+[] Product Videos » Path Classification 1root/Assets
{7 Classifications
i . > Wisibility
{7 Configurations
r_=| Index Words * Purpose b
E|r_=| Merchandising Hierarchy
(-] Apparel
[—'J|"_=| Automotive
B[] Tires
(=[] Tire Accessories
Al T490 N9 En

For more information on working with classifications, refer to the Classifications topic in this guide.

Entities

The Entity super type is used to create hierarchies and objects that do not require inheritance of data through
categorized groupings. Entities are commonly used to store customer, location, or person data, as well as to
store reference data. In addition, entities are used to store source data for golden records. Entities are
represented by gray folders and white and gray cubes by default, but these can be updated by an admin user, as
is evident in the screenshot below.

Tree

[#-{ 7] Assets
r_=| Configurations
r_=| ETIM Hierarchy
-r_=| Index Words
r_=| Merchandising Hierarchy
r_=| Suppliers
Web Sites
=[]l Entity Root
E}% Customer Hierarchy
= B Customer A
-y Axel Kiers Vej 11
Jesper Jensen
[—]8 Customer B
>ﬂ 3550 George Busbee Plwy
John Smith
----- 8 Customer C

. Key Accounts
b=
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For more information on working with entities, refer to the Entities section of this guide.

Products

The Product super type is used to create hierarchies and objects that use inheritance of data for objects
categorized by similar characteristics. In STEP, products are represented by default with blue icons either as
folders or nodes, though these icons can be updated by an admin user. Upper nodes in a product hierarchy are
often categories and subcategories, with leaf nodes being actual objects. Whether an organizational folder,
sellable object, or something else, each node in the hierarchy is of the product super type, and all child objects
are able to inherit attributes and values from parental objects.

7] Assets

r_=| Configurations

r_=| ETIM Hierarchy

-r_=| Index Words

r_=| Merchandising Hierarchy

r_=| Suppliers

-] Web Sites

- i Entity Root

-8 Publications

=17 Primary Product Hierarchy

El|j Products

r_=| Apparel

r_=| Footwear

- Safety

r_=| Hardware

r_=| Displays

E|r_=| Furniture

E}Fj Bedroom

E|r_=| Beds

E}- Beds Items
B Comy B

E Comfy Foothoard

E Comfy Headboard

[ STEP Workflow ” Bookmarks ” System Setup " BG Processes ” Search ]

|'=| Beds Sales Items

For more information on working with products, refer to the Products section of this guide.

Publications

The Publication super type is used to create hierarchies and objects used for print publishing solutions, including
Print Publisher, Print Flatplanner, and Print AutoPage. Publication objects are used to create templates used in
print solutions, as well as publications such as catalogs or pamphlets. Product objects can be linked into
publication hierarchies, meaning data from the product(s) will be reflected in the publication. Publication objects
use green icons by default, though these can be updated by an admin user.
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Tree Shirts - Publication Section
Elﬁ Publications ~ AutoPage Publication Planner || Pagination Rules || Page Inspector || Status || State Log || Tasks
ﬁ Templates Publication Section [ Flan ” Publication Planner ” Plan Motes ] Financial Summary ]
[—}-ﬁ Autopage Publications ) .
=@l Acme Wholesale Clothing >T> val 5
% Commerdial Data Mame Value
[ Caps and Hats » D 111845
> MName Shirts
> Object Type Section
> Revision 0.2 Last edited by USER4 on Mon Aug 29 11:40:21 EDT 2016
- EJ DTP Documents > Path Publications fAutopage Publications/Acme Wholesale Clothing/Shirts
B R Jewelry > Start section on page 2
[ @ Accessories -
B8 Gloves > EieemErats &
E- @ Beta Tools » Expiration Date =
[}-% Commerdial Data > Section Theme abe [Shirts
[ @@ Power Tools
> ICi i 123
[+ @ Hand Tools radation
[ Toolboxes * Cover Photo Shot Due &
[ @8 Garden Tools » FirstPageNumber &
I:}-ﬁ Standard Pubhﬁitlor.'ls > LastPageNumber %9
[+ &} Flatplanner Publications -

For more information on working with publication objects, refer to the Publication Hierarchy section of the
Publisher (Adobe InDesign Integration) documentation.
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Accessing STEP System Information

The simplest way to access system information about your STEP installation to click the About STEP link on the
Start Page.

STEP system information is useful for system troubleshooting and new project planning, as well as helping users
ensure compliance with their contracted license terms.

The most straightforward way to view system information is to click About STEP from the Start Page. System
information is also available in the Admin Portal install.log or by running a Stibo Patch Operations Tool (SPOT)
command on the application server. For more information on the install.log, refer to the Logs topicin the
Administration Portal documentation. For on-premise systems, information on SPOT is included in the SPOT
Program topicin the System Administration Guide found in Downloadable Documentation. For SaaS
systems, contact your Stibo Systems account manager.

‘About STEP' Page

When the About STEP icon is clicked, a new page is opened (e.g., http://[yoursystem]/about/step) that is
password protected to ensure that only STEP users have access to the information.

This 'about' page displays the following information:

o 'System name'

« 'STEP version'in a string (as shown below) that identifies the system by its baseline version that includes the
major release version number (e.g., 10); minor release number (e.g., .2); the maintenance patch version, if
applicable (e.g., mp2); and the baseline creation date.

o 'Number of user accounts' and the 'Number of allowed user accounts'. Standard STEP users that do not
count against the number of licensed users are not included in the user count, such as DBA, STEPSYS,
SERVICE, and SWADMIN.

« The approximate number of 'products’, 'classifications', 'assets', and 'entities’. Object counts are approximate
because changes can happen in the background while the page is being viewed. Also, for time purposes, the
quick approximation number is preferable to an exact count, which could potentially tie up system resources
for a prolonged time.

« The number of 'contexts', 'dimensions', and 'languages'.
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System name: doc-rel

STEP version: 10.2-mp2-2021-08-18-13-51-12

Detailed version information

Mumber of user accounts (including suppliers): 64

Mumber of supplier accounts: 7

Allowed number of user accounts: 100

Mumber of products (approx.): 900

Mumber of classifications (approx.): 8000

Mumber of assets (approx.): 500

Mumber of entities (approx.): 7000

Mumber of contexts: 12

Mumber of dimensions: 2

Is InMemory Enabled: false

Mumber of languages: 10

The full version information of this system is available via snapshotspr file, please submit this file along with any support requests,

If you are having any problems with the STEP system, please produce a diagnostics package instead. This can be done via the Administration page.

Detailed Version Information

A 'Detailed Version Information' hyperlink is also included that opens a new page (e.g., http://
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[yoursystem]/about/version) where you can access information about the add-on components, customizations,

and hotfixes applied to your system. If your system contains none of these, only the current baseline version of
the system is displayed.

[ |STIBOSYSTEMS

e MASTER DATA MAMAGEMENT

= Baszeline version: step-10.2-mp2-2021-08-18-13-51-12

= Add-on components: wikimetadata-7.0.7
value-generator-7.0.4
user-anonymizer-7.0.7
ui-search-7.0.11
vi-product-editor-7.0.19

ui-basket-7.0.14
syndigo-7.0.5

local-logate-7.0.14
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System Snapshot and Diagnostics Package Links

Below the bullet list, additional information is provided to assist users who need to access more complete system
information for support purposes.

Provided is a snapshot.spr link where you can download a snapshot file that contains full system information,
including installed bundles, metrics, and differences to previous snapshots. This file is intended to be submitted
to Stibo Systems along with support requests. For more information on snapshots and their contents, refer to the
Tools topic in the Administration Portal documentation.

Also included is a link to the Administration Portal page, in case you need to produce a diagnostics package. This
package is generated and uploaded to Stibo Systems from the 'Send Diagnostics' tab. For more information,
refer to the Send Diagnostics topic in the Administration Portal documentation.
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STEP Workbench Ul

The screenshot below shows a basic view of the STEP Workbench. Though system customizations and variable
access permissions may result in a slightly different view, the basic elements in this view of the workbench's Main
Window will be present for most users. The key elements of workbench Ul are numbered and defined below.

Important: A one-time install of the STEP Workbench Launcher needs to be done on each client
workstation before opening workbench. STEP Workbench users do not need Java installed separately on
their computers. After installation, the workbench will launch via conventional means. For details and
directions, click on the Workbench Launchers icon, accessible on the Start Page.

F | doc-dev - userj@https://doc-dev.stibo.com - STEPworkbench - O >

File Edit View Mavigate Format Maintain Window ﬂelpl

[T coent s < € 5 O [rprascone 1[0 £ [ oo s 1 0
2 11 -pm
r_=| Assets
[+ 7] Configurations
-@ Index Words

#-f Publications

1j Primary Product Hierarchy
@ Collections

-8 eCatalogs

@ Mo Object is Selected

e ©¢ 06 606 6060 ©

[STEP Workflow ” Bookmarks [sttem Setup " BG Processes ] Search

i) ®..al
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Note: The STEP Workbench is a Java client. STEP's backend is AdoptOpenJDK.

10.

11.

12.

13.

. The Menu Bar contains a collection of various tools for users to perform actions in the workbench. For more

information, refer to the Menu Items topic in this documentation.

The Toolbar contains actions that help with the view and navigation of the workbench. For more information,
refer to the Toolbar topic in this documentation.

The Tree tab navigates users to the object tree in the workbench. For more information, refer to the Tree Tab
topic in this documentation.

. The Search tab provides access to the advanced search functionality of the workbench where users can filter

results, save these results as a collection, export these results for external use, or perform bulk updates on
these results. For more information, refer to the Search Tab topic in this documentation.

The BG Processes tab contains all of the background processes occurring in the STEP instance. For more
information, refer to the BG Processes Tab topic in this documentation.

The System Setup tab contains all of the administrative actions to set up the workbench to maintain data. For
more information, refer to the System Setup Tab topic in this documentation.

The Bookmarks tab contains all of the bookmarks that are saved by the user. For more information, refer to
the Bookmarks Tab topic in this documentation.

The STEP Workflow tab contains all of the workflows currently associated with STEP. The toggles can be
flipped to show the states associated with each workflow. For more information, refer to the STEP Workflow
topic of this documentation.

Selecting an object in the workbench populates the Object Editor pane with fields and actions based on
associated permissions and validity for the selected object. For more information, including the hide (E4) and

show (B) buttons, refer to the Object Editor topic in this documentation.

System Information. The title bar includes important information about the user's system. Displayed are the
name of the system, the user ID, and the URL of the system being accessed.

Pushpin allows users to pin (E) the right-hand side of the window. The default is unpinned (ﬂ). When

pinned, a user can navigate to other items in the Tree while the information in the right side of the screen
remains unchanged. This can be used to add objects to the Flatplanner basket. For more information, refer to
the Adding Objects Manually to the Basket topic in the Print Flatplanner documentation.

STEP connection status displays the status of STEP's connection to the internet. When the connection is
strong and STEP is ready to run normally, the status will read 'Ready.' Other statuses that may appear are:

« Reading. STEP is requesting information from the database.
o Lost Connection to. STEP has lost connection to the server.

« Reconnected to. STEP has reconnected to the server after a lost connection. May alternate with the Lost
Connection to status if the connection to the internet is lost for a significant period of time.

Connection strength is a small graph illustrating the connection strength between the user and the server,
also know as the 'Network Latency.' If a user hovers their cursor over the graph, a hover-over display will
appear showing how fast data is traveling between the server and the user as measured in milliseconds.
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The BG Processes tab shows all active and inactive background processes (BGPs). Activity such as an import,
export, bulk-update, collection creation, etc., generates a background process and a log and informs users if the
process was successful. In the event of an unsuccessful background process, an error message is displayed

showing the reason for failure.

Background processes are based on the type of activity, for example 'Approve recursively,' 'Bulk update,'
'Create Collection,' 'Download Report,' as well as 'Translation,’ 'Translation Import,' and 'Unique Key

Processes' shown in the image below.

100703, en-US > German, Tue Jul 05 1!01

BG Processes

Backgrnund LT | Queue Info

= :{5 Translation

----- :E Queued Processes

- E Active Processes

%:% M_Item180837, en-US = Danish, Tue Jul 05 12:44:23 +0530 20|
485 M_Ttem 180570, en-US = fr, Tue Jul 05 12:52:36 +0530 2016
éﬁé M_Level2180559, en-JS = Hebrew, Tue Jul 05 13:06:52 +1530
--4t7 [100703, en-US > German, Tue Jul 05 13:53:00 +0530 2016 ]
€§§ M_Level1180971, en-JS = fr, Tue Jul 05 15:26:00 +0530 2016
-85 180247, UK English > fr, Tue Jun 23 19:05:08 +0530 2016
{'ﬁ% 180247, UK English > German, Tue Jun 28 19:09:09 +0530 201§
.48 180247, UK English = fr, Tue Jun 28 20:37:10 +0530 2016
é}:% 100703, enJS = Danish, Wed Jun 29 09:44:09 +0530 2016
% 100703, en-U5 = Hebrew, Wed Jun 29 09:44: 11 40530 2016
é:% 100703, enJS = German, Wed Jun 29 09:44:11 40530 2016
%:% 100703, en-UJ5 = fr, Wed Jun 29 09:44:10 +0530 2016

485 100703, en-US > UK English, Wed Jun 29 09:44:11 40530 2015
%:% List. xlsx, en-U5 = fr, Wed Jun 29 09:50:57 +0530 2016

%:'“3:% List.xlsx, en-US = Hebrew, Wed Jun 29 09:50:58 +0530 2016
éﬁé List,xlsx, en-US > German, Wed Jun 29 09:50:57 +0530 2016
%:% 180246, en4JS = German, Wed Jun 29 10:13:54 +0530 2016
%:% 180581, en-UJ5 = fr, Wed Jun 29 10:42;28 +0530 2016

%:9':% M_Ttem 180570, en-US = German, Wed Jun 29 13:17:21 +0530 |
é;% 180575, en-UJ5 = fr, Wed Jun 29 13:30:18 +0530 2016

48 M_Ttem180570, en-US > fr, Wed Jun 29 14:27:31 +0530 2016
{'ﬁ% 18202, enJS = fr, Wed Jun 29 16:46:00 EDT 2016

%ﬁ% Product hierarchy root, en-US = German, Wed Jun 29 16:51:00
é}:% Product hierarchy root, en-US = Hebrew, Wed Jun 29 16:51:00
-85 M_Ttem 180570, en-US = fr, Thu Jun 30 14:09:42 +0530 2016
é:% M_Item 180570, en-US = German, Thu Jun 30 14;32:17 +0530 2
%:{é 100703, en-JS = Danish, Thu Jun 30 19:00:20 +0530 2016
é:'ﬁ% 100703, en-US = Danish, Thu Jun 30 19:03:06 +0530 2016
%:% M_Item180571, en-US = fr, Fri Jul 01 09:40:21 +0530 2016
486 M_Ttem180571, en-US > fr, Fri Jul 0109:48:39 +0530 2016
éﬁé M_Item180571, en-US = German, Fri Jul 01 10:16:56 +0530 20
%:% M_Ttem 180571, en-US = Danish, Fri Jul 01 10:24:04 +0530 201§
:fb Ended Processes

- 85 Translation Import

EEI--% Unique Key Processes

Pruperty' > Value >
Started by IUSER.1
Id BGP_130953
Description 100703, en-US = German, Tue Jul 05 13:53:00 +0530 2016
Execution Server doc-dev
o [
Status failed )
Created Tue Jul 05 04:23:01 EDT 2016
Started Tue Jul 05 04:23:15 EDT 2016
Finished Tue Jul 05 04:23:17 EDT 2016
Processing Time Om2s
Time in Queue Om 14s
# of warnings 0
# of errors 2
' Execution Report
1 Analyse
= Logged on

2 Analyzing translation request
< Analysis selected 1 out of 1 nodes for translation
= Leaving query service
° Root node was specified. Will wait for user to accept analysis result
7 Parsed translation configuration
% Logged on
© Updating translation status
10 1 nodes will be exported for translation
1 Registering pending translation file 100703100703 xlsx
12 Xml for translation: exceltranslation BGP 180963.zip
12 Translation Export Completed
I 1< Export failed with exception: Optimistic locking errors were detected wta
|12 Caught OptimisticVerificationException at Tue Jul 05 042317 EDT 2y er
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A background process can be in the following states: queued, active, completed with errors, or ended. For
details on these states, refer to the BG Processes States topic in the System Setup documentation.

For information on Background Process Queues, refer to the Background Processes and Queues topicin
the System Setup documentation.

For information on initiating and monitoring BGPs in Web Ul, refer to the Background Process List Screen
topicin the Web User Interfaces documentation.

BG Processes Displayed

In the BG Process tab, a user can choose to view only the BGPs that they have initiated, or with the appropriate
privileges, they can view all the BGPs run by any user. The display is selected by clicking either the "Two People
and Gear' button or the 'One Person and Gear' button highlighted in the image below.

13

b AddItemsToCollection

33 Analyze Change-Package
33 Approve Recursively

7 Asset Integrity check

5 AssetDelivery

5 Autopage Batch Service
7 BGPTest

= Bulk Update
b Category Profile Batch Processes

m

BG Processes

| ey O e S ey O o S N oy SO o O o | i
| B S oy i ) i gy Ly Ly L R L iy L Ry | .

Two People and Gear () displays all background processes run by any user. This button is enabled by the
'View Background Processes of Other Users' setup action as defined in the Setup Actions and Error
Descriptions topic of the System Setup documentation.

One Person and Gear () displays only the background processes run by the user who is logged in.

Background Process Tab

The Background Process tab in the editor contains:
« The Properties flipper includes who started the background process, an auto-generated unique identifier,
the type of BGP performed (export, import, bulk update, etc.), status (Succeeded, Failed), creation date and

time, start date and time, end date and time, time taken to process the request, number of warnings, and
number of error messages.
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Background Process [ Queue Info l
@ Propertes

Property * |Value ¥
Started by LISER 1

Id BGP_180953

Description 100703, en-US = German, Tue Jul 05 13:53:00 +0530 2016

« The Execution Report flipper includes detailed information about the process. If the process failed, a
message displays the reason.

) 4 1sofs b b Truncate

« The navigation buttons are enabled when until the log reaches over 100 lines.
« Clicking the 1 button will navigate back one page.
o Clicking the “ button will navigate to the beginning of the log.
o Clicking the » button will navigate forward one page.

o Clicking the g button will navigate to the end of the log.

» The Save button allows the user to download the execution report. Click the 'Save' button to display the
'‘Save File' window. Browse to the download location, add a file name, and click the 'Save' button. The file
can be saved as a CSV or HTML file type. For larger files, CSV files can be zipped.

Note: The 'CSV (Zipped)' option is only available when there are more than one million lines
(presented as rows) within the execution report. This is a result of MS Excel having a limitation of one
million rows per file; the 'CSV (Zipped)' option allows multiple files to be saved.
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¥y Save File x
Look in: Documents w ?’ - v
£ >
File name:
Files of type: |y (Zipped) w Cancel
CSY (Zipped)
CSY

« Truncate - This button is available only on the 'Ended Processes' node.

When the Execution Report becomes cluttered or only specific information is needed (errors or warnings),
truncating the report permanently removes the unneeded information. Click the 'Truncate' button to display

the "Truncate execution report' dialog.

Important: Once execution report lines are removed via truncate they cannot be recovered.

[ ]Error
Info
[ ] Warning

[ Truncate execution report

Mumber of lines to retain |16

Execution report entry types to delete

Pt

OK

Cancel

For example, assume the execution report has 50 lines and a user wants to examine only 16 lines from the
report that are errors. With the settings shown in the image above, the user clicks the OK button and the
execution report retains only the first 16 error lines. All other lines are permanently deleted.

Queue Info Tab
The Queue Info tab in the editor displays the name of the queue being used for the process within the flipper title.
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Background Process

7 W
Position * |Process Type * |Process Description * Process ID > |Started by * |Server * [Progress » |[Created * |Started » |Finished * [Processing Time * [Time in Queug >

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 45



|STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

Bookmarks Tab

The Bookmarks tab allows users to set bookmarks for any objects in the Tree and allows users to easily access
these objects without having to search or navigate the Tree.

A bookmark is a Uniform Resource Identifier (URI) that is stored to provide the user with a quick method of
retrieving the data at any time.

Bookmarks are accessed via:
1. The Navigate menu using the Bookmarks option.

File Edit View Mavigate Forrnat Maintain Window Help
'@ Search Ctrl+F

Search Below -

Goto Ctrl+G
Goto Mext Ctrl+E

Back

Forward

N A

Bookmarks ¥

Find Similar Product

2. Clicking the Bookmarks tab.

Bookmarks

o 31 Brand Logos (BrandLogos)
i |i@ Endcap Displays (22177)

E = Copy Writing State (100100)
‘54 21 Export Configurations (stibo. EMConfigFolder)
[¥a]

W

=

n

£

=]

=]

==]

Note: Bookmarks are stored on the local STEP system and are not accessible when logging into STEP from
a different computer.
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Bookmarks are specific to individual users — just as in a web browser. This means that one user will not be able to
view the bookmarks created by another user.

To learn more about bookmarks and maintaining them, refer to the Bookmarks topic in the Navigation and
Searches documentation.
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Standard navigation Bookmarks are used to quickly access specific nodes in the Tree and System Setup
hierarchies. These bookmarks save the URL of the currently selected object. Any objects from Tree or System

Setup hierarchies can be added with the usage of Bookmarks functionality.
To save an object as a Standard Navigation Bookmark:

1. InTree, select the item to be bookmarked.

F-{ 7] Assets

r_=| Configurations
r_=| Index Words

r_=| Merchandising Hierarchy
r_=| suppliers

-] Web Sites

&=l Entity Root

E Publications

E|r_=| Primary Product Hierarchy
; E}Fj Products

7 0 poperel]

Tree

(8] ” Search ]

BG Processes

2. Onthe Navigate menu, select Bookmark > Add Bookmark.
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Earc tri+ w
& Search Ctrl+F
e L crl6 [ Product [[FTLRS
&[] Con [+ Goto Next Ctrl+E ® Descipton

] |‘='_=‘| eClz

J!«:% r_=| e € Back Name

i "@ Indd < Forward » D

— -- r % Mama

ﬁ -- Bookmarks '™ AddBookmark Ctrl+D |
§ B0 We , . @ Add Search Bookmark i
&1 F-0) Ad Find Similar Product i
&2 [+ (0] Customer Root * Approved
T "'@ Customers > Translation

=3 1

= (D Entity Root > bt

v | - GDsN

E | @1 Publications » Default InDesign ter
iy Eli Primary Product Hierarchy » Completeness Score
ARRE  Ctegory SpecticAt
5 =0 Apparel i —
£l -[[T] Upper Body Wear

[=] :

3 3 [75) Head Wear ©Dispay
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Note: Notice that the existing bookmarks are displayed on the menu.

3. The new bookmark is displayed on the Bookmarks tab.

2 Brand Logos (BrandLogos)
id Endcap Displays (22177)
= Copy Writing State (100100)

Export Confiqurations (stibo. EMConfigFalder)
Apparel (18200}

Note: The Standard Navigation Bookmark is saved under the Bookmark Tab. The bookmark is
represented with the product icon and automatically labeled with the product name and ID in parenthesis.

4. Click the new bookmark.
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5. Navigate to the Bookmarks main tab, and go to the Product tab on an object to view the bookmark data.

Bookmarks

(1 Brand Logos (BrandLogos)

&2 Endcap Displays (22177)

[ Copy Writing State (100100)

(21 Export Configurations (stibo EMConfigFalder)
&2 Apparel (18200)

Tree

W[ System Setup ” BG Processes (8) ” Search "

STEP Workflow

Apparel rev.0.3 - Product

Tables || Category Profile || Status || Statelog || Tasks

Product [ Sub Praducts ” References ” Referenced By ” Images & Documents I

?

Hame *| ¥ |Value ¥
* D 15200
* MName Apparel
» Dbject Type Levell
* Revision 0.3 Last edited by USER on Thu Jul 30 11:...
* |Approved x Last Approved on Thu May 21 14:58:...
» Translation Mot Translated
» Path Primary Product Hierarchy Products/Apparel
» City abe:
¥ Country ahe
» Btate abe:
* firest ah
> Bip 1za

@ seslemvarieingDescrptors

Mame >| > Value b
* Description, Long abe
¢ MbuteGowy
Mame > ¥ |Value ¥
> Bize e

Bookmarks can also be created using a shortcut. Select the object and press Ctrl+D. The bookmark is created

automatically.
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Removing a Bookmark

After saving a Bookmark, it may no longer be needed eventually. There is a right-click menu option that can
remove a selected bookmark.

Important: If user deletes a bookmark (Maintain menu > Delete), the object is deleted and is moved to the
Recycle bin.

No confirmation window displays before removing a bookmark.

1. Onthe Bookmarks tab, right-click the bookmark to be removed and click Remove Bookmark.

Bookmarks
251 Brand Logos (BrandLogos)

(251 Export Configurations (stibo. EMConfigFolder)
i Copy Writing (100400

Gd Apparel (182 Edit Bookmark

| Remove Bookmark |

Copy To Clipboard

2. The selected bookmark is removed.

Bookmarks
(21 Brand Logos (BrandLogos)

[£1 Export Configurations (stibo. EMConfigFolder)
5 Copy Writing State (100100)
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Both Standard Navigation (the link to specific objects) and Search Bookmarks may be edited in the Bookmarks

tab. To edit a bookmark:
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1. Onthe Bookmarks tab, right-click the bookmark to be modified and click 'Edit Bookmark.'

Bookmarks
5 Brang S i
3 Expo Edit Bookmark ronfigFolder)
@ Copy Remove Bookmark
@ Appa Copy To Clipboard

2. If desired, change the name of the Bookmark then click OK.

[ 1 Edit Bookmark

Mame |Primary Brand Logos (BrandLogos)
URL

[ Edit URL

Pt

step://dassification?editor =Classification&versionid=1115118&cont:

QK Cancel

3. The name will be updated in the Bookmarks tab.

Bookmarks

rand Logos (BrandLogos)
&g Endcap Displays (22177)
5 Copy Writing State (100100}

31 Export Configurations (stibo. EMConfigFolder)

4. The object URL can be edited only if the Edit URL checkbox is activated. In the below screenshot, the product

URL has been modified which points to a new product URL.
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[ 1 Edit Bookmark ot

Mame | Apparel (18200)

URL  |step: fjproduct?editor =Product&versionid=111511&contextid=Con
Edit URL

QK Cancel

Similarly, 'Search Bookmark' can be edited by editing the 'Search URL,' if the 'Edit URL' checkbox is edited.

5. Click the OK button to save any changes to this bookmark.
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Bookmarks are direct addresses to a specific object, such as a product, entity, or publication, in STEP. These
bookmarks can be shared to other users by copying the bookmark to the clipboard, and then pasting this
bookmark to a shareable medium.

1. Onthe Bookmarks tab, right-click the bookmark to be removed and click 'Copy to Clipboard.'

Bookmarks

(21 Brand Logos (BrandLogos)
£ Export Configurations (stibo. EMConfigFolder)

= Copy Writing St
kg Apparel (18200

2. Paste the copied URL of the bookmark (using Ctrl + VV on Windows).

Edit Bookmark

Remove Bookmark

I Copy To Clipboard I

B Untitled - Notepad

File Edit Format

View Help

step://collection?editor=NodeCollectionfversionid=111511&contextid=Context1&id=1001008&workspaceid=Main

The copied URL can be pasted in the URL Field of STEP Workbench, and the user can search the respective

objects.

g 6 e URL |step://collection?editor =ModeCollection&versionid=11151 1&contextid=Context1&id= E ﬂ E

search criteria.

Note: You may send the copied URL to other STEP users so that they can navigate to the object or to the
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The STEP Workbench menu bar provides access to many aspects of STEP's functionality. Some of the options
in these menus are also available via a right-click menu accessible elsewhere in STEP. For instance, users may
add a product to a product family by selecting the product family, and then selecting Maintain > Insert > Product

in the menu bar, but they may also perform the same action by right-clicking on the product family in the Tree.
However, some options, like changing the view target, are only available in the menu bar dropdown menus.
Each of the menu bar sections are detailed on subsequent topics.

Note: Many menu options can be used with a keyboard shortcut. For a list of the keyboard shortcuts, refer to
the STEP Workbench Keyboard Shortcuts topic in the Getting Started documentation.

[ doc-dev - userj@https://doc-dev.stibo.com - STEPworkbench

File Edit Wiew Mavigate Format Maintain Window Help

» File— The File menu provides access to import and export actions as well as general STEP Workbench
tasks, such as running bulk updates, changing passwords, and emptying the Recycle Bin. For more
information, refer to the File Menu topic.

« Edit — In addition to administration actions like copying and pasting, the Edit menu also provides access to

tasks like spelling checks, managing assets, and editing unique keys. For more information, refer to the Edi
Menu topic.

« View — The View menu contains options that change how data is displayed in the workbench. For more
information, refer to the View Menu topic.

t

» Navigate — The Navigate menu contains searching options and the ability to find similar objects. For more

information, refer to the Navigate Menu topic.

« Format — The Format menu allows for setting styles such as bold or italics and inserting character tags. For

more information, refer to the Format Menu topic.

« Maintain — The actions available on the Maintain menu pertain to data maintenance at the object level. Data

such as LOVs and attribute values can be merged. Data can also be forcefully deleted, duplicated, or
approved. Links and new objects can be created in this menu. For more information, refer to the Maintain
Menu topic.

« Window — The Window menu provides actions for changing the presentation of the STEP Workbench. For

more information, refer to the Window Menu topic.

« Help — The primary function of this menu is to link users to the online documentation. For more information,

refer to Help Menu topic.
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The file menu contains actions that are related to maintaining the workbench from a performance level, such as
cleaning the recycle bin, purging old revisions, scheduling bulk updates, as well as defining imports and exports.

Translate
Import
Export

@g Reports
Bulk Update

Schedule Category Profiling

Business Module Manager

Change Password

Ernpty Recycle Bin

& &

Ernpty Recycle Bin Before...

Purge old revisions

Check integrity of external assets...

Pre-generate Thumbnail Cache...

Close Window
Exit STEPwaorkbench

H Save Ctrl+Alt+5

Each of the options on the File menu are defined below.

Translate

The Translate menu allows users to translate products, classifications, and names of images and documents,
product values, index words, LOVs (List of Values), units, attribute names, free text cells in tables in the

workbench, and to import translations.
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File Edit View Mavigate Format Maintain Window Help

Translate : Data Objects...

Import : Setup Objects...

Export 3 Manual Excel Translation Export
@: Reports ﬁ Import Translation...

Bulk Update : Change Translation

By selecting 'Data Objects' or 'Setup Objects,' the Request Translation wizard will display. This process
results in the creation of a translation file that will include either data objects (objects that contain usable
customer data) or setup objects (objects that help organize the data objects). Refer to the Structured XML
Translation topic for data object translations and Structured Translation for Setup Objects in the
Translations documentation for more information.

The 'Manual Excel Translation Export' is best used for a specific set of use cases, namely when there is not
much content to translate, the translator does not have access to STEP, or the objects to be translated are
setup objects. For more information on performing a manual Excel translation, refer to the Starting a
Manual Excel Translation Export topic in the Translations documentation.

The 'Import Translation' allows users to select an external translation file.

The 'Change Translation' allows users to change configurations.

For more information on the translate functionality, refer to the Translations documentation.

Import

The Import menu contains actions for bringing data into STEP.

File Edit View Mavigate Format Maintain Window Help

Translate >|
Import : @ Data...
Export ; @ eCl@ss ...
P Reports o Images & Documents...
Bulk Update : ) )
Business Rule from Editable Format
Schedule Category Profiling

The 'Data..." option loads the Import Manager. For more information, refer to the Import Manager topic in
the Data Exchange documentation.

The 'eCl@ss' option launches the ECLASS Classification import wizard. ECLASS is used to group
materials, products, and services. For information on how to best use ECLASS and its importer, refer to the
ECLASS Format topic and the ECLASS Classification Import topicin the Data Exchange
documentation.

The 'Images & Documents...' option, while on a Tree node that contains assets (images and documents), will
load the Import Images and Document wizard. For more information, refer to the Import Images and
Document Wizard topic in the Digital Assets documentation.
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» The Business Rule from Editable Format allows users to manually import business rule definitions in the
editable format described in the Version Control System Integration documentation.

Export

The Export menu contains actions for getting data out of STEP for external management.

File Edit View Mavigate Format Maintain Window Help

Translate ]
Import ]
Export (i@ Data..
@: Reports @ Schedule Data Export...
Bulk Update 3 l@ Images & Documents...
Schedule Category Profiling Compare System Setup Exports...

« The'Data..." option loads the Export Manager. For more information, refer to the Export Manager topic of
the Data Exchange documentation.

« The'Schedule Data Export..." allows you to create a data export that executes at a specific time or
repeatedly. This option starts the Schedule Data Export wizard. For more information, refer to the
Scheduling a Data Export topic in the Data Exchange documentation.

« The'lmages & Documents..." option, while on a Tree node that contains assets (images and documents),
loads the Export Images and Document wizard. For more information, refer to the Export Images and
Documents Wizard topic in the Digital Assets documentation.

o The'Compare System Setup Exports' option enables you to migrate systems and allows users to determine
which items should not be added to the new system. This option will compare two STEP XML files that are
exported from two STEP systems, such as a production system being compared with a development system.

Reports

Selecting 'Reports' option will load the Reports wizard.
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Translate m Reports %
Import
Bt Steps Report Settings
@‘: Reports sl | 1. Report Settings Report Group
Bulk Update 2, Parameters Assets P
Schedule Category Profiling | o+ Advanced Settings Report Name
Assets Either Linked or Mot Linked to Products in PIM

Assets Lists

Report Description

Back Mext Finish Cancel

For more information on the reports wizard, refer to the Reporter documentation.

Bulk Update

Bulk updates allow you to perform one or more actions on multiple objects at the same time.

File Edit View Mavigate Format Maintain Window Help

Translate 5
Import >
Export >
@: Reports
Bulk Update : %] RunBulk Update
Schedule Category Profiling Schedule Bulk Update

« The'Run Bulk Update' option will start the Bulk Update wizard.
« The 'Schedule Bulk Update' option will allow users to create repeatable bulk updates.

For more information, refer to the Creating a Bulk Update topic and the Scheduling Bulk Updates for
Collections topicin the Bulk Updates documentation.

Schedule Category Profiling
Category profiles (also called data profiles) are used to take a snapshot of data that would be displayed in the

category profile tab. This snapshot does not update as new changes are made. With this action, the 'Schedule
Category Profiling' wizard will display and users may schedule the updates of existing profiles and the ability to
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copy profiles as well. For more information, refer to Generating, Updating, and Scheduling a Data Profile
topicin the Data Profiling documentation.

Business Module Manager

A business module is a functional configuration which handles use cases based on common practices observed
in the industry. The Business Module Manager allows an administrator to install a pre-configured data model for
a business purpose, such as the 'sell side' of the product enrichment process, or the 'buy side' for the vendor data
onboarding process. Business module installation can include the creation of product objects types, classification
objects, lists of values types, etc. The 'Business Module Manager' option displays on the File menu for all users.
The install functionality is available for users who are assigned the 'Install Business Modules' setup action
privilege.

[1 Business Module Manager >

b

Select  * |Business Module Installed Version * |Latest Available Version > >

Install Cancel

For more information, refer to the Business Module Manager topic in the System Setup.

Save

While saving in STEP Workbench is automatic, the Save option allows users to force a save without leaving a
field.

Change Password

During any session, any user may change their own password. Enter your current password in the 'Old
Password' field, then enter the new password twice in the 'New Password' and 'Retype Password' parameters.
Click 'Save' to complete the update or 'Cancel' to leave the password unchanged.

[ ! Change Current User Password *
0ld Password
Mew Password

Retype Password

Save Cancel
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This action purges the 'Not In Use' objects in the Tree Recycle Bin. For more information, refer to the In Use
and Not In Use Objects section in the Approval of Objects topic of this guide.

Select the 'Empty Recycle Bin' option to display the Confirm Purge dialog. The number of items that will be
removed is displayed. Click 'Purge’ to permanently delete the items, or 'Cancel' to leave the Recycle Bin

unchanged.

H Save

Change Password ‘

% Empty Recycle Bin ® [ Confirm Purge

@ Empty Recycle Bin Before...

Purge old revisions

O Are you sure you want to permanently delete these objects:

Assets: 38
Classifications: 2
Entities: 36
Products: 5

Skip Analysis Cancel

ped

This action is also available via by right-clicking on the recycle bin.

L LTINS TL YIS

-7 Recyde

-
-

Search in recycle bin

Empty Recycle Bin

Empty Recycle Bin Before...
Approve Deletion Recursively

Empty Recycle Bin Before

This action allows users to purge the recycle bin of anything created before a specified date.
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[ ! Empty Recycle Bin Options >

Only purge objects deleted before: |2020-12-01 11:10:41 | ..,

Cancel

This action is also available via right-clicking on the recycle bin.

[ [FE] RTINS TL MRS

- Recyde

Search in recycle bin

@ Ermnpty Recycle Bin
@ Empty Recycle Bin Before...

Approve Deletion Recursively

Purge Old Revisions

This is a global purge of revisions contained within a specified workspace. A further description of this
functionality is available in the Revisions section of the System Setup documentation.

Check integrity of external assets...

Assets can be stored in a file system on the STEP application server rather than in the STEP database itself.
This can reduce the size of the database significantly, and for DTP tools depending on having the referenced
high-resolution images directly available on the file system, replication from DB to file system of these images
can be avoided.

This option is disabled by default. To enable it, follow the steps defined in the Initial Setup for an External File
Structure topic of the Digital Assets documentation.

The 'Check integrity of external assets...' option is enabled on systems set up to store images in a file system and
not in the STEP database. If a Classification is selected, the user can click this menu item to examine if allimages
in the selected classification have been successfully migrated from the database to the file system.

The integrity of the file system for storing digital assets can be double-checked by selecting one or more
classifications and then select 'Check integrity of external assets' in the File menu. This starts a background
process reporting if any assets are missing or have been changed against expectations.

When errors are found, the assets with wrong or missing content are added to a collection and the URL of this
collection is referenced directly from the execution report of the background process.

A check of approximately 10,000 asset files on standard hardware can complete after one minute. Thus, expect
that the integrity check might take some time on systems with many assets.
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Pre-generate Thumbnail Cache...

This option will generate thumbnail cache of images and documents manually. This action allows any selected
image or images in a classification folder to display as thumbnails without having to wait for them to generate.

For example, on the Image and Documents tab of a classification folder, if the image thumbnails are delayed in
displaying, then Pre-generate Thumbnail Cache from File menu can be run to generate them in a background
process.

For more information, refer to the Image Cache Processing Plugin Parameters and Triggers topicin the
System Setup documentation.

This option is disabled by default. To enable it, ask an authorized user (one with the Setup Action = Maintain
System) to perform the following steps.

Note: Although this automates the loading process, there will be delays during upload.

Under 'System Setup' tab, navigate to 'Users & Groups.'
Select 'System Settings' tab.
Go to 'Image & Document Settings' flipper.

A owbd-=

Set 'Pre-generate thumbnail cache on upload' = Yes. On upload of image or document, the thumbnail will be
generated automatically.

For more information, refer to the 'Pre-generate Thumbnail cache on upload' section of the Images and
Documents Settings topic in the System Setup documentation.

Close Window

This option closes the active workbench window.

Exit STEPworkbench

This will exit the STEP Workbench completely by closing all active windows.
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The Edit menu allows for typical text editing actions, asset editing actions, unique key editing, and spell check.

5 Undo Ctrl+Z
[ Redo Ctrl+Shift+Z
S8 Cut Ctrl+ X
Copy Ctrl+C
[B Paste Ctrl+V
[E Paste and Match Style  Ctrl+Shift«V
B Paste Link Ctrl+L
Select All Ctrl+ A
Spelling
Aszet
Edit Unique Key Values
Remove Row(s) Ctrl+Minus
Insert Row Ctrl+Plus
Undo

This action reverses the last action of the user.

Note: It does NOT restore character-by-character changes in text editors.

Redo

Once an action is undone by selecting 'Undo’, a user can then select 'Redo' to repeat the action.

Cut

Standard 'cut' operation to remove the selected characters.

Copy

Standard 'copy' operation to duplicate the selected characters.
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Note: If a folder is copied, the subfolders will NOT be copied.

Paste

Standard 'paste’ operation to insert the copied characters at the selected point.

Paste and Match Style

Once something is copied or cut, this will paste with STEP styles associated with the copied / cut text. For more
information, refer to the Style tag section of the Tags topic of the System Setup documentation.

Paste Link

Allows the copied object to be linked into another object (e.g., linking an attribute into a second attribute group).
Creates a new instance of the same object (not a copy), just in a different location.

For example, if a user has an image for a product line that will live under multiple parents, the Paste Link action
can be used. The user selects the asset, and then selects another location that will serve as a parent object. The
paste link option can be used to create a link, giving this object two parents. This action will not work on products
as products can only have one parent.

Some considerations with this action are:

« an attribute must exist in at least one attribute group,
« ifthe data must be shown in the Web Ul, then an attribute for display purposes should be created

Note: The Paste option is available based on the selected node. For example, when selecting a product
node and placing it into a classification folder, only the 'Paste Link' option is available. However, if a product is
to be moved to another product family, when selecting the target family after cutting the original product,
'Paste Link' is disabled.

Select All

Standard 'select all' operation to mark all visible objects for another action, like copying or deleting.

Spelling

Allows a user to check the spelling of available text.

b

Spelling : Automatic Spell Check
Asset 3 Spell Check

Edit Unique Key Values
: i Mo Suggestions
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When the 'Automatic Spell Check' option is selected, as users type, incorrectly spelled words are displayed in

red text.

Mame

Value

W

Family Description

ab

is itmesis avalable in multi coolors

W

Brand Mame

ab

Hanes

W

Product Mame

-
abi

Hanes Beefy-T Short-Sleve T-Shirt

If the 'Automatic Spell Check' is disabled, then selecting the 'Spell Check' action while in a field checks that field's
spelling. If a user selects one of the incorrectly spelled words and navigates back to the Spelling menu, STEP will
offer possible spelling corrections.

Spelling : Automatic Spell Check

Asset : Spell Check

Edit Unique Key Values . Mame > |Value ’
avaliabie * Family Description abe [This itmezis svalabls in mult coolors

Remove Row(s) Ctrl+Minus avalanche » Brand Mame abe Hanes

Insert Row Ctrl+Plus availably » Product Mame abe Hanes Beefy-T Short-Sleve T-Shirt
zalable
assailable

Asset

When an asset is selected in Tree, the 'Asset' menu shows various options to manage and change assets.

Aszet

Edit Aszet

LW

Edit Unique Key Values

Remove Row(s)

Insert Row

Ctrl+Minus
Ctrl+Plus

External Viewer

Replace Asset Content

Create Local Content of Asset
Update System Properties
Delete Local Content of Asset

Note: If no object is selected or a non-asset node is selected, all of the 'Asset' menu options are disabled.

« The'Edit Asset' action will open the asset in the program that is associated with the selected file type, like

Adobe Acrobat for PDFs.

« The'External Viewer' will open the asset in a program on the user's local computer.

The 'Replace Asset Content' action will allow users to replace the asset with local assets.

o The'Create Local Content of Asset' option initiates an asset push and downloads the asset.
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« The'Update System Properties' action refreshes the asset's system properties in the 'Images & Documents'
tab of the asset.

« After selecting the 'Create Local Content of Asset' action, the 'Delete Local Content of Asset' option is
enabled and allows a user to delete that downloaded asset.

Edit Unique Key Values

Unique Keys provide a special way of designating objects for identification outside of STEP. Selecting the 'Edit
Unique Key Values' action on an object with active unique keys will display the 'Edit Unique Key Values' dialog,
allowing users to edit any unique key related attributes on the object.

D Edit Unique Key Values by
Attributes
Mame ¥ | » Value 3

» Receiver Product TM abe 3561247451231

> ETIM G4

» Receiver Product GLM GLH

» Supplier Part Mo. 1za PA1-23211

=

If there are no active unique keys for the selected object, then the following message displays.

[ Edit Unique Key Values *

Mo unigue key attributes to edit

For more information, refer to the Unique Keys topic of the System Setup documentation.

Remove / Insert / Add Options

At the bottom of the Edit menu are two options that will change based on the selected node or current view. The
following are a sampling of what may appear:

On attribute references

Remove Attribute Group  Ctrl+Minus
Add Attribute Group Ctrl+Plus

On the sub-products tab of a Product object
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Remowve Row(s) Ctrl+Minus

Add Product Ctrl+Plus

On Lookup tables

Remove Row(s) Ctrl+Minus

Add Row Ctrl+Plus

The options will allow users to add or remove to the selected node as desired.
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View Menu

The View Menu's purpose is to change the way a user views objects in the STEP system. In this menu, users
may change the viewable workspace, context, and mode, add a filter, change the primary hierarchy, and other
options to customize the view to their needs.

Note: This menu does not edit or change any of the values. For more information to edit these values, refer
to the Maintain Menu topic of this documentation.

Mode b
Context ]
Workspace ]
Source 2
Filter ]
Primary Hierarchy ]
Select version b
Mew View

Remowve view >
Product views b

Show Source Context
Rotate Table

' Reload F5
Collapse Tree

Disable calculated values

Default Font Size

Choose User Display Sequence Attribute

Toggle Show Hidden Background Process Templates

Default Context ¥
Logs »
Mode

The 'Mode' sub-menu includes options that allows the user to view STEP data in a variety of ways, dependent on
the need. These options are mirrored on the toolbar. For more information, refer to the Toolbar topic in this
documentation.
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View Mavigate Format Maintain Window Help

Mudee 6‘-" Mormal

Context .
Translation
Workspace
Workspace
Source Context
Filter ; Revision
Prirnary Hierarchy : Update

o Normal mode is the view where the majority of object maintenance occurs. From the toolbar, it is

represented with the E icon.
« Translation mode shows the split view of the different contexts for objects. To use the Translation mode,

select a Source context from the View menu. From the toolbar, it is the icon. Online Translation can be
done from this Translation Tab. Fields highlighted in green color can be translated within STEP from this
Translation Mode. For more information on translating data into other languages, refer to the Translations
documentation.

« Workspace mode shows a comparison of values between Main and Approved workspaces using the ﬂ
button. For more information on workspaces, refer to the Workspaces topic in the System Setup
documentation.

o Context mode shows a comparison of values between different contexts. From the toolbar, it is the E icon.
For example, this will allow a user to view values for all languages or for all price versions. For more
information on contexts, refer to the Contexts topic in the System Setup documentation.

« Revision shows a comparison of values between different revisions. From the toolbar, it is the £ icon. If you
have selected any object in STEP, then switched to the revision view, it will show a comparison screen of the
two latest revisions. The latest revision is displayed in the first column and the older revision is displayed next.
These revisions are also listed under the Status tab in a product editor. For more information on managing
revisions, refer to the Revisions topic of the System Setup documentation.

« Update shows a comparison between objects across workspaces (Approved and Main) and allows the user
to update the object in the current workspace from a source workspace.

Context

When an object is selected, 'Context' displays all available contexts in a dropdown. By selecting one of these
contexts, the viewed context for the current object and all other objects, is changed to the selected context.
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Workspace

View§ Byvigate Format Maintain Window Help

Mode ¥

Context by
gWurlcspace P Main
A d
Tarnet S

Workspace shows all available workspaces. It is possible to change the viewed workspace and view objects as
they appear in different workspaces. In this example, there are only two workspaces: Main and Approved.
However, more can be added as desired. For more information on setting up and using workspaces, refer to the
Workspaces topic in the System Setup documentation.

In the toolbar next to the context selector, the toggle allows you to switch between the Main ( A ) and Approved (

[¥ ) workspaces.

Target / Source
The 'Target' and 'Source' sub-menu allows users to choose alternative dimensions to show in the Context mode.
Depending on the view chosen, this function label changes from target to source.

« Inthe Translation view, this allows the user to select the source language.

Source > v UK English
All Languages
German
English
Danish

Hebrew

Spanish

« Inthe Workspace view mode, this allows the user to select the target workspace.

Target * ~  JApproved

« Inthe Context view mode, this allows the user to select a single target as context or multiple contexts to
compare the content.
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Target > v Danish DK

~"  French Belgium
English UK
English U5
French FR
Germany German
Global

Israel Hebrew

Other

« Inthe Revision view mode, this allows the user to select a past revision(s), provided there is a recorded
change in STEP. If the revisions are older than the current session, the 'Other" option will display a window
to select necessary revision for comparison. When the Revision view is selected, the selected object will
show the current version and the immediately previous version. By using target, users may select specific
revisions for comparison.

Target # " 049 last edited by USER) on Thu Jun 07 15:4%09 EDT 2017
0.48 last edited by USER) on Thu Jun 07 13:4%06 EDT 2017
047 last edited by USER) on ThuJun 01 153:47:33 EDT 2017

Cther

« Inthe Update view mode, this allows the user to select the source workspace.

Source # | Approved
Filter
File View Mavigate Format Maintain Window Help
Mode -] v | 6
W Workspace b
/]
=
= Target 2
= .
E Filter Hide Empty Values
| Prirnary Hierarchy Show Mandatory Attributes Only
P Select version Show Editable Attributes Only
i ) Show Legal Attributes Only
e 7 MNew View
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Select a view to filter out empty attribute values, show only mandatory attributes, show only editable attributes,
and/or show only legal attributes.

Primary Hierarchy

An object may be located in multiple hierarchies. When locating objects, there may be a reason that a user wants
the object's path to specify one of those hierarchies instead of all the applicable hierarchies. Changing this view
can be done by switching the primary hierarchy view used for workbench. This path is displayed in the object
details within workbench, but the path is also used when navigating to an object via a search results set.

For example, object 12345 is in a supplier hierarchy and a primary product hierarchy. When doing a search for
object 12345, upon clicking the 12345 link in the search results, User A wants the object to be displayed in the
Tree within the primary product hierarchy. User B wants to click on the 12345 link and be taken to the object
within the suppliers hierarchy. Both scenarios can be accommodated when each user sets their own view.

iew Mavigate Format Maintain Window Help

] Mode > =g
Context
- Workspace
"[ Target
Filter >| > |value
- Prirnary Hierarchy Prirnary Product Hierarchy
"[ Select version Configurations

An objects' path can be changed based on the selected primary hierarchy. To change the display view, select
Primary Hierarchy from the View menu, and then select the desired hierarchy. For many, the Primary Product
Hierarchy will be the default selection.

In the below example, Object 0726222 is a product object type being viewed in the Primary Product Hierarchy.
This path echos the location of the object in the Tree tab.

rEIE Primary Product Hierarchy
=[5 Products
r_=| Apparel
r_=| Footwear
|__=| Safety
[l]r_=| Hardware
E}Fj Tools
[=-{5] Task Lighting
=+ [ Flashlights
=il Flashlights Items

» Path Primary Product Hierarchy/Products/HardwareTools/Task Lighting /FlashlightsFlashlights Ttems /1725277 je—
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Examples of how objects will be displayed can be demonstrated with the Merchandising Hierarchy selection.
Notice the changed path and the object's location in the Tree tab.

-Lé_ITE Merchandising Hierarchy
|j Apparel
|j Automotive
|j Beverages
E}|j Footwear
=[] Women's Footwear
E||j Dress Shoes
[+-{I5) Stuart Weitzman Hispot

» Path Classification 1 root/Merchandising Hierarchy Footwear \MWomen's Foobwear Dress Shoes 0725227 j—

Select Version

Allows the user to set the default publication or version used for proofing.

New View

Select multiple products from Tree to enable this option and display a multi-editor tab where a view can be used.
Views are not valid with non-product object types. Multi-Editors and views are defined in the Editing Objects in
the Tree Tab topic. A view allows a user to customize the attributes shown for more than one object, instead of
displaying all attributes for all selected objects.

Remove View

Select multiple products from Tree to enable this option and display a multi-editor tab where a view can be used.
Views are not valid with non-product object types. Multi-Editors and views are defined in the Editing Objects in
the Tree Tab topic. A view that is no longer needed can be remove with this menu option.

Product Views

Select multiple products from Tree to enable this option and display a multi-editor tab where a view can be used.
Views are not valid with non-product object types. Multi-Editors and views are defined in the Editing Objects in
the Tree Tab topic. The Product Views option displays all saved views.

Show Source Context

Attribute names may be translated. This option allows a user to view attribute values in both a foreign language
and in the source language.
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Rotate Table

This will flip the selected table so that the columns become rows and vice versa. This is most often used in a
multi-product editor.

Reload

Retrieves updated information from the database including other users’ changes.

Collapse Tree

Collapses the folders in the Tree navigator.

Disable calculated values
Disables the automatic calculation of calculated attributes. This will make the STEP interface load faster.

If Disable calculated attributes is checked, calculated attributes can be rendered one-by-one by clicking the
Calculate button on a calculated parameter in the product editor.

= [CalculatedPrice B [Calu:ulate]

Default Font Size

Allows the user to change GUI font.

Choose User Display Sequence Attribute

Allows the user to select a user-specific Display Sequence Attribute. This option is different from the Attribute set
under Users & Groups in System Setup. For more information on using Display Sequence Attributes, refer to
Display Sequence Attribute topicin the System Setup documentation.

[ Select User Display Sequence Attribute >

The system default display sequence attribute: DisplaySeguence

IUser Display Seguence Attribute | DisplaySequence w

AttributeCompletenessScore
Completeness Score

PrintDisplaySequence
SmartsheetMandatory
TableSortCrder
VariantPriority
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Toggle Show Hidden Background Process Template

Once selected, any previously hidden Background Process Template will display.

Default Context

Sets the default context used when logging in.

Logs

Displays Workspace and System Setup logs.
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Navigate Menu

The Navigate menu offers options for moving around the workbench.

@ Search Ctrl+F
Search Below

Goto Ctrl+ G
Goto Mext Ctrl+E

Back

J A = v

Forward

Bookmarks 4

Find Similar Product

Search

The 'Search’ action accesses the 'Search' tab, which displays along the left side of the workbench window.
Using the search functionality, users may perform a search of all of STEP objects. For more information on
searching within STEP, refer to the Navigating and Searching topic in this guide.

Search Below

Only after selecting an object will the 'Search Below' action become selectable. Once this option is selected, the
'Search' tab will perform populate with a 'Search Below' for that object. Click the Search button to perform this

query.

]

ga - Reset Search
Show Details

[ MName

Goto

A quick way to jump to a particular object in the database based on the name, ID, or Unique Key value. A
dropdown displays multiple hits and allows the user to select the desired object.
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Goto | ID{Name w | T-5hirts

[ T-shirts (18202)

[l T-shirts Items (18203)

[[T] T-Shirts Sales Items (13205)
[ T-shirts (18206)

[ T-shirts (18454)

= T-shirts (253589)

Goto Next

When there are multiple 'Goto' results (or typeahead results) from the 'Goto' function, the user can opt to select
'Goto Next' to continue on to the next hit/ result.

When multiple items meet the criteria for a Goto action, the 'Goto Next' action will cycle to the next object in that
list. This listis ordered by STEP IDs.

Goto Next will be disabled if the previous Goto command has not been used.

Back / Forward

The 'Back' and 'Forward' actions will function the same as most web browsers. 'Back’ allows userstogotoa
previously visited screen, and 'Forward' returns to the screen from which a user went back.

Bookmarks

The Bookmarks sub-menu allows a user to bookmark the currently displayed object or create and name a search
based on the selected object.

[ Add Bookmark Ctrl+D
@ Add Search Bookmark

wt

Bookmarks

Find Similar Product

W T-shirts (13206)

Find Similar Product

The Find Similar Product option populates a search based on the attributes and its values of the selected
product. When this option is selected, a window will appear prompting the user to check off common attributes to
search for.

Important: Attribute values from calculated attributes and inherited attribute values are not searched
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[] calculatedattribute 1

[ ] category

[] child Count

[ ] Dimensions o

| Select || Cancel
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Note: The 'Please Select Attributes' dialog shows only the attributes which have values (inherited from
context, inherited from hierarchy, local values, and calculated values).

When the attributes are selected, click the 'Select' button, and the user is redirected to Search Tab, which is

populated with the Object type and selected attributes with its values.

Search
|-DbjectType Product
IVS arch: (BrandMame) = Hanes
IVS arch: (BrandOwner) = HanesBrands
Er | Reset || Search |
Show Details
| Name 3

After clicking the 'Search' button, the selected product(s) which match the search criteria are displayed.
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IVDbJect Type Product

Search: (BrandMame) = Hanes

Search: (BrandOwner) = HanesBrands

E B | Reset || Search |

Displaying 1 of 1 results Show Details
MName »

> gl Cotton T-shirts ID = 18205

Search Result Profiling

1 hit(s)
Click links to narrow down search

Results by Object Type
Product {1} - exclude
Bl tem Family (1) - sxclude

Results by Position in Tree Hierarchy

Results by Parent

[C]Products (2} - =xcludes
Bl T-chirts ltems (1) - =eciudes

Condition, Multivalued Text, or Multivalued LOV, etc.

Note: This search is recommended for externally maintained attributes with validation base types of Text,
LOV, and Numeric. It is not recommended for attributes with validation base types like Number, URL, Date,
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Format Menu

The Format menu contains items for stylizing and transforming text in the workbench.

Style g

Clear All Styles

Character Tag »
W& Insert Special Character Ctrl+Shift+E

Style
This option allows setting either bold or italics. Users may create their own styles, which will show in this menu.

Forrnat Maintain Window Help
Style ;B Bold
Clear All Styles I ltalic
Style i BodyRowStyle
bold
Bold_C
BoldHeader
bolditalic

Character Tag
¥ Insert Special Character Ctrl+5Shift+E

BottomLeftCorner
BottomRightCorner
bullet

Cther Ctrl+Y

Users can apply style formatting to selected strings of text such as bold, italics, or custom style tags. The
secondary 'Style' menu contains a list of additional styles. Selecting any will change the selected text. To add
more styles to the list of options, refer to the Tags topic in the System Setup documentation.

Selecting 'Other' from the extended Style menu displays a bank of all the custom styles in the STEP system.
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Format o
Style *B Bold Ctrl+B
Clear All Styles I ltalic Ctrl+l
5 bold
Character Tag tle
) ) BodyRowStyle
W Insert Special Character Ctrl+Shift+E
Bold_C
BoldHeader
d 1 Style X
bolditalic
[]BodyRowStyle ~ BoldRed
[ ]bold BottomLeftCorner
[ ]Bald_c BottornRightCorner
BoldHead
[] Boldreader _e Other Ctrl+Y
[] balditalic
[ ] Boldred
[ ] BottomLeftCorner
[] BottomRightCorner o
| ok | Cancel

Note: Formatting is limited to free text fields.

In this example, bullets are applied to the Long Description field. The word 'flash’ is bold.

Red carpet worthy pumps in scarlet suede is sure to turn heads. Metal disk details on the size will sparkle when the carneraiﬂasll.l
See product variations for other color foering,s.l

W

Long Item Description |abe D

Clear All Styles

This action clears all applied styles on the selected text.

Character Tag

The 'Character Tag' action allows for the insertion of custom-made character tags.
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Style
Clear All Styles

Character Tag

¥ Insert Special Character Ctrl+Shift+E
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LineBreak
MoVersionPageMo
Emspace

ft

gt
It
multisep

phone

Other

Ctrl+R

e MASTER DATA MANAGEMEMNT

To learn more about editing character tags, refer to the Tags topic in the System Setup documentation. In the
example below, a phone character tag is used, followed by a line break, and then a multi-item separator.

W

]
Long Itern Description |abe FI

Selecting 'Other' from the character tag menu displays a bank of all the character tags in the STEP system.

Clear All Styles

Character Tage

¥ Insert Special Character Ctrl+5Shift+E

6 [ 1 Insert Character Tag

Discretionary Hyphen
Discretionary Linebreak
EM Space

ermspace
EM Space
ft
gt

b
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Insert Special Character

This is an embedded character map. It shows the most recently used characters and offers a complete Unicode
character range.

Format
Style »
Clear All Styles
Character Tag >
€  Insert Special Character Ctrl+Shift+E

Selecting the 'Insert Special Character' option displays a pop-up of the most recently used symbols.

| » Lung Item Description |ah¢ | |

el:|s |l

Other... Enter

Selecting the 'Other..." option on this pop-up will generate another dialog that allows for selecting all of the special
characters, as well as changing the character set to choose from.
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[ Insert Special Character >
Most Recently Used Symbaols
K N 2 N T s
Unicode Character Blodk: |B-asicLat'r1 v|
? AlSpecal Characters
Ll s | %|&l |”
ClY | *|+|. |- /
012 3[4|5|6]|7
89 == |7
@ A|B|C|D|E|F |G
W
| |
e
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Maintain Menu

Maintain menu provides the user to maintain STEP data by inserting, linking, merging, deleting, approving and
others. Some options, such as Customer MDM Monitoring and User Anonymizer, are only available if the
functionality is activated via a license and/or add-on component. Many options have additional options and are
explained below:

Insert -]

Link >

Merge ]
¥ Delete

Force Delete & Purge
Unlink Object Type

Duplicate Ctrl+J

igliig

Duplicate Recursively
Make Revision

Approval ]

Enable group for workflows

Revive

Revive Recursively
Truncate log...

CMDM Menitoring >

User &nonymizer

Insert

The 'Insert' action allows the user to create an object based on the currently selected object. The options are
disabled based on the selection.

Note: Itis also possible to create objects products, classifications, entities, publications, and assets when
right-clicking in STEP. For more information on object creation, refer to the Creating Objects in the Tree
Tab topic of this guide.
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Insert : 0 Product
Link J Bl Classification
|3 Classification Root
Merge 1@ MNew Entity Node
¥ Delete [T Entity Rugt |
E Delete & P B Mew Publication...
eres et e G Mew Publication Group
Unlink Object Type B MNew Publication Section...
Ef  Duplicate Ctrl+) B NewPage Template ..
Ea Duplicate Recursively Orphan Attribute
Aszet
Make Revision II Attribute
Approval J T Attribute Group
Enable group for workflows Bl List of Values
. Dimension
evive . Dirmension Point
Revive Recursively - Action Set
Truncate log... Mew Image Conversion Configuration...

Create Transformation Lookup Table

=,

Mew Event Queue

Mew AssetPush Event Queue
Mew AssetPush Configuration
STEP Workflow

Background Process to Monitor Deadlines

User

Group

Mew Supplier

Create Package

Create STEP Worlkflow
Mew Business Condition
Mew Business Action
Mew Business Function

Mew Business Library

BREESOE ke BE

Setup Group Root...

The following options are available in the Insert sub-menu:

o Product — If the user is within the primary product hierarchy, this option will create a new product beneath

the selected hierarchy.

» Classification — If the user selected a classification hierarchy, this option allows creation of a new
classification folder beneath the selected classification with the predefined classification object types.
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« Classification Root — If the user would like to have a classification root to store images or configurations or
to link products in the classifications folder, this option creates a classification root with a set of predefined
classification root object types that are listed.

o New Entity Node — If the user selected an entity root, this option will create a new entity object based on one
of the predefined entity types.

» Entity Root — A new 'Entity Root' can be created in the tree hierarchy from predefined set of entity root
object types.

o New Publication... — Allows the user to create a new publication. If the user has already selected a
publication hierarchy, then when this option is chosen, 'Create Publication' dialog will displayed with default
object type selected. The user must provide a name of the publication and 'Page Template,' 'Product
Template,' and 'Publication Template' to create a new publication.

Note: The 'Create’ button in the ‘Create Publication’ dialog will be enabled only if the user has selected a
publication template.

o New Publication Group — Allows the user to create a new publication group within the selected publication
group. If a publication group is selected, once this option is chosen, ‘Create Publication Group’ dialog will
display with the predefined set of object type.

o New Publication Section... — The user will get a wizard to create 'New Publication Section.' When selecting
this option, the 'New Section' dialog will display. Complete the Section Name and select the Page Template
from the dropdown list.

 New Page Template... — Allows the user to create a new page template. After selecting a 'Publication
Group,' this option will display a wizard Create New Page Template in STEP.

« Orphan Attribute — This allows the user to add an attribute as an orphan attribute to a product by searching
or browsing from System Setup tab. For information, refer to the Linking Orphan Attributes topic in the
System Setup documentation.

« Asset — Allows the user to create placeholder with ID and name for a new asset on the selected classification
folder. The user may choose an asset object type from the Create Asset dialog, then asset content can be
added.

« Attribute — Allows the user to create a new attribute in the selected attribute group in System Setup.
« Attribute Group — Allows the user to create a new attribute group in System Setup.

« List of Values — Allows a user to create new list of values under Lists of Values Group / LOVs in System
Setup. User will be allowed to key in ID and Name in the Create LOV dialog.

« Dimension — This option will create a new dimension. A user must select the 'Contexts' node in the System
Setup for this option to be available. For more information on dimensions, refer to the Dimensions and
Dimension Points topic in the System Setup documentation.

« Dimension Point — Allows the user to create new dimension point. A user has to select a dimension under
System Setup > Contexts > Dimension (for example 'Language’). The label of this option changes
dynamically based on the selection of dimension, so the option ‘Dimension Point’ is never displayed. For
example, if the user has chosen 'Language' as Dimension, this option will be labeled as 'New Language'.

o Action Set — This option creates a new setup or user action. A 'Create Action Set' dialog displays with ID
and Name to be filled when user selects the option Action Set. Creating a setup or user action is based on
which node is selected in System Setup. For more information on action sets, refer to the Maintaining
Action Sets topicin the System Setup documentation.
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« New Image Conversion Configuration... — A wizard will display to create new image conversion
configuration and save it for reuse in the selected classification folder. For more information on image
conversions, refer to the Image Conversion Configuration topic in the Digital Assets documentation.

o Create Transformation Lookup Table — Allows the user to create a transformation lookup table under the
selected classification. For more information, refer to the Transformation Lookup Tables topicin the
Resource Materials online help.

« New Event Queue — The user can create a new event queue in System Setup. For more information, refer
to the Creating a New Event Queue topic in the System Setup documentation.

« New Asset Push Event Queue — The user can create a new asset push event queue in System Setup and
it will create a new event queue. The event queue can have any number of asset push configurations running
from it. For more on assets push events, refer to the Creating and Maintaining Asset Push Event
Queues topic in the Digital Assets documentation.

« New Asset Push Configurations — A new asset push configuration will be created under the selected
Asset Push Event Queue. For more on assets push configurations, refer to the Creating and Maintaining
Asset Push Configurations topicin the Digital Assets documentation.

o STEP Workflow — This will create a new workflow under System Setup > Workflows when the user first
selects "Workflows' in 'System Setup'. The STEP Workflow designer window will display. It is also possible to
create a workflow by right-clicking on the 'Workflows' folder. For more information on workflows, refer to the
Workflows documentation.

o Background Process to Monitor Deadlines — When first selecting the System Setup > Workflows node,
this option starts a background process for checking STEP Workflow items that have exceeded their
deadlines.

o User —Users are created by first selecting System Setup > Users & Groups > Group where the user will
belong. When a user selects a Group and select this option, the 'Enter New User' dialog displays. For more
information on users in STEP, refer to the Working with Users topicin the System Setup documentation.

o Group —Groups are created by first selecting System Setup > Users & Groups > and selecting the
necessary node to hold the group. For more information on groups in STEP, refer to the Working with User
Groups topic in the System Setup documentation.

o New Supplier — Supplier users are created in System Setup > Supplier Group. A new supplier can be
created by first selecting the supplier group.

« Create Package — Creates a package by first selecting System Setup > Change Package. After the user
has selected the change package option, a 'Create Change Package' dialog displays. Enter an ID and Name
of the Package. For more information on packages, refer to the Change Packages topic in the
Configuration Management documentation.

« New Business Condition — Creates a new business condition under Global Business Rules in System
Setup. Business Conditions can also be created under Workflows in System Setup. For more information on
business conditions, refer to the Business Conditions topic in the Business Rules documentation.

« New Business Action — Creates a new business action in System Setup under Global Business Rules.
Business action can also be created under Workflows in System Setup. For more information on business
actions, refer to the Business Actions topic in the Business Rules documentation.

o New Business Library — Creates a new business library in System Setup under Global Business Rules.
Business libraries can also be created under Workflows in System Setup. For more information on business
libraries, refer to the Business Libraries topic in the Business Rules documentation.
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o Setup Group Root... — Creates a new setup group root under System Setup. When the user selects this
option, the 'Create Setup Group Root' dialog displays with set of object types. The user may create a new
setup group root based on the object the object type selected.

Link

The 'Link’ action provides a list of object or reference types for linkable actions. This menu will only show the
relevant options as active if it is possible on the selected object.

Insert ¥
Link 3 Product Ctrl+5Shift+
Merge ; Asset Ctrl+Shift+F
Attribute to Classification  Ctrl+5Shift+Y
¥ Delete
Product to Classification  Ctrl+5hift+H
Force Delete & Purge
] ) Attribute to Product Ctrl+5Shift+E
LInlink Clhiect Tuvne

Based on the source object there are different link options available with keyboard shortcuts shown in the above
screenshot.

« When a user selects a product hierarchy and clicks on Link > Product, the product is linked to the selected
product via a product reference type dropdown.

« When a user selects a product hierarchy and clicks on Link > Asset, the asset is linked to the selected product
via an asset reference type dropdown.

« When a user selects an attribute, it can be linked to classifications.
o When a user selects a classification, it can be linked to products.
« When a user selects an attribute, it can be linked to products.

For more information on linking your attributes to products, refer to the Creating a Product Attribute Link
topicin the System Setup documentation.

Merge

Depending on the selected object, the user can merge attributes, LOVs, and LOV values. For more information,
refer to the Merging Attribute Values topic, the Merging Values in an LOV topic, or the Merging LOV
Values in Bulk topicin the System Setup documentation.

Merge : Attribute Values
LOVs
¥ Delete
Values in LOV
Force Nelete & Purne
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Delete

The 'Delete’ action sends items to the Tree Recycle Bin. If the selected item for deletion contains child objects,
the user will receive a warning that these items will also be deleted. For more information, refer to the Recycle
Bin for the Tree Tab topic of this guide.

Note: The keyboard 'Delete’ button does not delete objects in STEP Workbench.

Force Delete and Purge

If an object is selected in the workbench, and 'Force Delete and Purge' is clicked, the Confirm Force Delete and
Purge dialog is displayed. Click the 'Force Delete and Purge' button to permanently delete the object and purge it
from the recycle bin without any further opportunity to cancel.

[ 1 Confirm Force Delete and Purge x

After force delete and purge you cannot revive these objects again.
Force deleting and purging an object will MOT cause an Approve Deletion event.
Are you sure you want to permanently force delete and purge these objects:

Products: 1

Force Delete and Purge Skip Analysis Cancel

Unlink Object Type

When in System Setup, this option allows a user with the appropriate privileges to unlink the selected object type
from its parent.

Duplicate

This standard 'duplicate’ operation essentially copies and pastes in one click. Users may also right-click while
selecting multiple objects and duplicate each of them. A prompt will request a new ID when an auto ID is not set,
then automatically provides a different name. The user is also allowed to indicate if duplicate references should
be created.

Duplicate Recursively

A hierarchy can be duplicated when the user selects the top node in the hierarchy and clicks 'Duplicate
Recursively.' The ID should be editable for duplicate recursively.

In the below example, the ID is auto generated so the duplicate recursively background process will ultimately
give an error.
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Make Revision

Mame »| » |Value
* 1D TconRoot
* Marme Icons ] ]
[ Duplicate Recursively *
» Object Type Tcons
> Revision 0.1 Las @ D 214032 |
> oved
Appr v A Mew Mame |.ﬁ.]arm—13{2}| |
» Translation Mot Tral
s Path Classifid Duplicate references
» Nisibili
ity Start Process with Description
e = be Storage
— = Mame |Dup|i:3te Alarm-13(2) |
» ICatalog Group Theme abi:
(o] | cond |

Allows a user to force a revision on a product and provide a comment for explanation.

Approval

The approval options allow objects to be moved to the Approved workspace.

Approve Object
Partial Approve...
Check Approve
Approve Deletion

Approve Recursively

Ctrl+5Shift+)

o Approve Object — Approves an object from the Main workspace to the Approved workspace and changes
the red X ( X ) to either a green checkmark (4 ) or a yellow one (4 ). Refer to the Approval of Objects

section of this guide for more information.
» Partial Approval — Approve selected parts of the unapproved changes on the selected object.

o Check Approve — The 'Check Approve' action allows the user to refer to if anything is barring successful
approval of an object. In the example below, mandatory values are missing.
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[ Unable to approve product x

Approve report for 18217-012
Unable to approve object due to missing mandatory values on attribute(s):
Brand Owwner

QK

o Approve Deletion —For an approved object to be removed from the Recycle Bin, the object must be
Approve Deleted. If a previously approved object is deleted, in the Recycle Bin it will have ared '(in Use)'
header:

20709 rev.0.9 Deleted (in Use)

Performing an Approve Deletion changes the header to 'Not in Use' and allows the object to be deleted.

20709 rev.0.9 Deleted (Not in Use)

For more information, refer to the In Use and Not In Use Objects section in the Approval of Objects
topic of this guide.

« Approve Recursively — Launches a workflow process that will approve the currently selected object and
all of its children.

Enable Group for Workflows

This is a disabled legacy option.

Revive

Revives a deleted object, either 'In Use' or 'Not In Use', from the Recycle Bin. For more information, refer to the
In Use and Not In Use Objects section in the Approval of Objects topic of this guide.

Revive Recursively

Revives a deleted object as well as all of its children, either in use or not in use, from the Recycle Bin. For more
information, refer to the In Use and Not In Use Objects section in the Approval of Objects topic of this guide.
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Truncate Log

Once selecting an Event Queue or Asset Push Queue, this option will reduce the log to the most recent entries.
For more information, refer to the Event Queues topic of the System Setup documentation.

Customer MDM Monitoring

Selecting the 'Start background process for monitoring Customer Data Policies' option under Customer MDM
Monitoring will manually initiate any of the active data policies in the system. For more information, refer to the
Data Policies topic in the Data Governance documentation.

User Anonymizer

This option is available to admin users and is used to anonymize a deleted user within the object change logs,
revision logs, and workflow status logs. For more information, refer to the User Anonymizer topicin the
System Setup documentation.
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Window Menu

The Window menu offers actions around the STEP Workbench window.

Mew PIM Window Ctrl+MN

Goto Window

D Goto Dashboard

Zoom Window

New PIM Window

This action will create a new instance of the STEP Workbench.

Goto Window

This is a legacy option and no longer functions.

Goto Dashboard

This option will display the STEP Workbench dashboard.
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Hew ltem Creation by State Average Time in State Ohject Type Count

STEP Workflow profile is unavailable

STEP Workflow profile is unavailable

Profile generated Tue Jan 26 2016
15:03 in context 'English US', workspace
‘Main’

W |tam {79
N Sales ltam {S8)
Item Foldar {25)
M Loved 3 {23)
. Laved 2 (Z1)
Dhar objact typas (105)

| _Flexkt | Average Object Completeness

Profile generated Tue Jan 26 2016
15:03 in context ‘English US', workspace
‘Main’

W Yas {8)
- o 1)

No data available for context "English
uUs’, workspace 'Main’, completeness
metric with ID ‘Completeness Metric B

Translation Status

Profile generated Tue Jan 26 2016
15203 in context ‘English US', workspace
‘Main’

W hot Transbated (222)

Humber of kems in Workflow State

STEP Workflow profile is unavailable

Zoom Window

This action will center the STEP Workbench on your primary display.
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Help Menu

The Help Menu has two options: 'Help' and 'About STEP".

&7 Help F1

7  About STEP

Help
The 'Help' option opens the STEP documentation in your default web browser.

If configured to authenticate, you will be prompted to enter a STEP username and password before online help
is displayed. To enable this functionality, the property
OnlineHelp.Documentation.Authentication.Enabled=true mustbe added ittothe
sharedconfig.properties file. Authentication is disabled by default.

I Note: The authentication option will not work with any Single Sign On (SSO) solutions other than LDAP. I

— |STIBOSYSTEMS

e MASTER DATA MANAGEMENT

Production

Forgot password?

Locale English (United States) =
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You are here: Welcome to Online Help - - =5

Welcome to Online Help f

When you are done with online help, you should click the Logout button located on the far right of the online help
toolbar. Upon logging out, you will be taken back to the documentation login screen.

If authentication is disabled, the Logout button will still display. In this scenario, clicking on the button will take you
to the STEP Online Help welcome page.

About STEP

The 'About STEP' option displays the workbench introductory window.

[ 1 About STEPworkbench >

D STIBOSYSTEMS

MASTER DATA MANAGEMENT

Copyright ® Stibo Systems: All trademarks, service marks, and
logos appearing are proprietary to Stibo Systems or its licensors.
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Object Editor

When an object is selected from the left panel in STEP (e.g., Tree tab, System Setup tab, etc.), the right panel
displays details on the first tab for the selected object. The left panel can be hidden or displayed by clicking the
hide (f4) and show (BJ) toggle buttons.

The kind and number of tabs will vary depending on the selected object. However, all objects will have at least an
ID, Name, Object Type, Revision, Approved, Translation, and Path. These fields are called 'aspects.'

18207-012 rev.0.2 - Product
Commercial || Tables | Categary Profile || Skatus | State Log || Tasks
Product [ Sub Products ] References [ Referenced By ]
& Description il
Mame *| * |Value

* IO 18207

¥ Mame 18207-012

» Ohject Type SalesItem

» Revision 0.2 Last edited by USER. on Man Jul 27 15:43:10 EDT 2015

» pproved x Last Approved on Mon Jun 15 16:27:06 EDT 2015

» [Translation Mot Translated

» Path Primary Product Hierarchy/Products/ApparelUpper Bady Wear /T-shirts/T-Shirts L

* Condition [

» Parent e T-shirts

> Status
@ Sales Them Marketing Descriptions

Mame »| » |Value >
. The Hanes Beefy-T T-Shirt For over 35 years, it has set the standard for T-shirt comfort and quality.
» Description, Long abe Today it's better than ever, offering greater durability and less shrinkage than you'll get with ordinary
tees,

Refer to the Object Maintenance in the Tree Tab topic within this guide and child topics for additional
information on the various object editors available in Tree.

Information on editing non-Tree objects can be found within the relevant sections throughout the documentation
(e.g., information on workflow editors is available within the workflows guide).

For the product objects in STEP, users can create attributes (description attributes) along with aspects in the first
flipper called 'Description.' For more information about description attributes, refer to the Description
Attributes topic in the System Setup documentation.
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Search Tab

The Search tab allows users to perform simple searches by typing directly into the default search field.

=

5

& EEE [ Reset ][ Search ]
Search Result Show Details

g | [ ame 3

[+h]

2

el

Users can also perform more complex searches by selecting and/or combining additional search criteria.

@ Search

=
Search

= Object Type

) _|E

]

@i Search Below M

Hailz

Referenced fszets %l

Revised Objects Changed Since
Document Content

Search from List

Javascript search

Missing Mandatory Values
Unapproved

Product Override Search

Search in Publication Hierarchy
Referenced By

References

STEP Worlflow

Sample Result

Translation Status

Unpushed or Failed Assets

[ STEP Workflow " Bookmarks ” System Setup ” BG Processes (2] ]
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Below Search Operations can be performed on the entire search result.

-Operations on Entire Result

0| @

For more information about search operations, refer to Search Operations on Entire Result topic in the
Navigation and Searches documentation.

For more on searching, refer to the Search section of the Getting Started documentation.
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STEP Workflow Tab

STEP Workflow is STEP's native functionality for structuring and to some extent automating processes around
objects in STEP. Typical examples are Product onboarding processes and change / governance processes.

The concept of STEP Workflows differs from the general concept of a workflow, in that STEP Workflows are
data-centric, meaning that each instance of a given Workflow always will be tied to an object in STEP. As
illustrated below, technically, a Workflow Instance is a relation between a STEP object and a Workflow definition
that also exists as an objectin STEP.

Done

W

Marketing Reject

Done

v
Workflow Instance w

Accept

STEP Object 4

Workflow Definition

The STEP Workflow tab has these sub tabs: Tasks and Profile.

Tasks

The Tasks sub tab is the primary interface for working with workflows in STEP Workbench.

1. Each workflow has a flipper that can be opened to display details about the workflow.

STEP Workflow

|Filter by Collection "ZI

Failure ]
Initial 0

CE55E5 ” Search .[_]IFE
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2. Administrators can configure which states are displayed for each workflow. The number of tasks for the state
are displayed.

Profile

2 Approve Recursively
G P

Filter by Collection

Failure
Initial 0

CE55E5

3. The Refresh button updates the data displayed for number of tasks in the workflow.

STEP Workflow

Profile
2 Approve Recursively
el

Filter by Collection

Failure ]
Initial 0

CE55E5 ” Search ” Tree

4. Clicking the Show All Items button displays all tasks in all displayed states, regardless of the assignee. Only
users with the STEP Workflow Administrator privilege have access to this button.

STEP Workflow

; @ Approve Recursively

5| & P I

o

wil | |Filter by Collection

ﬁ Failure ]
@ Initial 0

5. Clicking the Show All Items assigned to me or any group | am a member of button displays tasks
directly assigned to the user or any group that the user is a member of.
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B Profile
; 2 Approve Recursively
5@ P

o

wil | I Filter by Collection

ﬁ Failure

@ Initial

e MASTER DATA MANAGEMEMNT

6. Clickingthe Show All Items assigned to me button displays only tasks that are directly assigned to the

user.

STEP Workflow

; 2 Approve Recursively
5@ P

o

Wil | Filter by Collection

E Failure

ﬁ Initial

7. Click the ellipsis button (|...)) to allow users to filter the list of displayed tasks based on a Collection. For

example, if a user wanted only to observe objects in the workflow where the Color Attribute = Blue, they can
first perform an Attribute search on the Search tab, then save the result as a collection, and use that collection

to filter the objects to display only those where Color is Blue.

STEP Workflow

@ Prafile
; 2 Approve Recursively
5|3 P

i

Wil | Filter by Collection

ﬁ Failure

ﬁ Initial
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Profile
STEP Workflow 4 New Item Creation Profile - By State - STEP Workflow profile i
Tasks m STEP Workflow profile
KPI_StatusTracking Configuration last edited by user on 2015-07-23 13:46: 21 On-demand data has not yet been generated for this profile
New Item Creation Profile - By Assign Edit configuration |Update on-demand data Copy to Clipboard ]
New Ttem Cr“tf"" Profile - By Stat State > ETEP Workfiow > [tems in State > [Average tme in State
New Item Creation Profile - By Worldlow > Copy Writing SalesItemCreation 11 81Days
» Copy Writing Cluster SalesItemCreationMewBR 4 123 Days
» Copy Writing Cluster SalesltemiCreation 11 31Days
» Copy Writing Ended e SalesItemCreationMewBR 4 123 Days
» Digital Asset Cluster SalesItemCreationMewBR 4 123 Days
» Digital Asset Cluster SalesltemiCreation 11 31Days
» Digital Asset Review SalesItemCreationMewBR 4 125 Days
» Digital Asset Review SalesltemiCreation 11 31Days

Click a Profile link to view details of the configuration.

The Edit Configuration button allows you to modify the data being profiled.

The Update on-demand data button runs the profile and updates the data displayed.
The Copy to Clipboard button saves the data displayed to your computer's clipboard

o~ b=

Once saved to the Clipboard, this data can be pasted into Excel for further analysis.

For information on how to configure workflows, refer to the Creating a Workflow topic.
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System Setup Tab

Schema objects are maintained from the System Setup tab. Examples of such objects are Attributes, Action
Sets, Contexts, LOVs, Object Types, Tags, Units, Users & Groups, Workspaces, Reference Types, and many
more. Most actions performed require Super User access. This is where the core components like integration
endpoint, STEP Workflow, Web Ul, business rules, etc. are created and configured.

System Setup

|'='_=I Attribute Groups

(3] Attribute Transformations
-- Action Sets
-- Contexts

-- Lists of Values /LOVs

&[5 Global Business Rules

Eﬁ Inbound Integration Endpoints
----- 5] Match Codes and Matching Algorithms
Eﬁ Outbound Integration Endpoints
EE; Portals

--(15] Status Flags
&8 Workflow Profiles
B8] Workflows

i [Z] Derived Events
{%‘ Object Types & Structures
% Tags

- Units

1@: Users & Groups
B\- Reference Types
- + Workspaces
@ Table

- Keys

Ii Ewvent Queues
#-[Bg Companent Models
ﬁ Recyde Bin

[ STEP Workflow ” Bookmarks ]W[ BG Processes ” Search ” Tree

Additional information on the System Setup objects and functions can be found throughout the online help. For
example, information on workflows is available in the Workflows guide, while information on integration
endpoints is available within the Data Exchange guide. Information for general functions that are not covered in
independent guides (e.g., attributes, references, users and groups) can be found in the System Setup
documentation.
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Toolbar

The features accessible on the toolbar, (located beneath the menu bar), are geared towards navigating between
objects and viewing object data in different ways.

[ doc-dev - userj@https://doc-dev.stibo.com - STEPwarkbench — O x

File Edit View Mavigate Format Maintain Window  Help

[T context [Engishus | € > Clur nr=Prnduct&mntexﬁd=Cnntext|E F ] [l coto [1D/Name

Hardware rev.0.6 - Product

-] Artide Groups Commercial || Tables || Category Profile || Proof View || Status || State Log || Tasks

|—_=| Assets l Sub Products ” References ” Referenced By " Images & Documents ]
rj Bulk Update Configurations - Description

|‘_‘=| Elas:iﬁﬁt;ms & Description Attribut
-
r—j or_1 gurations | |Name >| > |'l.-'a|ue >|

The various features available on the toolbar are described below.

Stibo Systems Logo
[

Clicking the Stibo Systems logo allows the user to toggle between the STEP dashboard and the STEP
Workbench. For more information regarding the dashboard refer to the Global Dashboard section of the Data
Profiling documentation.

Context List

Context |English US -

'‘Context' acts as afilter that allows a user to view object data defined by, for example, country or language.

To select the context, the user clicks the dropdown and then selects the desired context from those listed. It is
useful to check that the context is properly set because viewing data in the wrong context is likely to cause
significant confusion. For more information regarding contexts, refer to the Contexts topic in the System Setup
documentation.

Workspace Toggle Button
Located to the right of 'Context', the Workspace toggle button switches the user's view of a given object between

the 'Main' ( = )and 'Approved' ( E’) workspaces. In the 'Main' workspace, object information is editable. In the
'Approved' workspace, the user can only examine values that have been approved, and may not edit them. For
more information on workspaces, refer to the Workspaces topic in the System Setup documentation.
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Navigation Buttons

€>cC

To navigate backward or forward to a previously viewed screen or to refresh the current screen's data, the user
can click the 'Back’, 'Forward', or 'Reload' buttons, respectively. These buttons are located between the
'Workspace Toggle' button and the URL field. When clicked, these buttons behave in a way similar to most web
browsers' 'Back’, 'Forward', and 'Reload' functions.

Address Field

URL |sset?editor=AssetReferencedBy&contextid=Main

To maximize navigability of the STEP tool, all objects may be accessed via an in-tool URL. As with the URL bar
in a standard web browser, a product may be reached within STEP by pasting its unique URL into the URL bar.
Itis important to note that the STEP URL always begins with "step:/", unlike web URLs which begin with
"http:/I" or "https://."

Viewing Mode Buttons
EE=0&

Viewing mode enables the user to view data in a variety of ways, dependent on the need. When clicked, each of
the 'View' icons that appear to the right of the URL field in the toolbar present data in different ways. Below are
the view modes described:

Normal mode

S|

This is the default view of the STEP Workbench. With this view selected, users can examine a listing of all
relevant attribute and metadata associated with that object.

Translation mode

With this mode selected, users can view all object-related data in up to two languages. The data is presentedin a
comparison display format. Attributes that require translation are automatically highlighted in green. More
information of translations is available in the Translations documentation.

Workspace mode

.l
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With the "Workspace' view active, users can refer to object data as it appears in both the 'Main' and 'Approved
workspaces. This comparison view can be useful by allowing a user to view, at a glance, which values have
changed since the object was last approved. However, if the object is in 'Never been approved' status, only the
'Main' workspace will show when this view is active. For more information on workspaces, refer to the
Workspaces topic in the System Setup documentation.

Context mode

BB

With this view enabled users can view all of an object's data for two or more available contexts in a comparison
display format. The number of contexts viewable at one time is configurable. For more information regarding
contexts refer to the Contexts topic in the System Setup documentation.

Revision mode

With this mode selected, users can view the current state of an object's data as well as all previous revisions in a
comparison display format. The number of revisions viewable at one time is configurable, but the current and
previous versions are shown as the default. For more information on revisions, refer to the Revisions topicin the
System Setup documentation.

Goto Field

Goto | ID{Name v [

This field enables searching for specific objects. To quickly locate objects in the hierarchy by their ID, name, or
key, that data can be added into the 'Goto field' and searched on. When the desired item appears in this field, the
user can click on it, taking them directly to the object. For more information regarding the Goto field, refer to the
Goto topicin the Getting Started documentation. For more information on keys, refer to the Unique Keys topic
in the System Setup documentation.
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Tree Tab

This section contains information about how to create and remove local overrides and information about table
dimension points.

F-{ 7] Assets

r_=| Configurations
r_=| Index Waords

r_=| Merchandising Hierarchy
r_=| Suppliers

-] Web Sites

E Publications

r_=| Primary Product Hierarchy
(5 Collections

[ﬁ eCatalogs

-5 Recyde Bin

_H BG Processes (2] ” Search ]

The above hierarchies and their child objects can be navigated, edited, created, and deleted from the Tree.

The following table is an overview of the different elements of the Tree tab.
Object Description

Products It is used to store actual product information. Alternative name is 'Blue folder

Classifications | Itis used to store assets (Images and documents), configurations, and link products.
Alternative name is 'Yellow folders' or 'Secondary classification.'

Index Words An Index structure needs to be created in STEP, in the same way as a ‘Classification
Hierarchy, and products are linked into this structure.

Entities Itis used to store the party, supplier data, or contact information. Alternative name is "White
folders.'

Publications Itis used to store print (Example: InDesign) documents and print related configuration like
templates, versions, commercial data, and dtp documents. Alternative name is 'Green
folders.'
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Object Description

Collections Collections are containers for storing different sets of objects to perform bulk update or
export data.

eCatalogs It is used to create electronic product catalogs. An electronic product catalog is a data file
containing product and price information for a specific product selection. Alternative name is
STEP sync.

Recycle Bin Deleted objects (products, assets, classifications, configurations and entities) are moved to
recycle bin from the Tree tab.

Itis used to create electronic product catalogs. An electronic product catalog is a data file containing product and
price information for a specific product selection. Alternative name is STEP sync.

For further information about objects in the Tree and how to work with them, refer to the Basic STEP Concepts
and Object Maintenance in the Tree Tab topics within this guide.
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Object Maintenance in the Tree Tab

Regardless of the particular object type or hierarchy that you are working with, the general principles of
maintaining objects in the workbench are the same, and are described in the All Objects section of this guide.
This includes general information on creating, editing, approving, and deleting objects.

Note: The All Objects information should be read and understood prior to focusing on any of the object type
specific information (links below), as the basic information that is common to all object types is not repeated in
the type-specific sections.

Beyond the general object maintenance topics, additional information on working with specific object types in
Tree, including details about the various editors and functionalities available on them can be found in the
subsequent topics in this guide:

o Assets

o Classifications

o Collections

o Entities

o Products

« Recycle Bin for the Tree Tab

« Publications: Information about maintenance of objects in the green publication hierarchy is not covered in
this guide. Itis located in the Publication Hierarchy section of the Publisher (Adobe InDesign
Integration) documentation.

Note: All actions are controlled via privileges. Some users may not have access to create or delete objects,
or may only have options to edit specific object types, hierarchies, or attribute values. The information in this
guide focuses strictly on the means for carrying out the various actions, and assumes that all required
privileges are available to do so. More information on privileges is available in the Privilege Rules topicin the
System Setup documentation.

A variety of components are also available for maintaining objects in Web Ul. For more information, refer to the
Web User Interfaces documentation. Additionally, objects are often created or maintained within workflows, or
via imports, integration endpoints, bulk updates, etc. These types of object maintenance are outside the scope of
this material, but additional information is available in the relevant guides throughout the STEP Online Help.
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All Objects

This section covers the basic functionality of creating, editing, and deleting objects in the Tree, as well as
providing an overview of the commonalities between the various object editors. Regardless of the particular
object type or hierarchy that you are working with, the general principles of creating and maintaining objects are
the same.

Itis helpful if the Basic STEP Concepts topic in this guide has been read and understood prior to reading this
material.

A variety of components are available for creating and maintaining objects in Web Ul. For more information, refer
to the Web User Interfaces documentation. Additionally, objects are often created or maintained within
workflows, or via imports, integration endpoints, bulk updates, etc. These types of object maintenance are
outside the scope of this material, but additional information is available in the relevant guides throughout STEP
Online Help.

Note: All actions are controlled via privileges. Some users may not have access to create or delete objects,
or may only have options to edit specific object types, hierarchies, or attribute values.

The information below focuses strictly on the means for carrying out the various actions, and assumes that all
required privileges are available to do so. More information on privileges is available in the Privilege Rules topic
in the System Setup documentation.

Refer to the relevant section(s) below for detailed information on working with objects in the workbench:

« Approval of Objects

o Creating Objects inthe Tree Tab
o Deleting Objects in the Tree Tab
» Editing Objects in the Tree Tab
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Approval of Objects

This section introduces the user to the concept of approvals in STEP, and provides detailed information on how
to carry out approvals in the STEP Workbench.

Approval of objects in the Web Ul is handled via a Partial Approval action button on a Node Editor screen. Refer
to the Partial Approval in Web Ul topic in the Web User Interfaces documentation.

Approval Overview

The data in STEP is logically divided into two workspaces named Main and Approved.

The Main Workspace is the editable 'draft' Workspace where data is initially born and enriched. The Approved
workspace holds approved data deemed ready for production.

Main Approved

nmp

Approval

In a typical setup, data from the Approved workspace is made available to downstream systems. Data cannot be
edited directly in the Approved workspace. Instead, data is reflected in the workspace via an operation called
approval.

Approvals can be carried out manually by a user, or programmatically by a business rule, import process, or
other operation.

The approval operation only applies to objects that are workspace revisable. These are:

« Product objects
« Classification objects
» Asset objects
« Entity objects configured to be workspace revisable
All other objects in STEP (like attributes, references, etc.) will be identical in the Main and Approved Workspaces

and changes made to these will be reflected automatically in both workspaces. These objects are known as
being 'Globally revisable'.
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Detailed information on how to carry out approvals in STEP Workbench can be found in the Approving an
Object topic in this guide. This guide also contains a detailed description of the approval symbols that are visible
in the different object editors in the Approved Symbols and Messages topic in this guide.

Note: All actions are controlled via privileges. Some users may not have access to approve objects, or may
only have options to approve specific object types, hierarchies, or attribute values. The information in the
subsequent topics assumes that all required privileges are available to carry out the described actions. More
information on privileges is available in the Privilege Rules topicin the System Setup documentation.

In Use and Not In Use Objects

When an object is approved in STEP, it cannot be purged from the Tree Recycle Bin. This restriction prevents
approved objects that show on the Approved Workspace from being removed erroneously. This prevention is
done by way of the 'In Use' and 'Not In Use' indicators on the object records in the Tree Recycle Bin. For more
information, refer to the Recycle Bin for the Tree Tab topicin this guide or the Recycle Bin for System

Setup topic in the System Setup documentation.

'In Use' objects cannot be individually deleted nor are they included in the Purge action. A user must perform an
Approve Deletion action on each 'In Use' item.

” System Setup ” BG Processes ” Search ]

akmarks

-] Light-track
~[Z] Luminaire hoist
-] Mechanical accessaries for luminair

-] Mumber ftext label for house numbe

-[Z] Pictogram for emergency luminaire
-] Pillar for bollard
~[] Sales Flyers
-] Suppliers Root
-] Support profile lightine system
--[] Test device for emergency power |
[T (160323)
[T (160324)
=
|__=| (180353)
- | 12-GGK73(2)
-\ 12-GGK79(2a(2)
-\ 18210 M B(2)
- 18212 B(2)
—_ .

Proof 'u'iewl Status || State Log || Tasks

Images & Documents

H Commercial H Tables |

[ Sub Products

” References ” Referenced By |

) Description
Mame *| » Value
* IO 160350
¥ Mame
» Ohject Type Level 2
» Revision 0.8 Last edited by USEl
» pproved x Last Approved on |
» Translation Master
» Path Primary Product Hierar:
» Default InDesign template
» CalculatedAttribute 1 £ NfA-
¥ Child Conint -0

When an object that is not approved is deleted, the Tree Recycle Bin shows the 'Not In Use' indicator. This
means it will be purged with the 'Empty Recycle Bin' option and can be totally removed.
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€12-GGK79(2)a(2) rev.0.2 Deleted (Not in Use) -

—[7] Light-track L Tables || Proof View || Status || State Log | Tasks

~[Z] Luminaire hoist Referenced By H Images & Documents " Commercial |

| ~[Z] Mechanical accessaries for luminair [ Data Containers " Sub Products " References |
J.g --[=] Mumber ftext label for house numbe ® Description A
oz -[Z] Pictogram for emergency luminaire -1 |
— [ Pillar for bollard Plame Vel

D ~[7] Sales Flyers * D 243318

L] -

g -] Suppliers Root » MName 12-GGKTZ)al2)

1 -] Support profile lightine system > Dbiect T Tte

2 -] Test device for emergency power | ject TYPE "
— [T (160323) * Revision 0.2 Last edited by L

% [T (160324) > |Approved 3 Never Been Ap)

LE -1 (160350) » Translation Mot Translated

o |__=| (180353)

[ i i

= - ™ 12-G6K73(2) » Path Primary Product Hie

— E » Default InDesign template
I’? -'IG"I'lI"i KA O

If an object that is approved is deleted, it still displays in the Approved workspace until an Approve Deletion or
Approve Deletion Recursively action is performed.

An approved object can be removed from the Approved workspace by manually performing a Force Purge
operation from the BGP screen after a purge operation fails (due to the object being 'in use'), or, from the
Maintain menu. Additionally, you can force purge approved objects which have not yet been approved for
deletion from the Tree Recycle Bin, by running a scheduled Recycle Bin empty operation that has 'Force Purge
selected within the Schedule Recycle Bin wizard.

The key difference with the System Setup Recycle Bin and the Tree Recycle Bin is that all of the System Setup
objects in the Recycle Bin are flagged with 'Not In Use' since nothing in the System Setup is constrained by
Approval status.

Note: The workspace button has an orange background ( ﬁ ) when Approved workspace is displayed and

no background color (Q ) for the Main workspace. When in the Approved workspace, neither the Tree nor
the System Setup recycle bin are displayed.
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Approving an Object

This topic describes how to approve an object in the workbench. When an object is approved, it moves to the

Approved workspace.

Data Ownership

1STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

The concept of data ownership is very important in relation to approvals. For an object to be fully approved, all
data that the object owns must also be approved. When data changes, the object that owns that data is
considered 'modified' and can potentially become 'unapproved.’

The figure below shows data owned by a Product object (the largest box).

Parent Product

Product
& 1D
* Mame

* Local Specification
Attribute Values
Description
Attribute Values

T

Local References
to other Products

Local References
to Entities

Local Links to
Classifications

Local References
to Assets

Local Links to
Specification Attributes

o A Product owns its parent link (also true for Classifications, Entities and Assets).

« The Product owns local values, but not inherited Specification Attribute values. Thus, when these are
modified at an ancestor level, this will not affect the Product’s approval status. Also, the object's local values

(that is, assigned at the product level), will be approved.

o The Product owns all local References and Links for which it is the Source. When a Link or Reference is
modified, it is the Source that is changed while the Target is unaffected. Attribute values on the Reference /
Link are likewise owned by the Source object.
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Approving an Object

To approve an object, right-click on the object and select one of the available approval options, or use the options

on the Maintain menu.
_ Maintain Window Help

" Asg > = id =i jd =M
g A5 = New Classification :_ @:t > (¥ URL |d=1083748contextid=Context18id=As

| BET New Asset Ctrl+ Shift+ A "

| B0 & New Product Merge ? broducts || References || Referenced By || Ima
G| E-Me
— 1_._=| Sur a Import Images & Documents... 7 Delete

E r_=| We l@ Export Images & Documents... Force Delete & Purge >| > [value

g i Ent @ Export Data Below Unlink Object Type pssetsRoot

EI @ SD': Map eCl@ss Attributes ] pasets
= g pg Unlink classification EQ Duplicate Ctrl+J pisset Root
| B rin : :

=X ---L'é col B2 Duplicate Recursively 0.1 Last edited by Stibo Systems on Fri |
ﬁ -3 eCa o Cut Ctri+X T + Approved on Fri Jan 02 00:00:00 ES
% ﬁ Rec Copy Ctrl+C nt Translated
M [} Paste Ctrl+V Approval : Approve Object Ctrl+Shift+)

I & Paste Link Ctrl+L Enable group for workflows Partial Approve...

b}

%l 7 Delete Revive Check Approve

2 ' A Deleti
; B2 Duplicate Ctrl+) Revive Recursively pprave Deletion

A R ivel

H EE] Duplicate Recursively e

x

5 ) -

= Approve Object Ctrl+Shift+J]

[

E Partial Approve...
] Check Approve

Approve Recursively

Note: If 'approval' is a task within a workflow, then objects can alternately be approved from the task view.
Refer to Working with Tasks in Workflows in the Workflows documentation.

Approve Objects is available when the Main workspace is selected.
Approving objects is available for:

« Classifications

« Products

» Images & Documents

« Entities (set up to be Workspace revisable)

The status of an object in the various workspaces can be viewed in the Status tab in the Workspaces field of the
relevant editor.
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18210 M B_EN rev.0.57 - Status
Fri Aug 26 11:12:09 EDT 2016 Mon Aug 29 12:06:58 EDT 2016 LUSER4 Auto Generated
» 0.3 Fri Aug 19 14:13:53 EDT 2016 Fri Aug 19 14:13:53 EDT 2016 IUSERE Auto Generated
* 0.2 Tue Aug 02 09:15:20 EDT 2016 Tue Aug 02 09:15:44 EDT 2016 USERS Auto Generated
* D1 Fri Feb 13 11:36:39 EST 2015 Fri Feb 13 11:36:39 EST 2015 STEPSYS
% Workspaces
i » [Name » [Path >

» Main Main Main 0.57

» Approved Approved AWpproved 0.53

» Merification Verification Werification 0.49

Once object editing is complete, and the object is ready for publishing, approving the object copies the current
object values into the Approved workspace.

Conditions to approve an object

o Objects must be approved from the Main workspace.
« An object cannot be approved if parent objects are not yet approved (approving must be done from the top
down in the hierarchy).

o A Reference or Link cannot be approved if the Target does not exist in the Approved Workspace, i.e., ifa
Product/ Classification is referenced with another Product / Asset / Classification, then the referenced
Product / Asset / Classification needs to be approved first before the actual Product / Classification is
approved.

« If Attributes or References / Links are Mandatory, objects cannot be approved if there are no values / targets.

« Externally Maintained Attributes or References / Links are not under revision control. Values / references will
automatically be reflected in the Approved Workspace and modifying the data will not affect object’s approval
status.

« The user must have sufficient Approve privileges.

« To easily check differences in the Main and Approved Workspaces, select Partial Approve, as discussed
below.

« When approving, the object's revision number changes automatically.

« An entire hierarchy can be approved using the Approve Recursively option. For more information, refer to
Approving Recursively below.

Partially Approving an Object

Itis possible to approve an object that has a Reference / Link to another object that does not exist in the
Approved Workspace. In this instance, the object will become 'partially approved,’ meaning that the object and all
data that can be approved will be approved. However, the Reference / Link will not be approved. If the Target for
the Reference / Link is later approved, the Source will need to be approved again for the Reference Link to be
updated in the Approved Workspace.
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Main

Approved

Classification only
in Main

3 Product without Link to
approved E- Classification

Productsought

Partial approvals can also be performed deliberately - both manually and programmatically. Specific Attributes,
References, Links, and the object Name can be selected for approval. The Attributes, References, Links and
Names are sometimes referred to as 'part objects.' These part objects cannot exist in the Approved Workspace
without the object to which they belong. Thus, when the first part object is approved, the object will need to be
present in the Approved Workspace.

Usage

Partial approval of selected elements of the object is particularly helpful in situations where certain elements of
the object need to be available for usage (in the Approved Workspace) before the rest of the object or its
elements can be approved.

For example, consider that there are two users who perform changes for a product and then approve the
product. If the product is completely approved, then it can be difficult to identify which user performed specific
changes. In this case, using the Partial Approve will allow the user to approve the changes performed only by
them and leave the rest of the changes to be approved by the other user who made those changes.

Approving partially

1. Inthe Tree, select the object to partially approve.

2. Inthe Maintain menu, click Approval > Partial Approve. Optionally, right-click the selected object and click
Partial Approve.

3. This will bring up the Partial Approve dialog box:
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[ Partial Approve >
Main Approved

(71 [All Elements]

=1-£7 Attributes

=71 Attributes for Web UI Screensho

- DI Hazmat Yes Details. ..

. Expand Al | | Collapse Al

Suppress Re-Translation

| Approve Selected | | Chedk | | Cancel |

4. The user has to select the required element / elements (for example, attributes) and click on ‘Approve
Selected’ button.

Note: The attribute groups displayed to a user in the Partial Approve dialog are controlled by privilege rules.
For more information, refer to the Privilege Rules topic in the Users and Groups section of the System
Setup documentation.When an attribute is linked to multiple attribute groups that a user has privileges to, the
attribute will display to the user in all of these attribute groups.

Partial Approve Compare View Dialog
The dialog shows which elements of the selected object have been changed since the last approval of the object.

Besides Name, Parent Object, and Default DTP Template, the type of elements listed are attributes, references,
and tables. For each element the values in Main and Approved Workspaces are listed.

For detailed information about the value for an element, click the Details...link. This displays a detailed view of
the element showing the values for the Main and Approved workspace:

[ Partial Approval Compare View - Hazmat X

Main Approved

Cancel

In the above example, the value for the attribute Brand Name has changed. Values only present in Main
workspace are marked with a green background color. Values only present in Approve workspace are marked
with a red background color.

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 121



|STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

Note: The detailed view differs slightly depending on the element type selected.

All elements are selected as default. To deselect all elements, click the checkbox next to the All Elements node.

You can select the element(s) to approve by clicking the check boxes next to each element. You can also select a
whole element group, i.e., Attributes by clicking the checkbox next to the element group.

To expand an element group click the + sign next to the element group. To collapse the element group, click the -
sign next to the element group. To expand all elements in the dialog, click the Expand All button. To collapse all
elements in the dialog, click the Collapse All button. To check if the selected elements can be successfully
approved, click the Check button. An Approve report will subsequently summarize the result of the check.

This functionality is also available in the Web Ul. For more information on this feature, refer to the Partial
Approval in Web Ul topic in the Web User Interfaces documentation.

Clicking the Approve Selected button will approve the selected elements of the object and the Approve status
of the object will change accordingly. Normal Privilege rules apply to Partial Approve. For more information,
refer to Action Sets.

Suppress Re-translation

Normally, an approval of a translated Product in a source language will cause the Translation status of the
Product to be set to Re-translation needed. In the Partial Approval dialog this behavior can be suppressed by
clicking the Suppress Re-translation checkbox. All existing translation relations with status 'Up to Date' will
remain in status 'Up to Date'. This is especially used in cases where only minor changes are approved and no re-
translation is needed. For more information, refer to the Translations documentation.

Note: To get a list of language variations of the object that potentially will be affected by the approval, place
the cursor on the Suppress Re-translation label.

Check Approve

If you are unsure whether or not you are allowed to completely approve an Object, you can run a Check
Approve.

1. Inthe Tree, click the Object to be approved.
The Editor shows the Object contents in Main and Approved Workspaces.

2. Inthe Maintain menu, click Approval > Check Approve, or right-click on the object, and then select Check
Approve option.

« If you only have changed attribute values for which you have the Approve privileges, a Complete
Approval Possible dialog box appears.
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[ 1 Complete Approval Possible >

The object can be be approved completely

without errors,

« Ifthe product cannot be approved due to multiple reasons, such as Mandatory values / References being
empty, then the report will provide details about the missing information, as shown below:

[ 1 Unable to approve product >
pprove p

Approve report for 18210 M B
Unable to approve object due to missing mandatory values on attribute(s):
Manufacturer Name

[ox |

Note: If you have changed attribute values for which you do not have the Approve privileges the Approval
options are unavailable.

For example, consider a Product that has multiple attributes linked and has mandatory values and references
which needs to be approved after the changes have been done. In this case, scrolling down or switching
between tabs to check if the values are entered is time consuming; Check Approve will help the user to know if
the product can be approved completely with a detailed report.

Approve Recursively

Approving recursively is done from the Main menu by clicking Approve Recursively. Similarly, the Approve
Recursively can be done by right-clicking on the object.

Approving Recursively is available when a Main Workspace is selected.
Approving Recursively is available for:

o Classifications

« Products

» Images & Documents

« Entities (setup to be workspace revisable)

The status of an Object in the various Workspaces can be viewed in the History tab in the Workspaces field of
the relevant Editor.
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Approving Objects recursively means searching for unapproved Objects linked to (or below) a selected hierarchy

node, and approving these Objects (copying them to the Approved Workspace).

This is useful and time saving e.g., when a lot of images have been imported and checked and should all be
approved.

To recursively approve in the 'Main' Workspace:

1.
2.

In the Tree, select the hierarchy containing the Objects to be approved.

In the Maintain menu, click Approval > Approve Recursively.

A dialog box appears, listing the Name of the selected hierarchy node, contained Objects and status of

analysis.

Skip Analysis button if this is not needed.

Note: Approve Recursively automatically performs a search for unapproved Objects. You can click the

D Approve Recursively

@ Finding Unapproved Objects (This might be time consuming)

Object ¥ |Classifications * |Products  » |Assets
18210 ME_EN W] 1 0

% Empty mandatory links fvalues in Main workspace

Validator » |Classifications * Products > |Assets
Missing mandatory values 10 2 n
Missing mandatory links 0 n n

£

Start Process with Description

Name | approve 18210 MB_EN |

Skip Analysis

Optionally, type a name for the process.
Click OK button to start the approve process.

A dialog box appears displaying information on the process.

Click Go to process button.

The Process view opens, showing details of the process and a report of approved Objects.

The hierarchy will now have Approved status indicating that it is copied in the Approved Workspace.
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When clicking Approve Object or Partial Approve, you might get different types of warnings, depending on

your Approve Privileges.

Approve Object Feedback

If you have modified attribute values for which you have Approve Privileges and at the same time have
modified attribute values for which you do not have Approve Privileges, an Unable to Approve the Entire

Object dialog appears.

[ Unable to approve product

TshirtQuantity
Attribute English
Short Ttem Description

Missing approve values privilege on attributes:

If you have modified attributes values and do not have Approve Privileges, then the option 'Approve’ is
disabled in the right-click menu. If you have modified attributes values for which you do not have Approve

Privileges, a Missing privileges dialog appears.

D Missing privileges

on this object

Pt

You do not have sufficent privileges to approve
any of the non-approved modifications performed

For more information about user privileges, refer to the User Actions and Error Descriptions topicin the

System Setup documentation.

Partial Approve Feedback

If you have modified attribute values for which you have Approve Privileges, and at the same time you have
modified attribute values for which you do not have Approve Privileges, a Partial Approve dialog box

appears.
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[] Partial Approve et
Main Approved

(=71 [All Elernents]

=121 Attributes

&+ (11 Category Specific Attributes

=1 Display

[=1-£51 Manual Sequencding Display

i.[|T short Item Description | T-shirt, short sleeve, Mens M, T-shirt, short sleeve, Mens M, Details. ..

Expand All Collapse all

[ ] Suppress Re-Translation

| Approve Selected |

Ched: Cancel

In the example above, the user will be able to approve all attribute values in Attribute Group Manual Sequence
and Category Specific Attributes. All attributes users do not have permissions for will not be displayed.

Approve Recursively feedback

1. InBG Processes, click Approve Recursively, open Active or Ended Processes, click the relevant

process.

2. Inthe Background Process tab, open Execution Report.

D Execution Repart

1 Recursive approval started on ‘235915% in context ‘English LS
= Approved 0 classifications; 1 products; 0 assets; 0 entities..
* Recursive approval of 1 objects done. 0 warnings and 0 errors.

If there are any errors, the report will provide details about the error. If the process or approval was
successful, then the report will show 0 errors and 0 warnings.

The following example shows a missing mandatory attribute value, which caused the object to not approve.
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%' Execution Report
1 Recursive approval started on "235915in context ‘English LS
= Approved 0 classifications; 1 products; 0 assets; 0 entities; 1 errors
= Approve error report for 235815-2

I+ Unable to approve object due to missing mandatory values on attribute(s ). step.fattribute?id=Target_Attribute
= Recursive approval of 1 objects done. 0 warnings and 1 errars.

H 4l 1-50f5 | [p [i Save... Truncate

Approve Recursively dialog

D Approve Recursively =

@ Finding Unapproved Objects (This might be time consuming)

Object Classifications Products  » |Assets
18210 M E_EN W] i W]

W
W

% Empty mandatory linksfvalues in Main workspace

Validator » [Classifications » |Products » |Assets
Missing mandatory values 1 2 0
Missing mandatory links 0 n 0

£ >

Start Process with Description

Mame | approve 18210 M B_EN

Skip Analysis Cancel

There are multiple options which are explained below:

« Finding Unapproved Objects: This will analyze the hierarchy and then provide the count of the number of
Products / Classifications / Assets / Entities which are currently in unapproved status.

o Empty Mandatory Links / values in Main Workspace: This provides the details about the number of
mandatory links / references that are missing for the Products / Classifications / Assets / Entities.

« Start Process with Description: This option is used to enter the name for the Process before starting the
background process. This option is not mandatory but is recommended as entering an identifiable name
can be useful for review purposes.

» Skip Analysis: This option can be used in cases where the number of child products is large. The analysis
of the number of unapproved or missing mandatory values / References can be time consuming but will
provide the detailed report. By clicking this option, the analysis will stop and the user can proceed with the
approving recursively.
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For example, consider there are hundreds of products in a particular parent hierarchy. Selecting each
product, one at a time, and then approving them would be time intensive. In these cases, approving
recursively will help a user to approve all the products at one time.

Context Dependent Approvals

When an object is approved, that approval always happens in a specific context and will only be applicable to
data visible in that context.

Toillustrate this concept, refer to the figure below in which object 'P' has values for two different attributes,
Color and Width, in the Main workspace. While Width is not dimension dependent, Color is, and has
different values in two contexts: 'Blue' in the English context and 'Bleu’ in the French context. If the object is
approved in the English context, only the data visible in the English context will be reflected in the Approved
Workspace. Because of this separated approval, the object must also be approved in the French context to
have it become completely approved, indicated by a green checkmark in the approval status field. Until this
approval across contexts is done, the object in the English context will have the status 'Approved in Current
Context on [date + time]', indicated by a yellow checkmark, and the object in the French context will have the
status of 'Last Approved on [date + time]' (red X).

Main Approved

Width: 20 cm Width: 20 cm
Color [EN}: Blue Color (EN): Blue
Color (FR): Bleu Color (FR):

If Color is set as a mandatory attribute in the French context but is left empty, then an empty mandatory
attribute warning will display when attempting to approve the object in the French context.

[ Unable te approve product x

Approve report for (245034)
Unable to approve object due to missing mandatory values on attribute(s):

(ColorAtty)

=
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All mandatory attributes will be checked upon approval to ensure none are empty in the context in which the
object is being approved. For example, in the first of the images shown below, the value added for the
mandatory attribute 'Color' in the English context is 'Red'. The object can be approved in this context without
any issue. Note, however, that the approval icon is for the current context only (English), hence the partial

approval notation.

| I Context |English US

v g € — (' urL |tor=Productaversionid=2062398contexti

v I3 Fashion Board 6 m Data Containers | Sub Products || References [_
= - [l GDSN Products ® Description
— [l Packaging

b= [+ Product Overrides Mame >| > |value

1] :

o El|j Products * ID 245934
— (-0 Footwear > MName Thermal Valve

& +-[T Safe

& - Safety > Object Type Ttem

L -5 Apparel

EI El [ Hardware > Pevision 0.20 Last edited by USER4 on Fr
= ' E} rj Tools * \Approved «# Approved in Current Contex
T """ E Thermal Valve » Path Frimary Product Hierarchy/Produ
i EThermaI Valve_2 bed

A - 17| Task Lighting > Color C

= H

When the viewing mode is switched from Normal to Context, the empty mandatory attribute alert is shown in

the French context.

- F € (C LAL | MuitFroductfversionid= 206239 6contextid sContext 1id = 2455 348markspaced =+ain | ][] (3

Thermal Valve rev.0.20 - Compare Contexts

& Fashion Board A | References || Referenced By
= [ GDS Procucts

— w [ Packaging View: Showal =

£ !

g 5 %::ﬂ cts - » [Enghsh US > [French France 3]
L &8 Foot |* .ID 245934 :245‘334

£ - Safety » Mame Thermal Valve

E &) Apparel * Dbject Type  Item Item

E‘ T 'ﬂE'{ﬂs * Fomvissan 10, 20 Lask adited by USER4 on Fri Mo 16 09:56:52 EST 2018 0. 20 Last edited by USERS on Fri Mow 16 (f9:56:52 EST 2018
~ . E' * Fath [Primary Product Hierardhy ProductsHardware ToolsThermal Valhve Primary Product Hierandhy Products Handwane Tooks [{245934)
g 1= Thermal vaive _2 s sty o S naans e 2

s [+ {15 Task Lighting ::- ]::d.u F'-Qd ] m |

When changes are made to

both contexts and approved on both contexts, the object is fully approved,

garnering a green checkmark in both contexts.
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* [English US * [French FR »
> D 1245934 1245934
> Mame Thermal Valve
* Object Type Item Ttem
* Revision 0.24 Last edited by USERE on Tue Mov 20 15:39:31EST 2018 0.24 Last edited by USERE on Tue Mov 20 15:39:31EST 2018
> Baif rimary Product Hierarchv/Products Hardware ools/Thermal Valve Primary Product Hierarchv/ProductsMardware Tools/(245934)
> \Approved +" Approved on Tue Nov 20 15:39:31 EST 2018 « Approved on Tue Mov 20 15:3%:31 EST 2018
a1 s g=i=]

If a change is made in one context, e.g., changing the Color attribute value in the French context to '‘Blue," but
leaving the value for the Color attribute in the English context as 'Red,' then the object will regain full approval
once the object is approved in the French context.
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Approved Symbols and Messages

An object can contain both workspace revisable data and globally revisable data. The Approved symbols and
messages indicate the status of the workspace revisable data on a product, classification, image, or document.
The status can be viewed in the Approved field on these objects.

For details on the approval process, refer to the Approving an Object topic.

For more information on revisability, refer to the Revisions topic in the System Setup guide.

Approved Status Symbols

Approved Status Description

Symbols

X Unapproved | Anobjectis unapproved if it has never been approved or if revised data on the
product, classification, or images & documents in the current context is not
approved.
For example:

« An object has never been approved.

« Revised data has been changed in current context without being
approved. Revised data includes attribute values, references, object
names, or tables.

Examples of changes to revised data include:

« A change in object name.

« A changed value on an internally maintained attribute.
« Ifan attribute has been linked to a product.

« Ifreference links to objects have been made.

Note: When linking a product to classification and in case the classification
object type owns the product links, then the product does not get the
Unapproved symbol. For more information, refer to the Object Types and
Structures topicin the System Setup guide.

v Approved Revised data on product, classification, or images & documents is approved in
all contexts.

Note: No data in any context needs to be approved.
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Approved Status Description
Symbols
4 Partially Revised data has been approved in current context but a reference, object
approved name, or value needs to be approved for the object to be approved in all
contexts.

If you view another context, then you typically notice that:

« A dimension dependent reference is not approved.
« A dimension dependent value is not approved.
« A dimension dependent object name is not approved.

When all the dimension dependent references, attribute values, and object
names have been approved, the symbol changes from yellow Partial Approved
symbol to a green Approved symbol.

Approved Status Messages

Messages are displayed for workspace revisable data as follows:

Unapproved

When an object is newly created and never been approved as shown below:

Name *| » |Value >
* 1D 1235915
* MName 1235915-2
» Object Type Active Products
» Revision 0.1 Last edited by USERE on Thu Oct 12 12:04:10 EDT 2017
» \pproved x Mever Been Approved

When an object attribute / reference is modified, the status will show as 'Last Approved on' along with the date
and time as shown below:

Name *| » |Value >
* 1D 1233915
¥ MName 1235915-2
» Object Type Active Products
» Revision 0.3 Last edited by USERE on Thu Oct 12 12:09:07 EOT 2017
» \pproved x Last Approved on Thu Oct 12 12:09:03 ECT 2017
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Note: The 'Last Approved' message also displays if using the 'Partial Approve' option on an object. If
'Approved in Current Context' is displayed, then an object is also partially approved but a different message
displays (as described at the end of this topic).

Approved
When an object is approved in all contexts the status displays as shown below:
Mame ¥ * [Value >
» 1D 235915
> Name 235915-2
» Object Type Ttem
» Rewvision 0.31 Last edited by USER:4 on Mon Jan 07 17:56:10 EST 2019
* |Approved ( Approved on Mon Jan 07 17:56: 10 EST 2019

Partially approved

When an object is approved in only some contexts the status displays as shown below:

MName »| > |Value -]
* ID 1235915
* MName 1235915-2
» Object Type Active Products
* Revision 0.5 Last edited by USERE on Thu Oct 12 12:13:20 EOT 2017
» |Approved qf Approved in Current Context on Thu Oct 12 12:15:13 EDT 2017
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Creating Objects in the Tree Tab

Regardless of the particular object type or hierarchy that you are working with, the general principles of creating
objects in the workbench are the same, and are described below. Tree icons are set during object type creation
according to preference and may be different in your system.

Note: All actions are controlled via privileges. Some users may not have access to create or delete objects,
or may only have options to edit specific object types, hierarchies, or attribute values. The information below
focuses strictly on the means for carrying out the various actions, and assumes that all required privileges are
available to do so. More information on privileges is available in the Privilege Rules topic in the System
Setup documentation.

Objects can be manually created in the Tree via right-clicking or using the Maintain menu.

Create a new object via right-click

. Select a parent under which the new object should be created. Note that if the new object should be created
as a root node on the Tree tab, the Maintain menu must be used (refer below).

2. Right-click on the parent and select the appropriate 'New..." option. The options will vary based on the
selected parent. For example, note the differences between the available options on a classification and an
entity, as shown below.

lassi E‘i Entity Root A

-] Asse™ -1
B[ Con{ (3 New Classification % Customer
B[ ETL New Asset Ctrl+ Shift+ A “ g Key Accounts New Entity Node

E Ir|r.‘.| g4 Mew Product

. Selecting the right-click option will open a Create dialog, appropriate for the selected object super type (e.g.,
Create Assets for assets and Create Entity for entities). The options available in the dialog are based on the
data model defined in System Setup. For example, the Object Type selection will vary based on the allowable
object types under the selected parent, and ID will only be available for population if the object type being
created does not have autogenerated IDs applied.
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[] Create Asset > [] Create Entity >
Object Type Object Type
@ Assets & | ® Customer
() Auto Classification Rule Set
ID CUS_11488€
() Bulk Update Configuration W B
Marme
D
Create Cancel
Mame
Create Cancel

Note: The following restrictions apply to the ID for all objects:

o Maximum 40 characters.

« Only the standard ASCII printable characters in the range of 32-126 are allowed.

4. When an object type has been selected and an ID applied, the Create button will be enabled. Clicking Create
completes the creation of the new object, which is then accessible in the Tree. If a Name is not supplied, the
object will display in the Tree by the ID in parentheses. If a Name is supplied upon creation, the object will
display in the Tree using the Name entry. For example, two new objects have been added under Customer C
in the screenshot below. The first did not have a Name supplied, while the second did.

=-{jiil Entity Root
E}% Customer Hierarchy
: 8 Customer A
8 Customer B
=8
-4} (ADD_114888)

Henry Magnus

Create a new object via the Maintain menu

From the menu in the upper left corner of the workbench, select Maintain > Insert and choose the appropriate
option. Note that it is required to use this method when adding a new root node to Tree. Additionally, note that
the available options differ based on the active selection when the menu is accessed. For example, the below
shows the available insert options when a classification has been selected, whereas the publication-related
options would be enabled if a publication object had been selected instead.
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File Edit View Mavigate Format  Maintain Window Help

D Context |English US

r_=| Configurations

1‘_‘=| ETIM Hierarchy

r_=| Index Words

r_=| Merchandising Hierarchy
r_=| Suppliers

[#-[ 7] Web Sites

- il Entity Root

&[0 GDSM

ﬁ Publications

r_=| Primary Product Hierarch
[+~ Collections

Iﬁ eCatalogs

'ﬁ Recyde Bin

[ STEP Workflow " Bookmarks " System Setup " BG Processes ” Search l

& i

S

DB <

Insert

Link

Merge

Delete
Force Delete & Purge
Unlink Object Type

Duplicate Ctrl+)

Duplicate Recursively

Malke Revision

3 b D E=A-A-5:3 § A A Q¥

Approval

Enable group for workflows

Revive

Revive Recursively

Truncate log...

¥
¥
&

T

Product Ctrl+5Shift+P
Classification Ctri+5Shift+C
Classification Root Ctrl+5hift+R
Mew Entity Mode

Entity Root

Mew Publication...

Mew Publication Group

Mew Publication Section...

Mew Page Template ...

Orphan Attribute Ctrl+Shift+ 0
Asset Ctrl+5hift+A
Attribute Ctrl+5Shift+T
Attribute Group Ctrl+Shift+I
List of Values Ctrl+5Shift+L
Dirnension Ctrl+Shift+D
Dimensicn Point Ctrl+5Shift+M
Workspace Ctrl+Shift+W
Action Set Ctrl+5hift+5
Mew Image Conversion Configuration...

Create Transformation Lookup Table

Mew Event Queue

Mew AssetPush Event Queue

Mew AssetPush Configuration

STEP Workflow Ctrl+5Shift+R
Background Process to Monitor Deadlines  Ctrl+5Shift+D
User

Group Ctrl+Shift+G
Mew Supplier

Create Package

Create STEP Workflow Ctrl+5Shift+R

Mew Business Condition
Mew Business Action
Mew Business Library

Setup Group Root...

Many of the available options will only be enabled when an appropriate selection has been made on the System
Setup tab. For example, an attribute group must be selected for the Attribute or Attribute Group options to be

enabled.
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Deleting Objects in the Tree Tab

Regardless of the object type or hierarchy that you are working with, the general principles of deleting objects in

the workbench are the same, and are described below.

Note: All actions are controlled via privileges. Some users may not have access to create or delete objects,
or may only have options to edit specific object types, hierarchies, or attribute values. The information below
focuses strictly on carrying out the various actions, and assumes that all required privileges are granted. More
information on privileges is available in the Privilege Rules topic in the System Setup documentation.

Objects can be deleted from the Tree by right-clicking on the object to be deleted, or via the Maintain menu when
the object to be deleted has been selected. In both cases, the Delete option is selected from the menu. Deletion
of multiple objects is supported using Ctrl or Command to multiselect.

(7] Convert to Product-Override

=[] Products Unlink product

i=-{I3) Appar
= U
B
E
& Paste Link

Cut

Copy

Paste

ICESSES ” Search ]

Delete

Maintain Window Help

A
Ctrl+ X =] ’
Ctrl+C LEL: ’
Ctrl+V L3 ’
Ctrl+L Ir . Delete

Selecting Delete opens a deletion confirmation window, which will vary slightly based on the object selected for
deletion. For example, a classification provides an option to unlink child products rather than delete them, while
deletion of a product automatically deletes all child objects.

[T Delete X

Are you sure, you want to delete this object and its sub-objects?

Mame » Assete > Sub-Product Count  » Classifications  *

> Assets D = AssefsRoot B9 0 71

rSub Products

{®) Unlink

() Delete

[ Delete *

Are you sure, you want to delete this object and its sub-objects?

W

Sub-Product Count
0

Delete Cancel

Delete Cancel
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Clicking Delete attempts to delete the selected object (and delete or unlink child objects as appropriate). A
confirmation window displays success or failure.

Note: To delete an object, a number of conditions must be met. For example, the object must not be
referenced by any other object and must not be active in any workflow. If the deletion conditions are not met,
the confirmation window displays the errors to be corrected prior to deletion of the object.

[ ] Delete report *

Deleted 0 out of 1 objects. 1 object(s) could not be deleted due to the objections stated below,

Mame »
ﬁ 12-GGK799 ID = 100705

-Delete Ohjections

"12-GGK7I9™ could not be deleted due to the reasons listed below:

step://product?id=18210 has a cross reference to the object being deleted step: /fproduct?id=100703. The
link is visible in these workspaces Approved, Main,

step:/fproduct?id=18212 has a cross reference to the object being deleted step: /fproduct?id=100703. The
lirk: is wisible in workspace Main.

-Warning! If you use force delete, the below actions will be taken.

Cross references to objects being deleted will be removed. These cross references will not be reconstructed, if the objects
are revived.

Force Delete Close

In some cases, a 'Force Delete' option is available, though it is recommended to correct the data whenever
possible rather than forcing deletion.

Note: Approval may be required for the delete to take effect. For example, if an object has been referenced
by another object and that reference has been approved, removing the reference must also be approved (by
approving the change on the referencing object) to resolve the deletion objection.

Deleted objects are moved to the Recycle Bin for the Tree, where it can be revived if needed. To fully delete the
object, the deletion must be approved and the object must be purged. Following a purge, the object cannot be
revived.
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For more information on the Tree recycle bin and the available actions, refer to the Recycle Bin for the

Tree Tab topic.

Important: Alternatively, an object can be deleted and purged in a single step using the 'Force Delete &
Purge' option in the Maintain menu. Choosing this option bypasses the Recycle Bin and is equivalent to
completing a deletion and purge all in one action. Do not use this option if deletion events are required for
output to downstream systems since this option does NOT generate a DELETEAPPROVAL event.
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Editing Objects in the Tree Tab

Objects can be easily edited within the Tree tab, and general principles for editing are the same, regardless of the
type of object. The available tabs will vary based on the object type selected, as well as other considerations such
as data model and licenses. Some tabs are common across the various object super types, while others appear
only on specific object types or subsets of object types. Additionally, some editors appear on more than one
super type, but have differing functionality based on the type of object that has been selected.
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This topic covers the editing functionality available across the various editors, and provides links to additional
information for working with specific object types.

Note: All actions are controlled via privileges. Some users may not have access to create or delete objects,
or may only have options to edit specific object types, hierarchies, or attribute values. The information below
focuses strictly on the means for carrying out the various actions, and assumes that all required privileges are
available to do so. More information on privileges is available in the Privilege Rules topic in the System
Setup documentation.

When an object is selected, the main portion of the screen displays a corresponding editor. The main editor for
the object is the first tab, which is Classification in the below example.

Tree
Sub Products || References || Referenced By || Images & Documents || Tables || Status || State Log || Tasks
3 Description

El-{7] Assets

5
-] Hlustrations
-] Installation Manuals
[T Logos
~[T] MSDS Sheets
-] Owners Manuals
-] Product Images
[ Videos
[#-{—] Configurations
-] Index Words
[ Publications
[=)-{I=] Primary Product Hierarchy
>E Products

----- 7 Discontinued Products

Mame

>

>

Value

D

IconRoot

Mame

Icons

» Dbject Type Icons

* Revision 0.1 Last edited by Stibo Systems on Fri Jan 02 00:00:00 EST 1970
* Wpproved " Approved on Fri Jan 02 00:00:00 EST 1970

> [Translation Mot Translated

» Path Classification 1 rootfAssetslcons

> Wisibility

> Purpose abe Storage for icons

All objects will have an ID, Name, Object Type, Revision, and Path field. Objects that are subject to approval
(known as 'workspace revisable') will also have an Approved field.

« ID cannot be changed once an object has been created, so the field appears yellow, meaning it is not
editable. For details, refer to the Creating Objects in the Tree Tab in this documentation.

« Revision and Approved data is auto-populated by the system, so these fields are also not editable.
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« Conversely, object Name and Object Type can be edited (assuming the user has privileges to do so), so
those fields appear white.

Note: Any number of attributes may be added to objects under the Description flipper. However, not all data
shown in the Description section is an editable attribute. Fields such as ID, Revision, Approved, Translation,
and Path are aspects of the object (not attributes), and are not editable. Name and Object Type are also
aspects of the object, though these may be edited.

Some object types only support Description attributes, meaning all object data is accessed under the
Description flipper. For object types that support Specification attributes, data is organized by attribute group,
and clicking the magnification icon (indicated by a 1 in the screenshot below) will collapse or expand each group,
allowing users to focus on the relevant data. All attributes have a validation base type applied that determines the
allowable data that can be entered, and is indicated by the icon to the right of the attribute name below (2).
Detailed information on attribute validations is available in the Validation Rules topicin the System Setup
guide.

To edit data, click in any editable field. Text attributes can be edited by typing directly into the field, while LOV
attributes will provide a dropdown from which users can select a value, as shown below (3).

Tree
Elj Products ""* m Sub Products | References || Referenced By || Images & Documents
5. |
Bl 1j Appare . S
EH[IT] Upper Body Wear '
B- [ T-shirts ¥ Manufacturer Information
EI- T-shirts Ttems Mame *|  Value
- 12-GekTes » Manufacturer's Part Number |abe 090828842
il Cotton T-shirts » Manufacturer Name abe Hats-R-s
- {8 New Shirt » (Country of Origin ANTIGLIA AND BARBUDA
: &+l Polo T-shirt * Product Name |ah¢
[#-[[5) T-Shirts Sales Items & Category Spedfic Attributes
i E}'l;—:l ::ad Viear Mame alue
+- ootwear
Eﬂ--g Safety » Material abe: Cotton/Paolyester
-{I7) Hardware . E?Ior ol IEhﬂ
) * Primary Color abe
[-{T7] Displays - :
-] Furniture * [T-shirt Size
-7 Automotive ?
[-{I7] Building Products Ng-
[H-[IT] Electrical & Electronics » latl
[#-{I7] Food and Beverage » a4
M= Wbk hd —*L
dy K5
WXL
‘ | UKL
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Pressing the tab key shifts the focus to the next cell and Shift+Tab shifts the focus to the previous cell. Alt + F2
opens the Rich Text Editor, allowing the user to access styling options. For a complete list of shortcuts, refer to
the STEP Workbench Keyboard Shortcuts topic within this guide. The data fields available for editing will
depend entirely on the data model and will vary for each implementation.

Note: Data edited in the workbench is auto-saved, with the change / save being applied as soon as the user
exits any field. Therefore, no explicit save action is ever required by the user.

If an object is being edited that is workspace revisable (e.g., subject to approval), editing the object will change
the approval status (if the object had been previously approved). Refer to the Approval of Objects topic within
this guide for more information on approvals.

Multi-Editors

Objects can be multi-selected for editing using Ctrl + click, or by Shift + Down / Up arrow keys. Additionally,
objects of the products and classification super types have a Sub Products tab that can be used for multi-editing.
Functionality for editing objects is comparable, regardless of how the multi-editor interface is accessed.

Right-clicking in any row header will expose the Rotate Table option which can be used to access the preferred
orientation of the data (Pressing F11 will also rotate the table if any cell in the table is the active selection.).
Editing in this manner allows for easy copy / paste of values between objects using Ctrl + C and Ctrl + V.

< Products

¢ Key Accounts ~ m References || Referenced By
B [0) GDSM
[ Publications View: Show all ~
[=I-[IT] Primary Product Hierarchy .
E‘lj Products MName > |12-GGK739 » Mew Shirt >
|_-_||-'_=| Apparel Narme 5 Nama 12-GGK799 MNew Shirt
E}"E‘ %p_e};i"g Wear Object Type iz Item Item
- ir
= il T-chirts Items Revision show All Rows 0.13 Last edited by USER7 on W... 0.1 Last edited by USERE on Tue ...
[ ﬁ 12-GGKT99 Path Rotate Table Primary Product Hierarchy Produ. .. Primary Product Hierarchy Produ. ..
Approved » Approved | Rotates the current table red on Fri Oct 28 ... x Never Been Approved
[ i Polo Tshirt Translation » Translation Mot Translated Mot Translated
r_=| T-Shirts Sales Item Cefault InDesign template > Default InDesign template
B-[7] Head Wear Default Quark template > Default Quark template
{17 Footwear PC > PC
E-[IT] Safety EAN > EAN
(-] Hardware GTIN > GTIN
#-{I7] Displays « | |[Provider GLN > Provider GLN
I D > Completeness Score » Completeness Score

Right-clicking in any data cell will expose the Hide Equal and Mark Different options, which are especially
useful when working across multiple objects as they will hide all equal values, or highlight all different values,
respectively.
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Mame * |Object Type * R
- Al - w |- all - |-
Mame Chject Type Fe
13217054 Sales Item 0.
18207012 Sales Item o,
18214-012 l
a8 Cut Ctrl+X [
18215012 !
Copy Ctrl+C |-
18217012 = !
[B Paste Ctrl+V |
& Paste Link Ctrl+L

Rotate Table
Hide Equal
Mark Different

Additional options for viewing data are available using the View menu located in the upper left corner of the multi-
editors.

Product || Product Variants | (1145
*
>
>

View: Show all

Product views *

Mew View

I Edit view -]

Remove view *

The default view option is to Show all which displays all data on the object, similar to what would be available in
a single-object editor. Additional options can be configured using the New View option. Clicking this opens a
dialog for users to enter a name of the view. Clicking OK in that dialog opens an Edit Filter dialog where the user
can select the attributes to be included in the view.
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[ Edit Filter b
{Legal Atiributes 1|| (®) Show only () Do not show
e "~ Add e "~
Name Name
W Tm Remuue W Tm
Revision Revision
Fath Add Al Fath
Aooroved Agproved
Transiafion Remaoveall Transiafion
InDesign Template InDesign Template
Annual Sales Forecast, Maximum Annual Sales Forecast, Maximum
Annual Sales Forecast, Minimum Annual Sales Forecast, Minimum
Category Category
Colar Colar
Completeness Score Completeness Score
Description, Long Description, Long
Description, Web Description, Web
= oW Call=d 4 v = oW Call=d 4 v
Update table setting
Save Cancel

The dialog defaults to having only "legal” attributes shown, meaning those attributes that are valid for the object,
as well as standard aspects of the object such as ID and Name. Note that object aspects are italicized, while
attributes (which are always specification attributes) are shown in standard text. By default, all available
attributes and aspects are shown in both the left and right panels. The dropdown in the upper left corner also has
options to expose standard attribute search / browse functionality, though typically the Legal Attributes selection
is used as this prevents a user from defining an invalid view. The 'Show only' and 'Do not show' radio buttons are
applicable to the right panel, where the data for the view is defined. The Add button is used when an attribute or
aspect has been selected in the left panel and should be added to the view (the right panel). The Remove button
is used when an attribute or aspect has been selected in the right panel that should be removed the view. The
Add All and Remove All buttons are used to add or remove all attributes and aspects from the view. Clicking
Save stores the new view.

Once one or more views have been created, they are available for selection from the View menu under Product
views.

View: Show all

Productviews 3 ¥ Streamlined View
Mew View Show all

Edit view H » Mame
Remove view ¥ » Dhbijec
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An existing view can be edited using the Edit view option, and a view that is no longer needed can be removed
with the Remove view option.

Note: Views are user-specific and machine-specific, so a view created by one user will always be available
for that user when using the machine on which they created the view, but will not be available for any other
user or for the same user working from a different machine. Workbench views are stored in an XML file on
the user's local machine at C:\Users\[user\STEPUserViews[UserID].xml. If the file is deleted, the configured
views will no longer be available.

Right-Click Editing Options

Additional editing options are available by right-clicking within the various editors. These include standard cut/
copy / paste options, as well as more exotic options which are briefly described below.

Note: Not all options are available and/or enabled at all times. Some options are available only for particular
attribute validation types, and others are available only on specific editors and/or object types. Menus also
change based on whether the right-click takes place on the column or row header, or within the active
editable value field, as well as when a single object / column / row has been selected vs. when multiples are
selected.

« Character Tag: Used as a quick option to add tags to attribute values without having to enter the Rich Text
Editor. Character tags that have been defined for the system will be available as sub-options to the Character
Tag selection. For more information, refer to the Tags topic in the System Setup.

« Edit: Used to open the Rich Text Editor for attribute values, allowing users to apply styles, formatting, spell
check, special characters, etc.

« Filter: Used tofilter the displayed data under any flipper, by values, and is exposed by clicking the column
header. This can be especially useful when working with attribute groups with a large number of attributes in
them as it allows users to filter based on empty / populated, greater than / less than, etc.

« Footnote (Insert / Edit): Used to add an additional piece of information (e.g., a footnote) to an attribute
value. Footnotes are added / edited within the Rich Text Editor so using these options will open that dialog.
Note that footnotes are only supported for use in conjunction with STEP tables. Using footnotes within
attribute values that will output in something other than a table will not yield the expected results. For more
information on footnotes, refer to the Tags topic in the System Setup.

« Hide: Used to hide a particular row or column from view, and a hidden row or column is exposed by clicking
on the row indicator or column header.

o Hyperlink (Insert / Edit, Follow, End): Used for adding hyperlinks to attribute values. Highlight text within
the attribute value and select the insert option to provide a hyperlink to be assigned to the selected text. After
inserting, and with the cursor at the end of the hyperlinked text, use the end option. This ends the hyperlink so
that subsequent text does not become part of it. Use the edit option to edit a previously inserted hyperlink.
Select the follow option while the cursor is within the hyperlinked text to follow the hyperlink. For more
information, refer to the Tags topic in the System Setup.

« Inline Reference (Insert / Edit, Copy as): Used to add inline references to attribute values. Inline
references are used to re-use values present within another attribute, object Name, or ID. This avoids
duplication of data by maintaining the data only once, and re-using it from that source as needed. For
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example, a description attribute may need to dynamically include the object Name, e.g., '[Name] is a great
product!'. Detailed information on working with inline references is available in the Inline References in
Attribute Values topic within this guide.

Insert Special Character: Used as a quick option to add special characters to attribute values without
having to enter the Rich Text Editor. Opens an editor allowing for selection of the most recently used special
characters, with an option to access a full Unicode character menu. For more information, refer to the Tags
topicin the System Setup.

Override: Used to manually populate a local value to override a calculated (derived) value. This option is only
enabled on calculated attributes. For more information, refer to the Calculated Attributes topic in the
System Setup.

Recalculate: Used for on-demand display of calculated attribute values in the editor if they have previously
been disabled via the 'Disable calculated values' option in the View menu. For more information, refer to the
Calculated Attributes topic in the System Setup.

Rotate Table: Used to rotate the data display. As a right-click option, it is only enabled from row / column
headers when multiple objects are selected. For a single object, it can be used to rotate the data under a
flipper only via keyboard shortcut (Alt + F11).

Show All (Rows / Columns): Enabled after the Hide action has been taken, and exposes all hidden rows /
columns.

Sort: Used to sort data based on attribute value rather than attribute name or display sequence. This option
is exposed when a column header is selected, and requires a sort selection (Ascending, Descending, or
None).

Style: Used as a quick option to add styling to attribute values (e.g., bold or italics) without having to enter the
Rich Text Editor. Styles that have been defined for the system will be available as sub-options to the Style
selection. For more information, refer to the Tags topic in the System Setup.

Additional Information

In addition to the main editors for objects, several other tabs / editors are available for editing objects, such as
References, Referenced By, etc. However, the available editors and functions within them vary based on the
selected object. Therefore, they are described in the context of the type of object being edited, in the subsequent
sections of this guide:

Assets

Classifications

Collections

Entities

Products

Recycle Bin for the Tree Tab

Publications: The publication hierarchy and its associated objects are detailed in the Publication Hierarchy
section of the Publisher (Adobe InDesign Integration) documentation.
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Inline References in Attribute Values

Inline references can be embedded in attribute values for attributes that have Text, Text (exclude tags),
Numeric Text, and Numeric Text (exclude tags) validation base types. An inline reference use case follows:

You are working with product objects whose model number is the same as their STEP ID (for example,
'12345'). On these objects there is an attribute called 'Product Description' that needs to dynamically
reference the object's model number within the text of the attribute. For a Product Description such as 'Acme
lawn mower, model number 12345, the inline reference to the STEP ID would populate '12345." Using an
inline reference in this instance helps to avoid duplication of effort—since the product's model number
already exists in STEP asiits ID, there is no need for users to manually enter it a second time into the system.

Also, in many cases inline references are easier to use than calculated attributes and easier on system
resources. For example, it may be easier for users to use an inline reference to pullina STEP ID than to create a
calculated attribute using the formula 'StepID()'".

One attribute value can include several inline references. An inline reference can reference either a single
attribute or an attribute group.

Inserting an Inline Reference using Workbench

1.
2.

Select the relevant node. The corresponding editor appears.
Click on the leftmost tab within the editor, which is different depending on the object type (for example,
'Product’, 'Classification’, 'Images & Documents', 'Publication,’ and so forth).

Activate the Value field of the relevant attribute where you want to create or edit the inline reference. Or,
highlight the field, right-click, and select Edit to launch the larger value editor.

Note: Pressing Alt + F2 will also open the value editor.

Place the cursor at the position in the Value field where you want to insert the inline reference, or place the
cursor on an existing inline reference to be edited.

Right-click, and then click Insert Inline Reference to add a new inline reference or Edit Inline Reference
to edit an existing inline reference.
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Spelling

Tables || Category Profile || Proof Vie 5 Undo change value of 'Bas
Product [ Sub Products “ (¥ Redo change value of 'Cou
Mame *| » |Value
* Manufacturer's Part Mumber |abe % Cut
* Manufacturer Name b Copy
* Country of Origin B paste
* Product Mame |ah; Cosmic Party Hat .
[ Paste and Match Style
== Category Spedfic Attributes
= Attribute Group Style
@ Display Character Tag
ame >| > |Value W Insert Special Character
» Basic Manufacturer Information ahbe:
* Long Item Description abe. Suiﬁm Insert Inline Reference
: b . .
» Manufacturer's Part Mumber A Edit Inline Reference
* Country of Origin

6. The Inline Reference dialog displays.

Inline Reference

Object Selection
Object
(®) Resolve To Object ID

() Resolve To Object Name

Attribute Selection
Attribute

Attribute Mame(s)
Indude

Separator | =
Attribute Value(s)
Aspect

Attribute Separator

() Resolve To Attribute Value and/or Unit

Values(s) and Unit(s)

Cancel
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To return a value or values from another object in STEP, not the name or ID of the current object, click the
ellipsis button (...)) to the right of the Object field. Ignore this field if you plan to return value(s) from the

current object instead.

« Click the ellipsis button (|...)) to display the 'Select Object' dialog, search for or browse to the object that
holds the value(s) that you would like to return, then click Select to choose the object.

Select Resolve To Object ID to return the value of the STEP ID of the chosen or current object.

Select Resolve To Object Name to return the value of the STEP Name of the chosen or current object.

. Select Resolve to Attribute Value and/or Unit to activate the options in the 'Attribute Selection' portion of

the Inline Reference dialog.

Click the ellipsis button (|...|) to the right of the Attribute field to open the 'Select Attribute or Attribute Group'
dialog.

Search for or browse to the relevant attribute or attribute group for the inline reference, and then click Select.
For Attribute Name(s), check the Include box if the name of the attribute(s) should be included in the inline
reference.

In the Separator field, type a separator to be used between the name and value of the attribute. The default
is the equals sign (=). Note that the Separator field is not activated unless the Include box has been checked.

For example, if a single attribute is chosen, and the Include box is checked, the results will look as follows:

Inline Reference >

Ohbject Selection
Object

i) Resolve To Object ID
() Resolve To Object Mame

(®) Resolve To Attribute Value and/or Unit

Attribute Selection
Attribute | Manufacturer Mame ¥ !

. Mame > » Value
Attribute Mame(s)
» Basic Manufacturer Information  |abe Manufacturer Name=Acme Party Supplies
Include —_—

Separator | =

Attribute Value(s)
Aspect Values(s) and Unit(s) -
Attribute Separator

K Cancel
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15. Under Attribute Value(s), select the relevant Aspect from the dropdown list. Available options are 'Value

(s) and Unit(s)," 'Unit(s),' and 'Value(s).'
In the Attribute Separator field—which is only valid when an attribute group has been chosen for the

Attribute selection—type in one or more characters to specify how the attribute values should be separated.
The default is the semicolon character without a following space (;).

The following screenshot shows:

« (1) An attribute group called 'Manufacturer Information' selected for Attribute
« (2) A separator of = placed between the attribute name and attribute value

« (3) An attribute separator of ; placed between each attribute within the group
» (4) How the attributes and attribute values resolve in the inline reference.

Inline Reference

Object Selection
Object

() Resolve To Object ID

() Resolve To Object Name

(®) Resolve To Attribute Value andjor Unit
Attribute Selection

Attribute | Manufacturer Information
Attribute Name(s)

Indude
Separator

Attribute Value(s)
Values(s) and Unit(s) -

e

Ok

Aspect
Attribute Separator

et

Cancel

N
*o

Manufacturer Information

Name >

Value

Manufacturer's Part Number

121177

Manufacturer Name

Acme Party Supplies

W W | W W

Country of Origin

HOMNG KONG

Product Mame

Cosmic Party Hat

?

Display

\

MName

43

Value v ¥

W

Basic Manufacturer Informati

Country of Origin=HONG KONG;Manufacturer Name=Acme Party
Supplies;Manufacturers Part Mumber=121177;Product Name=Cosmic Party Hat

17. Click OK to complete the configuration of the inline reference.

Inline References and Multi-Valued Attributes

The Attribute Separator field in the Inline Reference dialog does not apply to the values of multi-valued
attributes. Instead, the separator for values of multi-valued attributes is handled by the <multisep/> tag
(multisep). The multisep tag is a Character Tag in System Setup and comes standard with STEP systems.
STEP stores the values of multi-valued attributes with the multisep tag between them, and this tag typically

renders as a forward slash (/).
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multisep/ - Character Tag

= Qs -

% Style Tags @ Character Tag Definition

% Special Characters Name » |value

=+(g) Character Tags > Name multisep
----- [¢3] BeforeLastDigitinMumerator > Edited By
----- [¢7] EndFraction > Chararter Tan yltisep
----- [s3] FractionBar » Rendering y
""" E ft ] ow L_haracter 1ag Tes
..... g it * Keyboard Shortout
----- [3] IntegerToFractionse r ? i
----- [&3] LineBreak romat S
..... E It * InDesign <0x000D =
..... [ | * | Add Formatting

If a multivalued attribute is used in an inline reference, the rendering setup for the multisep tag will be shown
between each of the values. In the below example, the 'Country of Origin' attribute has four values. When
rendered in the inline reference, these four values are separated by the forward slash (/) character.

¢ Display

OMG KOMNG
q TATVWAMN
ET MAM
EXICO

* Country of Qrigin

Mame >

.T-'eqmm

For more information on STEP character tags, refer to the Tags topic in the System Setup documentation.

Copying Attribute Values as Inline References

An alternate—and quicker—method of creating an inline reference is to copy the value of an attribute, then paste
it into the value editor of another attribute as an inline reference. This inline reference can then be edited like any

other inline reference.

1. Navigate to the attribute value that you would like to use as an inline reference and select the value editor

field.
2. Right-click and select Copy as inline reference.
@ Display
Mame *| > Malue
» Basic Manufacturer Information |abe % Cut Ctrl+
* Long Item Description abe Product information: , =
Co Ctrl+C

* Manufacturer's Part Number abe 121177 B —
> [Country of Origin HOMNG KONG Copy as inline reference  Ctrl+]
» Manufacturer Name abe Acme Party Supplies E Paste Ctrl+V
> Product Name abe Cosmic Party Hat S paste Link Crl+L
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3. Navigate to the 'destination' attribute value and select the value editor field.

4. Right-click and select Paste.

|STIBOSYSTEMS

5. The value appears in the destination field as an inline reference.

§ Display
Marme > >I_'I.|'alue
» Basic Manufacturer Informati abl Acme Party Supplies I
* Long Item Description abe Froduct intormaton: , par
» Manufacturer's Part Number |abe (121177
» Country of Origin HOMNG KONG

§ Display

Marme »| * |Value
» Basic Manufacturer Informatiiabe | o % Cust ChrleX
* Long Item Description abe Prodygct i .
» Manufacturer's Part Mumber [abe (1211 Copy S
» Country of Origin HDNG Copy as inline reference  Ctrl+I
» Manufacturer Name abe JAcme Pa | Paste Chrl+V
P T b Fenrnie D

e MASTER DATA MANAGEMEMNT

Note: The copied 'source’ attribute value is connected to the 'source' object, meaning that any time an
attribute value is coped as an inline reference and pasted elsewhere, the inline reference will never pick up
the attribute value from the current object but only from the 'source' object. Also, STEP IDs and STEP names
cannot be copied as inline references.
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Christmas Party Hat rev.0.11 - Product

Tables | Category Profile || Proof Wiew || Status || StateLog || Tasks
Product [ Sub Products ” Refere ] - .
I Inline Reference
* Gtatus
+ URL uL Ohiject Selection
» Walue 1 abe Object | | Cosmic Party Hat
%' Manufacturer Information I Resalve To Object ID
Mame >| > |value () Resolve To Object Mame
» Manufacturer's Part Mumber |abe
* Manufacturer Name abe: (®) Resolve To Attribute Value and/or Unit
» Country of Origin _ _
* Product Name |ah¢v Christmas Party Hat Attribute Selection
@ Category Spedfic Attributes Attribute | Manufacturer Name
== Attribute Group Attribute Mame(s)
¥ Display ] Indude
Mame * | » |Value l Separator
> Basic Manufacturer Informati|abe Party Supplies ¥
» Long Item Description abe Celebrate the holidays w Attribute Value(s)

Inserting an Inline Reference using Web Ul

Rich text editing allows users to enter and edit text within a web browser. Inline references can be inserted into
an attribute value using a Rich Text Editor (RTE) within a Node Editor.

Adding an inline reference in Web Ul is similar to adding one in the workbench. For instructions, refer to the Rich
Text Editor section of the Web User Interfaces documentation.
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Assets

This topic covers information specific to the asset super type that is important to know when working with assets.
For general object maintenance information (applicable to all object types rather than specific to assets), refer to
the All Objects topic within this guide.

An asset is any product-related electronic file, such as images (tiff, eps, jpeg, etc.), Word docs, Excel files, PDFs,
PowerPoint files, text files, etc. Images are a common asset so they will be the focus of this section. In most
cases, the terms “asset” and “image” are interchangeable.

Although any image can be loaded into STEP regardless of its quality or origin, it is important that a quality check
be performed by users with graphic arts knowledge. Ideally, this check occurs prior to importinto STEP so that
only approved images are available in the system.

Classification of Assets

Asset objects live in a classification hierarchy. The classification hierarchy for assets should be separated from
other classification hierarchies (e.g., those used for alternate structuring of products, import / export
configuration storage, etc).

The recommendation is to have one classification object type and instance for each asset object type. For
example:

System Setup

=-{# Object Types & Structures =[] Assets

|j Alternate Classifications |—_=| Icons

E}-- Assets |j Hlustrations
Assets &[] Installation Manuals
----- & | Icon [+ 7] Logos
----- 5| Tlustration |j MSDS Sheets
- ----- i Installation Manual rj Owners Manual
- ----- finge Logo rj Product Images
-] M5Ds [T Product Videos
b @ Owners Manual
- ----- 'E Product Image
----- Product Video

Within the individual type-based classifications, additional levels can be modeled if necessary. A common option
is to work with a 2-level folder structure based on the first characters of the asset file name. For example:
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EH[) Product Images
B
B
B 11
12
MR
B0 14
90 15
®[J16
2017
w1713
~m) 1714
':.J 1719

With a structure like this, it is not intended that users should be browsing the hierarchy to locate assets. Instead,
assets are typically located via references from other objects and/or via searches. STEP does not require that
the image hierarchy have multiple levels. Assets can be stored in a single folder (e.g., a flat structure). However,
this is not typically recommended as it can be impractical to navigate the hierarchy as the number of assets
increases.

The same asset object can exist below multiple different classifications. However, this functionality is typically
only used for cases where suppliers upload assets. These assets will initially go into supplier-specific
classifications and can subsequently also be linked into the primary asset hierarchy.

Asset File Type Designation

New asset object types are defined in STEP the same way any other object types are, via the System Setup tab.
One key difference between asset object types and other object types, such as products or classifications, is that
there are no parent-child relations between assets, as asset instances live in classification hierarchies.

Asset object types are defined in STEP Workbench System Setup under 'Object Types & Structures.' Apart from
the built-in generic type 'Assets', it will be a flat list of the different asset object types required for the setup. For
example:
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System Setup
{2 Object Types & Structures
(-] Alternate Classifications
E} Assets
Aszets
..... = Ican
- ----- ﬁ Tlustration
- ----- i Installation Manual

- fead Logo

b ﬁ Owners Manual

- ----- E Product Image
- Product Video

On older systems, you may observe asset object types that are file-type specific. For example: JPG Image, Word
Document, etc. For newer installations, this file type approach is generally not used, and instead, it is
recommended to use object types that convey information about the asset's use (as shown above), rather than
the file type. This is done for clarity as it is often more important to understand the purpose of the asset. For
example, an asset is not just a PDF file, instead it is an Installation Manual, a Product Brochure or an Owner's
Manual. One advantage of the purpose-based setup is that it is possible to restrict reference types to point to the
specific types of assets and not just to generic file types.

With the move away from file type specific asset object types, asset object types cannot be applied automatically
when digital media files are imported into STEP as there is no 1:1 relationship between file types and asset
object types. Itis possible to have object types automatically applied upon import when a file-based approach is
used, but this functionality generally does not weigh up to the disadvantages of the approach.

Asset Objects and Digital Media Files

A fundamental point when dealing with assets is that there is no 1:1 relationship between asset objects and
digital media files in STEP. Thus, it is possible to work with asset objects that do not have "content", i.e., are not
tied to any digital media files. Furthermore, the content can be dimension-dependent so that an asset is tied to
different files in different contexts. Finally, an asset can have different content in different historical revisions.
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Product Object

Asset Reference “Primary Product Image”

Asset Object

JPG File

As explained in the next section, there are different options for how and where the actual digital media files are
stored. Independently of which option is selected, asset objects are stored in STEP and it is to these objects (not
to the actual media files) that relations are modeled (using references).

Image Variants and Handling

Different publishing projects impose various requirements on the use of images. For example, a high-resolution
image in STEP may be a TIFF. However, for the web, a jpeg is needed. Or, if the high-resolution image is an
EPS, a GIF may be needed instead of a jpeg.

To handle these scenarios, STEP can use the original high-resolution image to generate the needed image
versions based on a set of templates or image conversion pipelines. When using an image conversion, the
images in STEP must be of sufficient quality to allow these variations to be properly created.

More information on image conversions is available in the Image Conversion Configuration topicin the

Digital Assets guide.

More Information

For specific details about working with assets in the workbench, refer to the Maintaining Assets and Linking
Assets to Products topics within this guide.

For information on working with assets in Web Ul, refer to the Asset Handling in Web Ul topic in the Web
User Interfaces guide.

For information on importing, exporting, and managing assets, refer to the Digital Assets guide.
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Maintaining Assets

This topic covers information specific to the Asset super type that is important to know when working with assets.
For general object maintenance information (applicable to all object types rather than specific to assets), refer to
the All Objects topic within this guide.

Creating Assets

The basic methods for creating an asset are the same as any other object type, as described in the Creating
Objects in the Tree Tab topic within this guide. However, there are a few considerations that are specific to
assets that users should be aware of when creating assets, which are described.

Assets are essentially placeholders in STEP, to which a digital media file must be associated. WWhen assets are
created in STEP via import of a digital media file, this association happens automatically. However, when assets
are created using standard object creation methods in Tree (e.g., right-clicking on a classification folder and
selecting 'New Asset'), itis only the placeholder that is created. An asset created in this manner will initially have
no system properties and no content. For example:

Chihuahua rev.0.1 - Images & Documents

=] Assets ARG SRR I [ | References || Referenced By || Status || State Log || Tasks

& [ ons r=——
r—=| Dustrations MName > | > Value *llasset has
[T Installation Manuals
4[] Logos > ID 115308 no content.
[-[=] MSDS Sheets > Name Chihuahua
l_—=| Owners Manual * DObject Type Product Image
] Product Images

EH_._:I 1 * Revision 0.1Last edited by USERS on Sun Jan 29 10:58:10 EST 2017

E”j 12 > Approved 3 Never Been Approved
]E 123456 * Mranslation Mot Translated

B ZE@I » Path Classification 1 root/Assets/Product Images/1/12/Chihuahua

B4 » ProductsGaloreAttribute ahe

6 7

B9 No System Properties

A user can right-click on the asset and select Replace Asset Content to open a dialog where a digital media file
can be selected from the local machine. STEP will automatically read and populate the properties of the asset,
and a thumbnail of the digital media file will display. For example:

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 158



Tree
El{ 7] Assets
- cons
Rl
B-[7] Hlustrations
- nstallation Manuals
b Installation M I
rj Logos
- ee
[-[T] MSDS Sheets
B[] Owners Manual
= r_=| Product Images
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Chihuahua rev.1.0 - Images & Documents

G EL R LT L E | References || Referenced By || Status || StateLog || Tasks

Mame | » |Value >
> D 115308
» Mame Chihuahua
> Object Type Product Image
» Revision 1.0 Last edited by USERS on Sun Jan 29 10;59:56 EST 2017
» Approved x Never Been Approved
> [Translation Mot Translated
» Path Classification 1 rootfAssets/Product Images,/1/12/Chihuahua
* ProductsGaloreAttribute abe:

® SystemProperties:

Mame »| » |value
* Class abe [True color
» Colorspace abe RGE
> Compression abe JPEG
* Depth il:: 8 (bitsfsample)
» Extension abe jpg
» Filename abe (136.JPG
> Format abe JPEG (Joint Photographic Experts Group JFIF image)
* Height 123 |1151.46 (mm)
* MIME Type abe imagefipeg
» Pixel Height ¢ 3264 (pixels)
* Pixel Width i1:2 [2448 (pixels)
» Profile abe [Custom EXIF, Custom XMP
» Samples i 3 (zamples,/pixel)
> Size abe 2,270,288
> Upload Time abe (2017-01-29 10:59:56
> Width 122 863,59 (mm)
* Horizontal DPI 122 72 (dpi)
» Wertical DPI 123 [72 (dpi)

To avoid this two-step process, assets are often introduced in STEP via import (or specific transfer protocols for
an initial implementation). More information on importing assets is available in the Importing Assets section of the

Digital Assets guide.

Asset Editor

General information about editing objects in STEP is available in the Editing Objects in the Tree Tab topic
within this guide and is not repeated in this section. However, assets have some additional editing options
specific to working with digital media files, which are described.

Images & Documents

The Images & Documents tab is the primary workbench interface for assets. It has three sections, described

below.
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[ References ” Referenced By ” Status ” State Log " Tasks ]
ame *| » |Value >

» D 115308

* Mame Chihuahua

* Object Type Product Image

» Revision 1.0 Last edited by USERS on Sun Jan 29 10:59:56 EST 2017 Edit Asset

» \Approved 3 Never Been Approved External Viewer

» Translation Mot Translated Save to disk

> Path Classification 1 root/Assets/Product Images//1/12/Chihuahua Image Viewer
me *| » |Value »

¥ Class abe True color

» Colorspace abe RLGE

> Compressian abe JPEG

» Depth 1 EE Fg.(bits,-'sample}

> Extension abe jpg

* Filename abe |136.1PG

» Format abe JPEG (Joint Photographic Experts Group JFIF image)

» Height 123 [1151.496 (mm)

* MIME Type abe imagefjpeg

» Pixel Height ili: 3264 (pixels)

» Pixel Width ili: 2448 (pixels)

* Profile abe Custom EXIF, Custom XMP

» Samples il |3 (samples/pixel)

> Size abe (2,270,288

* Upload Time abe | 2017-01-29 10:59:56

» Width 123 363,59 (mm)

> Horizontal DPI 123 (72 (dpi)

> rdferﬁml DFI 122 72 (dpi)

1. The Description flipper contains the same basic information as other object types. Additional Description
attributes can be made valid for assets to support data such as keywords or asset descriptions. Specification
attributes cannot be made valid for assets.

2. The System Properties flipper displays data that is read automatically from the digital media file. This
information cannot be edited.

3. The asset thumbnail has a number of options available for editing assets. Additional right-click options are
also available when the asset itself is right-clicked from the Tree. All of the options that are specific to assets
only (accessible from right-click on the thumbnail or the asset) are described below.

« Create Local Content of Asset: Creates a local version of the asset specific to the current context. Refer
to the Asset Dimension Dependencies section below for more information.
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« Delete Local Content of Asset: Deletes the content of an asset that is not dimension dependent.
Deletes the local (context-specific) content of the asset if the asset is dimension dependent. Refer to the
Asset Dimension Dependencies section below for more information.

« Edit Asset: Opens the digital media file for editing in an external program, in addition to an Edit Asset
dialog in STEP. Upon completion of editing in the external program, click save within the program to store
the edited asset to a temporary directory. Then click OK in the Edit Asset dialog in STEP to have STEP
retrieve the edited file from the temporary directory and store this in the asset. Note that the media file will
open in the application associated with the file type. For example, for files ending with .xls, Excel will
automatically be launched. This may be different from computer to computer. One user’s computer may
open up EPS images in Photoshop, while another user’s computer may open the same file types in
lllustrator.

o Export Images & Documents: Opens the Export Images and Documents wizard to make selections to
export the currently selected asset(s). Refer to the Export Images and Documents Wizard topic in the
Digital Assets guide for more information.

« External Viewer: Opens an external viewer for viewing the asset. This is comparable to the Edit Asset
function in that the program that is utilized is specific to the file type and the user's computer settings. It
differs in that any changes made to the asset in the external program are not saved back to STEP.

» Image Viewer: Opens an image viewer within STEP for the user to examine the actual asset (as opposed
to just the thumbnail).

» Push Asset(s): Initiates asset push for the selected asset(s). Refer to the Asset Push section of the Digital
Assets guide for more information.

» Replace Asset Content: Opens a dialog for the user to select a digital media file for the asset. Refer to
the 'Creating Assets' section above for more information.

» Save to disk: Opens a standard save dialog allowing the user to select a location on their local machine to
save the digital media file to.

« Unlink asset: Only enabled if the asset has been linked directly into a publication, in which case it unlinks
the asset from the publication. Refer to the Publication Hierarchy section of the Publisher (Adobe InDesign
Integration) documentation for more information.

References

The References tab displays the classifications that the selected asset is linked to, and allows for linking to
additional classifications using the Link to Classification link. Each asset must be linked to at least one
classification, but may be linked to many. Links can be removed by right-clicking on the row indicator and
selecting 'Remove Link to Classification'. The Name of each classification displayed is hyperlinked for easy
navigation, and revision, approval, and translation statuses are also displayed.
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L] Images & Documents Referenced By || Status || State Log || Tasks
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References

ID

> |Mame >

Chiject Type

> |Revision

> |Approved >

Translation

> B735

12

Agset Level 2

0.3 Last edited by USERS ...

3 Last Approved on Thu... Not Translated

| W

Link te Classification

Note: While the maximum number of references to one object node is limited to 10,000 instances, this value
can be changed; however, it is against Stibo Systems recommended practices to use this many references.
Before changing this value, contact your Stibo Systems account manager or partner manager for assistance.

Referenced By

The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects that
the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). The
display of the Referenced By tab on an asset will vary slightly from system to system, based on the data model.

-] Assets

[-[=] Icons

B[] Tlustrations

([ Installation Manuals
4 [ Logos

[#-[5] MSDS Sheets
[T Owners Manual

= |'_'=| Product Images

E| {1

L BOe
.
e ]j Chihuahua
202

B4

20

=39

v| * |Source

12"!4'3!3 rev.3.1 - Referenced By

~ Images & Documents || References [PLAEE IR | Status || State Log || Tasks

>

Thumbnail

v

&Reference Type

Image Display Sequence > [Caption 1 >

Caption 2

w

Primary Product Image <+

L=

v

Product Images

+ :[Flazmms

> |Area Used

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid target that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by
clicking the (+) on the reference. This will open a dialog allowing the user to select a source for the reference,
and a reference will be created from the object selected in the dialog to the currently selected object that you
are standing on (e.g., current object = target, dialog selection = source). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the
(X) on any existing reference. Additional information on configuring and working with references is available

in the Reference and Link Types topic in the System Setup.
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2. Ungrouped Referenced by Products, Classifications or Entities: The functionality is identical to what
is described for the Reference Flippers section above. The only difference is that this area displays
references that have not been placed in attribute groups for display purposes.

3. Used on Page: Displays publications that the selected object is used in. Additional information about
working with publications is available in the Publisher (Adobe InDesign Integration) section of the online help.

Status

The Status tab provides general information about objects, including revisions, translation status, and approval
status. For more information on these basic settings, refer to the Status Tab topic in the Products section of this
guide. For assets specifically, this tab also includes an Asset Push Status section that describes the status of
assets for the various asset push configurations on the system. For more information, refer to the Monitoring
Asset Push topic in the Digital Assets guide.

State Log

The State Log tab allows users to view the recent history of the object across all workflows in which it has been
entered. Refer to the State Log Tab topic in the Workflows documentation for more information.

Tasks

The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's privileges
(only tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place,
the user is able to act on the tasks from this editor, including to edit data and move tasks through the workflow.
More information on the Tasks tab is available in the '"Moving Tasks through a Workflow in Workbench' topic in
the Workflows guide.

Asset Dimension Dependencies

Individual asset object types can be made dimension dependent using the Dimension Dependencies parameter
on the object type. This configuration will only affect the STEP Name of assets, meaning that it allows for
individual assets to have a different name based on the indicated dimension dependencies (e.g., 'Red Hat' in
English and 'Chapeau Rouge' in French when the dependency is Language).
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----- Auto Classification Rule Se
----- Bulk Update Configuration
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..... Configuration
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..... 'E

----- | Iustration

----- Import Manager Configura
----- i Installation Manual

- esd Logo
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Icon - Object Type

Object Type ReFerences| Log
' Description

Mame »| > |[Value
> ID Icon
* Mame Icon

» Last edited by

2017-01-29 12:07:47 by USERG

» Mame Pattern

» D Pattern [id]
* [con 'E
application/postsoript
* MIME Types mage,tif
mage/tiff

* Dimension Dependendies Language;

» Reference Target Lock Palicy Strict

Itis also possible to make the content of assets dimension dependent so that an assetin STEP can be tied to
different digital media files in different Contexts. This is configured using the Image & Document Settings >
Dimension Dependencies parameter in System Settings.

System Setup < System Settings
[System settings [

-5 Web Uls

5] workflow Profiles

5] workflows

Derived Events

{2} Object Types & Structures

& Units

4 7% e o]

Buh Reference Types

@ Table

@ Keys

Ii Event Queues
Component Models
-1 Recyde Bin

~

2= Classification Hierarchy Settings
2 Image & Document Settings

» Dimension Dependendes

» Store assets and OTP documents in

Language;

Database

* DTPF asset source

Asset Push

» Pregenerate thumbnail cache on upload

Mo

» Disable auto-deanup of thumbnail cache

Mo

» Transformation Lookup Tables follow asset dimension d...

M

» Wisset Import Compatibility Mode

Simple

This setting is global, meaning it applies to all assets. Unless there is a very special reason for turning on asset
dimension dependencies, this should be avoided. As mentioned, the setting is global, meaning that special
procedures must be implemented for creating assets that are to have the same content in all contexts. Thus, if
you import a digital media file (and via this create an asset instance) in a context that does not use the top-level
dimension point for the dimension on which asset content depends, the content will be created only in the
dimension point the current context uses.

For additional information, refer to the Image & Document Settings topic in the System Settings

documentation.
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When importing assets into STEP, System Properties attributes can be automatically created in STEP on the
asset, and then populated with the image metadata detected on the incoming assets. The image metadata must
be formatted as either XMP (Extensible Metadata Platform) or EXIF (Exchange Image File). Determination of

which metadata attributes should be housed in STEP is configured manually.

In an image file, image metadata is stored as plain text in XML format. Based on the configuration file and import
shown below, the Creator, Subject, and Description metadata will be written to STEP. In the following sample,

some rows have been removed for brevity, as indicated by '...".

1 <«x:xmpmeta xmlns:x="adobe:ns:meta/" x:xmptk="Adobe XMP Core 5.3-cB87 1.136881, 2018/@6/1@-18:11:35 "
2  <rdf:RDF xmlns:rdf="http://www.w3.0org/1999/82/22-rdf-syntax-ns#">

3 <rdf:Description

4 rdf:about=""

5 xmlns:xmpMM="http://ns.adobe.com/xap/1.8/mm/"
6 -

"E <dc:creator: —

== <rdf:5eq>»

] <rdf:1i>0KL Photo:RM Style:RM</rdf:1i>
18 </rdf:5eq>»

11 - <fdc:creator:

12% <dc:subject) ffem—

13[= <rdf:Bag>

14 <rdf:lixlucite</rdf:1i>

15 <rdf:lirbox</rdf:1i>

16 <rdf:lixchest</rdf:1i>

17 <rdf:lirtrunk</rdf:1i:>

18 </rdf:Bag>

19 - </dc:subject>

SE <dc:description

1E <rdf:Alt>

i Ra

- </rdf:Alt>
</dc:description>

Ln

</rdf:Description>
- </rdf:RDF>
< /% xmpmetas

o
T

=

PR R OR ORI R R R R
i
T

(=]

Prerequisites

<rdf:1i xml:lang="x-default">Lucite trunk</rdf:1i:

The user should have a basic understanding of XML, the XML structure of image metadata, and XPath before
proceeding with configuration. The configuration file uses XML to define attribute names and the XPath query to

retrieve metadata. For more information, search the web.
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XMP Configuration File

The custom asset metadata configuration file uses the instruction "XmpConfiguration' to define the name of the
system attributes being created in STEP and the XPath that defines how to retrieve the image metadata.

XPath is an XML query language STEP uses to search the XML within an image file and identify the desired
metadata. The XMP configuration file defines the XPath queries to be run against an image file being imported.

The following sample configuration file defines three metadata attributes (Creator, Description, and Subject),
and the XPath query required to find the corresponding metadata.

1 <XmpConfiguration»
25 <XmpProperties allow="true">
3

4 <XmpProperty

5 name="Creator” unit=""

6 xpath="/*[name(.)="x:xmpmeta']/*[name(.)="rdf:RDF']/*[name(.)="rdf:Description’]/*[name(.)="dc:creator’]/*[name(.)="rdf:Seq" ]/*[name(.)="rdf: 11" ]"/>
7

8 <XmpProperty

9 name="Description” unit=""

o xpath="/%[name(.)="x:xmpmeta’ ]/*[name(.)="rdf:RDF" ]/*[name(.)="rdf:Description’ ]/*[name(.)="dc:description’ ]/*[name(.)="rdf:Alt" ]/*[name(.)="rdf:11"]"/>
11

12 <XmpProperty

13 name="Subject” unit=""

. xpath="/*[name(.)="x:xmpmeta"']/*[name(.)="rdf:RDF']/*[name(.)="rdf:Description’]/*[name(.)="dc:subject’]/*[name(.)="rdf:Bag']/*[name(.)="rdf:1i"]"/>
15

16 - </XmpProperties>

17 - < /¥mpConfiguration>

In the above example, the 'creator’ attribute is defined by the text:

name="Creator" unit=""

The XPath to find the creator metadata is defined by the text:

xpath="/*[name (.)="x:xmpmeta']/*[name(.)="'rdf:RDF']/*[name(.)='rdf:Description']/*
[name (.)='dc:creator']/*[name(.)='rdf:Seq']/*[name(.)="rdf:1i']"/>

Another example (an XML block in an image file and the XPath):

<x:xmpmeta xmlns:x="adobe:ns:meta/" x:xmptk="XMP Core 4.4.0-Exiv2">
<rdf:RDF xmlns:rdf="http://www.w3.0rg/1999/02/22-rdf-syntax-ns#">
<rdf:Description rdf:about=""
xmlns:iptcExt="http://iptc.org/std/Iptc4xmpExt/2008-02-29/"
xmlns : xmpMM="http://ns.adobe.com/xap/1.6/mm/"
xmlns:stEvt="http://ns.adobe.com/xap/1.0/sType/ResourceEvent#"
xmlns:plus="http://ns.useplus.org/ldf/xmp/1.0/"
xmlns :GIMP="http://www.gimp.org/xmp/"
xmlns:dc="http://purl.org/dc/elements/1.1/"
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xmlns:tiff="http://ns.adobe.com/tiff/1.0/"

xmlns:
Xmp
="http://ns.adobe.com/xap/1.0/"
iptcExt:
DigitalSourceType="http://cv.iptc.org/newscodes/digitalsourcetype/digitalCapture"

XmpMM: DocumentID="gimp:docid:gimp:7620dabd-f6a6-435f-a865-ff3b8315b650"
xmpMM: InstanceID="xmp.iid:9c338c25-620b-4d53-adc7-c2a921b771cd"

XmpMM: OriginalDocumentID="xmp.did:e19d764e-1731-46ca-9fel-8c86d0b29d05"
plus:ModelReleaseStatus="http://ns.useplus.org/ldf/vocab/MR-LPR"
GIMP:API="2.0"

GIMP:Platform="Windows"

GIMP:TimeStamp="1613727775463349"

GIMP:Version="2.10.22"

dc:Format="image/png"

tiff:0Orientation="1"

xmp:CreatorTool="GIMP 2.10">

<XmpProperty name="GIMP_Version" unit="" xpath="/*[name(.)="x:xmpmeta']/*[name
(.)="rdf:RDF']/*[name(.)="rdf:Description’']/*[name(.)="GIMP:API'] | /*[name
(.)="x:xmpmeta']/*[name(.)="rdf:RDF']/*[name(.)="rdf:Description']/@*[name(.)="GIMP:API"']"
/>

Using an XMP Configuration File

1. Create and save a custom asset metadata configuration file using XmpConfiguration instruction as shown
above, that defines:

« the image metadata attribute name(s)
« the appropriate XPath to the required metadata on the image
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Save the configuration file to the STEP server in the same directory as the sharedconfig.properties file.

Edit the sharedconfig.properties file and include the case-sensitive XMP.ConfigFile property as follows,
where 'customxmpconfiguration.xml' is the name of the configuration file created above.

XMP.ConfigFile = /workarea/customxmpconfiguration.xml
Save the sharedconfig.properties file.
Restart the STEP server to apply changes to both configuration files.

Import an image that includes the metadata attributes defined in the XMP configuration file.
Navigate to the imported asset to view the metadata assets on the System Properties flipper.

Custom attributes are identified in the STEP asset editor by the text 'asset.' which is prepended to the
attribute name (for example, 'asset.Creator").

Tree €Product_SDT10010_Image_1 rev.1.1 - Im4

r_=| Owners Manuzl Il Images & Documents |EEEEENE | Referenced By [E
E}E gduct Images . 5

B2 § System Properties:

'E Prm SOT10010_Image 1| Mame »| > |Value »

r_=| 2 > fasset, Creator 1za [OKL Photo:RM Style:RM

r_=| 4 » lasset.Description  [12a Ludite trunk

--r_=|6 » fasset, Subject 12a Judite;box;chest;trunk

E-[T 9 > asset, Title 12a SDT10010

r_=| A > Class abe [True color

Important: Custom coding by Stibo Systems can be used to allow attributes to be displayed in workbench
with names other than 'asset.[attribute name]'. For more information, contact your Stibo Systems
representative.
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Linking Assets to Products

If the asset’s name can be matched to the product, then this function can be performed when the asset is
imported. If not linked at this time, there are two ways that the interface allows the link to be made: a) from the
product or b) from the asset.

There are three ways to link images to products:

o From the product
o From the asset
o Fromimport

Note: While the maximum number of references to one object node is limited to 10,000 instances, this value
can be changed; however, it is against Stibo Systems recommended practices to use this many references.
Before changing this value, contact your Stibo Systems account manager or partner manager for assistance.

Linking Assets to Products (From Products)

1. Select the product and then select the References tab.

l Product ” Sub Products ][ Referenced By " Images & Documents ” Commercial " Tables ” Category Profile ” Proof View “ Status ” State Log ” Tasks ]

2. Navigate to the Image References section of the References tab. Click on the + symbol to link the image to
the correct area. For this example 'Primary Product’ will be used as it is the most common reference type
made.

9 Image References
Reference Type W

b

Target Thumbnail

» |Brand Mame Logo

» |Ilustration

» |Product Image

SIGIGEEE

+
+
* |Primary Product ...} +
+
+

* |Video

3. Asearch window displays.
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[ 1 Select Asset (Reference Type = Primary Product Image) x

Browse [RE=ENA

rj Aszsets

[+ [T] Classifications

|j Configurations

|j Merchandising Hierarchy
|j Suppliers

- [2] Web Sites US

|__=| Primary Product Hierarchy

®- Details

Select Cancel

4. Search for and select the appropriate image. By selecting 'Primary Image,' it denotes that the image is the
exact representation of the product. Once a Primary Image has been linked to a product, a thumbnail of the
image will appear when the product is selected.

¥ Image References

Reference Type w| » [Target ¥ [Thumbnail
> |Brand Name Loge  + |k \
» |Hlustration + H
* |Primary Product Image EEEDBUE I
» |Product Image + (i
> |Video + n

Note: When assets are linked to products, you must designate what type of reference is being made. For
example, is it an image that represents the product? Is it an accessory to the product? Or a related
document? This reference type denotes that the image being linked to the product is a direct
representation of that product. When you make such a reference, a thumbnail of the image is attached to
the product. The thumbnail will only appear for this reference type. It is possible to link more than one
image to the reference type if the reference type is set to allow multiple references 'yes.'

Linking Assets to Products (From Assets)

1. Selectthe image in the Assets folder in the Tree. Then, select the References by tab.

[ Images & Documents ” References ][ Skatus ” Skate Log " Tasks ]

2. Ifitis not already open, click on the 'Image References' flipper to open it. Click on the + sign for 'Primary
Product Image' to link the image to the product.
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[ Images & Documents " References ][ Status " Stake Log ” Tasks ]

|-0

Reference Type w| * |Source ¥ [Thumbnail
> |Primary Product ... | + i
* |Product Image + m
4
Reference Type w| * |Source > *
4
Publication * |Version * |Page * |Area Used

3. Navigate to the Product in the pop up window, and select it.

[ Select Asset (Reference Type = Primary Product Image) %

TGV | Search

E-{7] Assets ~
r_=| Configurations
r_=| Index Words
r_=| Merchandising Hierarchy
r_=| Suppliers
[ Web Sites
Eli Primary Product Hierarchy
E}i Products
L_-_Ii Apparel
[+-[[T) Head Wear
E}i pper Body Wear
=[5 T-shirts
=gl T-shirts Items
E]‘ Hanes T-shirts
™ 1382121 B
- 18213M O 2

epewls

4. Selected image will be linked to the product. Once a Primary Image has been linked to a product, a thumbnail
of the image will appear when the product is selected as illustrated in the below image.
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{7 Assets
rj {QAIcon)
|j Icons
[T Hustrations

(=]
(=]

(-7 Logos

B[] MSDS Sheets
rj Owners Manual
=S ] Product Images

=y

|j Installation Manuals

20701 rev.1.4 - Referenced By

Images & Documents || References [P0 Status || State Log || Tasks
F‘.eﬁaren::e Type w| » |Source » [Thumbnail >
» |Cal Green + (i
> |Primary Entity Image  + |3
e

*E 114613
» |Primary Product Image | + n P Jinch heels

n h Red and Gold heels

Linking Assets to Products using the Import Manager

This method is best used for large amounts of products / assets linking. Ideally, you should already have afile in
Excel that has the products and desired Image ID set up according to how you want them to be after import.

Note: If you only need to link a few assets to products, then it is more efficient to link them via the interface.

1. GotoFile and select Import, then Data. An 'Import Manager' window will appear. On 'Select Data Sources',
click the ellipsis button (E) next to 'Filename' and select your file.

6. Identify Destination
7. Select Business Rules
3. Advanced Settings

[ Import Manager x
Steps Select Data Source
1. Select Configuration Data Source File w |
2. Select Data Source _
3 cdl £ Retrieves contents from files reachable from your local computer,
4, Map Data Filename | 1nputFile. txt I - |
5. Identify Objects

Finish

| Back | | fext |

2. Proceed to the 'Map Data' step. Select a source column and click the Map button. Map the column holding
IDs to'ID', map the column holding the asset to be referenced to 'Asset Reference'. After selecting the 'Asset
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Reference' radio button, select the 'Primary Image' radio button. For more information on mapping, refer to
Inbound Map Data - Map in the Data Exchange documentation.

™ Map <Mame= to
O

() Name
() Attribute
(") Product Classification Link

(") Product Reference

() Classification Reference
() Entity Reference

i) Reference Meta-Data
() Parent

(") Object Type

(") Variable

() Multivalued Variable

() Overrides product

() Add child to override

() Data Container

Target ID Aspect 1D

(71 Brand Name Logo

() Hustration
i7) Installation Manual

(1 Owners Manual

(®) Primary Product Image

(7 Product Image

1 Video

[ ] Mandatory

Cancel | | OK |

. Click OK to close the Map To dialog.

If the image IDs were not found or the import file data was not done correctly, then columns will appear in red.
For information on input files, refer to Asset Reference - Map Inbound in the Data Exchange

documentation.

Note: If the image IDs were not found or the import was not done correctly, then columns will appear in red.
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[ Import Manager

>
Steps Map Data
1. Select Configuration Source;
2. Select Data Source <D # |<Mame: *
3, Select Format 18210 18210 MEB
4. Map Data 18212 182121 B
5, Identify Objects - e
6. Identify Destination
7. Select Business Rules < >
8. Advanced Settings Result: Map to:
ID=<IDz " rimaryProductimage AssetReference=<Mame > @
18210
18212
18213
Auto Map | [ Map i | Constant | | Remove | | Transform | | Generate Profile |
| Back | | MNext || Finsh | | Cancel |

STEPXML Import

Itis also possible to link the images to product via STEPXML import. The following code snippet, shows an
example XML file shown below:

<?xml version="1.0" encoding="utf-8"?>

<STEP-ProductInformation ContextID="Context7" WorkspaceID="Main"
UseContextLocale="false">

<Products>

<Product ID="18210" UserTypeID="Item" ParentID="18209">
<Name>18210 M B</Name>

<AssetCrossReference AssetID="20584" Type="PrimaryProductImage"/>

</Product>
</Products>

</STEP-ProductInformation>
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Classifications

This topic covers information specific to the Classification super type that is important to know when working with
classifications. For general object maintenance information (applicable to all object types rather than specific to
classifications), refer to the All Objects topic within this guide.

Classifications are used to build hierarchies and objects that bundle other objects into organized groupings. For
example, images, manuals, and icons could be uploaded to STEP as assets and stored in appropriate
subfolders under the 'Assets' classification folder. Product objects could also be linked into classifications to
provide alternative categorizations of objects that vary from the product hierarchy structure.

Classification Editor

The primary editor for classification objects is the Classification tab.

T-shirts and Sweatshirts rev.0.3 - Classification

[T Assets ~ Sub Products || References || Referenced By || Images & Documents || Tables || Status || State Log || Tasks
(- 7] Configurations 5
[H-[Z] ETIM Hierarchy ki ;
> >
-] Index Words Name Value
[-{"—] Merchandising Hierarchy » [ID 22586
B[] Suppliers » Mame T-shirts and Sweatshirts
= Web Site
7 EI—‘_:IE Ac:Tl:REEﬂ Web Site > PbiectType Web Level 3
,__—_|i—'_=| Apparel * Revision 0.3 Last edited by USERY on Mon Dec 26 07:24:26 EST 2016
E|‘_‘=| Mens Casual > Approved x Last Approved on Mon Aug 08 10:59:21 EDT 2016
r—=| Caps » [Translation Mot Translated
=1+ [T-shirts and Sweatshirts
I_ 18207012 > Path Classification 1 root/Web Sites/Acme Retail Web Site fApparel Mens Casual T-shirts and Sweatshirts
|_ 18214-012 > Misibility
IL 18215-012 » Landing Page Copy abs
vl 18217012
Sl 18217054
-[Z] Women's Apparel

This tab will display all description attributes that are valid for the classification. Note that only description
attributes are available on classifications (as opposed to products, which can also have specification attributes).
More information on description attributes is available in the Description Attributes topic of the System Setup
documentation.

Sub Products

When on a classification, the Sub Products tab is used to display objects of the product super type that are linked
into the classification via Product to Classification links. When the selected classification does not have product
children (e.g., classifications used to house assets or configurations), the Sub Products tab does not provide any
meaningful information.
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View: Show all w

Classification References || Referenced By || Images & Documents || Tables || Status || StateLog || Tasks

18207012 » 18214012 »|18215-012 » 18217012 » 18217054
jin] > 18207 18214 18215 18217 100305
Mame » |18207-012 18214012 18215012 15217012 15217054
Object Type > [Sales Item Sales Item Sales Item Sales Item Sales Item
Revision * 0.2 Last edited by USER o... 0.3 Last edited by USERL ... 0.4 Last edited by USERL ... 0.3 Last edited by USERL ... 0.22 Last edited
Path » |Primary Product Hierarchy... Primary Product Hierarchy... Primary Product Hierarchy... Primary Product Hierarchy. .. Primary Product
Approved > | € Last Approved on Mo... | € Last Approved on Mo... | 3€ Last Approved on Mo... |3€ Last Approved on Mo... |+ Approved or
[Translation > Mot Translated Mot Translated Mot Translated Mot Translated Mot Translated

Completeness Score

>

Classification 1root | Web
Sites | Acme Retail Web Site

Classification 1 root | Web
Sites | Acme Retail Web Site

Classification 1 root | Web
Sites | Acme Retail Web Site

Classification 1root | Web
Sites | Acme Retail Web Site

Classification 1
Sites | Acme Ret

Category > || Apparel | Mens Casual | || Apparel | Mens Casual | || Apparel | Mens Casual | || Apparel | Mens Casual | || Apparel | Mens
[ Automotive T-shirts and Sweatshirts | [ T-shirts and Sweatshirts |  T-shirts and Sweatshirts | [T-shirts and Sweatshirts | [T-shirts and Swe
18207-012 18214-012 18215-012 18217-012 18217-054
B#-{ 7] Buiding and Electrical Products Object Type > |Sales Ttem Sales Ttem Sales Item Sales Item Sales Ttem
- Entity Root Parent > [T-shirts T-shirts T-shirts T-shirts T-shirts
E-(0) GDSN ||Produtt Variant Priority >
[]---ﬁ Publications IlReleased by N
[-[IF] Primary Product Hierarchy ||5131us S
1[5 Collections ORL . v
-3 eCatalogs = S
[]--ﬁ Recyde Bin v > Add Product

Data can be edited on the products linked into a classification from the Sub Products tab by clicking directly into
any editable field. Standard editing capabilities are available within this interface (as described in the Editing
Objects in the Tree Tab topic within this guide), including copy / paste functionality using Crtl + C and Crtl + V.
Right-clicking on any field within the table will expose additional options, including Copy, Paste, Hide Equal, and
Mark Different selections - all of which are self-explanatory and can be especially useful when editing multiple
objects.
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Two views are available using the Rotate Table option. As shown above, the view can be organized to have
attributes on the vertical axis. As shown below, the table can also display products on the vertical axis. Right-
clicking within the header field exposes different options than within the data fields, including options to add and
remove products.
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Selecting Remove Product deletes the product to classification link between the objects, but does not delete

the product itself.

Selecting Add Product opens a dialog allowing the user to browse hierarchies to select a product to link, as well

as specifying the link type to be applied.

D Select Classification Product Link >
EH'_=| pper Body Wear ~
[+~ [ Scarves
--|'_'=| Sweaters
=[5 T-shirts
[+l T-shirts Items
(=H[IT) T-Shirts Sales Items
i | 1009143
----- | 198523
----- |..| 133409
----- |.. [18207-011 v
@ Details
Link Type | website Link v
Caneel

Note that the same functionality is available using the Add Product link at the bottom of the Sub Products editor.

References

The References tab is where all references of which the selected object is the source can be viewed and edited
(assuming proper privileges are in place). In addition, if the object has privileges applied, has objects visible in
other contexts, or has any linked attributes, that information can be viewed (and in some cases edited) on this

tab.

The display of the References tab on a classification will vary slightly from system to system, based on the data
model. If the selected object has classification reference types for which the object is a valid source, those will

appear on this tab, in addition to the default flipper options.
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T-shirts and Sweatshirts rev.0.5 - References

[-[T] Assets ~ Classification || Sub Products Referenced By || Images & Documents || Tables || Status || State Log || Tasks
(5 Canursons Gower

r_=| ETIM Hierarchy
|'_'=| Index Words
[+ Merchandising Hierarchy |

Reference Type w| » [Target 2>

> |Classification Reference  + (B

B+ Suppliers o}
E||j Web Sites &Ref&reno& Type ~| * [Target S
Ellj Acme Retal Web Site | » |Related Web Classification  + ¥ [=] Mens Tops El
=[] Apparel
£ [ Mens Casual G Appledprivieges
[l Caps ques to > |Action Set > |Attribute Group > |Object Type » |Group » |Language > |Country >

Il » [T] T-shirts and SweatshirtClassify Products Merchandiser Managers|<ANY = <ANY =
| add Priviege

?

Mo Visible Objects in Other Contexts

§awbuoes
D > [Name > |Attribute Groups » |Mandatory ¥ (Inherited from »
-] Automotive ¥ LCalor Color Apparel
B-{ ] Building and Electrical Products * fize Size 1
- Entity Root [ |Link to Attribute

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid source that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by
clicking the (+) on the reference. This will open a dialog allowing the user to select a target for the reference,
and a reference will be created to the object selected in the dialog from the currently selected object that you
are standing on (e.g., current object = source, dialog selection = target). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the
(X) on any existing reference. Additional information on configuring and working with references is available
in the Reference and Link Types topicin the System Setup documentation.

2. Ungrouped Classification References: The functionality is identical to what is described for the
Reference Flippers section above. The only difference is that this area displays references that have not been
placed in attribute groups for display purposes. If all references that are valid for the selected object have
been placed in attribute groups, the Ungrouped Classification References flipper will not be present.

3. The Applied Privileges flipper allows users to apply privileges to the selected classification. Detailed
information on creating and editing privileges is available in the Privilege Rules section of the System
Setup documentation.

4. The Visible Objects in Other Contexts flipper displays subproducts that are visible in another context,
which is only applicable if classification hierarchies have been set to be dimension-dependent in System
Settings. Refer to the Classification Hierarchy Settings topicin the System Setup documentation for
detailed information.

5. The Attributes flipper allows the user to view attributes linked to the classification, as well as to add new links
using the Link to Attribute link. When attributes are linked to a classification, they are available to be
populated on any objects of the product super type that reference the classification (assuming the attributes
are also made valid on the applicable product object type). The exact columns available will depend on the
data model and the attributes that have been made valid on the attribute links. Whether or not the various
attributes are editable will also depend on the setup of the data model. However, an ID and Name field are
always shown, with the attribute name being a hyperlink that can be used to navigate directly to the attribute.
An Attribute Groups column is also present, displaying the attribute group(s) that the attribute isin. A
Mandatory column is present and if checked, product objects that reference the classification cannot be
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approved until a value has been provided for the attribute. Note that mandatory settings on the attribute itself
apply globally, while mandatory settings on the attribute link apply only to product objects that reference the
classification at which the attribute is linked (or reference a classification that is inheriting the link). More
information on mandatory settings is available in the Mandatory Attributes topic in the System Setup. If the
attribute link is inherited (indicated by a green down arrow, =, in the row indicator), the 'Inherited from' column
will display the parental node where the attribute has been linked, which is hyperlinked for easy navigation.
More information on linked attributes is available in the Inheritance in the Product Hierarchy topic within this
guide and in the Attribute Links topic in the System Setup documentation.

Referenced By

The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects that
the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). In
addition, if the object is used by a match code or is used by any publication, that information can be viewed on this
tab.

The display of the Referenced By tab on a product will vary slightly from system to system, based on the data
model.

T-shirts and Sweatshirts rev.0.5 - Referenced By

Elj Acme Retail Web Site ~ Classification || Sub Products || References |BREEGEIMZ M| Images & Documents || Tables || Status || StateLog || Tasks
=[] Apparel o
EH[T] Mens Casual =k
: Reference Type v| » |Source > >
s
7] Mens Tops Classification Reference + [
& [ T-shirts and Sweatshirts © Ungrouped Referenced by Products, Classifications or Entities
""" I— 18214012 |F'.ef'erence Type > |Source > | »
----- |_ 13215012
IL 18217012 @ Used by Match Code Objects
----- |_ 13217054 |ID > |NamE * |
L ....|;_=|t°Won;ens Apparel @ UsedonP
5] Automotive |Pub|icah'on >|l-'ersion >|Page >|Area Used >|Page Type

(- =] Building and Electrical Products

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid source that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by
clicking the (+) on the reference. This will open a dialog allowing the user to select a target for the reference,
and a reference will be created from the object selected in the dialog to the currently selected object that you
are standing on (e.g., current object = target, dialog selection = source). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the
(X) on any existing reference. Additional information on configuring and working with references is available
in the Reference and Link Types topic in the System Setup documentation.

2. Ungrouped Referenced by Products, Classifications or Entities: The functionality is identical to what
is described for the Reference Flippers section above. The only difference is that this area displays
references that have not been placed in attribute groups for display purposes.

3. Used by Match Code Objects: If the selected object is the Category indicated in a match code, the match
code will display. For example:
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System Setup Find Similar - Match Code
E]E Match Codes and Matching Algorithms "~ Match Code Values || Statistics || Log
o s T '
. o] Find Similar
[_“_E; Outbound Integration Endpoints Mame >| > |Value
[+ Web Uls » ID FindSimilar
LDE Workflow Profiles > Mame Find Similar
-5 Warkflows -
=] Derived Events > Last edited by 2017-01-24 12:34:34 by USERG
%’ Object Types & Structures » [Category T-shirts and Sweatshirts (22586)
- L) Tags » Match Code Window Size 1
== fr-shirts and Sweatshirts| @ Used by Match Code Objects
Nl 18214012 D > IName > [Edited by >
-l 18215012 > Findsimilar Find Similar  [2017-01-24 12:34:34 by USER6

More information on match codes is available in the Matching, Linking, and Merging documentation.

4. Used on Page: Displays publications that the selected object is used in. Additional information about
working with publications is available in the Publication Hierarchy section of the Publisher (Adobe
InDesign Integration) documentation.

Images & Documents

The Images & Documents tab displays all assets that are child to the selected classification (e.g., all assets that
are housed within that classification). Note that assets can be tied to classifications in two ways: as child
products, or via image and document references. Assets are typically referenced to classifications only when the
classification contains non-asset children for which the asset is relevant. In any case, assets referenced to
classifications are not visible on the Images & Documents tab. This is in contrast to how the same tab functions
for products, where the tab displays all assets referenced to the selected product. However, for the displayed
assets (those that are child to the classification), the functionality available for interacting with the assets is the
same as what is available for referenced assets on a product, which is described in the Images and
Documents Tab topic in the Products section of this guide.

Tables

The Tables tab allows users to view and edit the tables defined for the object. Tables are generally used to
present consolidated data across multiple objects, such as object name, part number, and price. For more
information, refer to the Tables guide.

Status

The Status tab provides information about the status of the object, including revision history, translation status,
and approval status. Products and classifications share a common Status tab, which is described in the Status
Tab topic in the Products section of this guide.
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State Log

The State Log tab displays the history of the selected object across all workflows. If the object has ever beenin a
workflow, a flipper is displayed per workflow and the history of transitions of the object within that workflow can
be viewed. Detailed information on the State Log tab is available in the State Log Tab topic in the Workflows
guide.

Tasks

The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's privileges
(only tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place,
the user is able to act on the tasks from this editor, including to edit data and move tasks through the workflow.
More information on the Tasks tab is available in the Moving Tasks through a Workflow in Workbench topic
in the Workflows guide.
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Collections

Collections provide a valuable tool for data maintenance tasks. Collections are containers for storing sets of
objects from Tree and System Setup, independently of their placement in the hierarchies. A collection can be
created via a search or import, and all objects in a collection can be updated at the same time. Collections and
collection groups are found in the Collections hierarchy on the Tree tab.

When multiple collections need to be grouped together, they can be put into a 'collection group'. Collection
groups can also hold other collection groups. Refer to Creating Collections or Creating Collection Groups
in this documentation for more information on each topic.

Tree
1‘_=| Primary Product Hierarchy
EI@ Collections
B[] AllPPH

=8

- [5] Copy Writing State
EE}--@ Temporary Collections
[—]--@ Tshirt Group

El@ Men's Tshirts

. B3 Size Medium

----- 8 12-6eK7s

For more on data maintenance of collections and collection groups, refer to the Maintaining Collections topic.

Temporary Collections

The Temporary Collections node is system-generated to store read-only collections created by a process, such
as bulk update background processes, exports, profiles, and Web Ul basket. The right-click menu on this node
does not allow manual creation of new user collections nor deletion of existing temporary collections.

Temporary collections created by background processes (BGPs) are deleted automatically via the case-
sensitive sharedconfig.properties file entry AutoDeleteBackgroundProcesses.AgelnHours.
[processname]=[hours] when the BGPs are deleted. In this setting, the [processname] designation is
replaced with the name of the BGP and the [hours] designation is how long to wait before deleting BGPs. For
more information on this setting property, refer to the Create a Background Processes Maintenance Plan
topic within the System Administration documentation.
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For example, running a bulk update BGP creates three temporary collections. Setting the
AutoDeleteBackgroundProcesses property with 'BulkUpdate' as [processname] allows the related bulk update
temporary collections to be deleted when the bulk update BGPs are deleted, based on the [hours] setting.

Manually deleting temporary collections is necessary when background processes have been manually deleted.
On the Maintain menu, click 'Force Delete & Purge' and select one of the following options:

« 'Purge collection contents' - removes the contents of the collection but does not remove the root node.
« 'Purge collection node' - removes the contents of the collection and also deletes the collection root node.
Dimension Dependency and Collections

Collections and search results are dimension dependent. A search in one context can display different objects
than the same search in another context.

The following example illustrates how creating a collection from search results can return different objects, based
on the dimension dependent values in the context being searched.

This search is performed in the 'English US' context for the value 'red' in the 'Color (Color)' attribute. The search
finds four objects with the value.

‘Cnntegt ‘Eﬂglish Us ‘ v | € —» O urL [sid3=1799288contes

<
|'lm m References || Referenced By
| ﬂ

Color (Color) = Red

& Advanced
D * |Color >
9F | Reset || Search | |pName > ID Calor
Displaying 4 of 4 results Show Details | || 12-GGKS0 » 182922 Red
ame » || |[Mens T PBG * (179916 Red
Mens T POY > MT 18404 Red
Womens TPOY w Class > (179928 Fed

One of those objects has a translated value of 'rojo’ for the language dimension point in the 'US Spanish' context.
the other objects have no value for the attribute.

€ 12-GGKB80 rev.0.9 - Compare Contexts | |

Compare Contexts References | Referenced By
* |English LIS * |English Canada  * |English LIK >[Us Spanish »
> D 182922 152922 1832922 182922
> Mame 12-GGEKS0 12-GGEKS0 12-GGKE0 12-GGKA0
» Color Red Red Red Fojo
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Performing the search again in the 'US Spanish' context returns no records since the value of 'red' does not exist
for any of the records in the searched context.

Context |US Spanish Vi € Cur | |=]=]=t ] Goto | TD/Nzme
< Search Result Profiling

[Sesrch

Pﬂﬂlﬂr (Color) = Red ﬂ Search Result Profiling
& advanced 0 hit(s)

(g | Reset | | Search |

Displaying 0 of 0 results Show Details

[ Mame >
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Creating Collections

In workbench, collections can be created in two ways:

1. Using the Search tab, perform a search, and create a collection of the results
2. Using animportfile, create a collection of the contents

Regardless of how they are created, if a collection contains less than 10,000 objects, these can be inspected in
the Tree hierarchy by expanding the Collection node. The collection will be displayed in an entirely flat structure
regardless of any parent-child relations that may exist between the objects, and regardless of which parents /
children the objects have when viewed elsewhere in STEP.

Note: While this topic and the Collections section do not address Web Ul functionality, it is important to note
that the Web Ul Collection Content Screen also has the same 10,000 object restriction to allow for the best
performance.

In Web Ul, objects can be manually added to and removed from a collection. This functionality is not available in
the workbench.

Creating a Collection from Search

The most common way to create a collection is through creating a search. To do so, follow the steps below.

1. Navigate to the Search tab, enter in the needed search criteria, and click Search to verify the results. For
more on how to search, refer to the Navigating and Searching topic in the Getting Started
documentation.

2. Click the Save as Collection button.
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Search Below
’VFIashIights Items (20359) ﬂ
=
Displaying & of & results Show Details
Mame

I Blue and Purple Flashlight /D = 134557
I flashlight case 10 = 129555

I Flashlight C Batteries JD = 1705582

Bl Flashlights Ttems [0 = F0855

¥ pink Flashlight D = 19133

¥ Red flashlight D = 174554

-Operations on Entire Result
oL@ E

|Save as Cn:nlled:in:nn|

3. Select the appropriate parent in the collections hierarchy (either the top collections folder itself, or a
collections group folder), enter a collection name (the ID is autogenerated), and click OK.

[ | Save as Collection in Background Process ¢

=5 Collections ~
- []] Addresses

(5 Alltems

- 5] AllPPH

- Details

Collection ID 411276

Collection Mame |Flashlights

Cancel

4. Abackground process runs, and the new collection is created and saved under the specified folder.
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Tree
r_=| Primary Product Hierarchy
EI@ Collections
- (5 Al PPH
-- {5 Bottled Water

= 0 Feshighs|
- {8 Blue and Purple Flashlight

E flashlight case

-\ Flashlight C Batteries
‘ Flashlight Items

- {{® Pirk Flashlight

| Red flashlight

5. Right-click the collection, and run any needed bulk update, or export the objects.

Note: The initial search criteria used to locate the included objects is stored on the collection, which allows for
later updates of the collection. To learn more about editing searches to update collections refer to the
Maintaining Collections topic.

Creating a Collection from File Import

Collections can be created from a text or CSV import file containing STEP IDs of products, assets, or
classifications. Objects in the import file must already exist as the import will not create or update objects, only
place them in a collection.

Important: If the import file includes only attribute values or unique keys of the products, assets, or
classifications to be added to the collection (and does not include the STEP ID), you must use the above
steps for Creating a Collection from Search.

To create a collection from a file:

1. Inthe Tree, right-click the Collections top node or a collection group to determine where the new collection
will be saved, and select Create Collection From File....
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r_=| Merchandising Hierarchy
r_=| Suppliers

[+ 7] Web Sites

-] Entity Root

1[0 GDSN

ﬁ Publications

r_=| Primary Product Hierarchy

-5 Collectione
(+1-[E0 eCatalos Create Collection Group...
ﬁ Recydle Create Collection From File...
¥ Delete
Search Below

In the Create Collection From File dialog, locate the file to be imported.
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The Collection ID is autogenerated
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3. Forthe Collection Name parameter, add a Name for the new collection.
4. Forthe File Contains parameter, select if the import file contains IDs of products, classifications, or assets.
5. Click OK to start a background process which will create the new collection.
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Creating Collection Groups

Collection groups are containers that can hold collections or other collection groups. Below are instructions for
configuring collection groups.

Creating a Collection Group

1. Depending on where you want the collection group to live, either right-click the top-level Collections node or
an existing collection group in Tree and select Create Collection Group....

F-[2] Article Groups

|j Assets

|j Bulk Update Configurations
rj Classifications

rj Configurations

-- s* eClass 9.1

&[5 UNSPSC

- [Z] Web Sites US

@ ACME Customers

[+ [I5) Primary Product Hierarchy
- [ Collections
(-1 eCatalog & Create Collection Group...
ﬁ Recyde

5] Create Collection From File...
> Delete

Search Below

[ ” Bookmarks " System Setup ” BG Processes ” Search ]

2. Inthe'Create Collection Group' dialog enter a Name (ID is autogenerated) for the new group.
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a[ System Setup ” BG Processes ” Search ]

E-{ 7] Assets

r_=| Configurations
r_=| ETIM Hierarchy
r_=| Index Words

r_=| Suppliers

-] Web Sites

[+ i) Entity Root
[#-[C) GDSN

&) Publications
r_=| Primary Product H
[ Collections

(3 eCatalogs

'ﬁ Recyde Bin

Click OK.

r_=| Merchandising Hierarchy

Collection Group
' Description

Mame

> D

* Mame

[ Create Collection Group

D 411225

Mame |Mew_Products

Cancel
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Once created, collection groups can be selected to hold new collections, or more collection groups can be
created under them. For more on how to create collections, refer to Creating Collections in this
documentation.

Tree
=) Primary Product Hierarchy

EI@ Collections

- 5] Copy Writing State

E}-@ Temporary Collections

=+ Tshirt Group

= Men's Tshirts

. B[ Size Medium
- | 12-GGKT3

™ 12-GGKED

{13210 M B
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Maintaining Collections

Collections can be a valuable tool for data maintenance tasks, because they allow a user to group objects
independently of their placement in the hierarchies, and they can be updated. As an example, a set of objects
with data anomalies could be grouped in a collection via search criteria. Once the data is corrected, the objects
with updated information no longer meet the search criteria. Thus updating the collection automatically removes
any updated / fixed objects from the collection. In this way, only the objects that still need to be fixed are displayed
in the collection.

This topic addresses the various ways users can interact with and maintain collections.

o Delete

» Edit Search Criteria
« Export Data Below
o Refresh Data

o RunBulk Update

o Republish

o Search Below

Collections can also be maintained via the Web Ul. For more information, refer to the Collection Content
Screen section of the Web User Interfaces documentation.

Delete

Clicking on the Delete option deletes the Collection node, but does not delete the objects within the Collection.
They will still reside under their original nodes in Tree and System Setup. All collections and collection groups
below a collection group must be deleted before the parent collection group can be deleted.

Important: If an object is deleted from the collection, then the same object will be deleted from the original
hierarchy placement in STEP as well. In this case, it would be best to just updated the collection through
proper maintenance of collections such as through an updated search or a bulk update.

To delete the collection node, right-click on the desired collection and select Delete.
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- 8 Digital Asset Edit Search Criteria...

B [5] Flashlight ©

- 5 Group2 7 Delete
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< Search Below
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Additionally collections and collection groups can also be deleted from the Maintain menu, Delete option.

File Edit View Mavigate Formnat |Maintain Window Help

| I Context | English US e

" w]l||[m O FrocLiCTs
[+ Electrical & Electr
1‘_=| Food and Bevera
1__=| Kitchen

1'_=| Party Supplies
- Discontinued Product
[ Product COverrides
[l Packaging

Tree

(=il GD5M Products
-3 Collections

- (5 Assets made with Sez
- [ Copy Writing State
=} || Cotton T-shirts
- 13210 M B

” System Setup ” BG Processes (2] ” Search ]

[+ [Z] Digital Asset Review
#- [ Flashlight Collection
#- 5 Group2

Bookmarks

Insert
Link
Merge

Delete

i i

(=1}

Force Delefp—=-0 -
I||:fh.=-_||e1:va a selection

Unlink Object Type

Duplicate

Duplicate Recursively
Make Revision

Approval

Enable group for workflows

Revive

Revive Recursively
Truncate log...

Migrate Attribute Values

Ctrl+l

For more on creating searches, refer to the Navigating and Searching documentation.

For more on how to use bulk updates, refer to the Bulk Updates documentation.
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Edit Search Criteria

Collections created from searches can be edited if needed to reflect the needed objects in the collection.

1. Todo so, right-click on the collection and select Edit Search Criteria.

Tree
-3 Collections
-- (] Assets made with Search
i (5 Copy Writing State
E} 8 Cotton

%} Run Bulk Update

ik Export Data Below
Republish...
Refresh

- 5] Digital A

. § Flashiig Edit Search Critena...
G- 5 Group2
.. 8 Party H ~ Delete

- [ PetHat:
- [ Product

Search Below

2. Once selected, the user will be brought to the Search tab where they can examine the original search criteria,
and modify the search criteria if necessary.

IVSean:h Belnw Cotton T-shirts

= Db]En:tTypE—Item Family

(g | Save || Reset || Search |
Show Details

| Mame > ]

-Operations on Entire Result

Alternatively, if a collection was created using a search criteria, the 'Search URL' will appear in the collection's
Description flipper under the Search URL field. The user just needs to copy and paste this information into a
browser, and they will be brought to the Search tab with the original search criteria on it where they can make
adjustments if needed.
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Cotton T-shirts - Collection

Tree <
| SEEGT | Daka Profile | Log

E Product Overrides ~
= [ Padaging ¢ Desaripton
-l GDSN Products — >1> Val
=3 Collections Miame Value
G- [J Assets made with Search > [D 112803
B [ Copy Writing State > Name Cotton T-shirts
= Coth -zhirts
E 8 * Estimated Amount of Obje... 5
. - 13210 MB
E 18212 LE * Bearch URL step: f{search?args0.0=topnodetype % 3dproduct%e2ctopnodeid %34
- 18213M O > Last edited By 2017-08-17 16:48:25 by USERL
B =zsio OSatstes
: E InDesign W
£ > £ >

For more information on searches, refer to the Navigation and Search topic in the Getting Started
documentation.

Export Data Below

The Export Manager wizard allows a user to export data on demand and to create or modify an export
configuration.

1. Ifauser wishes to export all objects in the selected collection based on the selected format and the mapped
data, they can right-click on the collection and select Export Data Below.

=123 Collections
[+ [0 Assets made with Search
- 3 Copy Writing State

=8 @M@* Run Bulk Update
ﬁ 12121 ef d& Export Data Below
-8 18213M ¢ Republish...
E- D.;éi;? ilsjeLti Refresh
g g Elis:liiht Col Edit Search Criteria...
- 5 PartypHats 7 Delete
~ [ PetHats Search Below

2. Selecting this option will launch the Export Manager where a user can fill out the proceeding steps as needed.
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[ Export Manager =
Steps Select Format

1. Select Configuration ||=_K,:e4 >

2. Select Objects _

3. col Exports data in Excel format,

4, Map Data Excel version | Eycel 2007 v

5, Advanced

6. Select Delivery Method

| Back | | Next | Finsh | | Cancel |

For more information on exporting, refer to the Creating a Data Export topic in the Data Exchange
documentation.

Refresh Data

Collections created from search results can be updated for the most up-to-date information and object
groupings, as objects in a collection that no longer meet the search criteria will be removed from the collection.

« Tostart arefresh in workbench, right-click on the collection and select Refresh.

Tree
=[5 Collections
-- [ Assets made with Search
- (5 Copy Writing State
E} I} Cotton T-shirts
ﬁ 1821 @ Fun Bulk Update
ﬁ 1821 4 Export Data Below

E 1871 Republish...

- [ Digital As Refresh

- (5 Flashiight

.. i Group2 Edit Search Criteria...
B [ PartyHal 3 Delete

- [ PetHats

-- = Products Search Below

Note: The 'Refresh' option is Only available if the collection is created from a search.

« Tostartarefreshin Web Ul, go to the collection content screen, select the desired collection, and click the
Refresh collection action.
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Collection Detall

51 Clear all El‘ Export ﬁ Refresh collection

Mame - Object Type - Fath

Primary Product | "™

Hierarchy/Produc
Root/Apparel
JJpper Body

18210 M B_EN ltem Wear/T-shirts/T-
shirts ltems/Polo
T-shirt/18210 M
B_ENM

Note: For more on how to setup a refresh in Web Ul, refer to the Scheduling a Collection Refresh in
Web Ul topicin the Bulk Updates documentation.

Run Bulk Update

This option allows the user to interact with the objects in the collection in a number of ways. To name a few, the
objects could be submitted into a workflow, assigned to a user group, or have an attribute updated.

1. Right-click the desired collection and select Run Bulk Updates.

-3 Collections
(- (7 Assets made with Search
- [3 Copy Writing State

=8 [f] Cotton T-shi=

-4 1520 ®] Run Bulk Update
ﬁ 182121 | @ Export Data Below
E i:ig [1 Republish...

[+ [3] Digital Asset Refresh

G- [5 Flashlight Ca _ o

& (5 Group2 Edit Search Criteria...

&- [ PartyHats | #% Delete

- [3 PetHats

Search Below
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2. Complete the steps in the Bulk Update wizard to make the same updates to all objects in the collection.

[ Bulk Update b4

Steps Configuration

1. Configuration
2. Operations
3. Parameters
<4 Preview (®) Create New Configuration

5. Advanced

O IIse Existing Configuration

Back Next Fiish

For more on how to use the bulk update wizard, and the various operations that can be applied to collections or a
group of collections, refer to the Bulk Update documentation.

For information on how to schedule bulk updates for collections in Web Ul, refer to the Scheduling a
Collection Refresh in Web Ul topic in the Bulk Updates documentation.

Republish

The Republish action generates events on products, classifications, or assets in the collection. Common setup is
to use this option for on-demand creation of a republished event. For example, to generate events for all objects
in a collection that has never been published by an event queue.

For more information on events, refer to the Events topic in the System Setup documentation.

1. Torepublish an event, right-click on the desired collection and select Republish....

= Collections
- () Assets made with Search
- (@ Copy Writing State

=+ [J] Cotton T-shirtz __,
%] Run Bulk Update

- 18210 MB
™ 1321218 & Export Data Below
E 18213 M Republizh..
L 13216 L O
[+}- a Digital Asset R el
- (0 Flashight Coll Edit Search Criteria...
G- [ Group2
[+ [0 Party Hats X Delete
-5 PetHats

Search Below

Note: Users must have the privilege to maintain event queues in order to use this action.
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2. Clicking the action launches a wizard where users can choose the appropriate event queue from the

dropdown menu.

™ Republish collection

Republish to event queue:

Process Description:

>
TtemAdvSTEPKML e
TtemAdvSTEPKML ~
OVEventGenerationTest
eafPublishingEx W

Republish collection: Cotton T-shirts

Republish Cancel

3. Users can also enter in a Process Description to give a name to the background process, which can be
monitored in the 'Republish Node'.

BG Processes

i <)

5 Republish nodes
% Queued Processes

-5 Active Processes
E}--% Ended Processes

Search Below

If a certain attribute on some of the items in the selected collection needed to be changed, a user could use this to

locate the items.

When a user right-clicks on a collection and selects Search Below, it allows the user to search only the items in

that particular collection.
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=I5 Collections
-- {5 Assets made with Search
G- {5 Copy Writing State

Ea E.llﬁi;l-?: % Run Bulk Update
E 18212 L ik Export Data Below
- 18213 M Republish...

E 18216 Refresh
E InDiesigr

& [J) Digital Asset Edit Search Criteria...

- [ Flashlight Cq % Delete

- [ Group2 :

i@ Party Hats Search Below

. (5 Pat Hate

Refer to the Navigating and Searching topic in the Getting Started documentation.
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Collection Properties and Statistics

Working with and viewing the collections properties, collection statistics, Data Profile tab, or the Log tab can
provide a quick overview of the collection itself, and useful information in regards to the objects it holds.

Collection Tab

The Description and Statistics flippers provide information about the selected collection. Below the flippers are
described in more detail.

Products with Assets - Collection

1 5 P i WIS | Data Profile || Log
""" 2 1 § Desarpton
-\ 20801 .

E 20803 Mame | » |Value
ﬁ 0803-03 » D 114506
E 20305 » Mame Products with Assets
..... 444443
i * Estimated Amount of Obje. .. 28
----- g 4944441
..... CAEEEEEETS * Search URL step: fsearch?args0. 0 =topnodetype ¥:3dattributegroup ¥ 2ctopnodeid 36 3dAttribute
----- ﬁ 444445 * Last edited By 2016-12-05 09:36:43 by USERL

R e e Caps TS @ iaBitien 1

..... £33 (AttributeGroup)

..... T (attrsize) Collection Content

..... i .[p,ttrTfshirtSize} 28 object(s)
..... [ (attwithLangDeplod  potice: Objects in Collection may be hidden in Tree due to Context\Workspace visibility andfor privilege ch
----- [T (color, Interior)

..... 1T Hazmat) Content by Object Type
..... 1T (Hazmatym) Product {(10)
..... (I (Marketing Descriptia
..... DI (ReferenceAttribute g ::emf’:}a
..... Em
..... 13 Releasedsy) & ltems (1)
[T (selingPrice) L& Item2 (1)
..... 3 {ShippingREStriCﬁﬂﬂﬂ C& ltem3 (1)
..... H% E.zle} ) Il 'tem Folder (1)
..... alue
..... [T value3) Attribute (17)
v | specittpes

- [7] Sample Search Collection ¥ Attribute Group (1)

Description Flipper

This displays information about the collection:
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Party Hats - Collection

Data Profile [m
®Desopton
Mame > |alue »

* D 111807

¥ Mame Party Hats

* Estimated Amount of Ohie. .. 4

* Gearch URL step: /fsearch?args0. 0 =topnodetype%63dproduct®e2ctopnodeid %%3d 12 11898searchi. 0=BelowCriteria

* Last edited By 2016-08-22 11:53:40 by LUSER3

ID: Shows the collection ID, which is auto generated.
Name: Shows the name of the collection.

Estimated Amount of Objects: Displays the total number of objects in the collection based on the latest
'Refresh’ of the collection. The count is not filtered according to Context / Workspace visibility, privilege
checks, or object types.

Search URL: Displays only on collections created from a search result. A user can copy the URL, paste it
into the URL field, press ENTER, and observe the search in the Search tab. Itis possible to edit the search if
needed. For more on searching refer to the Navigating and Searching topics in this documentation.

Last edited By: Displays the date and time and user who last worked on the collection.

Statistics Flipper

The Statistics flipper gives an overview of which type of objects are included in the selected collection.
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Products with Assets - Collection

E} 7= i At Data Profile || Log
----- W 114413 @ Desaipton

- 20801 Name > > |Value
-8 20803 > D 114506
8 20803-03
E 20805 * Mame Products with Assets
..... Bd 499443 » Estimated Amount of Obje... 28
""" i » Search URL step: fjsearch?args0. 0=topnodetype 2t 3dattributegroup % 2ctopnodeid®: 3dAttributeGrou
----- 4444445
ﬁ » Last edited By 2016-12-05 09:36:43 by USERL
..... ﬁ 444445

-l Hats and Caps Tter| @ Staisties

----- 31 (attributeGroup)
----- [T (attributen) Collection Content

----- 0T (attrTshirtsize) | 28 ODject(s) . o o y
Motice: Objects in Collection may be hidden in Tree due to ContextWorkspace visibility and/or privilege checks

----- [T (color, Interior) Content by Object Type

..... DI {Hazmat}

..... T Hazmatvn) Product (10)

----- [T (Marketing Descrip ltem (4)

----- [T (Referenceattribuf ltermnd (2)

..... [T (Releasedsy) CH ltem5 (1)

----- [T (selingPrice) G tem2 (1)

----- 1T (ShippingRestrictio & tem3 (1)

_____ 0T (size) Bl ltem Folder (1)
----- [T (valuez) Attribute (17)

..... Di {ua|ue3)

----- [1F condition attribute| Special types (1)

----- [F value1 G Attribute Group (1)

In addition to breaking down the objects by type, it will also display the exact number of objects in the entire
collection based on the latest 'Refresh’ of the collection.

Note: While actually viewing the collection in Tree, it may appear that there are fewer objects in the collection
then what is reported by the Estimated Amount of Objects field under the Description flipper or the total
objects reported under the Statistics flipper. Examples of why this may happen could be because some
objects are not approved for the workspace the user is currently in, and thus do not show, or it could be due to
privileges.

Data Profile Tab

The Data Profile tab can display a dashboard to provide a graphical representation of the objects that are in the
collection. This can be modified based on the user's requirement.
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=] Primary Product Hierarchy
[ Collections

- 3 AllPPH

- |71 Backplate

- [7] Baskets

- [ Bottled Water
- EVN-06

-~ [F Collection ¥LS

- [3] CommDatalist

- [3 CommDataProducts

- [3 Copy Writing State

- [3 Cotton Shirts with DK D
- |31 Data Quality Collection
- |7 Digital Asset Review 5t
- |3 Flashlights

- |3 Hats

- [7] Hats & Caps

- |7 OrderProcess2

- |71 Sample Search Collectio
- [7] Shoes

-[53 Temporary Collections

<

Data Profile

Collection |FLEEENEGIIEE | Lag
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Generated: Mon Mov 28 2016 14:24 Update Profile

(®) Dashboard () Value Details

Object Count

4

ohjects

() Reference Details

Translation Status

- ot T sl (943

Least Complete Attribwutes

Jattribute » [Completeness »
IHarmunizaﬁun ver | 0%
IDismnﬁnued 0%
IProduct Name 0%

0%

Width (range)

]

v

Approval Status

Pty S ol (53
. ot Ao (4R

Most Complete Attributes

Attribute >

Completeness  »

selling Unit of ...

100%0

IManufacturer ...

100%0

|Country of Origin

100%0

|Erand Name
| |

100%0

]

Ohbject Type Count

- e ()

If a profile has never been created, a user can click on the Generate Profile link to create the collection's
Dashboard.

Collection [ Log ]

Generate Profile

Dashboard

Value Details

Reference Details

If it has already been created, it is recommended to update the profile when viewing if it has not been updated
recently.

Collection [ Log ]

Generated: Mon Mov 28 2016 14:24)Update Profile

(®) Dashboard () Value Details

i) Reference Details

For more information on how dashboards and data profiling work, refer to the Data Profiling documentation.
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Log Tab

The Log displays details about the creation and modification of the collection, details about which user performed
what actions, and the number of objects in a collection when a collection is refreshed.

Tree L 4 Bottled Water - Log

B-{I5) Primary Product Hierarchy Collection | Data Profile

EE@ Collections Showing page 1 of 1
B (5 AllPPH 2016-09-15 15:14:45 'USERT: Created
G+ [ Backplate 2016-09-15 15:14:45 'USERT: Mame modified from 'null
-- |=] Baskets 2016-09-15 15:14:45 'USERT: Collection refreshed, number of objects: 4

= I} Bottled Water 2016-11-23 15:25:24 'USERL": Collection refreshed, number of objects: 4
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Entities

This topic covers information specific to the Entity super type that is important to know when working with
entities. For general object maintenance information (applicable to all object types rather than specific to
entities), refer to the All Objects topic within this guide.

A STEP entity can be any object not defined as a product. Entities are commonly used to model customer-
related data, such as contacts, addresses, markets, or customers, though they can be used for any number of
data modeling scenarios, including modeling of reference data.

Entities differ from products in that they do not contain all of the product-specific functionality like specification
attributes, value inheritance, or tables. As entities can only use description attributes, the application of category-
specific attributes is not supported. Therefore, attributes are applied to entities strictly via object type validity and
all entity instances of a particular object type will have the same attributes available for population. Additionally,
entity handling is limited for publishing (e.g., as part of print publishing solutions as defined in the Publisher
(Adobe InDesign Integration) documentation), and you cannot translate entities using a background process.

Entities may or may not be subject to approval, dependent upon the revisability settings (globally revisable
entities are the same in the Main and Approved workspaces, while workspace revisable entities adhere to
standard approval concepts). This provides a great deal of freedom in determining how entities are handled,
specifically in terms of how events are generated and processed. For more information, refer to the Revisability
on Entity Object Types section of the Getting Started documentation or the Events section of the System
Setup documentation.

Entities cannot be linked into classifications, though configuration of entity references allows for determination of
a hierarchical display (with source displayed as child to target, or vice versa). In effect, this makes classifications
unnecessary for use with entities as entities can be classified via entities. Additional information on this is
available in the Entity Reference Types section of the System Setup documentation.

However, entities do retain the standard data modeling capabilities and provide even more configurability. The
Revisability parameter allows you to define an entity object type that does not have to be approved and also
determines how events are processed.

Entity Hierarchy

Any number of entity hierarchies can be added to any system. For example, you may set up address hierarchies,
customer hierarchies, market hierarchies, and so on. Entities are represented by icons chosen as part of the
implementation process and will likely differ on each system. The following is an example of an entity hierarchy.
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=il Entity Root

E}% Customer Hierarchy

L——_Ig Customer A

ﬂ' Axel Kiers Vej 11

Jesper Jensen

= B Customer B
...}y 3550 George Busbhee Pkwy
John Smith

----- 2 Customer C

,_-ﬁ Key Accounts

For more information on hierarchy setup, refer to the Object Types and Structures section of the System
Setup documentation.

Entity Editor

Once the entity hierarchy is created and description attributes are applied to the entity object types, the next
logical step is to start entering values.

Note: Only description attributes can be applied to an entity object types and will appear in the entity editor.
Specification attributes are not allowed on entities.

v r_=| Assets References || Referenced By || Status || StateLog || Tasks

gl Ccontorson Qomogen
: rj Index Words Name 5|3 |Value

2| [+ Merchandising Hierarch

| B[] Merchandising Y > ID ADD_101571

wil | -] Suppliers

i r_=| Web Sites » Name el Kiers Vej 11

21| - Entity Root > Object Type Address

0 i .

i 5% Customer Hierarchy > Revision 0.1 Last edited by USER on Fri Aug 14 10:59:02 EDT 2015
e Elg Customer A

{% ﬁ el Kiews Ve 11 » Path Entity hierarchy root/Entity Root/Customer Hierarchy/Customer AfAxel Kiers Vej 11
g Jesper Jensen » City abe Hojbjerg

— [—]a Customer B > Country abe Denmark

g 4% 3550 George Bushee Pwy

[ . > Glate b

i John Smith :

E 8 Customer C s Giroet abe 1Ael Kiers Vej 11

m

2l - Key Accounts > Zip 1za DK-3270
— [ Publications

For example, the image above shows an entity modeled as an address. The entity object has several description
attributes: City, Country, State, Street, and Zip. In addition to the Name attribute, these attribute can be modified
and maintained. Since this entity object type has been modeled to be globally revisable, approval is not
applicable. Therefore, the Approval Status field is not shown.
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Entity References, Referenced By, and Status
Tabs

Every entity editor includes a References, Referenced By, and Status tab. The labels on these three tabs
remains constant, while the label of the first tab differs based on the object type. Each is defined below.

References Tab
You can view associated references of an Entity object by selecting the References Tab. In this tab, you can
maintain references from the selected entity to other objects.

Selecting the References tab on an Entity Object will list valid References. In this tab it is possible to maintain
references from the selected entity to other objects.

Refer to Reference Types topic in the System Setup documentation for more information.
An entity can reference a number of different objects. Itis possible to create:

« Entity-to-Entity references

« Entity-to-Product references

« Entity-to-Classification references

o Entity-to-Asset references

In the example below, one Entity-to-Entity reference type is valid on the selected entity object. Clicking the plus

sign (+) will open a large editor where you can select objects to be referenced. Alternatively, you can type the
name of an object in one of the white target fields and press 'Enter.’

(- 7] Assets Cuskamer Referenced By || Status || State Log

-5 Configurations ' Ungrouped Entity References

[ Index Words Reference Type w| > [Target | »
[#-{_] Merchandising Hierarchy -

-] Suppliers > | Affilate O + %)/ & customer C &
[#-[ ] Web Sites

-l Entity Root
. - Customer Hierarchy

----- 4% Axel Kiers Vej 11

« Targets can be unlinked by clicking the delete button .

« Metadata attributes can be linked on to the target reference in References Tab.
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@ Ungrouped Enfity References

Reference Type w| * [Target * |Completeness Score
> |affiliate OF + [13|8 customerB

* |Send to +

« The attributes that are linked on to the target reference will be editable once the target reference is linked to
the entity reference type as shown in the above screenshot.

For the meta attributes to be visible on target reference type, add the required description attributes under
Valid Attributes in System Setup > Reference Type.

Reference Type [IE!=) a0 RNt

* Mame Contact to Contact
» Last edited by 2016-07-26 15:26:27.0 by USER.
» Externally Maintained Mo

* Dimension Dependendes

* Allow multiple references fes
* Mandatory Mo
* Parent/Child relation Maone
* Inheritance Mone
* Completeness Score 1 K

* Purpose T

?

Component > |Description >

D
¥ | Add Attribute Group

=3

1] * |Mame ¥
* ContactMame Contact Mame
* PhoneMumber Phone Mumber
» Completeness Score Completeness Score
* | Add Attribute
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Referenced By Tab

Selecting the Referenced By tab on an entity will list valid Reference Types. In this tab, you can maintain
references from other objects to current entities.

Refer to Reference Types in the System Setup documentation for more information.
An Entity Object can reference a number of difference objects. Itis possible to create:

o Product-to-Entity reference

« Entity-to-Entity reference

« Asset-to-Entity reference

» Classification-to-Entity reference

In the example below, one Entity-to-Entity reference type is valid from an Entity to the current selected Entity
Object. Clicking the plus sign (+) will open a large editor where you can select objects from where a reference to
the current selected Entity Object should be made. In the example, a reference from an entity named 'Customer
A'is made to the current selected Entity Object.

-] Assets [ Cuskomer " References ][ Status " Stake Log ]
r_=| Configurations Q

r_=| Index Words

Reference Type
{7 Merchandising Hierarchy

- [=) Suppliers @ Referencedby Objects
r_=| wWeb Sites Reference Type w| * |Source 3
=1-{ill Entity Root > | affiiate O + 13| & Customer A &
E}ﬂn Customer Hierarchy

= 8 Customer A

Y Axel Kiers Vej 11

Jesper Jensen

[—]2 Customer B

4% 3550 George Busbee Plwy

John Smith
-8

| » |Source »>

D > |Mame S

» Metadata attributes can be linked on to the target reference in Referenced By Tab.

@ Referencedby Objects

Reference Type w| * |Source >
> | Affilate O + 1)

« The attributes that are linked on to the target reference will be editable once the target reference is linked to
the entity reference type as shown in the above screenshot.

» Forthe meta attributes to be visible on target reference type, add the required description attributes under
Valid Attributes in System Setup > Reference Type.
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Reference Type [N W)
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R
® Despton

Mame *| » |Value
* D ConfirmedDuplicateContact
* Mame Confirmed Duplicate Contact
* Last edited by 2016-08-31 13:38:24.0 by USERE
* Externally Maintained Mo
* Dimension Dependendes
¥ Wllow multiple references Yes
* Mandatory Mo
* Parent/Child relation Mone
* Inheritance Mone
* Completeness Score 1
* Purpose b
?

Component * [Mame * |Description

Status Tab

A record of all the changes that have been made to a currently selected entity will be displayed. This record will
allow you to examine the user that made the change and when the change was made.

Tre
.r_=| Assets

m
m

Customer A rev.0.1 - Status

Customer || References || Referenced By @l Skate Log || Tasks

i #-{ ] Configurations
----- - Z] Index Words

Revision * [Created * [Edited * [Major  * |User

- { 7] Merchandising Hierarchy

* D1 Thu Jul 30 14:53:26 EDT 2015 Fri Aug 14 10:53:36 EDT 2015 LISER

r_=| Suppliers

-] Web Sites

=il Entity Root

E}% Customer Hierarchy

=& Lustomer ]

®Disgnostcs
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You can purge past revisions or revert the old revisions. There will be no Workspace, Translation, or Approval
Status flipper as Entities can be created as globally revisable, meaning they are the same in both the Main and
Approved workspaces.

However, Workspace, Translation, and Approval Status flipper will be displayed if we create entity object type as
'Workspace Revisable' as illustrated in below images.

Example of object type definition

Cobiect Tve [rmegyery
@ Desaipon

MName *| * |Value
> ID Account
* Mame Account
* Last edited by 2017-10-16 16:25:44 by USERE
* MName Pattern
* [0 Pattern
* Enable Profiling Mo
¥ Tcon
» Dimension Dependencies
Revisability orkspace Revisable

¥ |Description

D * |Mame »
| > |Add Attribute

Example status tab for workspace revisable object

@ Customer Root
[+~ (0] Customers
E| @ Entity Root

“‘ v

Au count Group 1 rev.0.1 - Status
r:l Assets Account || References || Referenced By State Log
i-[7] Classifications
= @7 Configurations —
: > > > » »
5| B3 eClass 10 Revision Created Edited Marjor User Comment
§| r_=| ETIM Hierarchy Bl Mon Oct 16 16:28:55 EDT 2017 Mon Oct 16 16:28:55 EDT 2017 USERE
— HER) Index Words @ Workspaces
§ |“_=| Merchandising Hierarchy D » [Mame » |Path > »
i -] Offers Main Main Main 0.1
2| =3 Suppliers
Q| @[] Web Sites
o
=
D
[¥al
E
B
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Products

This topic covers information specific to the Product super type that is important to know when working with
products. For general object maintenance information (applicable to all object types rather than specific to
products), refer to the Object Maintenance in the Tree Tab topic within this guide.

In STEP terms, a product is a part number, a stock number, an order number, a catalog number, a product
number, etc. In other words, any item that a company sells that can be ordered.

Product Hierarchy

The foundation for a product-centric STEP installation is the Product Hierarchy / Primary Product Hierarchy. The
product hierarchy consists solely of objects of the product super type. The product hierarchy is an organized
hierarchy where all products in the workbench are stored. This is also where products and product attributes are
linked. Although configurable, the product hierarchy is usually a multi-level hierarchy—each level controlled by its
own unique object type. Super users can control the naming convention(s) used to categorize the products at
their different levels.

Inheritance of attributes and values is supported within the Product Hierarchy and the hierarchy is usually
designed to take advantage of this capability, with objects classified according to similar characteristics. More
information on inheritance is available in the Inheritance in the Product Hierarchy topic in this guide.

A portion of a sample hierarchy is shown below. Categories are represented by folder icons, while discrete
objects are represented by cubes.
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#-{ 7] Assets

r_=| Configurations

r_=| Index Words

r_=| Merchandising Hierarchy

r_=| Suppliers

E-[7) Web Sites

E Publications

E]r_=| Primary Product Hierarchy

|_—‘_}|j Products

=-[15) Apparel

=T Head Wear

1‘_=| Hats and Caps

E}|__=| Upper Body Wear

-7 T-shirts
-l T-shirts Items
E}-[5) T-Shirts Sales Items
=7 T-shirts

|l 18214012
-\l 18215012
|l 18217012
|l Red Shirt

All objects of the product super type must exist in the product hierarchy, and may exist only once (e.g., each
object can have only a single parent). The primary purpose of the product hierarchy is proper attribution of
products. Thatis, in the product hierarchy, products should be grouped according to their similar properties so
that inheritance of attributes, attribute values, and references can best be used. Based on this, it is evident that
the Product Hierarchy is not intended to be used for modeling website hierarchies or other taxonomies (e.g.,
merchandising hierarchy, sales hierarchy, etc.) where an object can be represented multiple times. When a
product needs to "live" in more than one location, that can be accomplished using classification hierarchies. In
this case, the product continues to exist in the product hierarchy (and this is considered its true place of
residence). It is then linked into one or more classification hierarchies using references.

Product Editor

The Product Editor is displayed when an object of the product super type is selected in Tree.
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20808-013 rev.0.7 - Product

- Publications (e ables || Category Profile || Proof View || Status || StateLog || Tasks
(=175 Primary Product Hierarchy Product 1 Sub Products ” References ” Referenced By " Images & Documents ]
Eli Products ~
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. B3 T-shirts > D 101567
=[] Head Wear > Name 20808-013
[=I-{T7] Hats and Caps
- * Dbject T Sales Itel
[+l Hats and Caps Itemr Pbiect Type =es TEm
EI- Hats and Caps Sale * Revision 0.7 Last edited by USERS on Wed Jan 18 08:38:58 EST 2017 -
- [20808-013] > lapproved 3€ Last Approved on Mon Aug 10 09:47:21 EDT 2015
m 20803-04 » [Translation Mot Translated
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E 20808-09 > Path Primary Product HierarchyProducts/ApparelHead Wear/Hats and Caps/Ha...
G 0111 > Categor £ Primary Product Hierarchy | Products | Apparel | Head Wear | Hats and Caps
m A ¥ | Hats and Caps Sales Items | 20808-013 | 20808-013
-l 1112121 > Parent # Hats and Caps Sales Items
|l 20808-012 &=
G B
m c
m D
|l 1111111 ¥
[ [ Footwear Name |2 |Value >
-7 Safety » Manufacturer Name abe
[H-{IT] Hardware * Product Width 123
-] Displays > Product Height 123
[#-{I7] Furniture : :
(-5 Automotive » Belling Price 123 12,99 % 6
[H-{I7] Building Products » Product Depth 122
BT Electrical & Electronics > \nnual Sales Forecast, Maxin 123 250
[+-{f7] Food and Beverage
[]__= Kitchen =9 > Annual Sales Forecast, Minim|122 |100
&[] Party Supplies , [100% Cotton, Unstructured, Soft Crown, Low-Fitting, 6-panel cap, Seamed Front Panel without
- . > Description, Long abe Buckram, & Rows Stitching on Visor, Matching Fabric Underviser, Matching Fabric Adjustable Hook
r#- [ Discontinued Products and Loop Closure, One size fits most.

1. The Product tab (known as the Product Editor) is the primary interface for working with product objects in
the workbench.

2. The Description flipper displays basic information about the object. Additional information about the data
displayed is described in the Editing Objects in Tree topic within this guide. Note that some information
displayed is common for allimplementations, while other information is specific to the data model and
configuration of each system.

3. Ifthe object has a primary image referenced, a thumbnail version of it will display. The reference type to be
used for the thumbnail display is controlled in System Settings (on the Users & Groups node), and additional
information on this is available in the Primary Image Type topic in the System Setup. Additional information
on references in general is available in the Reference and Link Types topic in that same guide.

4. Specification attributes are displayed in flippers, with the flipper name matching the attribute group.
Flippers can be expanded / collapsed by clicking the magnification icon. Note that when attribute groups have
sub-groups, configuration determines whether the parent group or the child sub-group is displayed as the
flipper name. This is set via the 'Product Editor, Group attributes by top group' parameter in System Settings
(on the Users & Groups node), and additional information on this is available in the Product Information
Manager Default Settings topic in the System Setup. More information on attributes in general is available in
the Attributes section in that same guide.

5. Attribute values can be edited by clicking into any editable field. Additional information on the various editing
options is available in the Editing Objects in Tree topic within this guide. By default, attributes are displayed in
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alphabetical order within each flipper. However, if an attribute display sequence has been configured, this will
override the alphabetical sorting. More information on attribute display sequence is available in the Attribute
Display Sequence topic in the System Setup.

Additional Editors

Refer to the additional topics listed below for information on the other editors available on products.

Category Profile: Allows users to configure and view profiling data and dashboards for the objects under
the selected node. Refer to the Data Profiles topic in the Data Profiling documentation for more information.

Commercial: Allows users to add and edit commercial terms for the object. Commercial data / terms lists are
often used to store pricing information. Refer to the Commercial Data section of the Publisher (Adobe
InDesign Integration) guide for more information.

Images & Documents: Allows users to view and edit assets referenced by the object (or inherited from
parental objects). Refer to the Images & Documents Tab topic within this guide for more information.

Product Variants: Allows the user to generate and manage a family of products, which are basically the
same, only varying on the values of a small sub-set of their attributes. For example, clothing and shoes both
offer good use cases for product variants as shoes or clothing items may come in multiple sizes and colors,
but are otherwise identical. The product family holds all data for the item, e.g., a particular shoe, while the
variants would hold only the various combinations of the color and size varieties (e.g., size 7 red, size 8 blue,
etc). The Product Variants tab is only present if the system has been configured to support variants. For more
information on this, refer to the Product Variants documentation in the System Setup.

Proof View: Allows users to preview a close representation of how a product will look when mounted onto
an InDesign page based on a selected publication version and product template. For more information, refer
to the Print Proof View section of the Publisher (Adobe InDesign Integration) documentation.

Referenced By: Allows users to view all objects referencing the current object, and add / remove / edit these
references. Refer to the Referenced By Tab topic within this guide.

References: Allows users to view all objects that the current object references, and add / remove / edit these
references. Refer to the References Tab topic within this guide.

State Log: Allows users to view the recent history of the object across all workflows in which it has been
entered. Refer to the State Log Tab topic in the Workflows documentation for more information.

Status: Allows users to view basic information about the object, including revision history, translation status,
and approval status. Refer to the Status Tab topic within this guide for more information.

Sub Products: Allows users to view and edit all child objects of the selected object in a table form. Refer to
the Sub Products Tab topic within this guide for more information.

Tables: Allows users to view and edit the tables defined for the object. Tables are generally used to present
consolidated data across multiple objects, such as object name, part number, and price. For more
information, refer to the Tables guide.

Tasks: Displays all active tasks across all workflows for the selected object, subject to the user's privileges
(only tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place,
the user is able to act on the tasks from this editor, including to edit data and move tasks through the
workflow. More information on the Tasks tab is available in the Moving Tasks through a Workflow in
Workbench topic in the Workflows guide.
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Inheritance in the Product Hierarchy

Inheritance in STEP is the concept that when the value of an attribute is defined in a parent product, all the child
products that exist under the parent product can inherit the value - meaning that the value is present on the child,
as well as the parent. If the attribute is also valid on the child (in addition to the parent), then the value can be
locally edited on the child (e.g., a different value supplied so the child no longer inherits the value from the
parent). Note that value inheritance also applies to references, meaning that if a reference is populated on a
parent, it is also available on the child in the same way as an attribute value. However, references must be
explicitly configured for inheritance to be in place, while attribute values will automatically inherit to child products.

In addition to value inheritance, attribute inheritance is also available in the product hierarchy. This means that
attributes can be linked to specific nodes / categories so they only appear for those categories and their children.
For example, consider a company that manages data for both batteries and clothing. Size might be applicable to
both categories of objects since both batteries and apparel have sizes assigned. However, sleeve length and
voltage are characteristics applicable for clothing and batteries, respectively, and it could be confusing to have a
'Voltage' attribute on a clothing item. To avoid this, the 'Voltage' attribute could be linked to the 'Batteries'
category, while the 'Sleeve Length' attribute could be linked to an 'Upper Body Apparel' category.

Inheritance perpetuates throughout the hierarchy, no matter how many levels are present (e.g., inherited
attributes and values appear on children, grandchildren, etc.). When attributes are considered applicable to all
products, regardless of category, they are called 'global attributes'. For example, attributes such as Price,
Description, and Manufacturer Name. Thus, these attributes are linked to the top level in the product hierarchy
and are inherited down to all products beneath, no matter how many levels there are.

Attribute inheritance only means that the attributes are available for all of the products beneath where they are
linked. The process of linking attributes to different levels does not have anything to do with the actual values that
will go into the attributes for any particular product. In the 'Voltage' example, when linking that attribute, you are
only concerned with making that attribute available to all the battery products—not with the actual voltage for any
given product. However, if many batteries under a parent shared the same value, the value could be populated
on the parent to inherit down to the children. Any children varying from the parent value could then be edited
individually, while those having the same value as the parent do not need to be updated further. Note that
attribute inheritance within the product hierarchy is only available with specification attributes, and is not available
with description attributes. Further note that this topic focuses on inheritance solely within the product hierarchy.
However, it is important to be aware that attribute inheritance can also be used within classification hierarchies
that are used to organize product objects. Attributes can be linked to a classification, making them available for all
products linked into that classification (or a child classification). More information on attribute inheritance with
classifications is available in the Classifications topic within this guide, and within the Attribute Links topicin
the System Setup guide.

Important: Value inheritance is a powerful feature, but care should be taken not to maintain values at a level
too high in the hierarchy. With such a setup, a single change could mean that thousands or millions of
products would have to be updated in downstream systems and many systems are not geared to handle
massive feeds like that.
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When working with products and/or creating new products, users should be mindful of inheritance, considering
both the inheritance of the available attributes, as well as their specific values or references. It may be helpful to
consider the following:

« Isthe hierarchy granular enough to allow products within the category to be grouped so that all products only
have the relevant attributes, or are additional category levels required to obtain this granularity?

« Which attributes are required for the products in the category and/or subcategories?

« If product variants are used, which attributes should be maintained at the family level and which ones should
be maintained at the variant level?

Note: Data can also inherit from dimensions (e.g., language or country). More information on this is available
in the Dimension Dependent Data section of the Contexts topicin System Setup.

Linking Attributes to Products

To make attributes valid for products, they must be linked to the appropriate tree nodes in the product hierarchy.
Some attributes will be global attributes (applicable to all objects in the product hierarchy) and are linked to the
“Product Hierarchy” root node. These global attributes are then valid for all products. Other attributes apply only
to specific categories of objects, and are then linked directly to those categories, making them available for all
objects within that category (if also set as valid for those object types). Attributes should not be linked to individual
leaf objects, as each one would have to have the link individually applied. Instead, attributes should be linked to
some parental folder in the hierarchy above the objects needing to use the attribute.

Before proceeding, be aware of the following:

« Attributes can be linked to objects of the product or classification super type. In either case, the steps are
comparable and the attributes are made available for the children "under" the node at which they are linked
(being mindful that "under" means "actual children" in the product hierarchy, whereas it means "objects with a
reference to" when dealing with classifications).

« Linked attributes apply only to objects of the product super type. For example, linking attributes to a
classification object that holds assets does not make those attributes available on the child assets.

« Only Specification attributes can be linked to products or classifications. Description attributes cannot be
linked attributes.

Linking Attributes

1. Select the product group or classification and click the References tab.

2. Expand the appropriate flipper (Linked Attributes from Product Hierarchyon product objects or
Attributes on classification objects), then click Link to Attribute.
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Localizing an Attribute Link

[1STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

Classification || Sub Products Referenced By
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In the standard search / browse window that displays, locate the appropriate attribute(s) and click Select.

Local attribute links can be created to override inherited attribute links.

1.

2. Selectthe Create Local Link option.

@ Linked Attributes from Product Hi

DisplaySequence

>
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Select any existing inherited attribute link and right-click on the row indicator.
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This creates a local version of the link where attributes on the reference can be locally edited. Local links are
removed the same way as inherited links, though removing a local link re-applies the inherited link.

Unlinking a Linked Attribute

Unlinking an attribute does not delete the attribute from STEP; it removes the link so the attribute is no longer
available for population on the selected node (and child nodes, if applicable). Note that attribute links must be
removed from the same node to which they were added. In other words, trying to remove an inherited attribute
link is not possible and the 'Remove Link to Attribute' option will be disabled. To remove an inherited link, it must
be removed on the parental object that holds the link. However, care should be taken in doing this as it will
remove the link for all child groups, and will need to be re-linked at those lower child levels if it is still needed

there.

1. Onthe References tab of the object, expand the appropriate flipper (Linked Attributes from Product

Hierarchy on product objects or Attributes on classification objects).
Right-click on the row indicator and select Remove Link to Attribute from the context menu (or use Ctrl +

-”). Multiple attributes can be unlinked simultaneously by multi-selecting.

inherited link will again take effect.

Note: If an attribute has been linked locally, removing the link only removes the local link, and the

l Product " Sub Products IM[ Referenced By ” Images & Docur

@ Linked Attributes from Product Hierarchy

Completeness Score * (ID

Hide

Show All Columns

Rotate Table

Link to Attribute Ctrl+Plus
Remove Link to Attribute  Ctrl+ Minus

sef sl sel sl sel sel sel el

Create Local Link

t
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slelnit

Description

arersPartMumber

JrerMame

Additional methods for maintaining attributes links

Attribute links can be added and removed in a number of ways, in addition to what has been described above.

These include:
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o References tab of the attribute itself
o Maintain menu, then Link menu when a product or classification is selected

o Edit menu, then Link to Attribute / Remove Link to Attribute menu when a product or classification is
selected

All methods for adding and removing attribute links are equivalent, producing the same end result.

Working with Inherited Values

There are many advantages to setting common values:

o When an update is needed, the value is only entered once in the product group instead of — potentially —
separately, across hundreds of products.

o When new products are added to the group, they automatically inherit the product group’s values.

« The translation of product group values only need to be performed once, as opposed to translating the same
value every time for individual products.

As mentioned above, it is possible to set attribute values for an individual product, but consider a situation where
all products within a product group share common attribute values. For example, a set of hats that share a
common description and features.

There are two ways to approach this: 1) keep all common values with the individual product or 2) set the common
value at a higher level in the product hierarchy. By setting the value higher in the hierarchy, the attribute value is
inherited down to all products beneath.

20808-013 rev.0.7 - Product

:_Ir'_=| Primary Product Hierarchy ~ Images & Documents || Commercial || Tables || Category Profile || Proof View || Status || State Leg || Tasks
[_jl—‘_=| Products Product I Sub Products " References H Referenced By
-] Apparel
7 @ Display
=] Upper Body Wear
Elj Head Wear Mame *| » |Value >
({5 Hats and Caps > Manufacturer Name ahe
- Hats and Caps Items » Product Width 122
[=H{[T] Hats and Caps Sales Items > Product Height 13
= B lling Pri 123
>
Y] 20803-04 seling Price 1299 &
|l 20808-08 > Product Depth 123
li 20808-09 > |annual Sales Forecast, Maxin 123 250
YLl 20111 —
l_ A > \Annual Sales Forecast, Minim|123 100
l: 1112121 JL00% Cotton, Unstructured, Soft Crown, Low-Fitting, 6-panel cap, Seamed Front Panel without Buckram, &
= > Description, Long abe Flows Stitching on Visor, Matching Fabric Undervisor, Matching Fabric Adjustable Hook and Loop Closure, One
li 20808-012 ize fits most.
L B > Description, Table abe
li c > Description, Web abc
IL D > Feature Bullet 1 abe [uilt-in sweatband wicks away sweat to keep you cool & dry
li 1111111 > Feature Bullet 2 L abe ftretch construction provides a comfortable fit

The image above shows three inherited values, which are designated by a green down arrow ().

The value is set at the product group, or in this case, 'Hats and Caps Sales Items'. Therefore, all products
beneath will inherit the same value.
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Itis possible to override an inherited value by setting a different value at any subordinate level, e.g., the product
level. This is called a localized value. However, this requires that the attribute be valid for the child object type
(as is the case for the inherited values shown in the screenshot above). Attributes that display as inherited
(indicated by the green arrow) but not editable (e.g., value field is yellow rather than white) are not valid for the
object, so they can only have a common value with all sibling products, which is inherited from a parent higher in
the hierarchy. Detailed information on setting validity of attributes is available in the Validity on Specification
Attributes topic in System Setup.

If a value is localized, then subsequently deleted, the product will again automatically inherit the parental value.
Therefore, it is impossible to have null (blank) values for inherited attributes (unless the parental object has the
null value).

For information on working with and/or setting up inherited reference values, refer to the Inheritance Example
for a Reference section of System Setup.
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Images & Documents Tab

When working with products, the Images & Documents tab displays thumbnails of all assets that are referenced
by the selected product, or inherited from a parental object referencing the asset. When working with
classifications, this tab displays all assets that are child to the selected classification. The functionality for working
with the displayed assets is the same, regardless of whether a product or classification has been selected.

Tree Blue Hat rev.0.16 - Images & Documents
""'[1201?0} (120170 # ||| Commercial || Tables || Category Profile || Proof View || Status || State Log

....m{mﬁsﬁ} (120666) | Product ” Sub Products ” References ” Referenced By \ Images & Documents

- (179653) (179653)

- (179854) (179864)

- (179856) (179866)

- (179858) (179868)

- 109308 (109308)

E Baseball Hat (20805)  ©
™ Gray Hat (114509)

™ Industrial Hard Hat (208C
™ Industrial Hard Hat (1811

<< Previous Filter 1-20f2 Mext ==

E 5ki Hat (179857) purple cap Yellow cap
™ Ski Helmet (179853) 300 x 215 px 283x 178 px
[#[[7] Hats and Caps Salesltems (2 ~ KB 2B
4 T | b Primary Product Image Product Image

If more than 50 assets are present, the Next / Previous buttons are enabled at the top of the screen, allowing
users to page through sets of assets (50 at a time). Filtering functionality is also available and is especially useful
when working with large sets of assets. The options for filtering are described below.

Along with each thumbnail, basic information about the asset is displayed, including asset name, pixel size, file
size, and reference type used to link the asset to the selected object.

Interacting with Assets

From the Images & Documents tab, several actions can be taken with the displayed assets.

Edit asset

By right-clicking on the asset, users can edit any assets on the page, open an external viewer, save the image to
adisk or local PC, and view the image on a larger scale.
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[ Referenced By ] Images & Documents
1-2af2 MNext =

.-

Edit Aszet
- "* External Viewer
Save to disk
Yellow c Image Viewer
283 x 173 %
32KB

Product Image

Edit reference type

The type of reference that links the object and the asset is displayed in a dropdown below the asset thumbnail.
Selection in the dropdown will be disabled (grayed out) if there is only one valid reference between the object
type and asset type. If multiple valid reference types are available, selection of the reference type is enabled and
can be edited from this location. More information on references is available in the Reference and Link Types
topicin the System Setup documentation.

Filter the displayed assets

A user can filter the displayed assets by entering the name of the asset in the Filter filed. This action displays
assets that have the entered value as part of the asset name, as shown below.

Note: The filter automatically applies wildcard functionality so explicit entry of wildcards (*) is not needed.
Entering an asterisk will cause the system to search for assets with an asterisk in their name.
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To remove the applied filter, delete the characters in the filter field and press the Enter key on your keyboard.

Navigate to asset

The asset name is shown directly below the asset thumbnail as a hyperlink. Clicking the hyperlink navigates
directly to the asset in the classification structure.
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Product Overrides

Product overrides are alternate versions of products and product families that may have differing values,
references, links, and structures. Attributes and values applied to the product family are inherited to the product
override and can be replaced with local values and references on the product override. Product overrides allow
product objects to exist in multiple locations in the product hierarchy and are the primary building blocks for many
print product presentations. A product override allows for the creation of 'pseudo’ product families that are
flexible to ever-changing print presentations. They can be thought of as a workaround for when an existing
product family does not contain the exact products needed for a publication layout and/or its accompanying
STEP table(s).

A product override folder can include products from various "standard" (e.g., non-override) product families.
Similarly, a product override leaf object can live under a different product folder (override or standard) than the
folder in which its corresponding standard object resides.

Tree 101609 — SKU 00001 rev.0.1 - Product

7] Assets m Sub Products || References || Referenced By || Images & Documents || Commercial || Tables || Stab
5 Corfprtors Qowapen
----- o 7] Index Wards Name 1> Waloe
- 2] Merchandising Hierarchy
r_=| Suppliers > ID 101609
[ ] Web Sites * Name 101609
[+ [ Entity Root » Dhject Type Product-gverride
B2 Publications - -
Eli Primary Product Hierarchy Revision 0.1 Last edited by USER. on Tue Aug 04 11:18:17 EDT 2015
. ) Products > Approved 3 never Been Approved
: - F#}- i Discontinued Products * [Translation Mot Translated
Product Overrid

[?} ES Lu | Iem = » Path Primary Product HierarchyProduct Overrides/Level 1/Level 2/101609 — SKL 00001

eve

‘ B E Level 2 * Dverridden Product 5K 00001 (SKL 00001)

-\l m * Product Variant Priority

. i Packagng » |Cumuare thiz with Overridden product

I Regons rodc |Daebiteeow
-3 Collections

M | ¥ |val

(B eCatalogs .ame a u.e
-5 Recyde Bin » Size abe: Medium

1. Tree Structure: For clarity, it is recommended to house product overrides in a separate sub-hierarchy from
standard products.

2. Override Interface: The product override object makes it possible to override the children, attributes, and
references of a product / product family. This is useful in order to publish a limited version of a product family
without modifying the object itself.
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Example

E}E Product Overrides
EIE Level 1
E}E Level 2
=\ [104061 — Ski Jacket Pro]
@ SKU 00001
L @ SKU 00002
G-l Packaging
(=T Regional Products
Elr_=| Apparel
=) Winter
-5 Winter Coats
=+ Ski Jacket Pro

- 5K 00002
g SKL 00003

In this example a product family Ski Jacket Pro has three products. A product override 104061 is created and
based on the product family Ski Jacket Pro. Attributes, values, and references are inherited from the product
family Ski Jacket Pro to the product override folder and can be replaced with local values and references on the
product override.

Two products from the product family Ski Jacket Pro are linked into the product override folder (SKU 00001
and SKU 00002). The product override only contains a subset of the products included in the original product
family Ski Jacket Pro, as SKU 00003 is not included.

Important: Values and references inherited to a product override will not be inherited to products linked into
the product override. These products will have their values inherited from their original structure instead.

Selecting the Product tab or References tab on the product-override will indicate with a yellow icon (), if an

attribute or reference is inherited from an overridden product. Inherited values and references can be replaced
with local versions, assuming the relevant attribute and/or reference is valid on the relevant product override
object type.

Creating a Product Override

1. InTree, select an object for which an override should be created.
2. Right-Click and select New Product-Override
3. Inthe Create Product-Override dialog,

« Clickan Object Type
« KeyinID and Name
« Optional: Click the ellipsis button (|...|) to select a product family to adapt values, references, and links

from. The product-override will inherit all values, references, and links from the selected product family.
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« Optional: Click 'Adopt Children' if the product-override should also include all products from the
overridden product family.

4. Press Create to create the product-override.

Linking Products into a Product Override

1. InTree, select the product override
2. Right-click the product override and select Add Children to Override
3. Search or Browse for the products to be linked into the product override

Removing Products from the Product Override

1. InTree, select the product override
2. Expand the product override and select the product to be removed
3. Right-click and select Remove Child from Override

Creating a Subordinate Product Override

1. InTree, select the product override
2. Selecta product linked into the product override
3. Right-click the product and click Convert to Product-Override

The product will be converted into a product override. Values, references, and links will get inherited from the
overridden product.
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Referenced By Tab

The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects that
the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). In
addition, if the object is used by product overrides, has a match code acting on it, or is used by any publication,
that information can be viewed on this tab. Finally, privileges assigned to the product can be added and edited
from this location, and subproducts that are present only in other contexts can be viewed (if the object is of a
dimension-dependent object type).

The display of the Referenced By tab on a product will vary slightly from system to system, based on the data
model.

Tree
|_=_|i Primary Product Hierarchy
) Products

114613 rev.0.3 - Referenced By

Product || Sub Products || References |BRGEELNY Images & Documents || Commercial || Tables || Category Profile || Proof View

i Apparel

Eli Footwear Reference Type w| > |Source > |Qty
E- Shoes > |Bill of Materials + \ﬁ
E‘i Pumps » |supplier Replacement Item 4 %@
O e, || PSRy R
G- Sales Item References, Product
@ Referenced by Products, Clsssificstions er Enfibes

Reference Type vl >
Packaging Link + g

> |Name

[=H[[T] Pumps Sales Items

B 3inch heels
] 2070901
] 20738-01

> |Name

Lo

jin] > |Name

- il Translation | ®
[T Boots
(B 6 Publication > |Version > |Page > |hrea Used > |Page Type

[#-{I7] Safety I
[#-{77] Hardware r
[+{77] Displays ? Applies to > |Action Set > |Attribute G... > |Object Type * |Group » |Language » (Country >
-] Furniture L Add Priviege
[T Automotive 8
[+{77] Building Products

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid target that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by
clicking the (+) on the reference. This will open a dialog allowing the user to select a source for the reference,
and a reference will be created from the object selected in the dialog to the currently selected object that you
are standing on (e.g., current object = target, dialog selection = source). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the
(X) on any existing reference. Additional information on configuring and working with references is available
in the Reference and Link Types topicin the System Setup documentation.
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2. Referenced by Products, Classifications or Entities: The functionality is identical to what is described
for the Reference Flippers section above. The only difference is that this area displays references that have
not been placed in attribute groups for display purposes.

3. Used By Product Overrides: Displays product override objects that are based on the selected object. More
information on product overrides is available in the Product Overrides topic in this guide.

4. Linked into Product Overrides: Displays product override objects that have the selected object as a child.
More information on product overrides is available in the Product Overrides topic in this guide.

5. Used by Match Code Objects: If the selected object is the Category indicated in a match code, the match
code will display. For example:

System Setup Find Similar - Match Code

E‘E Global Business Rules Match Code | Match Code Values || Statistics
(#-(%5] Inbound Integration Endpoints ® Definition

El[fc)_‘i Match Codes and Matching Algorithms

P ﬁ Find Simil. Mame » | » |Value

Poobe _\_I,_, Find Similar > D FindSimilar
-[28] Outbound Integration Endpoints 3 MName Find Similar

- [F5] Web UI

% WE " § orofi > Last edited by 2017-01-19 13:55:37 by USERG
- orkflow Profiles

. 5] Workflows » Category Shoes (20685)
""" =] Derived Events * Match Code Window Size 1

.75 Ahiart Tunae & Cheoch rae

Tree Shoes rev.0.2 - Referenced By
|-_‘-|r_=| Primary Product Hierarchy ~ Tables || Category Profile || Proof View State Log || Tasks
([0 Products | Product ” Sub Products " References | REfEI‘EnEEd By [ Images & Documents ” Commercial l
: |
; g EEE::Zar & by . o
B |~_=I Shoes - Used By Product Overrides
- Pumps Items 2 Used by Match Code Objects
[#-[[T] Pumps Sales Items D s [Mame » [Edited by 3
-] Boots > FindSimilar Find Similar 2017-01-19 13:58:41 by USER6
[ e e SO

More information on match codes is available in the Matching, Linking, and Merging documentation.

6. Used on Page: Displays publications that the selected object is used in. Additional information about
working with publications is available in the Publisher (Adobe InDesign Integration) documentation.

7. Applied Privileges: Displays the privileges that have been applied to the selected node. Privileges can be
added using the Add Privilege link, and can be removed by clicking on the row indicator and selecting
'Remove Privilege'. Existing privileges cannot be edited from this interface. Detailed information on creating
and editing privileges is available in the Privilege Rules section of the System Setup guide.

8. Visible Sub-Products in Other Contexts: Displays subproducts that are visible in another context, which
is only applicable if the object type is dimension-dependent. Note that it is not recommended to make product
object types dimension-dependent; instead, it should only be data on objects (e.g., attributes and references)
that are dimension-dependent. As a result, this flipper is rarely used.
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The References tab is where all references of which the selected object is the source can be viewed and edited

(assuming proper privileges are in place). In addition, if the object has associated index words, is used by any

publication, or has any linked attributes, that information can be viewed and edited on this tab.
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The display of the References tab on a product will vary slightly from system to system, based on the data model.

£
£
£

-] Assets

r_=| Configurations

r_=| ETIM Hierarchy

r_=| Index Words

r_=| Merchandising Hierarchy
r_=| Suppliers

B[] Web Sites

&1l Entity Root

(-] GDSN

ﬁ Publications

=1-IZ] Primary Product Hierarchy
(=[] Products

EI‘ Apparel
E}i Upper Body Wear
-3 T-shirts
=}l T-shirts Items
e
E Mew Shirt
-l Polo T-shirt

+-[IT) Footwear
-7 Safety
[+-[IT] Hardware
(-7 Displays
[+-[IT] Furniture
-] Automotive
E]—-i Building Products
[#-[1T] Electrical & Electronics
[+-[IT] Food and Beverage
-1 Kitchen

[+-[IT] Party Supplies

+-[IF] Discontinued Products
t-[[Z] Product Overrides

[ Packaging

£

- (£7] GDSM Products

w133 Collections

i T-Shirts Sales Item:
[T Head Wear a

Product || Sub Products

Referenced By || Images & Documents || Commercial || Tables

Reference Type vl > |Target > Oty »
18212LEB 1
» |Bill of Materials + \ﬁ m El
"y M 15213M0 1 =]
k-

8.

Reference Type ¥

» |Packaging Link + \ﬁ
Inherited From ¥ (Index » Level 1 >
» Locally defined Indexdoc_Test Index Words/Indexdoc_Test/conseguati
* Locally defined Indexdoc_Test Index Words/Indexdoc_Test/doluptatus
* Locally defined Indexdoc_Test Index Words/Indexdoc_Test/polyester

|* |Add Index VWord

e‘L_

D > |Name >
» |108494 Autopage Publications/Acme Wholesale Clothing/Caps and Hats
> (111845 Autopage Publications/Acme Wholesale Clothing/Shirts
» (111512 Autopage Publications/Beta Tools/Fower Tools

* |Link to Publication or Section

© Unked Attributes from Classification Hierarchy

q'* Linked Attributes from Product Hierarchy
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1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid source that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by
clicking the (+) on the reference. This will open a dialog allowing the user to select a target for the reference,
and a reference will be created from the currently selected object to the object selected in the dialog (e.g.,
current object = source, dialog selection = target). If any attributes are available on the reference and
editable, they can be edited within this interface. References can be removed by clicking the (X) on any
existing reference. Additional information on configuring and working with references is available in the
Reference and Link Types topic in the System Setup.

2. Ungrouped References: The functionality is identical to what is described for the Reference Flippers
section above. The only difference is that this area displays references that have not been placed in attribute
groups for display purposes. If all references that are valid for the selected object have been placed in
attribute groups, the Ungrouped Classification Links and Ungrouped Product References flippers will
not be present.

3. Index Words: Allows users to view index words linked to the currently selected object, and to link index
words using the Add Index Words link. Index words are maintained in a dedicated hierarchy where it is
possible to maintain the word itself along with a sort word. More information is available in the Creating an
Index Words Structure topic in the Publisher (Adobe InDesign Integration) documentation.

4. Publications: Publications that the currently selected product is linked to are displayed, and new links can be
created using the Link to Publication or Section link. Additional information about working with
publications is available in the Publisher (Adobe InDesign Integration) documentation.

5. Linked Attributes: Attributes that are linked directly to the selected product or inherited from a parental
node in the hierarchy display under the Linked Attributes from Product Hierarchy flipper. The exact
columns available will depend on the data model and the attributes that have been made valid on product
attribute links. Whether or not the various attributes are editable will also depend on the setup of the data
model. However, an ID and Name field are always shown, with the attribute name being a hyperlink that can
be used to navigate directly to the attribute. An Attribute Groups column is also present, displaying the
attribute group(s) that the attribute is in. A Mandatory column is present and if checked, the object cannot be
approved until a value has been provided for the attribute. Note that mandatory settings on the attribute itself
apply globally, while mandatory settings on the attribute link apply only to objects that are child of the node at
which the attribute is linked. More information on mandatory settings is available in the Mandatory Attributes
topicin the System Setup. If the attribute link is inherited (indicated by a green down arrow, =, in the row
indicator), the 'Inherited from' column will display the parental node where the attribute has been linked,
which is hyperlinked for easy navigation. More information on linked attributes is available in the Inheritance in
the Product Hierarchy topic within this guide and in the Attribute Links topic in the System Setup.

The Linked Attributes from Classification Hierarchy flipper is comparable to the product hierarchy
counterpart described above, though shows attributes linked to a classification that the object is a member of
(e.g., has areference to), rather than attributes that are linked to a parental product. The same
considerations apply in that the exact columns available will vary based on the data model, with ID, Name,
Attribute Groups, and Mandatory columns always being present and functioning in the same way as for
product attribute links. Note that objects shown in the 'Inherited from' column in this case are parental objects
not of the selected object itself, but instead of a classification that is parent to the classification that the
selected object references.
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The Status Tab provides general information about objects, including revisions, translation status, and approval
status. For products and classifications, the Status tab displays the same information, regardless of the object
type. Publications, attributes, entities, and assets have slightly different information available, though much of it is

common to what is described below.

[ Product ” Sub Products ” References ” Referenced By ” Images & Documents ” Commercial ” Tables ” Category Profile ” Proof View ‘

Status

State Log

Tasks

? _
_Revision ¥ |Created Edited Major » User » |Comment ¥
» 0.4 Fri Oct 23 16:43:50 EDT 2015 Tue Jan 19 15:42:51 EST 2016 LSER Auto Generated

3 0.3 Fri Oct 16 09:39:06 EOT 2015 Fri Oct 16 09:39:06 EOT 2015 LSER Complete approval

0.2 Tue Sep 22 14:14:02EDT 2015 [Tue Sep 22 14:14:02 EDT 2015 USER Auto Generated

01 FriFeb 13 11:35:40 EST 2015 FriFeb 13 11:35:40 EST 2015 STEPSY3
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Context Approval Status ¥
» Danish DK xLastAmouedeﬂDctlﬁUS:SS}:UﬁE]TZtllS
> English LK € Last Approved on Fri Oct 16 09:3%:06 EDT 2015
» English US x Last Approved on Fri Oct 16 09:39:06 EDT 2015
» French Belgium x Last Approved on Fri Oct 16 09:39:06 EDT 2015
» French Canada 3¢ Last Approved on Fri Oct 16 09:39:06 EDT 2015
» FrenchFR x Last Approved on Fri Oct 16 03:39:06 EDT 2015
* fGermany German x Last Approved on Fri Oct 16 09:39:06 EDT 2015
b 'Israel Hebrew 3 Last Approved on Fri Oct 16 09:33:06 EDT 2015
1_
Attribute > |Visible in workspaces 3 |Visible in dimensions » Value
* Long Item Description Approved, Main Country=AlCountries, Lanquage=en-U5 Red carpet worthy pumps in scarlet suede is sure
» Packaging Type Approved, Main Country=AlCountries, Language=std.lang.al Box
» Supplier Name Approved, Main Country=AlCountries Products Galore
? _
No problems found
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1. Revisions: In STEP, historical versions of objects are stored as revisions. A revision thus represents a
historical "snapshot" of an object. The Revisions flipper provides a record of the revisions that have been
made to the currently selected object, including when changes to the object were made and who made them.
Viaright-click, users are able to purge old revisions or revert to previous revisions. For more information on
revisions, including how they are generated and how they should be managed, refer to the Revisions topicin
the System Setup documentation.

2. Workspaces: All the workspaces that the selected products are in will display, as well as the revision number
that exists in that workspace. Generally speaking, if the object has been edited since it was approved, the
Main and Approved workspaces will hold different revisions. However, it should be noted that not all changes
to an object generate a revision. More information on this is available in the Revisions topic in the System
Setup documentation. For more information on workspaces in general, refer to the Workspaces topic in the
System Setup documentation.

3. Translation: Translation relations (sources and targets) and status (e.g., Up to date, Re-translation needed,
etc) of the translations display. For more information, refer to the Translations documentation.

4. Approval status in all contexts: Displays the approval status of the object in each context on the system.
More information on approvals is available in the Approval of Objects topic in the Getting Started
documentation. More information on contexts is available in the Contexts topic in the System Setup
documentation.

5. Hidden values: Displays hidden inherited values on the object. Hidden values are those that are inherited
from another dimension (e.g., language or country) rather than from a parental object. More information on
this is available in the Dimension Dependent Data section of the Contexts topic in the System Setup
documentation.

6. Diagnostics: Displays any issues with the object found by system diagnostics. If a problem has been found,
the information can be copied by clicking the file link.

D Diagnostics
Problems found. Press button to copy information to clipboard. Please supply this information to Stibo System.
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Sub Products Tab

When the Sub Products tab is accessed on an object of the product super type, all direct children of the selected
node are displayed. If privileges allow, data can be edited on the displayed objects by clicking directly into any
editable field. Standard editing capabilities are available within this interface (as described in the Editing
Objects in the Tree Tab topic within this guide) including copy / paste functionality using Ctrl + C and Ctrl + V.

Tree
Product || Product Variants |REULRZOLINEEN [ References || Referenced By || Images & Documents || Commercial || Tables || Category Profile

-] Assets
r_=| Configurations
r_‘=| ETIM Hierarchy
r_‘=| Index Words
r_‘=| Merchandising Hierarchy
r_‘=| Suppliers
[#-[ ) Web Sites
&[] Entity Root
[~ (i) GDSN
ﬁ Publications
Elr‘_=| Primary Product Hierarchy
(-5 Products
Elr'_=| Apparel
E|"_=| Upper Body Wear
=] T-shirts
(=} T-shirts Items

B8 New shirt

[T Head Wear
[+-{I7] Footwear

-7 Safety

[+-{I7) Hardware

-7 Displays

[-[IT) Furniture

-7 Automotive

[#-[{7] Building Products
[+-[[7] Electrical & Electronics
[#-{I7] Foed and Beverage
-7 Kitchen

-] Party Supplies

[#-[8 Discontinued Products

View: Show all w
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T-shirts rev.0

B 12-6eK799
il Cotton T-shirts

¢ -l Polo T-shirt
(=[] T-Shirts Sales Items

| 18217-054 »|18207-012 » |18214-012 >
|ID » 100305 18207 18214
(Iame » [18217-054 18207-012 18214-012
”ObjectType » Sales Item Sales Item Sales Item
”Revision > 0,23 Last edited by USERE on Thu Ja...10.4 Last edited by USERS on Mon ... 0.5 Last edited by USERES on Thu Ja...
Path » Primary Product Hierarchy/Products/... Primary Product Hierarchy/Produc. .. Primary Product HierarchyProducts/...
Approved > x Last Approved on Fri Sep 16 10:... x Last Approved on Mon Jun 15... x Last Approved on Mon Jun 15 1...
Translation > Mot Translated Mot Translated Mot Translated
Classification 1root | Web Sites | Acme Classification 1 root | Merchandising Classification 1 root | Web Sites | Acme
atenor , Retail Web Site | Apparel | Mens CasualHierarchy | Apparel | Sportswear | Retail Web Site | Apparel | Mens
qary | T-shirts and Sweatshirts | 18217-054 [T-shirts | 18207-012 Casual | T-shirts and Sweatshirts |
18214-012
|Parent » [T-shirts T-shirts T-shirts
Selling Price > 3.57% 8.57%
Annual Sales Forecast, Maximum > 5000 5000
Annual Sales Forecast, Minimum > 12000 2000

Description, Long

The best-selling T-Shirt For over 35
wyears, it has set the standard for

. T-shirt comfort and guality. Today it's

better than ever, offering greater
durability and less shrinkage than you'l
get with ordinary tees.

The best-selling T-Shirt For over 35
years, it has set the standard for
T-shirt comfort and guality. Today
t's better than ever, offering
greater durability and less shrinkage
than you'll get with ordinary tees.

The best-selling T-Shirt For over 35
wyears, it has set the standard for
T-shirt comfort and guality. Today it's
better than ever, offering greater
durability and less shrinkage than you'l
get with ordinary tees.

Description, Table

Feature Bullet 1

. Fiber Content: Fabric: 100% Ring-spun

Cotton

Fiber Content: Fabric: 100%
Ring-spun Cotton

Fiber Content: Fabric: 100% Ring-spun
Cotton

Feature Bullet 2

v

Ultra-soft premium cotton feels great
against your skin. ENG value test

Lltra-soft premium cotton feels
great against your skin.

Ultra-soft premium cotton feels great
against your skin.

Feature Bullet 3

N Mon-chafe fabric taping reinforces neck

and shoulders.

Mon-chafe fabric taping reinforces
neck and shoulders.

Mon-chafe fabric taping reinforces neck
and shoulders.

Feature Bullet 4

. Lay Flat collar keeps its shape wash

after wash.

Lay Flat collar keeps its shape wash
after wash.

Lay Flat collar keeps its shape wash
after wash.

Feature Bullet 5

. Durable double stitching trims sleeves

and bottom hem.

Durable double stitching trims
sleeves and bottom hem.

Durable double stitching trims sleeves
and bottom hem.

Primary Color > Elue Orange

Sales Item Short Description > T-zhirt, Blug, M, cotton T-shirt, Orange, L, cotton
Selling Price UOM > EA EA

Size > Medium

Right-clicking on any field within the table will expose additional options, including Copy, Paste, Hide Equal, and
Mark Different selections - all of which are self-explanatory and can be especially useful when editing multiple

objects.

Note that two views are available using the Rotate Table option. As shown above, the view can be organized to
have attributes on the vertical axis. As shown below, the table can also display products on the vertical axis. Also
note that right-clicking within the header field exposes different options than within the data fields, including an

option to add a product.
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Object Type » |Revision > [P
18217054 » Sales Ttem 0.23 Last edited by USER... P
Hide
Show All Rows
18207 ted by USERG ... P
Rotate Table
Add Product Ctrl+Plus
Remove Row(s) Ctrl+Minus
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Selecting Add Product opens a Create Product dialog allowing the user to input data to create a new object,
which will be added as a child to the currently selected node. The options available in the dialog are based on the
data model defined in System Setup. For example, the object type selection will vary based on the allowable
object types under the selected parent, and ID will only be available for population if the object type being created
does not have autogenerated IDs applied.

D Create Product

Ohject Type

.........................

D |115206

Marme |

| Create | | Cancel |

editor.

Note: The same functionality is available using the Add Product link at the bottom of the Sub Products
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Recycle Bin for the Tree Tab

This topic describes the functionality available for objects within the Tree Recycle Bin. For information on the
System Setup Recycle Bin, refer to the Recycle Bin for System Setup topicin the System Setup
documentation.

Important: Objects in the Recycle Bin are not searched when a user performs a search in workbench and
Web Ul. This limitation also applies to searches done using the workbench Goto functionality. Additionally,
attribute values of objects in the Recycle Bin cannot be edited. If editing is required, the object needs to be
revived.

When an object is deleted from the Tree, it is moved to the Recycle Bin located on the Tree tab. For information
on deleting objects from the Tree, refer to the Deleting Objects in the Tree Tab topic within this Getting
Started documentation.

In the Web Ul, attempting to display an object that exists in the Recycle Bin, as shown in the image below,
displays recycle bin images in the background of the object that is no longer in the primary product hierarchy.
When the 'Show Recycle' parameter is checked in the Tree Navigator component, this background is displayed
when viewing objects in the Recycle Bin. For more information, refer to the Tree Navigator Component topic.

The user can follow the steps below to resolve the object's status by reviving or permanently deleting the object,
which also removes this background.

(& Aman Ad=im Eng ish ¢ E .ﬁ.
* Deleted PDLs :2000080964

Customer Details * Customer Specific data to PDL references

Customer > CONVENIENCE » FOODS INC. » 200 removed for :2000080564
Customer Data Sales Organisation List of Child Customer PDL
P Delete
Fod Mame . <
© | Master_2000080964 o

Mumber of items : 1

GTINs on Clavis PDL

Customer * CONVENIENCE > FOODS INC. * 2000080964

Select all
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Resolving Deleted Objects

To revive or purge (permanently delete) an object, right-click on it in the Recycle Bin and choose one of the
options described below.

Note: Objects can also be purged from the Recycle Bin on a scheduled basis by using the 'Schedule Empty
Recycle Bin' feature. For information on this functionality, refer to the Schedule Empty Recycle Bin topic.

=1} Recyde Bin

E {11150~

E {1148+ # Purge

ﬁ {1143 Approve Deletion

E (1148 Approve Deletion Recursively
E Eabcde Revive

- @ 12119 Revive Recursively

- 1821750

« Purge: Permanently deletes the object, with no subsequent option for revival.

o Approve Deletion: For workspace revisable objects only, removes the selected object from the Approved
workspace, and generates a deletion event for the object.

Note: Unless using the 'Force Delete & Purge' option from the Maintain menu, objects in the Recycle Bin
that exist in the Approved workspace cannot be purged unless their deletions have first been approved.
However, force purging an object without first approving the deletion does NOT result in a deletion event.
Therefore, if deletion events must be recorded for sending to downstream systems, the deletion should
always be approved prior to the purge action. For more information on the 'Force Delete & Purge' option,
refer to the Deleting Objects in the Tree Tab topic in the Getting Started documentation. For more
information on events, refer to Events in the System Setup documentation.

o Approve Deletion Recursively: For workspace revisable objects only, removes the selected object and all
of its children from the Approved workspace, and generates a deletion event for all impacted objects.

« Revive: Restores the selected object, returning it to the location in the Tree from which it was deleted.

Note: Object revival has dependencies and objects may not be revived exactly as they were prior to
deletion. For example, if an object had references to other objects which have subsequently been deleted,
those references are not present upon revival.

» Revive Recursively: Restores the selected object and all child objects to their previous location in the Tree.
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Schedule Empty Recycle Bin

Objects within the Tree Recycle Bin can be automatically deleted and/or purged on a scheduled basis by using
the 'Schedule Empty Recycle Bin' feature. Recycle Bin emptying scheduling is similar to scheduling other
processes in STEP (e.g., data imports, data exports, and bulk updates). The ability to schedule Recycle Bin
emptying at designated times (e.g., overnight) frees users from time-consuming, manual tasks to empty the
Recycle Bin, and allows the Recycle Bin to be regularly emptied with minimal or no user intervention.

Note: Scheduling is not available for the System Setup Recycle Bin. For more information on the System
Setup Recycle Bin, refer to the Recycle Bin for System Setup topic in System Setup documentation.

Configuring a Schedule Empty Recycle Bin Operation

To set a schedule for emptying the Tree Recycle Bin, follow these steps.

1. Right-click on the Recycle Bin in Tree and select Schedule Empty Recycle Bin to display the Schedule
Empty Recycle Bin wizard.

#-{J] Customer Root Py
[+ Entity Root
(+-{] GDSN
| B[] GDSN Receiver
= :
= {E Merge_Golden_Root
whi| -] Promotions
— IO wsEeP
w | F-E5l Publications
i [+-5] Primary Pros Search in recycle bin
1] H
§| @ Collections | (4} Empty Recycle Bin
[+ eCatalogs :
bt 5 Reqd:g&l E Empty Recycle Bin Before...
— S\ Schedule Empty Recycle Bin
Approve Deletion Recursively

2. Onthe Delete Options step, set the following options:
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[ Schedule Empty Recycle Bin et
Steps Delete Options
1. Delete Options Delete objects after 7= dayzin the Recyde Bin.

2. Select Contexts
[] Approve Deletion

3. Scheduled Execution Delete objects and their children from the Approved workspace.
4, Name Process

|:| Force Purge
Attempt to forcefully delete objects that cannot be deleted via the

standard Empty Recyde Bin operation.

Back Finish Cancel

« Delete objects after __ days in the Recycle Bin: Enter the number of days that an object must be in
the Recycle Bin before it is deleted. The default value is 7. Refer to the Approve Deletion considerations
below.

« Approve Deletion: Select this option to remove objects and their children from the Approved
workspace, which sends a DELETEAPPROVAL event.

Consider the following considerations for this parameter:

« The'Approve Deletion' parameter is not affected by the value provided in the 'Delete objects after _
__days...' parameter. As a result, when the Schedule Empty Recycle Bin operation runs, if 'Approve
Deletion' is selected, all objects in the Recycle Bin are removed from the Approved workspace, even
if they have not been in the Recycle Bin for the specified number of days.

o When an object is removed from the Approved workspace via 'Approve Deletion,' a
DELETEAPPROVAL eventis generated for that object. However, if the object is subsequently
purged from the Recycle Bin as part of the same Schedule Empty Recycle Bin operation, the event
is also deleted, since the object that the event is related to no longer exists in the system.

Therefore, if you have an event-based OIEP set up to capture DELETEAPPROVAL events, itis
recommended to schedule this OIEP to start at more frequent intervals than the Schedule Empty
Recycle Bin process, since the DELETEAPPROVAL event may disappear before the OIEP is
invoked. For example, schedule the OIEP to start every minute and configure the Schedule Empty
Recycle Bin process to run once a week.

« Force Purge: Select this option to attempt to forcefully delete objects from the Recycle Bin that cannot
be deleted via the standard Empty Recycle Bin operation. For example, with this option, objects in the
Approved workspace can potentially be force purged from the Recycle Bin without having first been
removed from the Approved workspace through Approve Deletion.

Note: To use the Force Purge option, the user who configures the Schedule Empty Recycle Bin
process must have the 'Force Delete and Purge' setup action included in their user privileges. For
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3. Onthe Select Contexts step, move the contexts from which to delete objects to the Selected list.

[ Schedule Empty Recycle Bin

Select Contexts

Select the context(s) from which objects should be deleted,

Available Selected
[English Danish
IFrench g m Engis-hm
\Germany DE m

K

2 context(s) selected

[FeeT] [Tt ] I o]

4. Onthe Scheduled Execution step, determine when and how often to empty the Recycle Bin.
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[ ] Schedule Empty Recycle Bin >
pty Recy
Steps Scheduled Execution
1, Delete Options Start
2. Select Contexts
() Mow Start at (hh:mm): 15:45
3. Scheduled Execution
4. Name Process () Later Start on (yyyy-mm-dd): |2019-05-15
(@) Weekiy End on {yyyy-mm-dd): |-
() Monthly Every: Mon [ ]Sat
() Later and repeat [1Tue []sun
[]wed
[ ]Thu
[ ] Fri
Start every Mon 15:46:00 ET, starting Wed May 15 2019
Back Mext Finish Cancel

5. Onthe Name Process step, name the batch process for easy identification, and click the Finish button to
complete the setup.

[ Schedule Empty Recycle Bin >
Steps Name Process

1. Delete Options

2. Select Contexts _

3. Ccheduled iy Batch Process Mame: |Weekly Scheduled Recyde Bin Purge

4. Hame Process

Back Mext Finish Cancel

6. Scheduled Empty Recycle Bin processes are stored on the BG Processes tab (using the batch process name
defined) under the Scheduled Processes node within Queued Processes. They display a status of 'waiting'
and can be edited by clicking the 'Edit' button in the Status row.
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BG Processe € Weekly Scheduled Recycle Bin Purge - Backgrou

8
--% Revive Recursively # || ¥ Properties
--% RuleSetExporter Property s [Value .
EE- {5 RuleSetimpor ter Started by USER4
--% STEP Workflow Profiling
[-#~ Scheduled Empty Recyde Bin Id BGP_312240
B-§ Scheduled Processes Description Weekly Scheduled Recyde Bin Purge
E}% Queued Processes Schedule Every Sun 01:00:00 ET, starting Fri Jun 21 2019
- st [Wweekly Scheduled Recyde Bin Purge
Execution Server doc-dev
. 5 Ended Processes Status waiting Edit
{5 Seal Change-Package Created Fri Jun 21 11:26:28 EDT 2019
--% Smartsheet Export = -
"':':h Smartsheet Import Starte Fri Jun 21 11:26:30 EDT 2019
--% StateflowDeadline # of warnings 0
"% SuspendBGPs # of errors 0
"% Tra”dah_m Mext Run Sun Jun 23 01:00:00 EDT 2019
--%ﬁ Translation Import
--% Unique Key Processes § Execution Report
"% Uniink Object Type T Context 1D(s). Context? (Fri Jun 21 11:26:28 EDT 2019
% Update actual page from plan onte (s). Context1 (Fri Jun 26 ]
% UploadOTPDocument 2 Workspace ID{s): Main (Fri Jun 21 11:26:28 EDT 2019)
% WWeb UI Asset Pipeline Download * Delete Objects after limit. 7 (Fri Jun 21 11:26:28 EDT 2019)
% Web UI Download < Approve deletion: true (Fri Jun 21 11:26:28 EDT 2019)
- Web UI Upload v ||| = Force Purge: false (Fri Jun 21 11:26:28 EDT 2019)
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Navigating and Searching

This section describes the many different ways you can access specific data in the workbench. STEP
Workbench offers rich functionality for finding both System Setup and Tree objects based on various criteria.
Whether it be by standard navigation, Bookmarks, searches using basic, advanced, or drill-down functionality,
STEP provides many ways to locate the required data.

This section will allow users to:

« Navigate hierarchies

« Find data quickly using the Goto function

« Find data using basic and advanced searches

« Perform drill-down searches using the Search Result Profiling page
» Use standard and Search Bookmarks

Note: Objects within the Recycle Bin are not searched and will not display in search results.

For information on search functionality in the Web Ul, refer to the Homepage Widgets topic and the Advanced
Search topicin the Web User Interfaces documentation.
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Navigation

You can navigate the STEP tree structures in the same manner as you navigate Windows folder structures.
Basic desktop computer skills are prerequisites for all users of the STEP system.

Expanding a Folder
Use one of the following methods to display the contents of a folder:
« Click the plus sign (+) to the left of a folder
« Double-click a collapsed folder
Collapsing a Folder
Use one of the following methods to hide the contents of a folder:
o Click the minus sign (-) to the left of a folder
« Double-click on an expanded folder
Collapse Tree

When folders in the Tree hierarchy are expanded, all can be collapsed by using the 'Collapse Tree' option from
the 'View' menu.
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rj Icons

|j Tllustrations

B[] Installation Manuals
[T Logos

[#-[T] Owners Manual
|j Product Images

[] Product Videos
Transformation Lookup Table
+-[ —| Configurations

+-[—] Web Sites

[
[
- [0 Addresses
[
[
[

+- (0] Customers

+- (0] Entity Root
]ﬁ Publications

=-IT] Primary Product Higrarchy
EHIT) Products

. -7 Apparel

[+-{I7| Footwear

[=-{IZ] Hardware

. B[ Tools

View

Maode
Context
Workspace

Target
Filter
Primary Hierarchy

Select version

Mew View
Remowve view

Product views

Show Source Context
Rotate Table
*  Reload

d Collapse Tree

Micahle ralrnlated valies

F5
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E-{T] Assets
r_=| Configurations

-5 eClass 10

r_=| ETIM Hierarchy

= Index Words

r_=| Merchandising Hierarchy
r_=| Offers

r_=| Suppliers

B[] Web Sites

---@ Addresses

-0 Customer Root

@ Customers

- (&) Entity Root

- () GDSN

ﬁ Publications

r_=| Primary Product Hierarchy
-3 Collections

[ﬁ eCatalogs

-1 Recyde Bin

Note: Folders too many sub nodes display an (x) and cannot be expanded in the hierarchy. To view objects
beneath such folders, use the search or Goto functionality. For more information, refer to the Goto topic.

Navigating and expanding folders and sub folders can be done in any tab. However, when in the Workflow tab,
first open a flipper to display the processes.
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Goto

The Goto functionality allows the user to locate an object in STEP in a quick and efficient manner. There are two
'Goto' features:

« Goto - A quick way to jump to a particular object in the database based on the name and/or ID. If there are
multiple hits, it displays the first one. Press 'Ctrl+G' to move the cursor to the Goto parameter.

« Goto Next - When there are multiple hits from the 'Goto’ function, the user can opt to select Goto Next to
continue on to the next hit. Press 'Ctrl+E' to display the next Goto Next item.

Type in the Name or ID of an object in the Goto field, press Enter or click the Goto next object button to the
right of the field, and the system will take you to the object without displaying a list of search results.

Once you start typing in the Goto field, the system will suggest objects matching the typed-in text (case
insensitive) and display them on a dropdown menu as shown below.

Goto :lD.I'N.amE - a [}[}
L2 A (12345-001) - u
[T A (B783) b
[IT asset.dass (asset.dass)

(1T asset.colors (asset. colors)

(1T asset.colorspace (asset.colorspace)
DI asset.compression (asset. compression)
(1T asset.creator (asset.creator)

ﬂi asset.depth (asset. depth) -

=

When typing in the 'Goto’ field all objects are searched not just products. This includes but is not limited to
classifications, assets, attributes, user names, etc.

Itis important to keep in mind that:

o Object IDs and Names are both searched.

o Object IDs are searched case-sensitive.

o Object Names are searched case-insensitive.
« Wild Cards are not allowed

Items can be selected from the menu using either the mouse or the keyboard up arrow and down arrow keys. A
maximum of 20 items will be displayed.

Another way to find the Goto and Goto Next options is in the Navigate menu.
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Mavigate Format Maintain Windov
@ Search Ctrl+F
Search Below

Goto Ctrl+G
Goto Mext Ctrl+E

Back

S o

Forward

Bookmarks >

Find Similar Product

Keys in the Goto function dropdown

The ID/Name dropdown list in Goto function will have any created keys as part of the dropdown list.

Goto | ID/Name - |Red
ICyMame

Supplier Part Number

Note: Only activated keys can be found in the Goto function dropdown list. Refer to the Creating and
Deleting Keys topic in the Data Quality documentation.

Selecting a key from this dropdown can be used to identify and delete objects, parents, referenced objects, and
assets. The system will take the user to the product that has the unique key value stored on that object.
Setting the Primary Hierarchy for ‘Goto' searches

A user can set the Primary Hierarchy to be either a Primary Product Hierarchy, Classification folder, Asset
Folder, etc, through the View > Primary Hierarchy Menu. Once the primary hierarchy is selected and an object is
searched, first priority is given to the folder that is selected and then the other folders will be searched.
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View Mavigate Format Maintain Window Help

Mode | v | € > Cure [teditor
Context

Workspace

Target

Filter Spediic Atirbutes

Primary Hierarchy P Assets

Select version Classifications

Primary Hierarchy

Configurations

Index Words

Mew View

Remove view

. Merchandising Hierarchy
Product views

Suppliers
Show Source Context Web Sites LS
Rotate Table Primary Product Hierarchy
' Reload F5
Other

Collanse Tree

For example, if the View > Primary Hierarchy is set to Assets, the product will first be searched under Assets.
Then when clicked on Search again, the user will be shown in the actual hierarchy where the product was initially
created. In normal circumstances, the product will by default be searched in the actual hierarchy where it was
initially created.

Important: Objects within the Recycle Bin are not searched as part of the Goto functionality.
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Bookmarks

Bookmarks are placeholders created by the user that serves as a shortcut for previously viewed objects.
The following types of bookmarks exist:

1. Standard Navigation Bookmarks
2. Search Bookmarks.

Note: Bookmarks are stored on the local STEP system and are not accessible when logging into STEP from
a different computer.

Standard Navigation Bookmarks

Standard navigation bookmarks are used for quickly accessing specific nodes in the Tree and System Setup
hierarchies.

You can add a standard navigation bookmark by selecting a node in the hierarchy and clicking Add Bookmark
in the Navigate: Bookmarks menu or alternately by using the Ctrl+D keyboard shortcut. The bookmark will
afterward be accessible in the left side Bookmarks tab.

Search Bookmarks

Search Bookmarks are used for storing specific searches that can then easily be re-run.
Steps to add a Search Bookmark:

1. Create a search criteria in the Search tab.

5 | search: T-shirts =]
- { Object Type ¥ ﬂ
= Sales Item "'|
5
2 e | Reset | | Search |

Displaying 3 of 3 results Show Details

ﬁ Mame >

8 || > = T-shirts ID = 18454

=]

ol * T-shirts I = 18206
[0
@ T-shirts ID = 18202

2. Goto Navigate > Bookmarks
3. Select'Add Search Bookmark'
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D Context E @ Search Ctrl+F

4. A dialog will be displayed to type in the bookmark name.

Enter Bookmark Mame

@ Enter the bookmark name
- |Search #1 |

5. Click on OK button.

Accessing the Saved Search Bookmark

When you click on a stored search bookmark, the search parameters will be populated. Select Search to rerun

the search.

B

&1 || Search: T-shirts

T:_ [DbjectType = Sales Ttem

-]

bl (oL~ | Reset || Search |
" Show Details
g [ MName *

> Gote Ctrl+G
Ohject Tyg ||~ Goto Next Cirl+E  Search Result Profiling
Sales Item )
v € Back 3 hit(s)
v 3 f 4 Click links to narrow down search
L onwar
Displaying 3
B [ Name Bookmarks [  Add Bookmark Ctrl+D
ﬁ : T-sh I Add Search Bookmark
210G |_=|T'5H Find Similar Product a

Note: Search bookmarks are saved under the Bookmarks tab with a search icon labeled with the bookmark
name provided by the user.
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Bookmarks

w |51 Brand Logos (BrandLogos)

~1 |21 Export Configurations (stibo. EMConfigFoal
5 Copy Writing State (100100)

S & Search #1

Saved bookmarks can also be found in the under the Navigate > Bookmarks.

Mavigate Format Maintain Window Help

@ Search Ctrl+F e g 6
[} Goto Ctrl+G
[>[> Goto Mext Ctrl+E
€ Back
< Forward
Bookmarks : Eﬂ Add Bookmark Ctrl+D
Find Similar Product L b el
2 Brand Logos (BrandLogos)
[0 Export Configurations (stibo.EMConfigFolder)
E  Copy Writing State (100100)
@ Search #1

Editing a Bookmark

Both standard navigation and Search Bookmarks can be edited in the Bookmarks tab by right-clicking the
bookmark and selecting Edit Bookmark in the context menu. It is possible to edit the name of the bookmark and
also the object / search URL if the Edit URL checkbox is activated.

Removing a Bookmark

Both standard navigation and Search Bookmarks can be removed from the Bookmarks tab by right-clicking the
Bookmark in the tab and selecting Remove Bookmark on the context menu.
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Search

The Search tab, in combination with the Search Result Profiling page, offers extensive methods for locating
objects in STEP quickly and efficiently.

Generally, there are two approaches to performing searches:

1. If you know specific details about the object to find, use the Search tab. For example, all products where the
value for the attribute "Weight' is less than '5 kg', the object is located below the product folder 'Office Chairs'
and is not of the object type 'ltem’'.

2. If you do not know details, start with a broad search and then narrow it down using the Search Result
Profiling.

Note: Objects in the Recycle Bin are not searched and will not display in search results.

Search Elements

The elements on the Search tab work together to create and refine a search for objects in STEP. The numbered
elements in the following image are described below.
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Search Search Result Profiling
|search: 20%
|Search: 3 || Search Result Profiling
: —

| = Chject Type = Aszet 127 hit(s)

[W-o Click links to narrow down search

| ‘ Motice: Profile is notfiltered according to contesd visibility / privilege check
@ Advanced

geset QEEF " ] Results by Object Type

Displaying 100 of 127 resullo ogh,:,w Detais || Product (107} - exclude
ame

EHEH'I (41) - exclude

*[C]2 ID = 20865 - | Salesltem (18) - =xcluge
>[T145 ID = 20836 .CEISE (10} - exclude

S =9 0 = 20135 [CLevel2 (7} - =xclude
>

>

m

[TlLeveld (B) - exclude
20 1D = 20695 -|’[EFHFD|E|EI'(51.' - exclude
I 20-68204 1D = 2058; 0 [T SaleshtemFolder (6) - exclude

» W™ 050-42151 D = 7525 EF‘allet (4) - exclude
Levell(3) - sxclude

> =
[ |91 D= 21% [CLeveld (3} - =xclude

> |20 ft. Medium Voltage Cable (Pallet) 0 = 755 [T SalestemFamily (2} - exclude
w| 7B32-200 D = 783 Il temFamily (1} - exclude

w 18207-012 D = 15207 | Pack(1) - scluce

M 18210 M B I = 18210 Classification {201 - exclude

18212 L B J[? = 18212 [CAssetlevel 2 (7) - exclude L

18213 M O D = 18213 [CAssetlevel 1(4) - sxclude
N [C]Department (3] - sxclude
> ; =
| 16219-012 D - 16214 [T MerchandisingClass (3) - excluge
* N 18215-012 I = 18215 [T SubDepartment (2) - =xclude

18216 L O 1D = 18215
M 20444 D = 101115 Results by Position in Tree Hierarchy
) 20635 D' = 20625 Results by Parent

w 20709-012 1D = 20705 iDisplaying the 5 most common)

20714 0 = 20714

m

W

L

r_=| Products fEQ} - exclude
M 20726 (box of 5 pair orange) 17 = 20725 - BB Euy Side Packaging (15} - =xclude
1 | b r_=| Products (110 - =xclude

- [l Crinking ltems (5} - =xclude
perations on [T T-shirts and Sweatshirts (4) - sxclude

:

1. Search criteria type selector - Click the text to display a list of available search criteria options. Refer to the
Search Functionality topic for more information.

2. Add criteria/ operator button - Click the green plus button () to add a new search criterion or hover the
mouse over and hold down the green plus button () to display a sub menu and choose an OR operator or
an Exclude operator. Refer to the Search Functionality topic for more information.
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Remove search criteria button - The X button clears an individual criteria from the search. Click the Search
button to refresh the Results Area.

Reset button - Clears all results and search criteria from the Search panel and Search Result Profiling page.
Search button - Runs the defined search.

Search result counts - The number of items currently displayed and total number of items found by the
search. If the search finds objects not visible in the current context or objects that you are not privileged to
view, a message is displayed and the objects are not displayed in the search result.

Show Details / Hide Details toggle - Hyperlink shows or hides search result details. The details view displays
asset thumbnails. The asset thumbnail is displayed when the search is under a classification folder and there
are assets. Similarly, if the search is for the products and the product is linked to an asset, the thumbnail is
displayed. If no image is linked, 'No Primary Image' is displayed.

Search results list - When a search has been executed, the results are shown in a list below the search box.
Clicking one of the results will open the object editor for that particular object in the Search Results Profiling
pane, while continuing to display the search results list. It is also possible multi-selection from this listand a
maximum of 100 results are displayed. The complete result set can be viewed, exported, or updated using
the 'Operations on Entire Result' options below.

Note: The maximum results displayed can be adjusted via the case-sensitive
'DrillDownSearch.Maxresults' property in the sharedconfig.properties file. However, it is not advisable to
adjust the number more than 100+ as this will diminish system performance as the number increases.

Save as Collection button - Click to open the 'Save as Collection' dialog and save the entire result setas a
collection. Collections are available on the Tree. Refer to the Search Operations on Entire Result topic for
more information.

Export button - Click to open the Export Manager wizard and export the entire result set to a specified file
type. Refer to the Search Operations on Entire Result topic for more information.

Bulk Update button - Click to open the Bulk Update wizard and modify a variety of elements on each item for
the entire result set. Refer to the Search Operations on Entire Result topic for more information.

Search Result Profiling - Panel displays profiling information about the search including categories and
provides a convenient way to further refine the search. Refer to the Search Result Profiling topic for more
information.

Search Options

The Search tab dropdown includes a number of options. Each is described in greater detail in the topics that
follow.

Search =
@ Advanced j
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o Object Type

o Search Below

o Referenced Assets

» Revised Objects Changed Since
« Data Containers

o Search from List

« JavaScript Search

« Missing Mandatory Values

o Unapproved

o Product Override Search

o Search in Publication Hierarchy
» References

« Referenced By

o STEP Workflows

o Sample Result

« Translation Status

o Unpushed or Failed Assets

For information on performing optimal searches, refer to the Scheduled Process Recommendations topicin
the System Administration documentation.
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Search Functionality

This section describes the different types of search criteria available in the STEP system as well as some basic
search functions.

Important: Calculated attribute values are generated on-the-fly. Searching for the value of a calculated
attribute is not allowed since generating all possible calculations would cause substantial performance
issues.

Standard Search Criteria

The standard search criteria named 'Search' allows you to find objects based on name, ID, attributes and their
values.

A text string entered in the search field will search for object names, IDs, or attribute values where the text
occurs.

Cearch ™
Hats!
@ advanced
ERE [ Reset ][ Search ]
Show Detailz
| Mame »|

If you enter a text string and click the Search button, search finds objects with an ID, and/or a name and/or an
attribute and/or their values matching the entered string. You can further refine standard searches as shown

below.

Note: By default, standard searches are case insensitive for name and attribute value searches, but are case
sensitive for ID searches. You can make name and attribute value searches case sensitive using the
Advanced option 'Match Case on Names and Values.' For more information on the options available under
advanced, refer to the Search: Advanced Options topic.

Search Field Typeahead

Once you start typing in the standard search criteria text field, the system suggests possible entries matching the
typed in text (case insensitive), and displays them on a dropdown menu as shown below.
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Search

[Search =
Haﬂ

|..| Hat123 (110130)

—[[T| Hats and Caps {20435)

[l Hats and Caps Items (20438)

[T Hats and Caps SalesItems (20433)
[ Hat Size (HatSize)

[E Hat Workflow (Hat Workflow)

|l |

In the typeahead menu, objects are displayed with their relevant icon, then name, and then ID in brackets.
Attribute values are shown as text.

Items can be selected from the menu using either the mouse or the keyboard 'arrow up' and 'arrow down' keys.
A maximum of 100 items will be displayed.

Note: Using sharedconfig.properties entries, it is possible for a system administrator to control the behavior
of the typeahead. E.g., after how many entered characters should suggestions be shown, etc. Search for the
"TypeAhead' section on the Configuration tab. For more information, refer to the Configuration topic in the
Administration Portal documentation.

Limiting Results to Matches on IDs

You can limit standard searches to match on ID only by entering 'ID =" at the beginning of the text field as shown
below.

ID = 108251
ID = 108252
% ID = 108255
% D = 108256
ID = 108286
ID = 108287 ~

[
5]
]
8
S
h
fun)
[l |

'id"and 'ld" will also work, as the spaces on each side of the equals sign are optional.

Limiting Results to Matches on Name

You can limit standard searches to match only on name by entering "Name =" at the beginning of the text field as
shown below.
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Search

Mame = hat]

lL Mame = Hat123

[[T| Mame = Hats and Caps

Il Mame = Hats and Caps Items

[[C| Mame = Hats and Caps SalesItems
|]I Mame = Hat Size

[E Mame = Hat Warkflow

| — el |

"name" and "NAME" will also work since the spaces on each side of the equals sign are optional.

Attribute Value Searches

Using a standard search, you can limit the result to only match on values for specific Attributes.

Important: Calculated attribute values cannot be searched since they are generated only when viewed or
processed.

There are at least three ways to construct an attribute search query:

1. Start entering an attribute name or ID, then select the relevant attribute from the typeahead menu, after
which "Attribute Name (Attribute ID)" is inserted in the text field, then enter a search operator or enter a
SPACE and select an operator from the typeahead menu and enter the value to search for.

Search
gF1i123 (110190)

T Hat123 (110190)
[[] Hats and Caps (20435)

[l Hats and Caps Items (20435) I
[T Hats and Caps Salesltems (20438) :
|]I Hat Size (HatSize) |

@ Hat Workflow (Hat Waorkflow)

2. Enterthe attribute ID (case sensitive), enter a search operator or enter a SPACE and select an operator from
the typeahead menu, then enter the value to search for.
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Search

[Search
Hat123 (110190) |
Hat123 (110190) !

| Hat123 (110190) 1!
Hat123 (110190) <
THat123 (110190) <=
Hat123 (110190) =
Hat123 (110190) =
Hat123 (110190) ==

T T

3. Enter the attribute name (case insensitive), enter a search operator or enter a SPACE and select an operator
from the typeahead menu, then enter the value to search for.

Search
Seanch |
SalesItem = |
SalesItern = 120-Volt Portable Tire Inflator, Campbell Hausfe -
| |SalesItern = 120-Volt Portable Tire Inflator, Husky E|

Salesltern = Battery, All purpose, AA, 2 pk

“|Salestemn = Bed, Expresso, Comfy, Queen

Salesltern = Bottled Water, Evian, 8 oz 12pk

Salesltern = Bottled Water, Evian, 8 oz 24pk

SalesItern = Bottled Water, Evian, 8 oz 6-pk

SalesItemn = Cap, Orange, One Size, Cotton =

|l

Note: As shown on the screenshot above, if you have the required privileges you will get typeahead
suggestions on existing values after having specified a search operator.

Attribute Value Search Operators

The following search operators that can be used when performing attribute value and reference metadata
attribute value searches.

Operator Description

< Less than operator. Only works for number validated attributes (Validation Base Type = number,
integer or fraction)

<= Less than or equal to operator. Only works for number validated attributes (Validation Base Type
= number, integer or fraction)
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Operator Description

= Equal to operator.

> Greater than operator. Only works for number validated attributes (Validation Base Type =
number, integer or fraction)

>= Greater than or equal to operator. Only works for number validated attributes (Validation Base
Type = number, integer or fraction)

! Operator used for finding objects where the specified attribute does not have values in current
context. Note that the search does not check whether the attribute is valid for a given object.
Also, if the specified attribute has an inherited value (not a local value), then the object will be
listed in the results set even though the value field is not empty.

Note: This operator does not perform searches on missing reference metadata attribute
values.

I Operator used for finding objects where the specified attribute does not have local values in any
context. Note that the search does not check whether the attribute is valid for a given object.
Also, if the specified attribute has an inherited value (not a local value), then the object will be
listed in the results set even though the value field is not empty.

Note: This operator does not perform searches on missing reference metadata attribute
values.

Wildcards in Searches

Two following two wildcards are available for performing searches on partial text strings:

« * (asterisk ), multi-character, represents any number of characters in a string
« 7 (question mark), single character, represents exactly one character

Wildcards can be used anywhere in the text string.

Note: Searches starting with a wildcard should be avoided since they are significantly slower than other
searches.

Searches in 'Full Text Indexable' Attribute Values

Searches in values for attributes configured with the 'Full Text Indexable' parameter set to 'Yes' do not work in
the same manner as searches in other attribute values. Apart from common English words like 'in' and 'as,’' each
word is indexed as a separate element. For more information about the words that are not indexed, search the

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 264



|STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

Oracle website for the 'English Default Stoplist.'
For example, consider an attribute named 'Description’ that has the following value on a given product:

Black powder coated die-cast aluminum enclosure. Textured surface. Bulk version: Enclosures may possibly
have flaws in the finish such as scratches, dents, discoloration, etc.

« Ifthe'Full Text Indexable' parameter is set to 'Yes' for the attribute, a search for 'Description = aluminum'’
returns the product.

« Ifthe'Full Text Indexable' parameter is set to 'No' for the attribute, a search to find this product would
require a wildcard on both sides of the 'aluminum’ text like this: 'Description = *aluminum®.

Note: Searches starting with a wildcard (as shown above) are significantly slower than other searches.

By default, if you have not specified an attribute, typeahead for Full Text Indexed attribute value entries is turned
off. If you have specified an attribute, you will first get typeahead suggestions after having entered three (3)
characters of the value entry. Refer to the 'Search Field Typeahead' section above.

Numeric Value Searches for Attributes with Units

Values for numeric searches with no units are assumed supplied in the default unit for the attribute. For example,
if kg is the default unit for the "Weight' attribute, 'Weight = 1' will match '1 kg' and '1000 g'. If no default unit is
configured, the search 'Weight = 1' will only match the value '1" with no unit.

ISO Date Searches

If an attribute with the validation type of 'ISO Date," where the date populated in the field is in the YYYY-MM-DD
format, a search on the populated attribute on objects can be performed using the following key words in the
Search tab: now, today, tomorrow, yesterday.

While it does not matter if the 'ISO Date' is set to 'Strict Validation' or not, it does matter that the date is written in
the YYYY-MM-DD format. Any other format, including using slashes ' /' instead of dashes '-' will not work since
searches work by matching only values conforming to the ISO standard (with dashes). For this reason, itis
recommended that 'Strict Validation' be set to Yes, otherwise, the stored values are not guaranteed to be
searchable.

In the example below, a user searched for an object that has a particular date. The user typed in the name of the
date attribute 'ISO Date', and then used an 'attribute value search operation' followed by the keyword
'tomorrow.' Then they narrowed their search even further to just under one particular node, giving them the
desired results.
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Search W™
ISCDate (ISCDate) = tomorrow

&= advanced

T

[Search Below = Flashlights Ttems =]
g Reset Search
Displaying 1 of 1 results Show Details

Mame

> | flashlight case I = 129565

Search Result Profiling
1 hit(s)
Click links to narrow down search

Results by Object Type

Product (1] - exclude

Eltem (1) - exclude

Results by Position in Tree Hierarchy
Results below child nodes of Flashlights [tems
B flashlight case (1) - exclude

Results by Parent
Bl Flashlights tems (1) - sxclude

Combining Search Criteria

You can combine different search criteria to create advanced searches. Except for cases where one or more
'OR' operators are used, the sequence of the criteria does not matter.

The search shown below:

|Search: Name = Hat123

E‘

|Search Below = Apparel

[W

Product

E

Displaying 1 of 1results

| Reset ||

Show Details

Marme

>

W

w Hatld3 I = 110190

generates the same results as the following search:
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Search

|Search Below = Apparel

| Object Type = Product
[Search
Mame = Hatl23
&= pdvanced

EE | Reset |
Displaying 1 of 1 results Show Details
Mame >

> | Hat123 1D = 110150

When not using 'OR' operators or 'Exclude’ search criteria, all criteria are combined with an implicit
'AND' operator.

Click the add criteria button (\5# ) to construct a query that includes more than one criteria. By default, the
criteria will be 'AND," meaning that all criteria will be met for the results.

As an example, the search shown below will find objects that have the value 'Black’ for the 'Color" attribute AND
that are present below an 'Audio Visual Equipment' hierarchy node. The order of criteria does not impact the
results.

|Sear::h: Color (Color) = Black (Bladk) E‘
Search Below ™
’VEIecl:rimI & Electronics (3302) Eﬂ
g Reset Search
Search Result Show Details
[ Name ¥
-Operations on Entire Result
0 @

For information on constructing your search using 'Exclude’ search criteria and 'OR' operators, refer to the
section below.

Using 'Exclude’ Search Criteria

Itis possible to negate all the different types of search criteria using the 'Exclude’ search criteria functionality.

You can add 'Exclude' search criteria to search either by clicking and holding the add criteria button (52 =), then

selecting 'Add Exclude' from the menu that displays (shown below). Criteria can also be excluded by clicking an
‘exclude’ link on the generated 'Search Result Profiling' panel.

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 267



Search
|Search Below = Apparel =]
[Object Type = Product =]
|Search: Name = Hat123 =]
Add Criteria | Reset |[ search |
Add OR Show Detailz
»
Add Exclude 5,0,

'Exclude’ search criteria appear with a red minus icon on the left side of the criteria panel (shown below).

|Search Below = Apparel x|
| Object Type = Product =]
|Search: Name = Hat123 =]
(Search |
= |Culur = Gray |
& pdvanced T
EEE [ Reset ] [ Search ]
Displaying 1 of 1 results Show Details
Mame >
* | Hatl23 I = 7707195

When no 'OR' operators are used, the sequence of 'Exclude’ search criteria does not affect the results.

Continuing with the example above, the search finds objects where all the 'positive’ criteria are met, minus
objects where the attribute 'Color' is 'Gray."'
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Note: Use as many 'Exclude’ search criteria as needed. Keep in mind that the 'Exclude’ criteria are
subtracted from the 'positive’ search results, so a search containing only an 'Exclude' search criteria without
an 'Include’ criteria as point of departure will not generate any results.

Using the 'OR' Operator

Add an 'OR' operator to search by clicking and holding the add criteria button (58 =), then selecting 'Add OR'
from the menu that displays (shown below).
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| Reset || Search |
Add Criteria Show Detﬂi:&l
9 Add OR
Add Exclude

When using 'OR' operators, search is divided into separate parts containing one or more criteria. Each partis, in
effect, executed separately and the results are then added before presenting the final result.

As itis not possible to work with parenthesis, when working with 'OR' operators it is often necessary to configure
the same criterion on both sides of an 'OR' operator. As an example, the search shown below will return all
objects where the name starts with the text 'Hat123' and the color is 'Black,’ plus all objects where the name
starts with the text 'Hat123' and the color is 'Gray.'

Search
|Search: Name = Hat123 =]
[Search: Color = Black =]
OR
|Search: Name = Hat123 =]
(Search
|Cnlnr = Gray |
€ Advanced j
EEE [ Reset ] [ Search ]
Show Details
[ Mame >
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Search Result Profiling

The Search Result Profiling page appears when you have run your search. The page displays statistics about
the search grouped under the headers Results by Object Type, Results by Position in Tree Hierarchy and
Results by Value. Apart from giving you information about the results of your search, you can use the page to
further refine your search. Thus, if you start by running a broad search, you can refine it by clicking the links
'Exclude’ in the profile - thereby adding additional criteria to your search. Refer to the example below:

Search Result Profiling

av hits
Click links to narrow down search

Results by Object Type
Product (78) - =:clude

64 Product (78 - exclude

Asset [B] - exclude

i TIFF Image (7) - exclude
L PG mange (1) - exclude

Attribute (1) - =xclude
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When exclude option is clicked, an additional search criteria called 'Add Exclude' is added as shown below:

|Sean:h Below = Primary Product Hierarchy

E‘

| = Search: Object Type (getDbjectType)

|§1

Search W™
= | Exncellence (I-Excellence)

&= advanced

T

B

Displaying 100 of 1232 results

Reset

Show Details

Mame

> | 7130-03-FR [D = 5554

W

w F132-06 [0 =5085

W

|.. 7133-12 D = 8051
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For all types of searches, the Search Result Profiling page will display the results sorted by Object Type. The
screenshot above shows the Results by Object Type. The search result includes 78 Products of the Object
Type "Product”, 8 Assets (where 7 are of the Object Type "TIFF Image" and 1 is of the Object Type "JPG
Image") and finally 1 Attribute.

If you click TIFF Image, an Object Type Search Criteria is added to the search. The search runs again, finding
only objects with the Object Type "TIFF Image."

If you click exclude next to TIFF Image, an Object Type Search Criteria is added to the search, but this time
as an Exclude Criteria. Hence, all objects of the Object Type "TIFF Image" will be excluded from the search
result.
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Search: Advanced Options

Additional options for narrowing a search can be accessed under the Advanced flipper in Search.
Each of the following advanced options is described in the following sections:

Match Case on Names and Values
Include Inherited Values

Exclude Values

Regular Expression

o o bd =

Include Data Containers

| Search ™ =]

¢ Advanced
[ Match Case on Mames and Values

[]Indude Inherited Values
[] Exdude values

[ ] Regular Expression
[]Indude Data Containers

Ha Reset Search

Show Details
[ |Name » |

1. Match Case on Names and Values - \When selected, Name and Attribute value searches are not case
sensitive.

For example, this is a basic search with search criteria of 'Search = T-Shirt.'

Search W
T-shirt
&= advanced

| o v| Reset Search |
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The search results are displayed with all the objects in STEP that match the search criteria, in this case 'T-
shirt.'

STEP objects in the search result includes:

» Classification / Asset/ Product/ Entity objects
« Special Types objects
o System Setup Tab objects

Search
t-shirts

= Advanced

3|

Displaying 3 of 3 results

Reset

Search

Show Details

Mame

>

>

T-shirts I = 18454

>

T-shirts I = 18205

>

T-shirts I = 18202

Search Result Profiling

3 hit(s)
Click links to narrow down search

Results by Object Type
Product (2} - exclude

r_=|LE'I.|'E|3f'HI - exclude
[Tl Sales ltem Family (1) - excluds

Classification (1] - exclude
[ MerchandizingClass (1) - ssxclude

Results by Position in Tree Hierarchy

Results by Parent

[C1T-Shirtts Sales ltems (1) - exclude
[ Sportswear (1) - sxcluds
[C1Upper Body Wear (1) - sxclude
[C1T-shirts (1) - exclude

Results by Value

Hame matching "t-shirts"

Mame (3} - exclude

Now, on the search, select the Advanced option 'Match Case on Names and Values.'
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Search

[ Search = 3

‘tshirts |
@ Advanced

Match Case on Names and Values

[] Indude Inherited Values
[ ] Exdude values
] Regular Expression

[] Indude Data Containers

(g | Reset || Search
Show Details

With this option selected, the search result will only include attribute values and all the object names in STEP
that match the search criteria in the correct case. Since the previous search results were all a different case,
this search will return no results.

Search Search Result Profiling -
[ Search W Ed
bshirts ||| search Result Profiling
@ Advanced 0 hitts)

Match Case on Names and Values
[] Indude Inherited Values
[ ] Exdude values

[ ] Regular Expression

[] Indude Data Containers

(g Reset ||| Search |
Displaying 0 of 0 results Show Details
|__Name > |
-Operations on Entire Result

Note: ID searches are always case sensitive.
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2. Include Inherited Values -When selected, attribute value search results will show objects where the match
includes inherited values as well as objects where the match includes locally defined values.

Attribute values with hierarchical inheritance (values with green triangle) will only be included in the search
result when Include Inherited Values option is selected.

|> Frnduct Weight |! 3] |

Dimension dependent Attributes — Specification or Description attribute values inheriting from other contexts
(values with a red triangle) will also be displayed in the search result even when the user does not select the
option Include Inherited values.

Exdusive? |E'li E
Mew Product |E"l: E

W

W

3. Exclude Values - When selected, attribute values are not searched for the entered search term. If
unchecked, attribute values are searched for the entered term and objects with the search term populated as
an attribute value are included in the search results.

The Exclude values in advanced search are useful for neglecting objects which are having search content as
avalueinit.

For example, assume there are attributes which has value 'Red' in few objects and there are objects which
has Object Name/ID as'Red.’

If a normal search is performed, the results for 'Red' are shown below.
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Search < Search Result Profiling ~put
Search +
Red Search Result Profiling
@ pdvanced 11 hit(s)
H Reset Click links to narrow down search
Displaying 11 of 11 results Show Details
Mame ¥ Results by Object Type

18212 LB ID = 18212
88723-12 ID = 100914
A ID = 12345001 B Active Products (7) - =xclude
¥ Cosmic Party Hat - Gold and Red 1D = 13442: E gzrlr; ; ﬁ;”r'r:?fg‘? - ;’;l'*“‘

i:] Cosmic Party Hat - Green I = 134414 Bl ltem Folder (1) - =xclude

e Mens TPBO 2 [0 = MT 18400
I Pink & Blue Giraffe Party Hat [D = 121185 Results by Position in Tree Hierarchy
¥ Red Baseball Cap 1D = 20805

jj Red Cotton T-Shirts 1D = 18205
I Rustic Bed Frame D = 132495
ji T-shirts Ttems [ = 15205

Product (11] - exclude

Results by Parent
(Displaying the 5 most commaon)

[C]Products (3} - exclude

Bl T-=hirts ltems (2} - =xclude

Bl Children's Hats (2} - excluds
- Red Cotton T-Shits (2) - =xclude
|‘_=|Hats {1} - exclude

Results by Value

Values matching "Red"
(Values are displayed in lowercase)

red (11) - exclude

Attributes with values matching "Red"

1T secondary Color (7) - exclude
I]I Color (2} - exclude

[T Available Colors (1) - exclude
[T attribute B (1) - exclude

-Operations on Entire Result

B &

If the same search is performed but with 'Exclude Values' selected under Advanced, only attribute IDs and
Names matching the search are turned.
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Search Result Profiling

M| Searnch W 2]
Red Search Result Profiling
Ad d
? Advance 2 hit(s)
[ | Match Case on Names and Values Click links to narrow down search
[] Indude Inherited Values
Results by Object Type
Exdude values
Product {2} - exclude
] Regular Expression

8 Active Products (1) - ssxclude
‘HEH"I Family (1) - sxclude

[] Indude Data Containers

b -| Reset Results by Position in Tree Hierarchy

Displaying 2 of 2 results Show Details || Results by Parent
Mame ¥ (Displaying the 5 most common)
> = REE'H
:Eﬂﬁll D 7 r_=| Products (2) - exclude
> [l Red ID = 18205 1181167 — Hats and Caps ltems (1) - =xclude

[ Hats (1) - exclude
Il Hats and Caps ltems (1) - exclude
Bl T-chirts Items (1) - excluds

Results by Value

Hame matching "Red"

Mame (2] - sxclude

-Operations on Entire Result

B E

4. Regular Expression - When selected, attribute values are searched using the regular expression entered in
the Search text box. Although establishing an attribute with Validation Base Type of Regular Expression
allows more than 2000 characters (for example, [A-Z]{1,3000}), searching via a Regular Expression only
returns results for matches within the first 2000 characters. For more information, refer to the Regular
Expression topicin Resource Materials online help.

5. Include Data Containers - Include any search terms contained inside data containers.
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Search Operations on Entire Result

There are three operations that can be found at the bottom of the Search Tab.

Mame
|.. Hat123 [D = 110190

W

a4 | m b

-Operations on Entire Result

Exporting a Search Result

After conducting a search it is possible to export the search result by clicking the Export Search Result button
at the bottom of the Search tab.

When clicking the Export Search Result button, STEP will attempt to use all the objects in the result as root
objects for the Export Manager (equaling selecting the objects on the Product Selection step of the Export
Manager). The actual objects exported are determined by the selected Export format and the selections made in
the Export Manger. For more information using the Export Manager, refer to the Export Manager topic in the
Data Exchange documentation.

[ Export Manager =
Steps Select Objects

1. Select Configuration Product selection made by search URL,

2. Select Objects

£ >

3. Select Format

4. Map Data Only export selected objects

5. Advanced Only export leaf objects Export: | Product iy

6. Select Delivery Method 1, 4 object types <Al ohiect types:

Back Mext Finish Cancel

Saving a Search Result as a Collection

After conducting a search it is possible to save the entire search result as a Collection.
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When clicking the Save as Collection button, a dialog is opened where it is possible to specify the ID, Name,
and location of the new Collection. For more information on collections, refer to the Collection topicin the

Getting Started documentation.

[ Save as Collection in Background Process ot

-5 Collections
=[S eCatalogs

®pewls

Collection D~ |411232 |

Collection Mame | |

| [ e

Bulk Updating a Search Result
When having conducted a search it is possible to Bulk Update the entire search result.

When the Bulk Update Search Result button is clicked, the Bulk Update wizard appears with the search result
selected as the dataset. For more information on bulk updates, refer to the Bulk Updates documentation.

[ Bulk Update X

Steps Configuration

1. Configuration
2. Operations
3. Parameters

l::) Ise Existing Configuration

4. Preview (®) Create New Configuration:
5, Advanced

Back Next Finish

Note: To Bulk Update only some of the objects in the result, you can select or multi select in the search
result and then select the Run Bulk Update option on the File menu.
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Search: Data Containers

The Data Containers search criterion allows users to limit search results to only objects for which data containers
exist for the specific data container types, or those objects for which specific attributes are linked via data
containers.

Searching for objects with information in data containers is available using the standard search criterion and also
using the specific Data Containers criterion. Each method is defined below.

For more information on data containers and the terminology used in this topic, refer to the Data Containers
topic of the System Setup documentation.

Standard Search Including Data Containers

This option searches data containers and other identified objects for the defined values. For more information,
refer to the Examples section below.

1. Click the Search tab, and select Search from the dropdown.

Reset Search

Show Details

Search

2. Openthe'Advanced' flipper and check the 'Include Data Containers' option.

r | Seanch » B

§ Advanced
[ ] Match Case on Mames and Yalues

[ ] Indude Inherited Values
[] Exdude values

[ ] Regular Expression

| Indude Data Containers I
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3. Ifneeded, click the green plus button () to add additional search criteria.

4. Click on Search to run the search and view results.

Data Containers Only Search

This method requires that the searched data exist in a data container. Matching data outside of data containers is
not displayed. For more information, refer to the Examples section below.

1. Click the Search tab, and click the Search dropdown.

Tree

Search W™

€ pAdvanced

T

oE v Reset Search

saarch Resultt

Show Details

[Name

2. Inthe Search Criteria Type Selector, select the 'Data Containers' search criterion.

Search

Search
Search
Search
Object Type

Search Below
Referenced Assets
Revised Objects Changed Since

Data Containers

[ System Setup ” BS Processes (2) ]

Docurment Content

Search from List
Javascript search

Missing Mandatory Values
Unapproved

Product Override Search

Search in Publication Hierarchy

3. Supply the Data Container Type parameter and the additional text input parameter as needed:

« Continue to the next step without populating either parameter to return all objects for which any data
container of any data container type that has been added.

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023

281



|STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

« Click the ellipsis button (|...|) for the Data Container Type parameter to limit the search results to only those

objects for the selected data container type. Click Select and then click Search. The search returns a list of
objects for which the data container type has been added, even when no attribute values exist in the data
container. For more information, refer to the Examples section below.

Search
Data Containesrs ¥
Data Container Type

&= Advanced

[ Data Container Type

Pt

Reset

B

Search

Search Result Show Details

[ IName

=-E5 Attribute Groups
-0 Attribute Group
=-E3 Data Containers

F-E3 ETIM Attributes

= Details

Cancel

« Ifnecessary, narrow the search using additional search terms in the text input parameter. Type the
selected ‘Data Container’ attribute to display typeahead suggestions. Once selected, the available
operators =, <, >, <=,>= | Il are displayed. If the selected attribute has a value in the ‘Data Container’ tab,
the values display as a dropdown. However, the search result will be displayed only for the attribute value
which is present for the attribute in the Data Container tab. For more information, refer to the Examples

section below.

Datz Contsiners ™

Search

D=tz Contsiners

Data Container TYpe  |shipping Address (ShippingAddress)

Country Code (CountryCode) =

Country Code (CountryCode) = ANGUILLA (AT) Y

Country Code (CountryCode) = ANTIGUA AND BARBUDA (AG

Country Code (CountryCode) = ARGENTIMA (AR)
pjlCountry Code (CountryCode) = ARUBA (AW)
Country Code (CountryCode) = AUSTRALIA (AL
Country Code (CountryCode] = ALISTRIA (AT)
Country Code (CountryCode) = BAHAMAS (BS) I
|Cnuntry Code (CountryCode) = BARBADOS (BE)

-Operations on Entire Result

9 4@ E
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Data Container TYpe  |Shipping Address (Shippingaddress)

Country Code (CountryCode) = BAHAMAS (BS)
& Advanced

5 -

Displaying 1 of 1 results Show Details
Marme >

2 Customer B ID = (LS 107835

W

-Operations on Entire Result

0 & %
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4. If necessary, open the Data Containers Advanced flipper and set the following parameters:

Search

r [ Data Contsiners =1

=]

Data Container Type  shipping Address 2 (211422) ...

2 Advanced

Instance count |> e | |1

[] Match Case on Values

[ | Regular Expression

9~

» Instance count - specify a number of data container instances an object must have.

| Reset || Search |

o Match Case on Values - makes the search case sensitive.

o Regular Expression - search data containers using a regular expression. For more information, refer to
the Regular Expression topic in Resource Materials online help.

5. If needed, click the green plus button () to add additional search criteria.

6. Click on Search to run the search and view results.

Examples

The following examples show a variety of searches for values in data containers.

Standard Search for Product Data Container Value

1STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

The dataset includes an object with a Flat Crush Test value of '10 kN'. This value is in a product data container.

Tr
--i Apparel

(]
(]

Corrugated Box rev.0.1 - Data Container

Product |BEEIEREIETEA | Sub Producks || References | Referenc

Eli Hardware

i Tools

i Doors and Doorknobs

i Hardware Kit

E}i Packaaing Supplies
B

[+~ Displays

[+-Z] Furniture

* |ID Attribute Name * |value

IndustryStandardB_271889  Edge Crush 12a 43-47

N IndustryStandardB_27188%  Flat Crush 12a [10 kN

IndustryStandardB_271882  Pin Adhesion 123 (11.05
IndustryStandardB_271882  Scuff and Abrasion  |12a [JON

Searching for the value '10 kN' with the standard Search criterion returns 0 results.
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Search

Search Result Profiling -

Search W
10 kM

&= advanced

Search Result Profiling

135~

Displaying 0 of 0 results

Reset

Show Details

0 hit(s)

| Mame

]

|STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

Checking the Advanced option to 'Include Data Containers', and searching again, displays the object as a result.

Search

Search Result Profiling -

M| Gearch -
10 kM

@ advanced
[ ] Match Case on Names and Values

[] Indude Inherited Values
[ ] Exclude values
[ ] Regular Expression

Indude Data Containers

Search Result Profiling

1 hit(s)
Click links to narrow down search

Results by Object Type
PdellCt“} - exclude
ﬁltem (1) - exclude

B

Displaying 1 of 1 results

Reset

Results by Position in Tree
Hierarchy

Show Details

Results per Parent

Mame

>

> | (245934) 1D = 245935

o Tools (1) - exclude

Standard Search for Entity Data Container Value

In this example, a user searches for all instances of the value 'BAHAMAS' in STEP. Select the standard 'Search'’

from the dropdown, add 'BAHAMAS' into the text input parameter, open the advanced flipper and check the
'Include Data Containers' option, and click Search. The results includes Customer A and Customer B entity

objects where 'BAHAMAS' occurs inside a data container, and also includes the 'BAHAMAS' values that appear

outside of data containers.
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BAHAMAS
@ advanced
[ ] Match Case on Names and Values

[] Indude Inherited Values
[ ] Exclude values
|:| Regular Expression

Incdude Data Containers

|STIBOSYSTEMS

o Reset

Displaying 5 of 5 results Show Details

Mame

>

} 18210 M B_EN [ = 18710

£y Axel Kiers Vej 11 ID = ADD_101571

2 Customer A ID = CLES_101545

W Vl'\l‘l

2 Customer B [D = CLS_107835

> ™ InDesign modified ID = 123216

-Operations on Entire Result

9 @ &

Data Container search for Entity Data Container Type

e MASTER DATA MANAGEMEMNT

In the example below, a user searches for a data container type called 'Shipping Address' without refining the
search any further. If the user selects 'Shipping Address' as the Data Container Type and clicks Search, a list of
entities for which a data container has been added to an entity under the data container type 'Shipping Address'

will display. In this instance, four entities are listed.
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[ Data Containess

Data Container Type &hipping Address (ShippingAddress)

=

&= advanced
dh - Reset |E Search i
Displaying 4 of 4 results Show Details
Mame
¥ 2 Customer A ID = U5 101545
i 2 Customer B ID = (L5 107835
i 2 Customer D [ = (/5 114565
> |8 Customer E ID = CUS_114565

1STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

The entity with the ID 'CUS_107835' has an attribute 'Country Code' with the value of'ARGENTINA' in the
Contact tab, but with the value of' BAHAMAS' on the Data Containers tab.

Customer B rev.0.4 - Customer

o=t

% (18212) "~ Referenced By || Status || State Log | Tasks
- [0 Acrount Group 1 Customer [ Data Conkainers ]
= 2 Allen L2
CON_124334 Marne »| » |Value »
[—}-ﬁ Customer Hierarchy > D CUS_107835
=2 Customer A
ﬁ Axel Kiers Vej 11 > Name Customer B
Jesper Jensen » Object Type Customer
- g _ » Revision 0.4 Last edited by USERJ on Tue Sep 26 17:1...
-4 3550 George Busbee Pk — - -
John Smith » Path Entity hierarchy root/Entity Root/Customer Hi...
H- 2 Customer C » Completeness Score i
{;3 Key Accounts » |available Sizes Eﬁ
1l GDSN ¥ -
= = I * Country Code | ARGENTINA o

B 2 allen

[—}-% Customer Hierarchy

Customer ]

ontainers

Referenced By || Status || Skate Log

Data Conktainers

o=
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When a search is performed on the ‘Shipping Address' data container and the attribute 'Country Code' is
selected, all of the values are displayed. The search result will display the entity ‘Customer B’ only if the value is
‘BAHAMAS.’ The search result will return ‘0’ if the value selected is ‘ARGENTINA’

Search Search Nz

Dstz Contziners =

Data Container Type  |Shipping Address (Shippingaddress)

Drata Contzsiners

Data Container Type | Shipping Address (ShippingAddress)

Country Code (CountryCode) =

Country Code (CountryCode) = ANGUILLA {AI) S
Country Code (CountryCode) = ANTIGUA AND BARBUDA (AG

Country Code (CountryCode) = BAHAMAS (BS)
& Advanced

Country Code (CountryCode) = ARGENTINA (AR) ah - Reset
pilCountry Code (CountryCode) = ARUBA (AW) Displaying 1 of 1 results Show Details
Country Code (CountryCode) = AUSTRALIA (AL Name 5

Country Code (CountryCode) = ALISTRIA (AT)
Country Code (CountryCode) = BAHAMAS (BS) I
|C|::un1ry Code (CountryCode) = BARBADOS (BE)

W

2 Customer B ID = CLS_107835

-Operations on Entire Result

=3
-Operations on Entire Result EI @ ﬁ'

9 @ &

Data Container search for Entity Data Container Type and Value

To continue the previous example, if the user refines the search for entities with a 'Country Code' data container
type to only include those data containers containing the value 'BAHAMAS', the user would enter' BAHAMAS' in
the input field. In this example, results returned from the search show two of the original four entities. This means
that a 'Shipping Address' data container has been added to these two entities, and an attribute within those data
containers also contains the value 'BAHAMAS'.

Search
r | Data Containers L]

Data Container Type | shipping Address (ShippingAddress)

BAHAMAS
W
=
Displaying 2 of 2 results Show Details
Mame >

W

B customer A ID = CLS_101545
2 Customer B ID = CLS_ 107835

W

-Dperations on Entire Result

9 @

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 287



|STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

Search: Document Content

With the Document Content search criteria you can search for a specified word / text string in text documents
stored as Assets in STEP.

1. Click the Search tab.
2. Click the Search dropdown and select Document Content.

Search
=l
@ Advanced Seis
Object Type

Search

Search

Show Details

(op

Search Result

[ Mame

Search Below
Referenced fszets
Revised Objects Changed Since

Data Containers
H Document Content
Search from List

[ BG Emc%es (413 ]

Important: A prerequisite to searching in documents is that they are indexed. Document Content displays as
a search option only in systems that have full text indexable functionality enabled and are not running In-
Memory.

3. Enterthe word/ text string into the text field that appears.

Find 9

EF—: [ Reset ] Search
Displaying 0 of 0 results Hide Details
[ Name >

"[Doammm -

4. Click the green plus sign () to add additional search criteria. (Optional)

5. Clickon'Search' to run the search and view results.
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Search: JavaScript Search

The JavaScript search criteria searches through all JavaScript in STEP. It can match items according to
Business Rules, Match Algorithms, Decision Tables or any other structure programmed through JavaScript.

Follow the steps below to set up a JavaScript Search:

1. Click the Search tab and click the Search dropdown.

Search
aarch Result Show Details

2. Select JavaScript search.

Search [

Jawasoipt search
Find |3 Search Result Profiling
[] Match caze 59 hit(s)
Click links to narrow down search
[] Match whiole word only
[ — ] _ Results by Object Type
Displaying 59 of 59 results Show Details Special types (55)
Mame . . .
e |_JBusiness Action (47) - =sxclude
. w("C“'Bsfmc'fﬂeh"“ﬂ'“113'391“3“59‘5'_ __1Business Condition (8) - sxclude
» \# (acn-b35434c0-5c7a-4413-ad89-ecad7e6cal |

JavaScript Checkbox Options
These checkbox options are available with JavaScript search criteria:

« Match Case: If you select this, the search will only return results that match the upper or lower case letters
that are in the search criteria.
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[] Match whole word only

¥ =
Displaying 38 of 38 results Show Details

Mame
> H‘ (acn-88fdd33c-fceb-4754-a118-a9103b75%e =

> 4 (acn-b35434c0-5c7a-4413-ad89-ecad7e6cad |

« Match whole word only: will return only results that are the exact criteria that were put in that standalone.
An example would be if the letter 'a’ were typed into a search, and only results that had 'a' in it that standalone

somewhere in the JavaScript were returned.

Search
Jawasoipt seanch
[] Match case
Match whole word only

X | Reset ||
Displaying 1 of 1 results Show Details

MName
> @ BssSPackagingLlibrary (final) I = A555FPack=gingl,
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Search: Missing Mandatory Values

The Missing Mandatory Values search criteria is used for finding Product objects that have valid Mandatory
Specification attributes without values.

To set a criteria as a Missing Mandatory Values search:

1. Click on the Search tab and click the Search dropdown.

Search
aarch Result Show Details

2. Select Missing Mandatory Values from the dropdown.

[ Missing Mandatory Vales =
|-Missir1g Mandatory Values ﬁ"""- E1
EEE [ Reset ” Search ]
Show Details
|_MName > ]
Use Cases

1. Product object which has specification and description attribute as mandatory with empty values.

The 'Product Name' attribute is set as mandatory for Item Object Types. For Object 22200, the attribute value
is left empty. In the Search tab, Missing Mandatory Values search criteria is used with Object Type
‘ProductsRoot’ search criteria. 22200 is included in the search results.
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m Sub Products || References || Referenced By

| Products (ProductsRoot) . 1
Missing Mandatory Vahees w E1 @ Description
Missing Mandatory Values Name s 3 [value
op '| Reset Search » ID 22200
Displaying 100 of 194 results Show Details » Mame 22200
Name > (Object Type Ttem
Bl 3 inch heels 1D = 20594 4]
12-GG D = 100705 * Revision 0.1 Last edited by STEPSY:
m 3 K799 = o
050-42151 [0 = 7575 * Approved x Mever Been Approved
, M - -

M 555-22346 ID = 5506 * [Translation Mot Translated
18213 MO ID = 18213 » Path Primary Product Hierarchy/
Nl 20883 1D = 0555 & Manufacturer Information

e 20888 AAA Batteries ID = 109005 Mame s s |Value

m 20888 AAA Batteries RECHG I = 109007 » Manufacturer's Part Mumber 33 IRO&Y
21873 (box of 5 pair multi-color) ID = 21875 » Manufacturer Mame abe
I 21882 (sellable case of 20 boxes of 5 pair oranc > Country of Qrigin [ScHINA
I 22126 (box of 20 pair orange) D = 2717 > Product Name £

22200 ID = 22200 . abe
W 2262112 11 = 27507 > Supplier Part Number abe (448291

2. Description attribute is mandatory and is left blank on entity object.

In this example, the 'Available Sizes' description attribute is set to mandatory. On the address entity ADD _
107837, the 'Available Sizes' attribute is empty. A search is performed that has a 'Missing Mandatory Values'
search criteria with Object Type ‘Entity root’ search criteria. The ADD_107837 object is returned as aresult.

References || Referenced By || Status || Sktate Log |Tasks
2 Description

| Entity hierarchy root (Entity hierarchy root) 1
Missing Mandatory Vakes =
|-I'~"Iissir1g Mandatory Values E1 Mame > Value
E:}i = Resst Search »> ID ADD_107837
Displaying 100 of 10049 results Show Details | || * Mame 3550 George Busbee Plwy
Mame » Dbject Type Address
-‘““H“' = 3 ]
> |0 64TH MED DET (VS) 1D = D& 116595 » Revision 0.1 Last edited by USER. on Fri Aug 14 16:32;
.2 750 South Hampton De [0 = 400 [ 14355
» Path Entity hierarchy root/Entity RootfCustomer H
> @mmmm iD= ADD 107837
T/ 114580 1= J0CRTECATCA7E 1T = T7oTT —Compietencss Score =
» (@ 114.333_ 3550 George Busbee Pkwy |] » Available Sizes (=2
> | AB.C.UN |D = ADD_107837 711655, T oy W frerese
s A RD I-'V'II-":I'I'I-'DI_ T — NeEn 7 isnss % Mantzrt Blama :.hr\-l
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The search criteria requires no data input or selections to be made. However, it is encouraged to use in
conjunction with another search criteria (by clicking the green + sign) to help further refine the search.

Note: As the Missing Mandatory Values search criteria only works on Product objects, using it in
combination with other search criteria will limit the search result to such objects.

The Missing Mandatory Values search criteria can also be set to exclude Product objects with missing
Mandatory values. This functionality is described in Using Exclude Search Criteria within the Search
Functionality topic.
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Search: Object Type

With the Object Type search criteria you can limit your search result to items of a specific Object Type. These
objects are maintained in the workbench System Setup > Object Types & Structures folder.

1. Click on the Search tab and click the Search dropdown.

T

Show Details

Search

Reset Search

2. Select Object Type from the dropdown.

Search
Object Type ™
’VPrnduct 'ﬂ
oF v| Reset Search
Show Details
[ MName

3. Inthe dropdown that displays 'Product' by default, select an object type. Refer to the System Setup Object
Types section below for more information.

« Hover on an object type to display a sub menu when available.

o When an Other... option is available, click it to display a selection dialog. Use the Browse or Search tab to
select the object type. Click Select to confirm.
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[ 1 Please Choose Object Type =
o x orowee (Y
Product
Product ] Product E||__=| Primary Product Classification
[+ Boards
Asset 1 Sales ltem G+-[3 Business Unit Root

--i Discontinued Products
G+ [l External Products

Classification
Product Folder

Attribute :

_ Dltem (- Jill GD5M Products
List of Values External ltem Enric @ Packaging hierarchy
Unit - Packaging Hierarchy

] tinued Prod :
iseontinued Fre |__=| Primary Product Classification

Publication Group

L | Buy Side [#-[5) Product Folder

Publication ; : i

Level 1 [1-[5) Product Hierarchy Root
Publication Section : ol :

NewObj =] Product Qverrides
Entity ; S

rodu & Details

Special types ;

I Other... Select Cancel

4. If needed, click the green plus button () to add additional search criteria. For example, return only products
with the text'ACME".

| Object Type = Level 1 =]

Search

ACME - —
@ pdvanced

o v| Reset Search

Search Result ow Detal
| Mame *|

Note: Without the additional search criterion shown above, the results will be a list of all objects of the
specified type.

5. Click Search to run the search and view results.

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 295



|STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

s [

|DbjectT1fpe = Product

E‘

[Search =
ACME

&= Advanced

[P -

=3

Displaying & of & results

Show Details

Mame

>

g 21933 [0 = 21955

N 27244 ID = 27244

¥® Comfy Bed ID = 22155

I™ Comfy Footboard ID = 22165

B Comfy Headboard I = 22167

I® comfy Side Rail ID = 22155

System Setup Object Types

Search Result Profiling

& hit(s)
Click links to narrow down search

Results by Object Type
Product {G
EV[EH"I (6) - exclude

- exclude

Results by Position in Tree Hierarchy
Results by Parent

-EEUS ltems (4} - exclude
[C]Products (1) - =xclude

Bl Refrigeration ltems (1) - =xclude
[C]Products (1) - =xcluds

Bl Drinking ltems (1) - excluds

Results by Value

Values matching "ACME"
Values are displayed in lowercase)

acme (V) - sxclude

Attributes with values matching "ACME"

[If Brand Name (5} - =sxclude
(I Manufacturer Name (1) - esclude
(1T supplier Mame (1) - sxclude

The following object type selections require further information.
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"| Object Type ¥
Attribute
Product ]
Asset >
Classification b
Attribute
List of Walues
Unit
Publication Group >
Publication b
Publication Section ]
Entity *
Special types >

Attributes, Lists of Values, and Units

The Attribute, List of Values, and Unit object type categories do not include sub selections. All of the selected
object types available will be searched for each of these categories.

Special Types

Special Types includes Table Type, Business Rule, Business Library, Business Condition, Business Action, and
Business Function object types.
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With the Product Override search criteria you can locate and identify any product overrides present in your
system. You can search for all overrides in STEP or you can narrow your search to overrides of a specific

product. If more concise results are required, you can specify sub-products.

1. Click on the Search tab and click the Search dropdown.

Search

T

Reset

Search
Show Details

Product Ovemide Search =
- Overridden Product

() Find Al

(@) Find by Overridden Product

COwerridden Product

-Sub Products

[[] Exact Match on Child Products

|5|_|I:| Product

> | Add Child Product

S

Reset

Search
Show Details

Mame

3. Inthe Overridden Product group, select a radio button :

« Find All - Searches for all product overrides.

« Find by Overridden Product - Searches for the specified product, as shown in this image. In the text
box, either type the product's name, or click the ellipsis button (|...|) to browse or search for a product.
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D Owerridden Product -
- | Product Owemide Search =
-Overridden Product Search
(O Find All [=1-{I5) Primary Product Hierarchy "
[+-{Ji) Discontinued Products
Find by Overridden Product / ;
@ n .!l'l WETTI 2N Frody / i External Pruducts
Overridden Product |Batteries (20873) i Packaging
[+ Product Overrides
- Sub Products Elfl Products
[ ] Exact Match on Child Products -5 Displays
|5|_||;. Product 3 | E]F_=| Electrical and Electronics
> | Add Child Product =+ Electronic Accessories
5 E|1'_=| Power
-- Batteries
Ha Reset Search =
-]l Type 5 Contactors and Starters ¥
Show Details
|_Name = Details
Canel

In the Sub Products group, set the following options as needed:

« Exact Match on Child Products - WWhen checked, search results must have every sub-product specified.

« Add Child Product - Click the link to select sub products that will narrow the search further by requiring
search results to have exactly the specified sub-products linked to them.

Click the arrow button ([> ) on one or a group of rows to display the following menu and perform the action:

« Hide - Hides an added child product from list.

Sub Products
[ ] Exact Match on Child Products
ub Product >
Hide
— Show All Rows
dh Rotate Table Search

Displa Add Child Product  Ctrl+Plus Show Detaile
[ I Remove sub product Ctrl+Minus 2]

o Show All Rows - Show all hidden child products.
o Add Child Product - Does the same operation as the ‘Add Child Product' link as stated above.
« Remove sub product - Removes the selected child product.
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5. If needed, click the green plus button () to add additional search criteria.
6. Clickon Search to run the search and view results.

This image shows products with the specified child product, but others child products could exist as well.

-~ seach ______]< SearchResultProfiing

[ | Product Crvemide Search =]
-Overridden Product Search Result Profiling
() Find Al 2 hit(s)

@ Find by Overridden Product Click links to narrow down search
na oy Lverndden Froddu

Overridden Product | Batieries (20878) Results by Obiecl'. Type
r5Sub Products Product(2) - exclude
[L] Exact Match an Child Products i Product-override (2) - exclude
Sub Product * T
» Batteries Rechargeable ItemFolder Results by Position in Tree
> Batteries Items Hierarchy
> |Add Child Product

Results per Parent

CCiLevel 2(2) - excluds

oa v Reset

Displaying 2 of 2 results Show Details
Mame >
* Batteries Override 1 — Batteries D = 124085
> Batteries Override 2 — Batteries [0 = 179577

This image shows there are no overridden products with only this exact sub product.
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Search € Search Result Profiling .
r [ Product Ovemide Search = 5]
-Overridden Product Search Result Profiling
(O Find Al 0 hit(s)

(®) Find by Overridden Product

Overridden Product | Batteries (20873)

~5Sub Products
Exact Match on Child Products

Sub Product »
» Batteries Rechargeable ItemFolder

> | Add Child Product

oa v Reset Search

Displaying 0 of 0 results Show Details

[ Mame *

This image shows overrides regardless of sub products.

Search € Search Result Profiling na
r | Product Ovenride Search = ]
-Overridden Product Search Result Profiling
() Find Al 3 hit(s)

® Click links to narrow down search
Find by Overridden Product

Overridden Product  |gztteries (20878) Results by OM Tym
-5ub Products Product {3} - e=clude
[] Exact Match on Child Products gl Product-override (3) - sxcluge
|Sub Product >
> |Add Chid Product Results by Position in Tree
Hierarchy
oh - Reset Search
Displaying 3 of 3 results Show Details Results per Parent

Mame > CClLlevel 2 (3) - exclude

* Batteries Override 1 — Batteries [0 = 174055
> Batteries Override 2 — Batteries D = 179577
» Batteries Override 3 — Batteries I = 179554
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Search: Referenced Assets

The Referenced Assets search criteria is used for finding product objects which has referenced assets to the

specified product.

By default, all local referenced assets for the specified product are displayed.

To set up Referenced Assets search criteria:

1. Click on the Search tab and click the Search dropdown.

Search

T

Reset

Search
Show Details

|STIBOSYSTEMS

Search
Show Details

]

Referenced fssets
Search
: .
E Object Type
@i Search Below
@ Referenced fszets
e Reset
@ Revised Objects Changed Since
EI Data Containers
]
©= Search from List

e MASTER DATA MANAGEMEMNT

3. Specify a Product Name in the input field by either tying in the actual product name or the product ID. By
running a basic search, it will return results of all referenced assets of the product specified.
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| Referenced Assets
Product Mame

|Dress Shoes

Incude Inherited Assets ]
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arch Result Profiling

Search Result Profiling

3 hit(s)
Click links to narrow down search

> [m| 20695 main 1D = 20701

W

') 20695 side 1D = 2070:

Match Case on Mames ]
E | Reset | || Results by Object Type
DisPIaYing 3 of 3results Show Details Asset (3] - exclude
Mame >
> Ems hack m =3}mﬁ 'E F’rCIdLIC't IrTIEICIE! [,3} - exclude

Results by Position in Tree Hierarchy
Results by Parent

r_=|2|:| [3E - exclude

Note: If the product ID and name are the same, or if the product name has numbers as part of its name, the
search result will still display all the local referenced assets of the product specified.

Checkboxes for Referenced Assets Search

When performing a search, there are two search checkbox options that can be selected.
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Include Inherited Assets - This option is used when the inherited referenced assets on the specified
product are to be included in the search result.

----- E Fashion Board

_l il GOSN Products
i Packaging
E Product Overrides
E}i Products
Eli Apparel

=-[[F) T-shirts

=i

BT Head Wear
[H-[IT] Electronics
-7 Footwear

L)

(=}-[IT) Upper Body Wear

=gl T-shirts Items

i + - il Cotton T-Shirts
----- il 5o Many T-shirts
[T T-5hirts Sales Items

2359

Category Profile || Proof View || Status || State Log || Tasks

14-1 rev.0.3 - References

Referenced By

Images & Documents Commercial

Product "

Product Variants " Sub Products ]

Reference Type w| » [Target » [Thumbnail » |ImagePrior
» |Brand Mame Logo 4 [
» |Tlustration + [
¥ |Primary Product Image E'EEHUE cap I-
* |Product Images + H
» |Video + [
£ > W
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o Match Case on Names - This ensures that the specified product name is searched matching the case (case
sensitive) and all local referenced assets are displayed in the search result.

}]i External Products

i Fashion Board
1l GDSN Products
E}i Packaging
E}E Product Overrides
E}E Products
E|r_=| Apparel
E}|“_=| Upper Body Wear
. -5 T-shirts
= [ T-shirts Items
| i 235914-1

I ]

Search

Referenced Assets ™

Product Mame T-shirts [tems

Incude Inherited Assets N

Match Case on Mames

[ | Reset | [ Search ]|
Displaying 1 of 1 results Show Details
Mame
> [@|Blue cap Ip = 107525
£ >

-Operations on Entire Result

4 Search Result Profiling

Search Result Profiling

1 hit{s)
Click links to narrow down search

Results by Object Type

Asset (1) - exclude

'E Product Image (1) - sxclude

Results by Position in Tree Hierarchy

Results by Parent
CO101) - exclude
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Search: References and Referenced By

The References and Referenced By criteria work similarly.
To navigate to either of these searches:

1. Click on the Search tab and click the Search dropdown.

T

Show Details

Search

Reset Search

2. Select References or Referenced By from the dropdown.

Search

Search
Object Type
Search Below
Referenced Assets
Revised Objects Changed Since
Search Data Containers
Search from List
T Javascript search

Missing Mandatory Values

&= advanced

om Unapproved
Search Result Product Override Search
[ Mame

Search in Publication Hierarchy

Referenced By

References

Both options require a reference type selection to begin. Reference types are setup in STEP Workbench System
Setup tab in the Reference Types folder, and the Web Ul Advanced Search allows you to pick from image and
document reference types, classification reference types, and product reference types.
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Once a reference type is entered, no additional options need to be filled in to start a search. Use the information
at a high level or fill in the other values to drill down further (e.g., multi-supplier item references). Select a
reference source under Referenced By and a target under the References. Plus enter specific attributes and
values to search reference metadata.

References

For References, there are three boxes that can be checked: Include Inherited References, Include Data
Container References, and Finding Missing References.

Include Inherited References: When this is selected, it will show items that have the particular search criteria
passed down to them from a parent folder or level.

References ;] = =
RE'FEFEHCE T'ﬂ:"e Jwners Manua| {Dwners}ﬂanuan E] S’Eﬂfﬂh R'E'SU" Prﬂ'ﬁling
I Indude Inherited References 4 hit(s)
| Click links to narrow down search
[ Find Missing References -
Reference Target Results by Object Type
rm L T || Producti4) - exciude
Product f2} - exclude
=
Advanced g ltem (2} - exclude
i, — .
T = Results by Position in Tree Hierarchy
] Results by Parent
Reset :
50 o [ 5 ] é d (Displaying the 5 most commaon)
Displaying 4 of 4 results Show Details
MName > Bl Tire Care ltems (2) - zxcluds
» W™ 20-68204 D = 2065: |_=_|Ski,_|EleEt Light (1) - exclude

~ | 104061 — Ski Jacket Xtreme (1) - exclude
N 555-22346 ID = 5505 [C]Products (1) - exclude

> | g SKU 00001 ID = SKU 00001 51 Ski Jacket Xireme (1) - sxclude
> |42 SKU 00011 ID = SKU/ 00011

Include Data Container References: \When this is selected, references that appear on data containers may
appear in the search results.
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 Referances =

Reference Type  |5AP Account Group (SAPAccountRef) ||Z|

[] indude Inherited References

Indude Data Container References

[] Find Missing References

Reference Target

Search

& Advanced

Reference Metadata

8| H L
g | L L

dh | Reset |
Displaying 1 of 1 results Show Details
Mame

Bilka Tilst I = 137500

W

Search Result Profiling

Search Result Profiling

1 hit{s)
Click links to narrow down search

Results by Object Type
Entity {1} - exclude

Crganization Customer (1) - sxclude

Results by Position in Tree Hierarchy

Results per Parent

ﬁlDruanisaﬂnn Customers (1) - sxclude

Finding Missing References: When the reference type is selected, and this box is checked, the populated
results will show all items that have that particular missing reference.
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~ [References =
Reference Type  |yideo (videa)

[] Indude Inherited References

Find Missing References

Reﬁget

ER

(-]

b o
Reference Metadata
a8
EE | Reset || _
Displaying 98 of 98 results Show Details
MName

| 255-22346 1D = 65806

> | 6642 ID = 6542

> | .a 7130-03 D = 5555

W

w F133-12 [0 = 5081

Reference Target

Search Result Profiling

93 hit(s)
Click links to narrow down search

Results by Object Type
Product (98] - exclude

EHEH"I (46) - exclude

|.. Salesltemn (43) - exclude

[l SalesltemFamily (5) - sxclude
Bl temFamily (4) - sxclude

Results by Position in Tree Hierarchy

Results by Parent
(Displaying the 5 most common)

[C)Products (21} - =xcludes

[C1Products (8) - exclude

[C/Hats and Caps Salesltems (7) - sxclude
Il Crinking ltems (5} - sxcluds

Bl Hanes T-shirts (5) - seclude

The user has to type the ID/Name of the target in the ‘Reference Target’ field and click on the ‘Search’ button.
This will display all the Source / Products which uses the Target reference specified in the ‘Reference Target’

search field.

In this example, the ‘Reference Type’ field is empty. Hence the result is irrespective of the reference type.
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| Referemces = ]
Reference Type Search Result Profiling

18 hit(s)

Indude Inherited Refe
[] tnclude Inher SlErences Click links to narrow down search

[] Find Migsing References

Reference Target Results by OM Type
Search w Product (17} - e=xclude
imagefj
ge/ipeg ltern Family (9) - sxcluce
©- Advanced ltem (6) - exclude
= || Sales item (1) - exclude
[Tl Sales Item Family (1) - exclude
Reference Metadata Entity (1) - exclude
2 customer (1) - exclude
Results by Position in Tree Hierarchy
b Reset | Il Results by Parent
Cisplaying 13 of 13 results Show Details (Displaying the 5 most commaon)
Mame >

Il Pull-DowniPull-Out Kitchen Faucets (8] - sxclude
[C]Products (4) - sxclude

[ Tire Accessories (1) - sxclude

Bl T-Shirts Family (1} - =xclude

[C1Tire Care Salesltems (1) - sxclude

W

w B225 D =5225
N5 123857 G ID = 123857
N 0726222 1D = 111204
o Acme Automatic Drip Coffee Maker D = 227195

The search result will differ when we specify the ‘Reference Type'.

In this example, the ‘Reference Type’ is selected and shows all the results for that ‘Reference Target.'
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I N

| References = = A
Reference Type  |product Images (Productimage) ||... Search Result Profiling
[] Indude Inherited References 7 hit(s})

Click links to narrow down search
[] Find Missing References

Reference Target Results by Object Type
5eard‘:] = Product - exclude
image ipeg
& Advanced a ltem (6) - exclude
Bl tem Family (1) - =xclude
o
Results by Position in Tree Hierarchy

Reference Metadata
Results by Parent

v (Displaying the 5 most common)

on '| Reset E Search il [C1Products (4) - sxclude

Displaying 7 of 7 results Show Details __1Flashlights ltem Override — Flashlights ltems (1} - exclude
Mame > []Dress Shoes (1} - exclude

5123857 G D = 123557 Il T-Shirts Family (1) - =eclude
¥ 0726222 D = 111204 [C1Pary Hats (1) - =sxclude

I Acme Automatic Drip Coffee Maker ID = 22195
i Cotton T-shirts /D = 15205

¥ Dog Party Hats Assortment ID = 115305

¥™ Dog Party Hats Assortment [D = 121190

L m Yellow & Pink Party Hat ID = 17717

If a narrowed search is needed, use the advanced option. To use this option click the ‘Advanced’ flipper and
select the appropriate option. For more details on the advanced options, refer to the Search: Advanced

Options topic.

 [Gearch = =]
image fipeg
@ Advanced

[ ] Match Case on Names and Values
] Indude Inherited Values

[] Exdude values

[ ] Regular Expression

] Indude Data Containers
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Referenced By

Reference Source

The user must type the ID / Name of the source to search. It will list the items which have been used as a source.

r [Referenced By ™| ]
Reference Type Search Result Pr
615 hit(s)
Reference Source Click links to narrow dot
Search Below ¥ Motice: Profile is not filte
[Primary Product Hierarchy (Product hierarchy root) ﬂ

dh Results by Objec
PrOdH{:t{45‘ﬁ} - excluc

Reference Metadata
W External lter
Exernal lter
Active Prod
|- Sales Item
|| Case (20)
3 Reset || - | Pack(s) -
Displaying 100 of 615 results Show Details Iterm Family
MName Open Item
> || 120-Velt Tire Inflators (case of 10) ID = 5512 5 - —'-'—lL a”elt 321
eve ! )
> || 120-Volt Tire Inflators (case of 4) ID = 6513 % Sales ltem
> |__120-Volt Tire Inflators (pack of 2) ID = 19515 W External lter
> ) 555-2033_M D = 8601 Bl Salesitemf
w| 7130-03-FR [T = 68549 Asset (120) - exclude

Click the ellipsis button (|...|) to browse for a reference type for search either type in the reference type ID / Name
for more restricted search.
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r[Referenced By ¥

Reference Type  |product Images (Productimage)

Reference Source

E

Search Below =
IVF‘rimary-I Product Hierarchy (Preduct hierarchy root)

Reference Metadata

P

Ex|

Displaying 53 of 53 results

Show Details

Mame

>

W

'm| 1st Birthday_Category Image ID = 157524

W

'w| 1st Birthday Boy Blue Cupcake Kit 1D = 187820

W

'm| 1st Birthday Boy Cupcake Kit ID = 157515

Search Result Profiling

53 hit(s)
Click links to narrow down search

Results by Object Type
Asset (63) - exclude
'm| Productimage (53) - =«

Results by Position in Tree

Results by Parent
(Displaying the 5 most commaon)

r_=|13f14} - exclude
|‘_=|AC£B[ - exclude

[ClAssets (4) - =xcluds
DL -
1203 -

exclude

exclude

If the user needs a narrowed search, then the user can also use the advanced option. To use this option, open
the Advanced flipper and select the appropriate. For more details on the advanced options, refer to the Search:

Advanced Options topic.

r [ Referenced By

Reference Type  |product Images (Productimage)

Reference Source

r [Search |
@ Advanced
[ ] Match Case on Names and Values
[ ] Indude Inherited Values
[ ] Exdude values

[ ] Regular Expression

[ ] Indude Data Containers
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References and Referenced By Metadata Attribute Value Searches

Values for metadata attributes may be searched by using the References or Referenced By search options.
Users may indicate any value to search all metadata attributes for a matching value. The following pictures will
demonstrate with References, but know that the same holds true for Referenced By.

| Referemces ;]
Reference Type |.|5.Jternaﬁue (Alternative) |E]

[7] Indude Inherited References

Search

[ Find Missing References

Reference Target

Reference Metadata

|U|:|sell |
de | |~
| Reset || search |

[ Syskem Setup ” B5 Processes ]

Alternatively, users may enter an attribute /D or name, operator, and value for a more restricted search.

- [References | =]
=

Reference Type | |E]
E [ Indude Inherited References
U
WAl

[ Find Missing References

Reference Target

Reference Metadata

Mumber == 5

m Setup ” BG Processes (1) ]

Note: Itis not possible to perform searches on missing metadata values.

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023 313



|STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

Search: Revised Objects Changed Since

With the Revised Objects Changed Since search criteria you can find recently edited objects in the
workbench. To narrow your search, enter an exact date / time to determine how old the changes can be, or you
use intervals of days, hours, or minutes. Revised Objects Changed Since criteria can be combined with any

other search criteria.

1. Click on the Search tab and click the Search dropdown.

T

Show Details

Search

Reset Search

2. Select Revised Objects Changed Since from the dropdown.

Search
Revised Oibjects Changed Since ™
Date 8T

2013-07-02 09: 3424

o '| Reset Search

Search Result Show Details
[ Name > |

3. Adropdown appears with the following options:

o Date

« Interval of Days

« Interval of Hours

« Intervals of Minutes

the number value is considered.

Note: Only number values are accepted as input for the options Interval in days, Interval in hours,
Interval in minutes. When Days/day, hour/Hours/H, or minutes/Min/M is suffixed along with number,
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For the purpose of this example, 'Date’ will be used for the 'Revised Objects Changed Since' search field.
The Date option will provide a data picker, allowing for the selection of the data and time.

Revised Objects Changed Since
(2 v

Date
2020-11-23 09:57:28 [...]

Reset Qearch :I

&4 Date Picker >

Hours: Minutes: Seconds;

L -|o 0g | |57 28
Show Details
[ MName > | oK |

Cancel

4. Click the ellipsis button (|...|) and determine the date / time of the oldest objects to search. Click OK.

5. Ifnecessary, click the green plus button ( [gh +|) to define additional search criteria.

6. Click on Search to run the search and view results.

[ Revised Objects Changed Since ]
Date -

2015-08-05 09:08:39

B

| Reset ||

Displaying 8 of &8 results Show Details

Mame

(@ BuySidesellSide_Internal I = SuySideSalsSide_Intern
* | Gloveworks case (Bx of 5 pair orange) I = 21875
44 SKU 00001 D = SKU 00001

i SKU 00011 D = SKU/ 00011

I Test11189 D = 100705

» 5| Test docl ID = 107275

» [i[7] Test docl ID = 107272

> T Test document D = 107257

W

W

W

© Stibo Systems - Confidential - Release 11.2 (2023.2)-MP2 - August 2023

Search Result Profiling

a8 hit{s)
Click links to narrow down search

Results by Object Type
Product (4) - exclude
EF’TUUUCT(E':I - exclude

tem (1) - exclude
I_CE[SE (1) - exclude

Asset (3] - exclude

J%| Owners Manual (2) - excluds
P'.SSETS (1) - exclude

Special types (1)
| Portal Configuration Type (1) - exclude

Results by Position in Tree Hierarchy

Results by Parent
(Displaying the 5 most commaon)

COIMA(3) - exclude

[C]Products (1) - exclude

[C1Ski Jacket Pro (1) - sxclude

[T Ski Jacket Light (1) - exclude

Bl Buy Side Packaging (1) - exclude
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« Interval in days — Specify the number value in the field.

[ Revised Objects Changed Since |
Interval in days

3

|Search: ACME

E‘
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The search result is displayed as shown below with objects which are revised since last 3 days.

[ Revised Objects Changed Since |

- Interval in days e

< IRE

IS

v

18 | Search: ACME =]

185

Displaying 13 of 13 results

Show Details

Mame

*

» 21933 [0 = 21835
* | | Black Lamp D = 122907

¥® Black Lamp D = 208553

I Black Lamp by Mell ID = 122905

I Black Lamp with dimmer by Mell I = 122012

I Blue Lamp by Mell I = 122915

¥™ Comfy Bed ID = 22155

I Comfy Foothoard /D = 221565

I Comfy Headboard 1D = 22167

¥® Comfy Side Rail ID = 22155

I Purple Lamp by Mell I = 122915

¥™ Red Baseball Cap 1D = 20805

I Yellow Lamp by Mell ID = 122914

[ STEP Workflow ” Bookmarks ” System Setup ” BG Processes ]

« Interval in hours —Specify the number value in the field.
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Search Result Profiling

13 hit{s)
Click links to narrow down search

Results by Object Type
Product {13} - exclude

ﬁltem (12) - exclude
|- Sales ltem (1) - esxclude

Results by Position in Tree Hierarchy

Results by Parent
(Displaying the 5 most common)

[C1DesklLamp ltems (F) - =xcluds
Bl Beds tems (4) - excluds
|‘_=|S.A3Prnducts (1) - exclude

(3 Acme Baseball Cap (1) - sxcluds
[0 arcimento (1) - sxcluds

Results by Value

Values matching "ACME"
(Values are displayed in lowercase)

acme (14) - esxclude

Attributes with values matching "ACME"

(I Manufacturer Name (7} - exclude
I Brand Name (6} - =xclude
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[ Revised Objects Changed Since |
Interval in hours e

a0

The search result is displayed as shown below with objects which are revised since last 60 hours.

[ Revised Objects Changed Since |
Interval in hours v Search Result Profiling

a0 4 hit(s)
Click links to narrow down search

|Search: ACME =]

& | Reset | || Results by Object Type
Displaying 4 of 4 resuts show Details Product (4] - exclude
MName Y

¥ Black Lamp ID = 208553 Bitem (4) - seclude
) Comfy Bed ID = 22155
¥ Purple Lamp by Mell ID = 122915 Results by Position in Tree Hierarchy

I Yellow Lamp by Mell ID = 122914 Results by Parent

[CiDesklamp ltems (3) - exclude
Il Beds ltems (1) - =xcluds
[C1SASProducts (1) - sxclude

« Interval in minutes — Specify the number value in the field.

[ Revised Objects Changed Since |
Interval in minutes e

30

The search result is displayed as shown below with objects which are revised since last 30 minutes.
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|I.ntenra| in minutes

30

9

Displaying 3 of 3 results Show Details

Mame

»

> |5} Asset Push 1 Queue D = AssetPushi

‘alf DTP Queue ID = DTPConfiguration

>
>

Al NSUIAssetpush 1D = NSL_dssetoust

1STIBOSYSTEMS
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Search Result Profiling =i

Search Result Profiling

3 hit(s)
Click links to narrow down search

Results by Object Type
Special types (3)
[ JAsset Push Bvent Queue (3) - sxcluds
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Search: Sample Result

The Sample Result Search Criterion allows users to refine the search results to only those specified numbers.
When the ‘Sample Result’ criterion is selected, one input field ‘Sample Result Size’ is displayed below it. If a user
enters a random number and clicks on Search, the search result will be zero. Hence, this search should always
be appended to an existing search and entering a numeric value for 'Sample Results Size' will further refine the

search result based on the entry

For example, a user searches for a set of products below a hierarchy that displays a set of results which has 16
products. To do so they go to the Search tab > Search Below option in the Search dropdown > and choose what
node to search below. For more on how to search below, refer to the Search: Search Below topic.

Search <

W

|..| 7134-24 ID = 8094

Search Result Profiling

Search Balow ™
’Vand and Beverage (2303) ﬂ Search Result Proﬂ"ng

H Reset 16 hit(s)

Click links to narrow down search

Displaying 16 of 16 results Show Details
Mame >
> Nl 7133-12 ID = 5081 Results by Object Type

Product {16} - exclude

> Beverage I = 58315
i Evian Water, Single 1D = 505z

> Evian Water Family 1D =5i05
> Evian Water Family D' = 5110

o EVN-06 [0 = 110001

W

] EVN-24 [0 = 20575
> Food and Beverage D = 8303
> | Naive water_7132-06 ID = 8095

W

_>- Packaged Water Ttems [0 = 8055
Packaged Water Sales Ttems [0 = 8071
ﬁ Spring Water, Case of 24 [ = 107807

W

W

-Operations on Entire Result

ﬁltem (4) - exclude

| Sales ltem (3) - excluge

i Open Sales ltem (2] - exclude
|jLE!'I.-'E| 101} - exclude
[CiLevel 2 (1) - exclude

[T Level 3{1) - =xclude

Bl ltem Folder (1) - secluds

[Tl Sales ltem Folder (1) - exclude

Bl ltem Family (1) - secluds

[T Sales ltem Family (1) - exclude

Packaged Water ID = 5315 Results by Position in Tree Hierarchy
Results below child nodes of Food and Beverage

[C1Beverage (15} - sxclude

Results by Parent
3
5] @ ﬁl (Displaying the 5 most comman)

_.'.|

|STIBOSYSTEMS

e MASTER DATA MANAGEMEMNT

]

Now, the user wants to append the results with the ‘Sample Result’ search criteria. To do this they will keep their
original search, but select the plus sign > Sample Results > and enter a number. In this example ‘10’ is used to
define the Sample Results Size. The search result will give random results.
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|Search Below = Food and Beverage

[IW

Sample Result Size |1D

(g Reset | /
Displaying & of & results Show Details
Mame >

w F133-12 D = 5051
w F134-24 [0 = 5024
i Evian Water, Single i = 5058:
Evian Water Family ID = 8106
4% Evian Water Family [0 = 8110
EVN-24 I = 205745
Packaged Water D = 8715
Packaged Water Sales Items 7 = 8071

WW WYY

W Vl\l"

-Operations on Entire Result

|STIBOSYSTEMS
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Notice that the results will display and not go above the specified sample results size number. If this Search
button is clicked multiple times, the sample search results will change each time, though always staying below

the specified sample number.
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Search: Search Below

The Search Below Search Criteria allows you to limit your search result to objects below a specified node in the
System Setup or Tree tab hierarchy.

Note: The search below option can be applied to the following object types only: attribute, classification,
collection, entity, product, and publication.

1. Click on the Search tab and click the Search dropdown.

ﬂ

| Reset || Search |
Show Details

Search

2. Select Search Below from the dropdown.

[Search Below =i
Primary Product Hierarchy (Product hierarchy root) |Eiﬂ
[Eh - | Reset || Search |
Show Details
[ Mame >

3. Click the ellipsis button (|Z|) to display the Search Below... dialog. By default the Primary Product Hierarchy
is selected as search criteria.
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Search

Search Below
“F‘rimaryI Product Hierarchy (Product hierarchy root) ﬁ]

search Below...

Search W Details
[N >

[#-[T] Classification 1root
IE Entity hierarchy root

'+ [ Primary Product Hierarchy

(- 3 Attribute Groups
(- [ Publications
@ Collections

®Detsls

Select Cancel

4. Selectanode in the hierarchy and click the Select button.

Search Below
“Primary Product Hierarchy (Product hierarchy root) ||:ﬂ

Search Below...

L——_Ii Primary Product Hierarchy ~
EHS) Products
Eli Apparel
- Upper Body Wear
E}i Head Wear
Eli Hats and Caps J
=+l Hats and Caps Items]|
- | 20801

-l 109011 w

¢petals
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5. Click the Search button

Search Below
[Hats and Caps [tems (20438)
Er Reset
Show Details
| Mame > |

The Results displayed includes only items at or below the selected node. Additionally, the selected node for

the search below criteria will also be included in the search results. In the example shown below, Hats and
Caps ltems is also included in the search result

b Search Below
"Hats and Caps Items (20438)

I [Reset || _
| Displaying 3 of 3 results Show Details
ame
] 20803 D = 20805

(8)

il Hats and Caps Items [0 = 70435

Processes
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Search: Search from List

With the Search from List search criteria you can search using a list of data. This data can be manually entered
into the user field or pasted in from another source, such as an Excel spreadsheet or Smartsheet. Users may
specify whether the entered data should be used to search for object IDs, names, key values, attributes values
(with specification of the particular attribute), or other criteria. This makes Search from List an efficient and
easy way to find large numbers of objects in STEP and, in combination with other available search option,
suitable for highly complex and extensive searches.

1. Click on the Search tab and click the Search dropdown.

Search W
B Advanced j

g v Reset Search

saarch Resultt Show Details
[Narme

Tree

2. Select Search from List from the dropdown to display a text field and dropdown with a number of options
based on your system.

Search
I | Search from List = E3
Mumber of entries: 0
|D v
M~ —
I=
o
upplierPartMumber 1
W

tiribute. ..

In this example, we choose Search from List: ID, which allows specifying the data list in the text field and
searching by 'ID' (selected from the dropdown).

3. Use one of the following methods to enter the data list to search in the text box:
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" | Seanch from List =]

17739
23345

12323

Mumber of entries: 1

D -

B | Reset ||
Displaying 0 of 0 results Hide Detailz
[ Mame >

« Manually use the Enter key to create a line break between each value.

» Copy data from Excel or any other application where line breaks or tabs are included to separate the
values. Each value must be listed on a line or be separated by a tab delimiter, without any characters
(including bullet indicators and spaces) around it. Refer to the Using a Data List from an External
Application section below.

4. If needed, click the green plus button () to add additional search criteria.

5. Clickon Search to run the search and view results.

Search Result Profiling

I | Seanch from List =
17739 Search Result Profiling
ﬁﬁgg? 4 hit(s)
Click links to narrow down search

Mumber of entries: 3

Results by Object Type

D -
| . Product {3} - exclude

Gm ~ | Reset | | Salesitem (3) - excluce
Displaying 4 of 4 results Hide Detailz . .
Name S Classification {1} - exclude
[T55 [ClAssetlevel 2 (1) - excluds
&
17739 I _
Results by Position in Tree Hierarchy
| 20670-012
> Results by Parent
17739

[C1Hats and Caps Salesltems (3) - zxclude

. ILIDBDB—HIZ C5 (1) - exclude
20303

|..20808-013
101567
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Each of the 'Search from List' options available from the dropdown are described and illustrated below.

Search from List: ID

Search by specifying the ID in the list text field and selecting 'ID' from the dropdown, as shown in the example
above.

Search from List: Name

Search by specifying the object name in the list text field and by selecting 'Name' from the dropdown.

r [Search From List ™ =]

Mumber of entries: 0

Marne v

Enter the values to search into the text field. Click Search to run the search and view results.

The search results display with the name of the objects specified in the data list.
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£Search Result Profili... -

r [Search from List =

[

Folo A
T-Shirts Family

Mumber of entries: 2

MName e
&< e
Displaying 2 of 2 results Show Details
Mame

* Polo A 1D = 113202

} T-Shirts Family [0 = 123555

£

-Operations on Entire Result

SN 1y

Search Result Profiling

2 hitis)
Click links to narrow down
search

Results by Object Type
Product (2} -

EHEH"I (1) - exclude
Il tem Family
1) - exclude

exclude

Results by Position in
Tree Hierarchy

Results by Parent
r_=| Cffers ["11.' - exclude

[C1SAProducts
1) - exclude
Il Folo T-shirt
1) - exclude
Il T-=hirts ltems
(1) - exclude

)

|STIBOSYSTEMS

Search from List: Key

e MASTER DATA MANAGEMEMNT

Search by specifying the key values in the list text field, and by selecting the key from the dropdown.

In this example, the search results display with the Supplier Part Number that holds values specified in the data

list.
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< Search Result Pr..._

r [Search from Lt | 1 ~
555-21333 Search Result
173311 Profiling
2 hit(s)
Number of entries: 2 Click links to narrow down
search
- . v
R Reset -
Displaying 2 of 2 results Show Details ¥ESI.I“S by o ]
Mame ype
* 179915 D = 179915 Product (2} - exclude
* e Item =1 10 = 18212 Eltem
{2) - exclude
Results by Position
in Tree Hierarchy
Results by Parent
Il Cotton T-shirts
fg} - exclude
< > [C] BA Products
-Operations on Entire Result ——— % r; ‘ﬂﬂ% |
™ Mens Casua
5] @ ﬁ' Website W

Itis important to keep in mind that:

« Only active keys will be available as an option in the dropdown list.
« Active Keys that have values in products can be searched.
« Searching for active keys with empty values in a data list field will NOT return search results.

For more on keys and how to activate them, refer to the Unique Keys documentation.

Search from List: Attributes

Search by specifying the attribute values in the list text field, and by selecting the option 'Attribute’ from the
dropdown.
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Tree

=
=]
=
m
u
W

Mumber of entries: 0

—
—
it

[Atiribute. ., v]

%]
i 1]
7]
7]
[:H]
]
o
=
O

EE | Reset || Search

D Please Select Attribute

m Search |

et

1STIBOSYSTEMS

= E3 Attribute Groups

-3 00 | Reference Metadata
-3 02 | Product Attributes
--Ifl Address Attribute Group
- £31 Application Record Attributes
--Ifl Asset Analyzer Atiributes
-3 Asset Download Attributes
--Ifl Asset Export Configuration
- £31 Attribute Group

-3 Attributes for Web UI
-3 Autopage Attributes

--Ifl Board Essential Attributes
- E3 CalculatedAtiributes

--Ifl Camping

£ CASS Attribute Group
--Ifl Category Specific Attributes
- £3) Clerical Review Attributes

e MASTER DATA MANAGEMEMNT

Note: Description attributes are displayed under the product hierarchy node in the folders for which they are

valid.
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D Please Select Attribute

| Search

E}Fj Products

r_=| Apparel

r_=| Automotive
r_=| Building Products
E|r_=| Displays

E |__=| Displays

t- |1 Colours

|]I Completeness Score
ﬂi Description, Lang
[T status

r_=| Electrical & Electronics

r_=| Food and Beverage

r_=| Footwear

r_=| Furniture

r_=| Hardware

E|r_=| Kitchen

: rj Major Appliances
rj Small Appliances

@ Details

Select

Cancel

e MASTER DATA MANAGEMEMNT

The search results display with the attributes specified, in this case it is the attribute 'Color' which holds values of

'Orange.’
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Search

I | Gearch from List = =

[Jrange

Mumber of entries: 1

Primary Color e

v [ e

Displaying 1 of 1 results Show Details
Mame
ﬁ 18213 M O ID = 18215

£ >

-Operations on Entire Result

0 @ &

€ Search Result Profil... -

Search Result Profiling

1 hit(s}
Click links to narrow down search

Results by Object Type

Product (1] - exclude

Eltem (1) - exclude

Results by Position in
Tree Hierarchy

Results by Parent

Il Cotton T-shirs
(1) - exclude

Itis important to keep in mind that:

|STIBOSYSTEMS
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« Only one attribute can be selected from the Attribute Group browse / search window to be used as search

criteria.

« Inherited attribute values (hierarchical inheritance) can be specified in the data list. The result set includes the
object that contains the searched value as a local value. While this object may not match an object type
restriction, it points to the origination of the searched text.

« Attribute values inheriting from other contexts can be specified in the data list.

« Calculated Attribute value (description or specification attributes) when specified in data list, will NOT be
displayed with any search result. (This restriction is not limited to the Search from List functionality.)

Using a Data List from an External Application

Copied data can come from Excel or any other application as long as line breaks or tabs are included to separate
the values. To copy data in, each value must be listed on its own line or separated by a tab delimiter, (tab key
from keyboard) without any characters (including bullet indicators and spaces) around it.

In the example below, IDs have been copied over from an external file. Data can be horizontal or vertical as long
as the appropriate line breaks or tabs are in between the values.
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r [ Search from List ™| =

Search

r [ Search from List ™|

124143 15213

124143
13213

Mumber of entries; 2

Mumber of entries: 2

|STIBOSYSTEMS

D e D e
oh v Reset || Search { | oo "'| Reset
Displaying 2 of 2 results Show Details | |Displaying 2 of 2 results Show Details
Mame > Mame »

* 18213 MO [0 = 124145
*EN18213 MO ID = 18215

-Operations on Entire Result

J o E

18213 M O 1D = 129145
* 18213 MO D = 15215

-Operations on Entire Result

9 @
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Search: Search in Publication Hierarchy

Objects below a specific publication hierarchy can be searched, and the status or a specific result can be
determined, by using the ‘Search in Publication Hierarchy.’

Keep in mind that this search is not used to search for different templates (such as products, publications, or
page templates) or to search number of objects / links placed in product template. It is only used to search the
objects below a specific publication hierarchy.

Note: To use 'search in publication hierarchy' in the Search tab, it is recommended to have prior knowledge
of Print Publisher and the publication hierarchy. For more information, refer to the Publication Hierarchy
section of the Publisher (Adobe InDesign Integration) documentation.

To search in a publication hierarchy:

1. Click on the Search tab and click the Search dropdown.

Reset Search

Show Details

Search

2. Select Search in Publication Hierarchy from the dropdown.

Search in Publication Hierarchy
Search below: Publications
Search for: Objects linked to Publication / Section ~
oo 1r| Reset Search
Show Details
[ Mame > |

Note: The search criteria requires no data input. However, it is helpful to further refine the search by
pressing the plus sign button (), and entering in information to limit the search results.
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3. Supply information for the following parameters:

Search in Publication Hierarchy =]
Search below: Publications

Search for: Dbijects linked to Publication [ Section

] v| Reset Search

Search Result Show Details
[ Mame > |

« Search below: Used for choosing a node. Select either the publication group or publication. The search
result will display all matched product objects which are under the selected publication group or publication.

» Search for: Specifies what object is being searched.

Search for

The available options in the dropdown are:

Search in Publication Hierarchy W

Search below: Publications
Search for:

|

Search Result

|_MName |

Objects linked to Publication [ Section e
Objects linked to Publication [ Section
Ohjects in Assortment Lists
Chjects in Baskets

Ohjects on actual pages
Chjects on planned pages

1. Objects linked to Publication / Section: When this option is selected, products and assets linked to a
publication will be displayed in the result.
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_______ search < SearchResult Profilng

Search in Publication Hierarchy w

Search below: Electronics Sale Poster

Search for: Ohbijects linked to Publication / Section ~

o '| Reset

Displaying 7 of 7 results

Show Details

Mame

B 21933 [0 = 21955

B8 22196 I = 221595

e 22200 [0 = 22200

P Chardonnay Glasses - 4 I = 5055

¥ Comfy Bed 1D = 22155

I Comfy Footboard ID = 22165

Luigi Bormioli Chardonnay Glass - 1 1D = 8053

£

-Operations on Entire Result

0 a E

Search Result Profiling

T hit(s)
Click links to narrow down search

Results by Object Type

Product (7] - exclude

tem (6] - exclude
Open ltem (1) - exclude

Results by Position in Tree
Hierarchy

Results by Parent
(Dizplaying the & most common)

EPFUHUETS (3) - exclude
|__=|E|E!d5 fg} - exclude
r_=|F'FCIC|LIE'tS (2} - exclude
Bl Irons ftems (1) - seclude

Il Coffee Maker ltems
1) - exclude

]

2. Objects in Assortment Lists: This is a legacy component.

3. Objects in Baskets: The products saved in a Basket will be displayed in the results.
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m Spring Wedding Catalog - Plan =P

@ GOSN Recsiver ~ Page Inspector || Status || State Log || Tasks
lﬁ Merge_Golden_Root AutoPage Publication Planner ” Pagination Rules
@ Promations mm[ Version ” Pages ” Publication Planner " Plan Mokes " Financial Summary |
E'@ Publications Basket maintained locally
&+ Templates
@ Standard Publications Column View: |Deﬁ:ult - Public ~ |
-Efl AutoPage Publications
Iﬁ Flatplanner Publications 1o * Name . I?Iimary:ProducﬂmagE
=+ {§l pring Wedding Catalog B ”
=l Commercial Data 121183 N Pink & Blue Giraffe Party Hat
=1-[S) Party Favors
[ 2-Pages 243
(T 4-Pages 455 121218 F Pink & Blue Owl Party Hat
{3 6 -Pages 6 &7 v
-- DTP Documents = = >
-5 Glassware
&1 DTP Documents

=5 Cards & Stationery

(%) 8 - (208225)

el s el o PO

L [Dnf=]

| Search in Publication Hierarchy |

Search below: | Spring Wedding Catalog /I

Searchfor: | Objects in Baskets [/ -~
2B~ Reset f Search |
Displaying 25 of 25 results I Show Details

ame
] 18210 M B [D = IS210

4. Object on actual pages: the product and asset are used on actual pages (D TP documents) and will display
the results field.
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Flatplanner Publications
#-[@l Christmas Catalog
EI Acme Party Supplies
-- Commercial Data
=[5 Party Hats

P
ﬁ 4 - Galley Page

(-l DTP Documents
=5 Party Favars

{3 4 - Confetti

ﬁ & - Mapkins

ﬁ 8 - Streamers

ﬁ 10 - Moisemakers_linked class
F-f20 [P Naoments

[ Search in Publication Hierarchy |
Search below:

Search for:

Flatplanner Publications

COhjects on actual pages

Galley Page - Plan

m Flanned Pagel Plan Maotes ReFmencesl Status || State Log || Tasks

|STIBOSYSTEMS
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. .
= [Pink & tGreen Party Hat fiy

8 &
D::ug Pary Hats P.ssnrtm#r
F f wd

. .. @ oo | E”X ¥ B H: |'u'iew Prewview o
Galley Page
5 5

Farty Hals

£

Reset

&

Displaying 100 of 110 results

Search
Show Dt

ne

W

Pink & Green Party Hat 1D =

12171

W

Pink & Green Party Hat_2 [ = 13749

5. Object on planned pages: The products and assets used on planned pages will be displayed in the result.
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Search

I | Search in Publication Hierarchy =
Search below: Flatplanner Publications
Search for: Objects on planned pages w
& v| Reset Search
Displaying 28 of 28 results Show Details
S
]
b3
-Operations on Entire Result
%
g &

Tree

ﬁ Autopage Publications ~
[+ [ Standard Publications

Pages 2 & 3

Skatus | State Log || Tasks

Flanned Page ” Flan Motes

=} Flatplanner Publications
=@ Spring Party Catalog
% Commercial Data

[=}-[§§ Party Favors

.ﬁ 2 -Pages 2 &3

(7] 4-Pages 4 &5

ls253 l

|t

5] 6 -Pages 6 & 7

-2 DTP Documents

|Christmas Party Hat

]
[Purple & White Party Ha

[+-[E8 Cards & Stationery

[ 58 Glassware

[l Spring Wedding Catalog

- India Test

E}--ﬁ Publication Group

=-{IZ) Primary Product Hierarchy

E]|‘_=| Products

r_=| Apparel v

T <
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Search: STEP Workflow

With the STEP Workflow search criteria you can search for and monitor STEP workflows. Selecting a specific
workflow from the dropdown list will show all items associated with the workflow. You can also specify the

workflow state to narrow your search.

1. Click on the Search tab and click the Search dropdown.

Search

T

Reset Search

Show Details

|STIBOSYSTEMS
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2. Select STEP Workflow from the dropdown to display two additional dropdowns with options based on

availability in your system.

STEP Workflow
STEP Workflow |Sales Item Creation Y
State v
] ‘r| Reset Search
Show Detailz
[ Mame > |

In this example, 'Sales Item Creation' will be used for the STEP Workflow search field.

3. Forthe State dropdown, specify the state to search within.

« Select a state defined in the workflow to search only items currently in the state.

« Select [any State] to search the entire workflow, as shown in this example.
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STEP Workflow |

STEP Workflow | Sales Item Creation e

|STIBOSYSTEMS

State

X
Displaying 0 of O
ame

{any State]

[notin STEP Workflow]
Copy Writing
Digital Asset Review

Mew Digital Asset
Sales Ttem Review

VWeb Categorize

TE

e MASTER DATA MANAGEMEMNT

» Select[notin STEP workflow] to search objects which are not present in the selected workflow.

STEP Workflow ;1

STEP Workflow | Sales Item Creation
State [notin STEP Waorkflow]

gp Reset

Displaying 0 of 0 results Show Details

[ Mame

>

4. If needed, click the green plus button () to add additional search criteria.

5. Click Search to run the search and view results.
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STEP Workflow _
STEP Workflow _Eales Item Creation Search Re=zult Proﬁling
[any State
State [any ] ] 5 hi(s)
p==== (lick links to narrow down search
Ex =1 IEX8
Displaying 5 of 5 results Hide Detailz .
Mame > Results b}" Db]ect T}"PE
) .. 18207-012 Product (5) - exclude
18207 | Salesitemn (5) - =xclude
|..18214-012 — _
> 18214 Results by Position in Tree Hierarchy
R It P t
ILIBIIS—DIZ esults by Paren
? 18215 ro—BhiI’TS (4) - exclude
[C1T-shirts and Sweatshirs (4) - =ccluds
ILIBEI}"—DIE [T Tire Care Salesltems (1) - =xcluds
F
18217
| 101164
*
101164
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Search: Unapproved

This criteria is used to identify objects that are not currently approved. These include classifications, products,
images and documents, and entities setup to be Workspace revisable.

1. Click on the Search tab and click the Search dropdown.

Reset Search

Show Details

Search

2. Select Unapproved from the dropdown.

Search
| Unapproved =
@ MNever Approved or Modified in Main

() Newver Approved
(71 Modified in Main

Status in Current Context

(Ep [ Reset ] [ Search ]
Show Details
[ Name 3

3. Select the appropriate radio button and set the checkbox:

« Never Approved or Modified in Main: All objects that have 'Never been approved' and have been
'Modified in main'.

« Never Approved: Objects (products, classifications, assets & documents, or entities) that are workspace
revisable and that have never been approved.
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Product

Black Lamp rev.0.1 - Product

Images & Documents || Commercial || Tables || Category Profile || Proof View || Status || Skate Log | Tasks

Sub Products References

@ Desaipton

Mame *| * |Value
» D SP2085653-2
* Mame Black Lamp
* Ohject Type Active Products
> Pevision 0.1Last edited by USERM on Wed Jul 26 08:48:51 EDT 2017
Approved x Mever Been Approved
* [Translation Mot Translated
* Path Primary Product Hierarchy Products Hardware Tools Task Lighting/Desk Lamps/Desk L:

» Modified in Maintenance: Objects that are modified after the approval or added to in the maintenance

workspace.
@ Desipfon

Mame *| * |alue >

> [0 120223

* Mame 120223

»* DOhiject Type Open Item

> Revision 0.6 Last edited by USER] on Wed May 31 08:42:19 EDT 2017

> \Approved x Last Approved on Mon Mov 02 10:37:35 EST 2015

» [Translation Master

> Path Primary Product Hierarchy Products/Electrical and Electronics \Wire & Cable/Cable/Cable Ite...

1STIBOSYSTEMS
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» Status in Current Context: When this box is checked, only the current context is searched. If unchecked,
all objects in all contexts are searched.
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| I Context _English s

r [ Unapproved =]
i@ Mever Approved or Modified in Main

Tree

(") Never Approved

(7 Modified in Main

(2) |

I Status in Current Context

Er | Reset || Search |
Show Details

| Mame *|

BG Processes

4. If needed, click the green plus button () to add additional search criteria.

5. Click Search to run the search and view results.
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Search: Unpushed or Failed Assets

The Unpushed for Failed Assets search criteria allow you to identify assets that have not been successfully
pushed. These assets have an Asset Push Status of 'Never been handled', 'Asset not in workspace,' or 'Error.'

5-2033 M rev.1.0 - Status

Images & Documents || References || Referenced | State Log || Tasks

Configuration * |Asset Push Status » |Relative Path * |Workspace * |Visibility »
* |asset Push Configuration 1B | Downloaded |E| AssetPushConfiglB/88/01/8801.jpg  [Main
* raw-main Never been handled Main
¥ |Asset Push Configuration 1 A Asszet not in workspace Approved

1. Click on the Search tab and click the Search dropdown.

ﬂ

| Resst || Search |
aarch Result Show Details

[ Unpushed or Failed Assets ¥} |Eﬂ

Configuration: |

3. Click the ellipsis button (E) to display the Select Asset Push Configuration dialog.
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Configuration: | j

dh - Resst | Search |

Show Details

[ Name >]
[ Select Asset Push Configuration >

m Search

El--[f Event Queues

[ﬂ Addresses

ﬁ] assetpushl

E}ﬁ] Asset Push 1 Queue

. .- Asset Push 4 A
-]l Asset Push Configuration 1 A
@ Asset Push Configuration 1B W

®-petals
s

4. Select a configuration and click the Select button.

[ Select Asset Push Configuration >

m Search

E--[ﬂ Ewvent Queues
i Addresses
ﬁ assetpushl
E}ﬂ Asset Push 1 Queue

----- % Asset Push 4 A

%l Asset Push Configuration 1A

----- @ Asset Push Configuration 1B W

o-;
[Cose ]| cones

5. Click the Search button to display the Search Results List and Profiling information.
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< Search Result Profling >

[Unpushed or Failed Assets |
{Canﬁguraﬁon: |Asset Push Configuration 1 A (AssetPushConfigl) ‘Eﬂ

Search Result Profiling

58 hit(s)
9 Click links to narrow down search
Displaying 58 of 58 results
IName It ;
> {1 555-2033_M 10 = 5501 - Res by Object Type
> || 20695 back D = 207 Asset (58) - exclude

w

'w| 20695 main I = 20701

'w| 20695 side 10 = 2070:
'w|910835 I = 210835
'w|910836 1D = 91053

'w| ACME Comfy bed o = 22215
'w|Battery I = 22325

'm| Product Image (40} - scclude

g% Owners Manual (B) - excluds

] Export Manager Confiquration (2) - exclude
1000 (2) - exclude

lcon (2) - exclude

Installation Manual (2) - sxclude

Wl oW | oW | oW

w

;%:ﬁ:fii;isjjﬁ Configuration (1} - sxclude

? [B]caull single 1D - 623 Results by Position in Tree Hierarchy
> |\ Coffee Maker 10 = 22191

> || Cup1 1D = 2505: _ || Results by Parent

> [ Cup2 ID = 25083 “ ||} (Displayingthe 5 most comman)

> || cup3 D = cups [ Assets (17) - sxclude

s M@l dicnlae T - 77090 EM - exclude

Note: Click an item in the list to view it, or click a profiling link to update the search results list.
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STEP Workbench Keyboard Shortcuts

Within STEP Workbench there are many shortcut key combinations that allow users to quickly navigate and
make changes through the system. The following tables list and describe the options available for Shortcut Key
options.

Basic Shortcuts

Shortcut Description Shortcut
Key
Copy Creates a duplicate of the information selected that can be pasted somewhere else. | Ctrl+ C
Cut Takes away information that can be pasted into a different location if desired. Ctrl+ X
Duplicate | This duplicates the item selected, with the option to duplicate references as well. Ctrl+J
Goto This brings the user to the Goto field in the upper right hand corner of the workbench | Ctrl+ G

screen where items are looked up.

Goto Finds the next item that most closely matches what the user is looking for. The Ctrl+ E
Next results may differ depending on what tab the user is in and working with, or what
area is selected as active.

Help When workbench is open, displays a new window that with the STEP Online Help F1
documentation.
Next Shifts the focus to the next cell. Tab
Paste When information that was either cut or copied from before is placed into an Ctrl+V
alternate area.
Previous | Shifts the focus to the previous cell. Shift +
Tab
Redo Goes to the changed sate, if the change was reversed. Ctrl +
Shift+Z
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Shortcut Description Shortcut
Key
Reload Reloads the workbench and updates to any changes made. F5
Select All | When the desired areais clicked in or is already the active area, pressing this key Ctrl+ A
combination will choose everything in this particular area.
Undo Goes back to the original state before the change was made. Ctrl+Z

Navigate to Main Side Bar Tabs in Workbench

Shortcut Description Shortcut
Key
Background | Unless a product is being viewed, this will bring the user to the Background Alt+P
Process Processes tab. If a user is on a product, this key combination will not transpire.
Tab
Bookmarks | Brings the user to the Bookmarks side tab. Alt+M
System Brings the user to the System Setup tab. Alt+Y
Setup Tab
Search Tab | Leaves the user looking at what they were on in the main frame, but bringsup the | Ctrl+F
Search Tab along the left hand side.
Tree Tab This will bring a user to the Tree Tab only if not viewing an itemin Tree inthe main | Alt+ T
screen, or having an item still show up in the main screen even though navigation
has been away from it.
Workflow Navigates to the STEP Workflows tab. Alt+W
Tab

Navigate to Horizontal Tabs within Main Sidebar Tabs

To navigate to the horizontal tabs within the main tabs in workbench, press Alt + (the letter underlined on the

tab).

For example, if a workflow is selected within System Setup, pressing Alt + S displays the Status tab for the
workflow being viewed because 'S' is the underlined letter for the Status tab.
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Note that options for shortcut keys to horizontal tabs vary depending on what item is selected and in what main
tab a user is located (Tree, Search, Background Processes, System Setup, Bookmarks, and STEP Workflow).
Not all tabs have underlined letters for shortcut key options.

General Shortcuts Useful in Workbench

Shortcut Description Shortcut

Key

Add Bookmark When on an object and this is pressed, it will add the item to the Ctrl+D
bookmark list on the Bookmark tab.

Add Element When adding various elements, pressing this key combination will often | Ctrl +
(notin all cases), bring up a dialog allowing the user to add to the Plus
desired list.

Approve Object When in Main, approves an object that was previously unapproved. Ctrl +

Shift+J

Mark Different (On In Tree, when viewing multiple products at once, or when viewing the Shift +

multi-product display) | horizontal Sub Products tab for an item, selecting this key combination F12
will mark all areas that are different green.

New Window With STEP Workbench open, this will open an additional STEP Ctrl+N
Workbench window.

Remove Element When deleting various elements from lists or rows, pressing this key Ctrl +
combination will often remove the desired connection or item. Minus
Rotate Table (On In Tree, when viewing multiple products at once, or when viewing the F11

Multi-Product display) | horizontal Sub Products tab for an item, this rotates the table view if the
table is the active area.
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Shortcut Description Shortcut

Key

Toggle attribute
values selection
between blinking
cursor and blue filter

When on afield that is editable, selecting F2 allows the user to write in F2
the field. When pressed again, the entire field turns blue, rendering it

entered and non-editable, unless F2 is pressed again or the field is

clicked into again.

Insert Options

Shortcut

Description

Shortcut

Key

Insert Action Set In System Setup, when in the Action Sets, pressing this key | Ctrl + Shift
combination will create a child Action in an Action set. +S
Insert Asset The Create Asset dialog appears when in Tree. Ctrl + Shift
+A
Insert Attribute Displays the Create Attribute dialog in System Setup. Ctrl + Shift
+T
Insert Attribute Group In System Setup, this creates a new Attribute Group if Ctrl + Shift
sitting on the proper level. +1
Insert Background This allows a user to set up a background process to Ctrl + Shift
Process to Monitor monitor states with exceeded deadlines in the desired time | + D
Deadlines/ STEP frame.
Workflow Deadline
Monitoring
Insert Character Tag When typing in a field and this is selected, a dialog appears | Ctrl+ R
allowing the user to select from character tags.
Insert Classification In Tree, this inserts a new yellow folder, or classification. Ctrl + Shift
+C
Insert Classification Root | In Tree, a new Classification Root or top node yellow folder | Ctrl + Shift
is created. +R
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Shortcut Description Shortcut
Key

Insert Dimension In System Setup, when sitting on the top node for contexts, | Ctrl + Shift
clicking these keys will bring up the dialog to create a new +D
dimension.

Insert Dimension Point In System Setup, when on a dimension, selecting this will Ctrl + Shift
create the dimension point. +M

Insert Group In System Setup, when on the node that houses Usersand | Ctrl + Shift
Groups, selecting this key combination will create a new +G
group.

Insert List of Values In System Setup, when sitting on the top node for List of Ctrl + Shift
Values, pressing this will bring up the dialog to createanew | + L
List of Values.

Insert non-breaking space | Enters a non-breaking space when editing attribute values. | Ctrl + Enter

Insert Orphan Attribute When on a product, this will insert an orphan Attribute, Ctrl + Shift
which will appear in italics. +0

Insert Product When in Tree, this will create a new object under the one Ctrl + Shift
selected. +P

Insert Special Character When in a field that allows typing, selecting this bringsupa | Ctrl + Shift
list of characters that can be selected and inserted into the +E
field.

Insert STEP Workflow In System Setup, when on the top node for workflows, or Ctrl + Shift
when inside the node for workflows, selecting this willbring | + R
up a new STEP Workflow Designer window to create a
new workflow.

Insert Workspace In System Setup, when on a workspace, selecting thiskey | Ctrl + Shift
combination will create a different workspace. +W
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Shortcut Description Shortcut
Key
Link Asset When on References or References By tab, this allows asset links or references | Ctrl +
to be selected and put into the appropriate folders. Note that the Reference Type | Shift + F
can be changed from the drop-down menu in the dialog that appears.
Link Attribute | To link an Attribute to an item, select the item that needs the attribute and select Ctrl +
to this key combination. Linked attributes will appear in the References tab under Shift+Y
Classification | the 'Attributes' flipper.
Link Attribute | When on a product, selecting this key combination links an attribute to a product. | Ctrl +
to Product Shift + K
Link This links a classification to a product. It can be found under the Reference tab Ctrl +
Classification | under the 'Linked Attributes to Classifications Hierarchy' flipper. Shift +H
to a Product
Paste Link Creates a new reference (pointer or link) to an existing / copied object. An Ctrl+L
example would be if the user copied a SKU from a blue folder and pasted it into
the yellow folders. Note that object types need to be compatible.
Link Product | When on References or References By tab, this allows product links or Ctrl +
/ Create Link | references to be selected and put into the appropriate folders. Shift + Q

Style Options

Shortcut Description Shortcut
Key
Bold When typing in afiled, this activates bold text. Ctri+B
Character Tag | Opens the Insert Character Tag dialog for adding charactertagsto | Ctrl+R
attribute values.
Italic When typing in a field, this activates italic text. Ctrl + 1
Non-breaking Enters a non-breaking space when editing attribute values. Ctrl +
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Shortcut Description Shortcut
Key
Space Enter
Special Opens a dialog showing the most recently used special characters, | Ctrl+
Character as well as an option to select to view all special characters. Allows Shift + E
user to select a special character to insert when editing attribute
values.
Style This key combination can be pressed to bring up the Style box, Ctrl+Y

where there are a number of styles to choose from.

Rich Text Opens the Rich Text Editor in STEP Workbench when editing an Alt+F2
Editor attribute value.

Paste and Whenin a field, if 'text A" is copied from one area and is going to be Ctrl +
Match Style pasted into 'text B' that is a different style, pressing this key Shift+V

combination will make it so the copied 'text A' will past into 'text B'
with the style of 'text B'.

Flatplanner Shortcuts

Shortcut Description Shortcut Key

Save (In Flatplanner) This save what is being worked on. Ctrl+ Alt+ S

Zoom In (In Flatplanner) This zooms in on what is being worked on. | Ctrl + Plus

Zoom Out (In Flatplanner) | This zooms out of what is being worked on. | Ctrl + Minus
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